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Introduction 


Minimum PC Specifications 


Consider a number of factors when determining the correct PC specifications for different 


scenarios.  The Database Server usually has the highest specification requirements.  Consider 


the following factors when specifying the Database Server: 


 


 Number of doors (Terminals) 


 Number of Tagholders supported by the System 


 Number of client (Module) connections to the Database 


 


DDaattaabbaassee  SSeerrvveerr  


 
Figure 1 – Database Server 


 


 


The number of client connections to the Database Server will affect the performance of the Database 


Server.  Adjust the specification allowing for all client connections to perform Database tasks efficiently. 


 


 


The volume of transactions per Site affects the performance of the Database Server.  Adjust the 


specification allowing for rapid Database growth and Reports that work with large result sets. 


 


 


This specification is for a dedicated Database Server only, without additional Software (third-party or 


ImproNet Modules). 
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IImmpprrooNNeett  MMoodduullee  PPCC’’ss  


 


 


Ensure that you install all ImproNet Modules on dedicated PC’s. 


 


 
Figure 2 – Standard Software Modules (Engine, Access (including Card Designer), QuickTag, 


Visitor, Transaction Viewer, Alarms Client) 


 


 
Figure 3 – Optional Client Software Modules (Graphics Designer, Graphics Runtime) 
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Figure 4 – Optional Server Software Modules (Impro Touch, Impro Vision) 


 


 


The number of third-party devices that are used by each optional Server affects the performance of the 


System.  Adjust the specification to allow the optional Servers to run at an optimal level. 


 


 


The number of client connections to each optional Server affects the performance of the System. 


 


KKnnoowwnn  IIssssuueess  


 There are known isolated cases of ImproNet not installing correctly on some Dell PC’s 
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ImproNet Applications 


The ImproNet Software Suite consists of a collection of Modules and Utilities.   


 


The Modules form the core of the ImproNet Suite and provide control for everyday and 


important functions.  The Utilities provide support for advanced configuration and system 


maintenance.  This section provides a brief description of the ImproNet Modules and Utilities. 


 


ImproNet Modules 


It is possible to run the entire ImproNet Software Suite on a single PC.  However, the Suite is 


designed to operate on multiple PC’s in a Client-Server configuration.  Therefore, to ensure 


correct functioning, it is essential to have dedicated PC’s as specified in this Manual.   


 


The configurable aspect of the ImproNet Modules enables efficient operation in LAN and WAN 


infrastructures; each ImproNet Module performs a specific function. 


 


AAcccceessss  MMoodduullee  


ImproNet Access is the configuration module for ImproNet.  It performs a number of important 


functions including: 


 


 Site and Host configuration. 


 Hardware configuration – enables an installer to define and configure ImproX hardware 


such as Terminals and Controllers. 


 Tagholder Access Group configuration.  The key element of access control – a Tagholder 


Access Group is a combination of when (Access Time Patterns) and where (Areas) 


Tagholders have access. 


 The Live Video Image Capture feature enables capture of photographs of Tagholders using 


live video from a web camera.  Photographs captured in this way are inserted into the 


stored Tagholder data and displayed in the Add Tagholder or Edit Tagholder screens for 


that Tagholder. 


 Photographs (in suitable formats) can also be loaded from files and inserted in the same 


way. 


 Batch card printing is a feature of this Module. 


 


EEnnggiinnee  MMoodduullee  


ImproNet Engine is the communications Module.  It is required to do the following: 


 


 Monitor the Database for edits made by ImproNet client applications such as ImproNet 


Access, or QuickTag.  Edits or changes are communicated to the ImproX Controllers. 


 Polls the ImproX Controllers for transactions, then logs the transactions to the ImproNet 


Database. 
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 Runs the ImproNet Reports web server. 


 


 


Engine must be running for Web Reports to run. 


 


 Open socket connection ports for Modules such as ImproNet Graphics, which make a direct 


connection to the Engine. 


 


WWeebb--bbaasseedd  QQuuiicckkTTaagg  MMoodduullee  


The web-based QuickTag Module is intended for use for example, by an operator using a PC at 


a location remote from the System’s Access Host PC.  This Module requires no extra ImproNet 


software installation, simply installing Java Runtime Environment V1.60 and above allows any 


member of your staff access to the Module.     


 


The Module’s basic function is enrolling Tags so employee Tagholders and visitor Tagholders 


may access selected areas at named times.  As this is an enrollment Module, each PC running 


the web-based QuickTag Module must connect to a Registration Reader.   


 


The benefit of running this now entirely web-based Module, is less bandwidth usage promoting 


improved network speed.   


 


You may use the web-based QuickTag Module with Windows® Internet Explorer 7 (and above) 


or alternatively Firefox 2 (and above). 


 


QQuuiicckkTTaagg  MMoodduullee  


The QuickTag Module is intended for use for example, by an operator using a PC at a location 


that is remote from the System’s Access Host PC.  This Module could typically be installed on a 


PC in the Reception Area.  The QuickTag Module is a rapid Tagholder/Tag entry Module for 


enrolling both Employee and Visitor Tagholders into the Access Control System.  This Module’s 


basic function is to add Tags so Employees and persons visiting the company may have access 


to selected areas at named times. 


 


This Module also allows the Supervisor to disable certain editing features, thus improving the 


security of this Module.  By disabling these features, the operator has limited access and 


therefore cannot change any sensitive setting in the System.  Each button within the application 


can be disabled. 


 


The Live Video Image Capture feature enables capture of photographs of Tagholders using live 


video from a web camera.  Photographs captured in this way are inserted into the stored 


Tagholders data and displayed in the Add Tagholder or Edit Tagholder screens for that 


Tagholder.  Photographs (in suitable formats) can also be loaded from files and inserted in the 


same way.  


 


VViissiittoorr  MMoodduullee    


The Visitor Module is designed to be used, for example, by an operator using a PC remote from 


the Systems Access Host PC.  This Module could typically be installed on a PC in the Reception 


Area.  The Visitor Module is a rapid Tagholder/Tag Entry Module for enrolling Visitors into the 
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Access System.  It is intended to be a front-desk, Reception area, application.  This Module’s 


basic role is to add Tags so persons visiting the company may have access to selected areas at 


specified times. 


 


This Module also has the facility of setting up Visitors’ Tags so that they cannot gain access to a 


door unless a Host Employee first presents a Tag, after which the Visitor’s Tag should be 


presented within ten seconds.  This facility enhances the security of the company by not 


allowing Visitors to walk freely into sensitive non-Visitor areas.  


 


GGrraapphhiiccss  DDeessiiggnneerr  MMoodduullee  


Used to create graphical plan representations of Sites, buildings, offices, car parks, and so on 


within a Site.  Graphics Designer permits the arranging of icons that represent buildings on a 


Site map, and icons that represent ImproX hardware units on Floor Plans within those buildings.  


We suggest that Graphics Designer be installed on a secure PC to limit the possibility of the 


setup being tampered with.  


 


GGrraapphhiiccss  RRuunnttiimmee  MMoodduullee  


This Module provides real-time graphical monitoring of the Site. This Module can be used to 


display alarms from related systems such as Ziton or CaddX, and to acknowledge these alarms.  


Initial set-up is made via the Graphics Designer Module.  At Runtime the operator chooses 


which Ground Plan or Floor Plan to display.  Thereafter the operating actions are limited to 


responding to any alarm displays, finding the last known position of a Tagholder, displaying 


transactions and so on.  


 


CCaarrdd  DDeessiiggnneerr  MMoodduullee  


The Card Designer Module allows the user to design templates for use with Credit Card Tags. 


These templates can then be used to print information on to these tags, such as company 


name, Tagholder’s name, ID number, employee number, department, barcode, etc, as well as a 


photograph of the Tagholder.  The related batch card printing is a feature of the Access Module.  


 


TTrraacckkeerr  MMoodduullee  


The Tracker Module keeps you advised as to the whereabouts of selected Tagholders 


(maximum 10 Tagholders per site) as they move about the Site.  Alternatively, you may use the 


Tracker Module to monitor events at a selected Reader (maximum 10 Readers per Site).  Both 


these facilities allow for better end user site management, by displaying the latest 20 


transactions for today only, in time order per your group (Tagholders or Readers) selected.    


 


  


In instances where a single Tagholder (Reader) returns more transactions than others it may happen 


that some Tagholders (Readers) do not appear in the list of transactions.  It must be emphasized that it 


is the most recent 20 transactions for the group, not the most recent for each individual Tagholder.  


Achieve best results with this Module by narrowing your range for monitoring to your exact 


requirements.    


 


On opening, the Tracker Module remains discreetly minimized as an icon in the System Tray 


(Notifications Area).  As Tracker receives Tagholder transactions or events from Monitored 


Readers, notification pop-up windows display in the Notification area. 
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By default the Tracker Module refreshes every 10 seconds, this is the recommended setting.  


The refresh rate is, however, user configurable where you need a faster or slower refresh rate. 


 


AAllaarrmmss  MMoodduullee  


This Module provides real time monitoring of alarm transactions and acknowledging of alarms. 


 


TTrraannssaaccttiioonn  VViieewweerr  MMoodduullee  


The Transaction Viewer client Module gives a live real-time view of all types of transactions in 


the System.  It displays the names of the access points (Locations) and details of the persons 


who have entered or exited those Locations.  The process can be set to monitor the whole Site, 


or just a selected Zone or access point.  The Module supports Tagholder image display  as well.  


The Transaction Viewer client process may be run on any machine on the network and more 


than one Module can run simultaneously. 


 


CCuussttoomm  AAcccceessss  MMoodduullee  


The Custom Access Module works in conjunction with the Access Module.  Where the Access 


Module allows access to Tagholders based on Access Time Patterns and Tagholder Access 


Groups the Custom Access Module uses its own set of rules for granting or denying access.  


  


As a third-party validation system, the Custom Access Module connects via TCPIP Client 


Socket connection to the started Engine Module.  The Custom Access Module listens for all 


third-party transactions coming from all Engines’ Sites.  Based on the Custom Access Module’s 


own set of user defined rules, the Module allows or denies the transaction. 


 


ZZiittoonn  SSeerrvveerr  MMoodduullee  


This Module interfaces the third-party Ziton Fire Alarms system to ImproNet.  The Impro Ziton 


Server permits alarms from one or more Ziton Fire Alarm Panels to be displayed on, and 


acknowledged from, the associated Floor Plan in the Graphics Runtime Module.  


 


CCaaddddXX  SSeerrvveerr  MMoodduullee  


This Module interfaces the third-party CaddX Alarm system to ImproNet.  The CaddX Server 


Module displays alarms from CaddX Alarm Panels.  Acknowledgement of alarms takes place 


from graphics Floor Plans in the Graphics Runtime Module.  


 


DDVVRR  SSeerrvveerr  MMoodduullee    


The DVR Server Module controls the operation of a related iNet DVR, or Vista CCTV 


surveillance system.  This Module lets the ImproNet operator select cameras, zoom, pan, and 


perform other functions in the CCTV system using the ImproNet Graphics Runtime Module.  


 


GGaannzz  SSeerrvveerr  MMoodduullee    


The Ganz Server Module allows integration of Ganz CCTV surveillance systems with the 


ImproNet Software.  
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IImmpprrooVViissiioonn  IInntteeggrraattiioonn  MMoodduullee    


The ImproVision Integration Module is a rule-action based Module.  This essentially means a 


matched rule must trigger for execution of up to 5 actions.  Born as a Digital Video Recorder 


based system, for interfacing Digital Video Recorders direct to the ImproNet’s Graphics 


Designer and Graphics Runtime Modules, ImproVision’s interface capabilities now include other 


third-party devices (including Lift Servers and Alarm Panels).  


 


ImproVision’s digital video recording and monitoring integration facilities include: 


 


 Integration with Mirasys V/N Series Digital Video Recording (DVR) equipment. 


 Integration with Dedicated Micros Digital Video Recording (DVR) equipment. 


 


BBiioommeettrriicc  SSeerrvveerr  MMoodduullee  


Embedded in the ImproNet Software, the Biometric Server Module integrates selected biometric 


readers into an ImproNet System.  This Module uses a centralized Database, and permits the 


user to add, edit or delete bio-templates. This Server is part of the Impro Touch concept. 


 


ImproNet Utilities 


AArrcchhiivvee  UUttiilliittyy  


The Archive Utility enables you to create copies of the ImproNet Database on specified dates.  


You can use these Database copies to generate transaction reports for a particular historical 


period.  Running Archive also decreases the size of the ImproNet Database. 


 


DDaattaabbaassee  UUppggrraaddee  UUttiilliittyy  


This Utility enables automatic updating of the ImproNet Database.  The Utility checks for 


available update scripts and processes them automatically. 


 


IIBBCCoonnssoollee  UUttiilliittyy  


IBConsole is a third-party database configuration and administration tool.  You can use 


IBConsole to perform advanced configuration and administration tasks on the ImproNet 


Database. 


 


IImmppoorrtt  UUttiilliittyy  


This Utility is used to import comma separated value (CSV) files into the ImproNet Database.  


You can use it to import data such as employee records from other applications, to the ImproNet 


Database.   


 


FFiinndd  DDuupplliiccaatteess  UUttiilliittyy  


Importing CSV files into the ImproNet Database can result in duplicate records.  The Find 


Duplicates Utility enables you to search the Database for, and delete duplicate records. 
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IIXXPP220000  CCoonnvveerrssiioonn  UUttiilliittyy  


The IXP200 Conversion Utility facilitates conversion of an IXP200 Database to an ImproNet 


Database.   


 


 


This Utility converts user data only.  Ensure that you reconfigure Site information in ImproNet. 


 


PPuummpp  UUttiilliittyy  


Pump transfers user-defined data from the existing ImproNet Database to a new empty 


database when ImproNet is upgraded to a new version. 


 


TTrraannssllaattee  UUttiilliittyy  


This Utility facilitates changing the field names in the ImproNet Database to words of another 


language.  The Translate Utility requires you to manually enter replacement text.  


 


UUnnlloocckk  UUttiilliittyy  


The Unlock Utility enables you to activate applications that are otherwise disabled.  You do this 


by entering a code called a Product Unlock Key into the Utility.   


EEtthheerrnneett  CCoonnffiigguurraattiioonn  UUttiilliittyy  


Communications between the Host PC and the ImproX EC uses Ethernet protocols.  The 


ImproX EC must be configured for the Ethernet protocol in use on the LAN/WAN, using the 


Ethernet Device Configuration Utility software.   The Ethernet security and operational settings 


for the ImproX EC are also configured in the Ethernet Device Configuration Utility. 


 


DDiissccoovveerryy  UUttiilliittyy  


The Discovery Utility allows the following actions: 


 


 Detection of Controllers (System Controllers) on the network. 


 Detection of Terminals (Door Controllers) on the network. 


 Configuration of network address settings. 


 Configuration of the Controller’s settings. 


 Configuration of the Terminal's settings. 


 


FFiirrmmwwaarree  UUppggrraaddee  UUttiilliittyy  


The Firmware Upgrade Utility lets you perform the following actions: 


 Identify Firmware versions of connected Hardware. 


 Selection and configuration of Communications Port. 


 You may Ping the connected Hardware (feedback informs you of whether Hardware is 


connected and working as specified). 


 Perform in-field Firmware Upgrades to connected Hardware. 
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MMaannuuaall  AAuuttoo--IIDD  UUttiilliittyy  


This Utility lets you add Controllers and Terminals not previously added in Access.  You may 


also edit selected Controller and Terminal properties (for example:  Site SLA, Unit Type, Fixed 


Address, Controller LA and Terminal LA) or delete Controllers and Terminals. 


UUnniivveerrssaall  DDaattaa  EExxppoorrtt  UUttiilliittyy  


The Universal Data Exporter Utility lets you extract transaction (including time and attendance) 


records from the ImproNet Database for use by third-party applications.   


 


The Exporter Utility makes use of user defined templates (created in Design Mode) that specify 


the data for extraction and the export format.  Using the Run Mode, you have the choice of 


exporting the records interactively or as scheduled (using Windows® Scheduler).  Command 


line arguments specify the Mode and other parameters. 
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Peripheral Hardware 


ImproNet uses various peripheral hardware devices to perform a software protection function.  


Some ImproNet Modules search for these devices on start-up.  If the required device is not 


present, the Module does not run.  Some devices also perform Tag enrollment and 


communication functions. 


 


 


USB Enrollment Readers are compatible with ImproNet Software Suite V6.44 or later only. 


 


 Device Description 


 The ProxMate performs a Tag enrollment and software 


protection function.   The ProxMate connects directly to the 


PC’s RS232 serial port or to the Host Interface that connects 


to the PC.  There are two versions of the ProxMate: 


 


 INS900—bundled with the INS904 software package.  


The following Software Modules run with the ProxMate:  


Access, QuickTag, Visitor, Graphics Designer and 


Graphics Runtime.  An additional unlock code is required 


if the ProxMate is required to run on the iNet DVR 


integration.   


 XPM912 Utility ProxMate—generally used when 


ImproNet Modules are required to run on multiple PC’s.  


The Utility ProxMate enables you to run the following 


Modules:  QuickTag, Visitor, Graphics Designer and 


Graphics Runtime.  The Utility ProxMate requires an 


additional unlock code to run ImproNet Access. 


 The Host Interface carries out the following functions: 


 


 Acts as an RS232 to RS485 converter. 


 Performs a software protection function. 


 Facilitates inter-controller communications. 


 


The ImproX RH is a USB version of the Host Interface.  It is 


used as an RS485 to USB converter and for Software 


protection (Engine needs connection to an RH at start-up). 


The ImproX RH facilitates inter controller Communications.  


Connect the ImproX RH to an external battery backed-up    


(10 to 30 V DC) power supply thus ensuring inter controller 


communications is maintained during a power failure or PC 


reboot. 


 


The ImproX RH does not support the ProxMate; however you 


may connect the ImproX RRA or ImproX RRM (supports the 


enrollment of 125 kHz or MIFARE® Tags respectively). 
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 Device Description 


 


The ImproX RS enables third-party readers such as Barcode 


and Magstripe readers, to interface with the ImproNet System 


as enrollment readers. 


 


The RS also performs a software protection function for the 


same Modules supported by the Utility ProxMate, that is 


QuickTag, Visitors, Graphics Designer and Graphics Runtime. 


 


The ImproX MDE is an external Enrollment Reader that 


connects direct to the USB Port of the PC.  The ImproX MDE 


performs the following dual function: 


 


 Authentication device—interfacing with the ACCESS 


Software Module on the various Database platforms.  And 


interfacing only with the UTILITY Software Modules 


across the Firebird and SQL Server Database platforms. 


 Registration of 125 kHz and 13.56 MHz Tags.  
 


The ImproX RRA is an external Enrollment Reader that 


connects to an ImproX RH or ImproX RS.  The ImproX RRA 


reads 125 kHz Tags. 


 The ImproX RRM is an external Enrollment Reader that 


connects to an ImproX RH or ImproX RS.  The ImproX RRM 


reads MIFARE® 13.56 MHz Tags. 


 


The ImproX B-SHO USB Fingerprint Enrollment Reader 


and ImproX B-SHO BioMini USB Fingerprint Enrollment 


Reader are external enrollment readers that connect direct to 


the USB Port of the PC.   


 


These Enrollment Readers allow for registration of 


fingerprints for use by ImproX B-SHO Fingerprint Terminals.  


For more information on the use of these products with the 


ImproNet System, refer to Part 8 – Integration Modules. 


Table 1 – Peripheral Hardware 
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ImproNet Network Specifications 


The ImproNet Suite is designed to run over a network in Client-Server mode.  However, it can 


also run successfully on a single PC. 


 


Architecture 


BBaannddwwiiddtthh  UUssaaggee  


The following table outlines the estimated completion time (bandwidth usage) when uploading 


information from the Database to the Controller using TCP/IP. 


 


 


Figure 5 – Bandwidth Usage Matrix 


 


 


Note 1—This Bytes Sent and Received information is not required as the test only shows the average 


data usage over a given time period. 


 


 


Note 2—These Bytes Sent and Received figures refer to SQL Server. 
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CClliieenntt--SSeerrvveerr  


Client-Server architecture consists of users’ PC’s (Clients) connected via a network to a central 


host (Server).  In most situations, Client PC’s are workstations that access files or databases, or 


applications running on one or more Servers.  In ImproNet, the Engine and Database are the 


Server components.  The rest of the applications are Client components. 


 


SSooffttwwaarree  CCoonnnneeccttiioonn  RReellaattiioonnsshhiippss  


The following diagram shows the relationship between the ImproNet Database and ImproNet 


Client applications.   


 


 
Figure 6 – Software Connection Relationships Diagram 
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Socket connections enable communication between PC’s.  Database connections enable 


communication between PC’s and the ImproNet Database.  Jaybird is an interface component 


installed with the Firebird database; it facilitates database interaction. 


 


NNeettwwoorrkk  HHaarrddwwaarree  


An ImproNet compatible network requires CAT5 or CAT6 UTP cabling and a 100 Mbps or 


faster, TCP/IP enabled Network Interface Cards (NICs). 


 


 


The ImproX ECII is rated to 100 Mbps, however the Controller will work on a 1 000 Mbps (1 GB) 


network. 


 


RRoouutteerrss  


If routers or switches are used, they must conform to the TCP/IP protocol operating at           


100 Mbps or faster. 


 


ImproNet Modules in a Network Environment 


The ImproNet Suite is designed to run over a network in Client-Server architecture.  However, 


all Modules can run on a standalone PC if required.  The following components are important 


when running ImproNet over a LAN or WAN: 


 


 ImproNet Database 


 Firebird Database Server or SQL Server 


 ImproNet Engine 


 


IImmpprrooNNeett  DDaattaabbaassee  


By default, ImproNet uses a Firebird Database.  Firebird installs with ImproNet during the 


Software installation process.  By default the Database installs at C:\ImproNet\Database.  


Impronet.fdb is the name of the database file. 


 


 


Firebird is an open-source product—it has no licensing fee.  For more information refer to the following 


websites: www.opensource.org and www.firebirdsql.org. 


 


FFiirreebbiirrdd  SSeerrvveerr  


Firebird Server is a Database Server program that facilitates connections between the 


ImproNet Database and ImproNet Applications such as Engine and Access. 


 


 


Firebird Server must be installed in the same PC as the ImproNet Database. 


 


SSQQLL  SSeerrvveerr  


SQL Server is a Database Server program that facilitates connections between the ImproNet 
Database and ImproNet Applications such as Engine and Access. 
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IImmpprrooNNeett  EEnnggiinnee  


ImproNet Engine functions primarily as a Communication Server.  It performs the following 


functions: 


 


 Retrieves transactions from ImproX Controllers. 


 Monitors the ImproNet Database for changes. 


 Communicates Database changes to the ImproX Controllers. 


 


Some Client Applications, such as Graphics Runtime, Transaction Viewer, and Alarms, 


process and report information in real-time.  To do this, they use TCP/IP socket connections to 


connect to the Engine.  Socket connections are also used to send messages to ImproNet 


Engine.  For example, when Graphics Runtime initiates a Door Unlock command, it is sent to 


the Engine via a socket connection.  The Engine then sends the command to the Access 


Control hardware.  Table 2 displays the Socket Ports used by ImproNet. 


 
 


Ports Port Number 


Transaction 26663 


Alarm 26661 


Messaging 26665 


Host Validation 26669 


Door Status 26667 


Firebird Server 3050 


Table 2 – ImproNet Socket Ports 


 


 


You can configure Socket Ports in ImproNet Access. 


 


The following ImproNet Client Modules connect to the Engine, or the ImproNet Database, or to 


both. 


 


 Access 


 QuickTag 


 Visitor 


 Alarms 


 Transaction Viewer 


 Graphics Designer 


 Graphics Runtime 


 


General Network Requirements 


The following requirements are essential for ImproNet to operate over a network: 


 


 Network hardware must support the TCP/IP protocol 


 The network must support 100 Mbps bandwidth or greater 


 


 


The ImproX ECII is rated to 100 Mbps, however the Controller will work on a 1 000 Mbps (1 GB) 


network. 
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Running ImproNet Applications across a LAN 


Figure 7 illustrates the network configuration for running ImproNet across a Local Area Network 


(LAN). 


 


 
Figure 7 – ImproNet Configuration across a LAN 
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Running ImproNet Applications across a WAN 


Figure 8 illustrates the network configuration for running ImproNet across a Wide Area Network 


(WAN). 


 


 
Figure 8 – ImproNet Configuration across a WAN 


 


 


Communication across a WAN is generally slower than across a LAN.  Therefore, a WANs 


performance must be carefully assessed before ImproNet is implemented across it. 


 


MMiinniimmuumm  WWAANN  RReeqquuiirreemmeennttss  


An Engine, and the Controllers the Engine communicates with, needs a minimum throughput of 


1 Mbps.  For example, a WAN capable of 2 Mbps bandwidth, must assign at least 1 Mbps for 


exclusive use by the Engine and Controllers. 
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Properties Files 


ImproNet Client applications store their connection settings in editable text files called 


Properties Files.  These files contain URLs that specify the location of the Database Server.  If 


the URL is incorrect, the application will not function. 


 


Properties Files are stored in the ImproNet root folder.  The following applications have their 


own Properties files: 


 


 Access 


 Archive 


 Engine 


 Graphics 


 Pump 


 Biometric 


 Web Reports 


 Web-base QuickTag 


 


The files have the same name as their application.  For example, the Properties file for 


ImproNet Access is called Access.properties, and is stored in C:\Impronet.   


 


Other ImproNet applications including QuickTag, Visitor, Alarms and Transaction Viewer use 


the Access.properties file. 


 


 


There is one Access.properties file per PC. 


 


Configuring Modules for a Stand-Alone (Single PC) System 


This section provides the requirements for installing all ImproNet Modules, including the 


Database Server, on a single PC. 


 


CCoonnnneeccttiinngg  ttoo  tthhee  DDaattaabbaassee  


The ImproNet Suite installs by default to C:\Impronet.  The URL in each Client Properties File 


points to the following default Database location C:\Impronet\Databases\Impronet.fdb. 


 


 


If you move the Database to another location on the PC, you must change the URL in each Properties 


file to point to the new Database location.   


 


 


For security reasons, we recommend that you do not share the Database folder. 


 


The following code is the default format for the Database URL: 


access.database.Interbase.URL=jdbc:firebirdsql://localhost/C:/ImproNet/Database/Impronet.fdb 


If you move the ImproNet Database, you must update this code to reflect the new location.   
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For example, if you move the IMPRONET.FDB file to a folder called Site1 on drive D, change 


the URL to access.database.Interbase.URL=jdbc:firebirdsql://localhost/D:/Site1/Impronet.fdb. 


 


 


If other ImproNet Applications are installed on the Database Server, the URLs in each Client 


Properties File must use a local path, not a network path. 


 


Configuring Modules for a LAN (Firebird) 


If ImproNet Modules are distributed across a LAN, Properties files must be edited to point to the 


Database Server PC, and the location of the Database on the PC. 


 


CCoonnnneeccttiinngg  ttoo  tthhee  DDaattaabbaassee  


Figure 9 shows an example of the Engine.properties file when ImproNet is installed over a 


network. 


 


 
Figure 9 – Edited Engine Properties File 


 


In Figure 9, the Database resides on a PC with an IP Address of 192.1.3.1.  In a stand-alone 


configuration, the default computer address is always Localhost.  In a networked environment, 


replace Localhost with the IP Address or Machine Name of the Database Server. 


 


Configuring ImproNet for a Microsoft SQL Server 2000 Database 


 


 


Microsoft SQL Server 2000 will NOT run on the Windows® Vista platform.   


 


 


If using the Windows® XP platform ensure that you run Microsoft SQL Server 2000 with, at minimum, 


Service Pack 4 installed. 


 


CCoonnffiigguurriinngg  MMiiccrroossoofftt  SSQQLL  SSeerrvveerr  ffoorr  IImmpprrooNNeett  


1. Open the SQL Server Enterprise Manager from SQL Enterprise Manager>Console> 


Microsoft SQL Servers. 
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Figure 10 – SQL Server Enterprise Manager 


 


2. Connect to the local server via Console Root>SQL Server Group>Databases. 


3. Right-click on the Databases folder. 


4. Select All Tasks.  


5. Select the Attach Database option. 


6. In the Attach Database dialog, click on the  button.  


7. In the Browse for Existing File dialog, select the ImproNet Database file DB400.MDF. The 


default path is C:\ImproNet\Database\sqlserver\DB400.MDF. 


8. Click on the OK button.  (The default log file DB400_LOG.LDF is automatically added to the 


Attach Database window). 


 


 
Figure 11 – Attach Database Dialog 


 


A dialog appears confirming that the Database attached successfully. 
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Creating the SYSDBA User 


 


Create a default log-in Username (SYSDBA) and Password (masterkey) as follows: 


 


1. Open the Security folder. 


2. Select the Logins option. (The right hand pane of the screen below lists the currently 


configured users).  


3. Right-click on the right side on the SQL Server Enterprise Manager window.  


4. Select the New Login option on the menu. 


 


 
Figure 12 – Server Enterprise Manager – New Login Dialog 


 


5. In the SQL Server Login Properties – New Login dialog, General tab assign the Users 


Name, in this instance we used SYSDBA. 


6. Assign the Users Password, the default password is masterkey. 


7. Select DB400 from the Database pull-down menu. 


 


 
Figure 13 – In the SQL Server Login Properties – New Login Window, General Tab 


 


8. In the SQL Server Login Properties – New Login dialog, Server Roles tab check the 


check-box alongside each of the Server Roles. 
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Figure 14 – SQL Server Login Properties – New Login Window, Server Roles Tab 


 


9. In the SQL Server Login Properties – New Login dialog, Database Access tab, ensure 


that the SYSDBA user has access to the DB400 Database. 


10. Click on the OK button completing the step. 


  


CCoonnnneeccttiinngg  ttoo  tthhee  DDaattaabbaassee  


Figure 15 shows an example the Engine.properties file when ImproNet is installed over a 
network. 
 


 
Figure 15 – Edited Engine Properties File 


 


In a stand-alone configuration, the default computer address is always Localhost.  In a 


networked environment, replace Localhost with the IP Address or Machine Name of the 


Database Server. 
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Configuring ImproNet for a Microsoft SQL Server 2005 (Standard 
Edition) Database 


IInnssttaalllliinngg  MMiiccrroossoofftt  SSQQLL  SSeerrvveerr  22000055  


1. Run Disk 1 of the Microsoft SQL Server 2005 Software. 


2. At the Start dialog, under Install, select Server Components, Tools, Books Online and 


Samples.  


3. At the End User Licence Agreement dialog, select the I Accept the Licensing Terms and 


Conditions checkbox. 


4. Click the Next button. 


5. At the Installing Prerequisites dialog, click the Install button. 


6. On successful installation of the prerequisite components, click the Next button. 


 


Microsoft SQL Server Installation Wizard 


1. Click the Next button. 


2. At the System Configuration Check dialog, click the Next button. 


3. In the Registration Information dialog, fill in the required details.  These include: 


 Name 


 Company 


 Product Key 


4. Click the Next button. 


5. In the Components to Install dialog, select the components for installation. 


6. Click the Next button. 


7. In the Instance Name dialog, select the Default Instance radio button. 


8. Click the Next button. 


9. In the Service Account dialog, select the Use a Domain User Account radio button. 


10. Complete the Username, Password and Domain textboxes. 


11. From the Start Services at the End of Setup pane, select the SQL Server checkbox. 


12. Select the Analysis Services checkbox. 


13. Click the Next button. 


14. At the Authentication Mode dialog, select the Mixed Mode checkbox. 


15. Complete the Enter and Confirm Password textboxes.    


16. Click the Next button. 


17. At the Collation Settings dialog, click the Next button. 


18. At the Error and Usage Report Settings dialog, click the Next button. 


19. At the Ready to Install dialog, click the Install button. 


20. At the prompt, insert Disk 2 into the drive and click the OK button. 


21. When all Products show their Status as ―Setup Finished‖, click the Next button. 


22. At the Completing Microsoft SQL Server 2005 Setup dialog, click the Finish button. 


 


 


After installation, you may want to install the latest service pack for Microsoft SQL Server 2005.  Follow 


the on-screen prompts. 


 


CCrreeaattiinngg  aa  LLooggiinn  AAccccoouunntt  ffoorr  SSYYSSDDBBAA  


1. In Windows®, click Start>Programs>Microsoft SQL Server 2005>SQL Server 


Management Studio. 
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Figure 16 – Connect to Server Dialog 


 


2. In the Connect to Server dialog, from the Server Name drop-down list, select the 


appropriate Server Name. 


3. From the Authentication drop-down list, select the SQL Server Authentication option. 


4. In the Login textbox, type in sa. 


5. In the Password textbox, enter the password you created in the section titled Microsoft 


SQL Server Installation Wizard (page 28), point 15. 


6. Click the Connect button. 


 


 
Figure 17 – Microsoft SQL Server Management Studio Dialog 


 


7. In the Object Explorer Pane, select the Security folder. 


8. Right-click over the Security folder and select the New menu option. 


9. Select the Login menu option. 


 


Login – New Dialog 


1. On the General page, in the Login Name textbox, type in SYSDBA. 


2. Select the SQL Server Authentication radio button. 


3. In the Password and Confirm Password textboxes, type in a suitable password. 


 


 


In this example we used the password masterkey. 
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4. Deselect the Enforce Password Expiration checkbox. 


5. Select the Server Roles page. 


6. In the right-hand pane, select the checkbox alongside each of the Server Roles. 


 


 


Ensure that the SYSDBA user has access to the DB400.MDF Database. 


 


 


7. Click the OK button. 


 


CCoonnffiigguurriinngg  MMiiccrroossoofftt  SSQQLL  SSeerrvveerr  ffoorr  IImmpprrooNNeett  


Attaching the Database 


1. In Windows®, click Start>Programs>Microsoft SQL Server 2005>SQL Server 


Management Studio. 


2. In the Connect to Server dialog, from the Server Name drop-down list, select the 


appropriate Server Name. 


3. In the Login textbox, type in SYSDBA. 


4. In the Password textbox, enter the password you created in the section titled Login – New 


Dialog (page 29), point 3. 


5. In the Object Explorer Pane, select the Databases folder. 


6. Right-click over the Databases folder and select the Attach menu option. 


7. In the Attach Databases dialog, click the Add button. 


8. In the Locate Database Files dialog, browse to the DB400.MDF Database. 


 


 


The default path is C:\ImproNet\Database\sqlserver\DB400.MDF. 


 


9. Click the OK button. 


10. In the Attach Databases dialog, click the OK button. 


 


 


From the Object Explorer pane, if you select the Databases folder, you should see the DB400 


Database in the list on the right-hand side pane. 


 


11. From the File drop-down menu, select Exit. 


 


Properties Files 


1. In Windows®, click Start>My Documents. 


2. Browse to C:\ImproNet\Database\sqlserver. 


3. Select and Copy the following files: 


 Access.properties 


 Biometric.properties 


 Engine.properties 


 Graphics.properties 


 Localization.xml 


4. Browse to C:\ImproNet. 


5. Paste the copied files, ensuring that you replace the existing Properties files. 


6. Click the  button. 
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Configuring ImproNet for a Microsoft SQL Server 2008 R2 (Express 
Edition) Database 


IInnssttaalllliinngg  MMiiccrroossoofftt  SSQQLL  SSeerrvveerr  22000088  


1. Select one of the following options: 


 If running a 32-bit operating system, run the SQLEXPRADV_x86_ENU.exe file. 


 If running a 64-bit operating system, run the SQLEXPRADV_x64_ENU.exe file. 


2. At the SQL Server Installation Centre dialog, from the left-hand side panel, select the 


Installation option. 


 


Microsoft SQL Server Installation Wizard - Part 1 


1. From the right-hand side panel, select the New SQL Server Stand-alone Installation or 


Add Features to an Existing Installation option. 


2. At the Setup Support Rules dialog, click the OK button. 


 


 


Ensure the indicated Rules are passed.  Where the Status indicates a failure, make the necessary 


corrections and re-run the test.   


 


3. If prompted to, enter your SQL Server Product Key.  


4. Click the Next button. 


5. At the License Terms dialog, select the I Accept the License Terms checkbox. 


6. Click the Next button. 


7. At the Setup Support Files dialog, click the Install button. 


8. On successful installation of the prerequisite components, click the Next button. 


 


Microsoft SQL Server Installation Wizard - Part 2 


1. At the second Setup Support Rules dialog, click the Next button. 


 


 


Ensure the indicated Rules are passed.  Where the Status indicates a failure, make the necessary 


corrections and re-run the test.   


 


2. Click the Next button. 


3. At the Feature Selection dialog, click the Select All button. 


4. Click the Next button. 


5. At the Instance Configuration dialog, select the Default Instance radio button. 


6. Click the Next button. 


7. Review the Disk Usage Summary presented, ensuring that you have sufficient drive space 


for a successful installation. 


8. Click the Next button. 


9. In the Server Configuration dialog, click the Use the Same Account for all SQL Server 


Services button. 


10. From the Account Name drop-down list, select NT Authority\System. 


11. Click the OK button. 


12. Review the Server Configuration summary information that displays.  Refer to Figure 18 for 


details of the information displayed. 
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Figure 18 – Microsoft SQL Server, Server Configuration Dialog 


 


13. Click the Next button. 


14. On the Account Provisioning tab, within the Authentication Mode group, select the Mixed 


Mode (SQL Server Authentication and Windows Authentication) radio button. 


15. In the Enter Password textbox, enter the password (masterkey). 


16. In the Confirm Password textbox, enter the password (masterkey). 


17. Click the Add Current User button. 


18. Click the Next button. 


19. Select the Install the Native Mode Default Configuration radio button. 


20. Click the Next button. 


21. Complete the Error and Usage Reporting dialog according to your preference. 


22. Click the Next button. 


 


Microsoft SQL Server Installation Wizard - Part 3 


1. At the Installation Rules dialog, click the Next button. 


 


 


Ensure the indicated Rules are passed.  Where the Status indicates a failure, make the necessary 


corrections and re-run the test.   


 


2. Click the Install button. 


3. At the Computer Restart Required dialog, click the OK button. 


4. Click the Next button. 


5. Click the Close button. 


6. Click the OK button. 
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After installation, you may want to install the latest service pack for Microsoft SQL Server 2008.  Follow 


the on-screen prompts. 


 


SSQQLL  SSeerrvveerr  CCoonnffiigguurraattiioonn  MMaannaaggeerr  


1. In Windows®, click Start>Programs>Microsoft SQL Server 2008>Configuration 


Tools>SQL Server Network Configuration. 


2. From the Directory Tree on the left-hand side of the dialog, expand the SQL Server 


Network Configuration tree node. 


3. Select the Protocols for SQLEXPRESS option. 


4. From the Items Panel on the right-hand side of the dialog, right-click your mouse over the 


TCP/IP option. 


5. Select the Properties option. 


 


 
Figure 19 – TCP/IP Properties Dialog 


 


6. Set the Enabled property to Yes. 


7. Select the IP Addresses Tab. 


8. Within the IP1 Group, set the Enabled property to Yes. 


9. Set the IP Address property to that of your local IP Address. 


10. Set the TCP Port property to 1433. 


11. Within the IPALL Group, set the TCP Port property to 1433. 


 


 


Where you have multiple Network Interface Cards, you may have more IP Address settings for 


configuration.  For each additional (IP2 to IP7) Group, change the settings as shown in points 8 to 10 


(above).  Take care to set the TCP Port to 1433.   
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12. Click the Apply button. 


13. At the Warning dialog, click the OK button. 


14. At the TCP/IP Properties dialog, click the OK button. 


15. From the Directory Tree on the left-hand side of the dialog, select the SQL Server Services 


tree node. 


16. From the Items Panel on the right-hand side of the dialog, right-click your mouse over the 


SQL Server (SQLEXPRESS) option. 


17. Select the Restart option. 


 


CCrreeaattiinngg  tthhee  BBllaannkk  DDaattaabbaassee  ffoorr  AAttttaacchhmmeenntt  


1. In Microsoft® Explorer, browse to C:\ImproNet\Database\sqlserver (this is the path used 


in a default installation). 


2. Copy the DB400.MDF and DB400_Log.LDF files. 


3. Browse to C:\ImproNet\Database (this is the path used in a default installation). 


4. Paste the DB400.MDF and DB400_Log.LDF files copied earlier. 


 


CCrreeaattiinngg  aa  LLooggiinn  AAccccoouunntt  ffoorr  SSYYSSDDBBAA  


1. In Windows®, click Start>Programs>Microsoft SQL Server 2008>SQL Server 


Management Studio. 


 


 
Figure 20 – Connect to Server Dialog 


 


2. In the Connect to Server dialog, from the Server Name drop-down list, select the 


appropriate Server Name. 


3. From the Authentication drop-down list, select the SQL Server Authentication option. 


4. In the Login textbox, type in sa. 


5. In the Password textbox, enter the password you created in the section titled Microsoft 


SQL Server Installation Wizard - Part 2 (page 31), point 15. 


6. Click the Connect button. 
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Figure 21 – Microsoft SQL Server Management Studio Dialog 


 


7. In the Object Explorer Pane, select the Security folder. 


8. Right-click over the Security folder and select the New menu option. 


9. Select the Login menu option. 


 


Login – New Dialog 


1. From the Select a Page panel, ensure the General page is selected. 


2. In the Login Name textbox, type in SYSDBA. 


3. Select the SQL Server Authentication radio button. 


4. In the Password and Confirm Password textboxes, type in a suitable password. In this 


example we used the password masterkey. 


5. Deselect the Enforce Password Expiration checkbox. 


6. From the Select a Page panel, select the Server Roles page. 


7. In the right-hand pane, select the checkbox alongside each of the Server Roles. 


 


 


Ensure that the SYSDBA user has access to the DB400.MDF Database. 


 


 


8. Click the OK button. 
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CCoonnffiigguurriinngg  MMiiccrroossoofftt  SSQQLL  SSeerrvveerr  ffoorr  IImmpprrooNNeett  


Attaching the Database 


1. In Windows®, click Start>Programs>Microsoft SQL Server 2008>SQL Server 


Management Studio. 


2. In the Connect to Server dialog, from the Server Name drop-down list, select the 


appropriate Server Name. 


3. From the Authentication drop-down list, select the SQL Server Authentication option. 


4. In the Login textbox, type in SYSDBA. 


5. In the Password textbox, enter the password you created in the section titled Login – New 


Dialog (page 35), point 4. 


6. Click the Connect button. 


7. In the Object Explorer Pane, select the Databases folder. 


8. Right-click over the Databases folder and select the Attach menu option. 


9. In the Attach Databases dialog, click the Add button. 


10. In the Locate Database Files dialog, browse to the DB400.MDF Database.  The default path 


is C:\ImproNet\Database\DB400.MDF. 


11. Click the OK button. 


12. In the Attach Databases dialog, click the OK button. 


 


 


From the Object Explorer pane, if you select the Databases folder, you should see the DB400 


Database in the list on the right-hand side pane. 


 


13. From the File drop-down menu, select Exit. 


 


Properties Files 


1. In Windows®, click Start>Documents. 


2. Browse to C:\ImproNet\Database\sqlserver. 


3. Select and Copy the following files: 


 Access.properties 


 Biometric.properties 


 Engine.properties 


 Graphics.properties 


 Localization.xml 


4. Browse to C:\ImproNet. 


5. Paste the copied files, ensuring that you replace the existing Properties files. 


6. Click the  button. 


 


Configuring ImproNet Modules for a WAN 


Running ImproNet across a WAN is similar to running ImproNet across a LAN.  However, WANs 


generally have slower performance.  ImproNet has options to minimize the resources required 


by a slower-than-usual architecture. 


 


AAddvvaanncceedd  EEnnggiinnee  SSeettttiinnggss  


Figure 22 shows an extract from the Engine.properties file.  Lines beginning with a # are 


comments describing the settings.  Edit the highlighted settings as required to compensate for 


the Engine running across a WAN: 
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Figure 22 – Engine.properties WAN Settings 


 


 


You can also edit these settings via the ImproNet Engine Software.   


 


Figure 8 on page 22 illustrates a possible ImproNet Configuration where a second site is 


connected via a WAN.  In this type of scenario, it is important to determine how much bandwidth 


is available to the Engine Server.  If resources are limited, we recommend editing the advanced 


Engine settings to further reduce the bandwidth that Engine requires to operate efficiently. 


 


CCoonnnneeccttiinngg  ttoo  tthhee  DDaattaabbaassee  


Refer to Figure 8 on page 22—to connect the Engine 2 PC on Site 2 to the Database Server; 


edit the Engine.properties file on Engine 2 to point to the Database Server.   


 


Because a second Engine (Site) has been added, you must update the Engine.properties file 


on Engine 2 to reflect Site 2.  You must do this before you execute an Auto-ID procedure.   


 


In this example, change the System Site SLA from system.sitesla = 01000000 to 


system.sitesla = 02000000. 


 


Using Routers Configuration 


The following factors affect bandwidth when a router is used: 


 


 Number of hardware devices configured in ImproNet Access 


 Number of Tagholders 
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 Existing WAN load usage 


 Number of ImproNet client applications that access data via a router 


 


RRoouutteerr  CCoonnffiigguurraattiioonn  


WAN routers must enable pass-through communication on the port that the Database Server is 


using for connection.  This is essential if the router has a built-in firewall. 


 


FFiirreebbiirrdd  PPoorrtt  


Firebird uses Port 3050 by default.  Therefore, ensure that WAN routers have TCP/IP enabled 


for network traffic sent to Port 3050. 


 


BBaannddwwiiddtthh  RReeqquuiirreemmeennttss  


Every ImproNet installation will have different bandwidth requirements.  For example, an Engine 


that uploads 200 Tags to a single Controller can do so through a 64 k ISDN line.  However, an 


Engine that has to upload 5 000 Tags to five Controllers needs at least a 768 k dedicated ISDN 


line.   


 


It is impossible to specify the exact requirement for a WAN.  However, we recommend a 


minimum WAN connection bandwidth of 1 Mbps.  For optimal performance across a WAN, we 


advise you to consider a connection with at least 2 Mbps of bandwidth. 


 


 


Perform bandwidth-intense activities such as uploading Tag data to Controllers after-hours, thereby 


reducing network load during normal hours. 


 


 


Refer to Part 8 – Utilities for more information on the ImproX EC and ImproX ECII Controllers 


configuration. 
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System Concepts 


System Architecture Concepts 


An ImproNet Access Control System comprises the following elements: 


 


 Sites 


 Controllers 


 Locations 


 Zones 


 


The ImproNet System Architecture is illustrated elsewhere in this Manual. 


 


Sites 


Each System consists of one or more Sites.  Sites are independent of each other.  Each Site 


can have only one Host.  The Host is the Engine Module for a particular Site. 


 


CCoonnttrroolllleerrss  


 An IXP300 Site supports up to 16 IC Controllers.  Each Controller supports up to 48 


Terminals (Fixed Addresses). 


 An IXP400 Site supports up to 64 EC Controllers.  Each Controller supports up to 64 


Terminals (Fixed Addresses). 


 An IXP400i Site supports up to 64 ECII Controllers.  Each Controller supports up to 64 


Terminals (Fixed Addresses). 


 


 


It is possible to use a mixture of IC and EC Controllers on the same Site.  However, a Site using 


a mixture of IC and EC Controller types is limited to the parameters of the Controller with the 


lowest limits.  For example, a Site with an IC Controller will accept a maximum of 16 Controllers 


and 8 000 Tags instead of the EC Controller’s limit of 160 000 Tags. 


 


LLooccaattiioonn  


A location is a physical access control point.  It comprises a group of Terminals servicing an 


access control point such as a Door.  A Location supports up to three Terminals for the following 


functions. 


 


 Door Entry 


 Door Exit 


 Door Relay Control 
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ZZoonneess  


A Zone is a group of Locations (access control points).  Entry and exit to and from a Zone is 


achievable via its Locations only.  Generally, a Zone is a physically bounded area containing 


one or more locations.  A Zone can also contain other Zones within it.  This enables an Operator 


to configure settings such as Anti-Passback settings.  These Zones are referred to as Nested 


Zones. 


 


 
Figure 23 – Nested Zone 


 


Zone Grouping is when one Zone is linked to another Zone to form a Common Zone.  This 


enables Tagholders to enter via a Location in one Zone and exit via a Location in another Zone.   


 


Adjacent Zoning is a form of Zone grouping.  It is when two neighbouring Zones use a single 


Location to go from the one Zone to the other Zone. 


 


 
Figure 24 – Adjacent Zoning 


 


System Building Blocks 


IImmpprrooNNeett  SSooffttwwaarree  SSuuiittee  


The ImproNet Software Suite is designed to run on Microsoft Windows® 2000, XP and Vista 


(Business or Ultimate).   These limitations are important for the efficiency and reliability of the 


System. 


 


SSuuppeerrvviissoorryy  EElleemmeennttss——HHoosstt  PPCC  


Each Site requires a Host PC for control and supervision of the Site.  Alternatively, multiple PC’s 


can be used for the same function. 


 


 


In this manual, the term Host PC refers to the computers that perform control and supervisory 


functions, regardless of the number of PC’s used. 


 


On a typical Site, the following functions are performed by the Host PC: 


 


 Database Server—dedicated to the Site Database. 







 Part 2 – Software 


 


January 2012  41 


 Site Engine—dedicated to processing communications between the Database Server and 


the Controllers.  It also performs a polling function from the Server to the Controllers. 


 Client Workstation—dedicated to supervisory aspects.  These include entering and 


deleting data, viewing Graphics Runtime and Alarms, preparing Transaction reports, and 


running Utilities.  Note that some monitoring installations may need a dedicated PC to run 


Graphics Runtime. 


 CCTV—required when Cameras are installed as part of the monitoring system. 


 


 


Additional, dedicated CCTV PC’s may be required depending on the number of cameras. 


 


 


The CCTV DVR Server must be a dedicated PC. 


 


SSyysstteemm  BBuusseess  


There are two system buses in an ImproNet Access Control System: 


 


 The Host Bus—the RS232 or RS485 bus that links the Host PC via the Host Interface Unit 


(ImproX HI or ImproX RH), to the Controllers.  EC and ECII Controllers can operate on a 


LAN communications infrastructure.  Each Site in a System requires its own Host Bus. 


 The Terminal Bus—the RS485 bus that connects each Controller to its Terminals.  There 


is one Terminal Bus per Controller. 


 


SSeerriiaall  PPeerriipphheerraall  PPoorrttss  


Some hardware units have an RS232 Serial Peripheral Port.  They can be connected to a single 


peripheral device. 


 


HHoosstt  IInntteerrffaaccee  UUnniitt  


The Host Interface unit converts RS232 to RS485.  It serves as an interface between the Host 


PC and the Controllers. 


 


RRHH  IInntteerrffaaccee  UUnniitt  


The RH is the USB equivalent of the Host Interface unit.  It converts RS485 to USB. It serves as 


an interface between a USB enabled Host PC and the Controllers. 


 
 


 
Figure 25 – Access System Communications Paths 
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Software Installation Procedure 


 


ImproNet no longer supports Windows® 95, 98, or NT.  ImproNet will, however, support Windows® 


Server platforms (Windows® 2000 Advanced Server and Windows® 2003 Server) only when used with 


a Microsoft SQL Server Database.   


 


 


Validated Linux Support exists for ImproNet Engine, Access and the Database.  The validated Linux 


Operating Systems include:  Fedora Core 7, Debian 4.0 and OpenSuSE10. 


 


 


Log on to Windows® with Administrator privileges to install ImproNet. 


 


New ImproNet Installation 


The ImproNet Software Suite is supplied on an installation CD-ROM.  Before you install it, 


ensure you have read the following: 


 


PPCC  HHaarrddwwaarree  RReeqquuiirreemmeennttss  


Refer to the section Minimum PC Specifications on page 5. 


 


TTCCPP//IIPP  NNeettwwoorrkk  


 


 


Do not install any software until the TCP/IP protocol is installed, and the machine is assigned an 


IP Address. 


 


TCP/IP is required for single and multiple Host PC scenarios to provide IP Addresses.  For a 


single Host PC without a Network Interface Card (NIC) install a Virtual Network Adapter such as 


the Microsoft Loopback Adapter or the Microsoft Virtual Private Networking (VPN) Adapter.  


These are virtual software adapters only; no additional hardware is required.  Install the TCP/IP 


protocol using the Windows® Control Panel.   
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Figure 26 – ImproNet Software Installation Flowchart 


 


IInnssttaallllaattiioonn  SSeeqquueennccee  


 


 


Read the Release Notes on the Installation CD.  The following items are specifically mentioned:  


Removal of InterBase V6; Default Username and Password; Database Update, Coding and Error 


Settings; Windows® XP Restore Feature; Controller and Firmware Versions and  New Software 


Features. 


 


 


If you have an earlier version of InterBase, InterServer, or InterClient installed on the PC, you MUST 


uninstall them before running the Software Installation Wizard.  New versions of these software 


programs are installed.  If the Installation program detects an earlier version, you are prompted to 


remove the earlier version and start again. 


 


The ImproNet Installation CD uses an automated, interactive Installation Wizard to guide you 


through the installation process.  The Wizard prompts you at various stages to select installation 


options.  This makes it possible to customize the ImproNet Software Suite.   
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Install the ImproNet Software in the following sequence: 


 


1. Database Sever—this is ESSENTIAL.  Refer to the section, Installing the Database Server. 


2. Applications—Modules and Utilities. 


3. Database—Installed with the Engine Module. 


4. USB Driver—Only if USB Enrollment Readers or Converters are used. 


 


Installing the Database Server 


 


 


A Database Server is required to host the ImproNet Database.  If the ImproNet Suite is installed 


on to a single PC, the Database Server is installed automatically.  However, if more than one PC 


is used to host the ImproNet Software, you must install the Database Server manually. 


 


 


You need not install Firebird if you are using SQL Server. 


 


 


Firebird automatically prompts to install, if a previous version is not detected. 


 


Any PC on the network can host the Database Server.  ImproNet uses Firebird 1.5 as its 


Database Server.  To install Firebird 1.5 manually, proceed as follows: 


 


IInnssttaalllliinngg  FFiirreebbiirrdd  


1. Select a PC to host the Database Server.  


2. Insert the ImproNet Installation CD in the PC’s CD-ROM drive. 


3. Browse to the \database\firebird directory on the ImproNet Installation CD. 


4. Double-click Firebird.exe. 


5. In the Select Language Setup dialog, from the drop-down menu, select your preferred 


language. 


6. Click the OK button. 


 


Firebird Installation Wizard 


1. At the Welcome dialog, review and follow the on-screen instructions.  


2. Click the Next button. 


3. At the Licence Agreement dialog, select the I Accept the Agreement radio button. 


4. Click the Next button. 


5. Review the Information dialog, and then click the Next button. 


6. In the Select Destination Location dialog, select the Destination Directory—we 


recommend that you use the default location of C:\Program Files\Firebird\Firebird_1_5. 


7. Click the Next button. 
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Figure 27 – Firebird Select Components 


 


8. From the drop-down menu, select the Full Installation of Super Server and Development 


Tools option. 


9. At the Select Start Menu Folder screen click Next. 


 


 
Figure 28 – Firebird Select Additional Tasks 


 


 


In Vista installations, ensure that you de-select the "Install Control Panel Applet?" option. 


 


10. On the Select Additional Tasks screen:  


 Select the Use the Guardian to Control the Server? option. 


 Select Run as a Service? option. 


 Select the Start Firebird Automatically Everytime You Boot Up? option. 


 Select the Copy Firebird Client Library to <System> Directory? option. 


 Select the Generate Client Library as GDS32.DLL for Legacy app. Support? option. 
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11. Click the Next button. 


12. Click the Install button. 


13. Review the Information dialog and then click the Next button. 


14. Click the Finish button. 


 


ImproNet Installation Procedure 


To install the ImproNet Software Suite on a single Host PC proceed as follows: 
 


1. Insert the ImproNet Installation CD into the CD-ROM drive. 


2. Select the Install ImproNet Suite option. 


 


 


If the CD does not start up automatically, browse the CD in Windows® Explorer and double-click 


Setup.exe. 


 


3. Select English as the language option. 


4. Click the OK button. 


 


 


If no Database Server is present, one is installed. Follow the onscreen instructions for this. 


 


5. At the Introduction screen, click Next.  


6. At the Licence Agreement screen, select the I Accept the Terms of the Licence 


Agreement radio button. 


7. Click the Next button. 


8. At the Choose Install Folder screen, click Next. 


 


 
Figure 29 – Install Set Menu 


 


9. At the Choose Install Set screen, from the Install Set drop-down list, make your preferred 


installation type selection. 
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An Install Set is a collection of pre-selected applications suitable for specific scenarios.   


 


 


Customize an Install Set option by selecting or de-selecting applications from the list. 


 


10. Click the Next button.  


11. Click the Install button. 


12. At the Install Complete dialog, click the Done button. 


 


Installing the Access or Engine Modules Only 


This Section describes the installation procedure for the Access and Engine Modules and the 


Database Server only. 


 


IInnssttaalllliinngg  IImmpprrooNNeett  AAcccceessss  OOnnllyy  


To Install the Access Module only, proceed as follows: 


1. Insert the ImproNet Installation CD into the CD-ROM drive.  If the CD does not start up 


automatically, browse the CD in Windows® Explorer and double-click Setup. 


2. The Install Anywhere screen displays and files are extracted. 


3. Select English as the language option. 


4. Click OK.   


 


 


If a Database Server is present, it is detected.  If no Database Server is present, one is installed.  


Follow the onscreen instructions for this. 


 


5. Click Next.  The License Agreement screen displays. 


6. Select the I Accept the Terms of the Licence Agreement option. 


7. Click Next.  The Choose Install Folder screen displays.  


8. Click Next. 


9. Select the Custom option from the Install Set menu. 


10. Select the Access checkbox from the list. 


11. Clear all other checkboxes. 


12. Click Next. 


 


IInnssttaalllliinngg  IImmpprrooNNeett  EEnnggiinnee  OOnnllyy  


To Install the Engine Module only, proceed as follows: 


 


1. Insert the ImproNet Installation CD into the CD-ROM drive.  If the CD does not start up 


automatically, browse to the CD in Windows® Explorer and double-click Setup.exe. 


2. The Install Anywhere screen displays and files are extracted. 


3. Select English as the language option. 


4. Click OK.   


 


 


If a Database Server is present, it is detected.  If no Database Server is present, one is installed.  


Follow the onscreen instructions for this. 
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5. Click Next.  The License Agreement screen displays. 


6. Select the I Accept the Terms of the Licence Agreement option. 


7. Click Next.  The Choose Install Folder screen displays. 


8. Click Next. 


9. Select the Custom option from the Install Set menu. 


10. Select the Engine checkbox from the list. 


11. Clear all other checkboxes. 


12. Click Next. 


13. Click Install. 


 


 


During the Engine Module installation, a blank Database is created in C:\ImproNet\Database.   


 


 


The Installation Wizard prompts you to install Firebird database if there is no Database Server on the 


PC.  If the Database Server is installed on another PC, cancel the Database install set-up. 


 


Next, proceed as follows: 


 


1. Connect the ImproX hardware via the Host Interface to the RS232 Serial Port on the 


Engine PC. 


2. If the Database is not installed to C:\ImproNet\Database on the Engine PC, set the 


Database Connection URL to the location of the Database.  For further information on 


Engine Properties configuration, refer to the Properties Files section on page 23. 


 


DDaattaabbaassee  EEnnccooddiinngg  


The default database uses UNICODE-FSS encoding.  ISO 8859_1 (Western Europe) and 


WIN1250 (Eastern Europe) are provided for archiving support and for installations that need 


ImproNet Pump. 


 


IInnssttaallll  UUSSBB  DDrriivveerr  ffoorr  UUSSBB  RReeggiissttrraattiioonn  RReeaaddeerr  IInntteerrffaaccee  


ImproNet uses a USB Registration Reader Interface to read Tags.  Some Interface versions also 


provide an RS485 communication link to the Controllers.   


 


The ImproNet Installation CD includes a USB driver for the USB Registration Reader Interface.  


You can find the USB driver in the following locations: 


 


 USB_Device_Driver directory on the CD 


 The ImproNet folder on the Host PC 


 


To install the driver, proceed as follows: 


 


 


If there are old USB Drivers on the PC, delete them before installing the provided driver. 


 


1. Plug the USB Registration Interface into a USB port on the PC.  The Found New 


Hardware Wizard displays. 
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2. Follow the onscreen instructions.  In some cases, two drivers install; one for the USB 


Registration Reader and one for the COM port to USB Bridge.  Therefore, the Wizard 


pops up twice. 


 


In Windows® XP, proceed as follows: 


 


1. The second time the wizard pops up, select Install From a List or Specified Location. 


2. Click Next. 


3. Select Search for Best Driver in these Locations and select Include this Location.   


 


 


The Location specified should be USB_Device_Driver/V5.4.24 and select the appropriate folder for 


your operating system. 


 


4. Click Next.  Ignore any warning dialog screen, if displayed. 


5. Click Finish. 


 


 


On some PC’s, the New Hardware Found wizard is displayed every time a USB Registration Reader 


Interface with a new USB Serial Number (Fixed Address) is plugged in.  If this happens, choose the 


option to automatically install the unit.  The New Hardware Found wizard will not display again. 


 


Upgrading an Existing Installation 


1. Backup the existing ImproNet Database to folder for safekeeping.  


2. Copy all the Properties files and Localization.xml file, if ImproNet is running on a LAN or 


WAN, to the safekeeping folder. 


3. Make a backup copy of the Security.fdb file outside of the ImproNet folder.  In a default 


installation you will find the Security.fdb file at C:\Program Files\Firebird\Firebird 


1.5\security.fdb.  


4. Uninstall the existing ImproNet Modules. 


5. Install the NEW ImproNet Modules. 


6. Ensure that the Database Server is Firebird 1.5 or higher (but less than 2.0).  If not, 


uninstall the existing version and replace it with the newer version. 


7. Move the backup Security.fdb file to the NEW Firebird installation folder. 


8. Upgrade the ImproNet Database if necessary.  


9. Perform a Pump on the ImproNet Database. 


10. Upgrade the Controller and Terminal Firmware if necessary. 


 


 


Ensure that you configure your ImproX EC and ImproX ECII Controllers correctly before proceeding 


further with your ImproNet installation.  Refer to Part 8 – Utilities for configuration information. 
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Pre-configuration Procedure 


When all ImproNet Software components are installed, you need to perform the Pre-


configuration Procedure.  This procedure determines if the hardware communication 


infrastructure is functioning correctly. 


 


 


ImproNet hardware operates on a two-tier communications architecture comprising of 


Host Communications (Connects to ImproX Controllers and the Host Interface, or ImproX RH) and 


Terminal Communications (Connects to ImproX Terminals).  It is critical that there are no 


communication problems prior to Software configuration.  Otherwise, the System will not function.   


 


When the ImproX hardware is physically connected and powered, perform the following steps to 


determine if the hardware is communicating correctly: 


 


 


Ensure that the Engine has a working connection to the ImproNet Database.  Configure this connection 


in the Engine.properties file.  For more information, refer to page 23 for a single PC, page 24 for a 


LAN, or page 28 for a WAN. 


 


HHaarrddwwaarree  AAuuttoo--IIDD  


You may perform an Auto-ID at any time.  During an Auto-ID, the Engine polls attached 


Controllers and Terminals, identifying their type, and their Logical Address.  Run an Auto-ID as 


follows: 


 


 


Ensure that you STOP Engine before executing the Auto-ID. 


 


 


Hardware detected for the first time receives a Logical Address.  Once allocated a Logical Address 


does not change.  This ensures continuity in the ImproNet Database. 


 


 


See Part 1 – Hardware, Installation Information (Fixed Addresses) for extra information on Fixed 


Address arrangement when using the ImproX iTT (Antenna Ports 1 and 2). 


 


1. In Windows®, click Start>Programs>ImproNet>Engine. 


2. On sites running ImproX ECII Controllers connected by Ethernet, continue as follows: 


a. Select Configuration>Import Devices. 


b. Alongside the File textbox, click the  button. 


c. Select the Discovery.txt file. 


d. Click the Open button. 


e. Click the  button. 


f. At the Import Devices confirmation dialog, click the Yes button. 


3. Start the Auto-ID process by clicking the  button.   
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HHaarrddwwaarree  PPiinngg  TTeesstt  


 


 


We recommend that a list of each Terminal and its physical location be updated during the hardware 


installation process.  This ensures an efficient software configuration process. 


 


After performing an Auto-ID, use the ImproNet Firmware Upgrade Utility to ping the hardware.  


The Ping Test requests ImproX Controllers and Terminals transmit their Fixed Address, 


Product ID and Logical Address.   


 


Open the Firmware Upgrade Utility as follows:  In Windows®, click Start>Program Files> 


ImproNet>Utils>Firmware Upgrade.  See Part 8 – Utilities, Firmware Upgrade Utility for 


more information.   


 


 


Ensure that the communication infrastructure is working correctly before configuring ImproNet. 


 


 


USER NOTES 


  







Part 2 – Software 


52  January 2012 


USER NOTES 


 


 


 


 


 


 


 


 


 


 


 


 


 


 


 


 


 


 


 


 


 


 


 


 


 


 


 


 


 


 


 


 


 


 


 


 


 


 


 


 


 


 


 


 


 


 


 


IXP362-0-0-GB-10 Issue 11 January 2012 
ImproNet\English Manual\LATEST ISSUE\ 


P2 400i-swm-en-11.docx 
 





		PART 2 – SOFTWARE

		Contents

		Introduction

		Minimum PC Specifications

		Database Server

		ImproNet Module PC’s

		Known Issues





		ImproNet Applications

		ImproNet Modules

		Access Module

		Engine Module

		Web-based QuickTag Module

		QuickTag Module

		Visitor Module

		Graphics Designer Module

		Graphics Runtime Module

		Card Designer Module

		Tracker Module

		Alarms Module

		Transaction Viewer Module

		Custom Access Module

		Ziton Server Module

		CaddX Server Module

		DVR Server Module

		Ganz Server Module

		ImproVision Integration Module

		The ImproVision Integration Module is a rule-action based Module.  This essentially means a matched rule must trigger for execution of up to 5 actions.  Born as a Digital Video Recorder based system, for interfacing Digital Video Recorders direct to t...

		ImproVision’s digital video recording and monitoring integration facilities include:



		Biometric Server Module



		ImproNet Utilities

		Archive Utility

		Database Upgrade Utility

		IBConsole Utility

		Import Utility

		Find Duplicates Utility

		IXP200 Conversion Utility

		Pump Utility

		Translate Utility

		Unlock Utility

		Ethernet Configuration Utility

		Discovery Utility

		Firmware Upgrade Utility

		Manual Auto-ID Utility

		Universal Data Export Utility





		Peripheral Hardware

		ImproNet Network Specifications

		Architecture

		Bandwidth Usage

		Client-Server

		Software Connection Relationships

		Network Hardware

		Routers



		ImproNet Modules in a Network Environment

		ImproNet Database

		Firebird Server

		SQL Server

		ImproNet Engine



		General Network Requirements

		Running ImproNet Applications across a LAN

		Running ImproNet Applications across a WAN

		Minimum WAN Requirements



		Properties Files

		Configuring Modules for a Stand-Alone (Single PC) System

		Connecting to the Database



		Configuring Modules for a LAN (Firebird)

		Connecting to the Database



		Configuring ImproNet for a Microsoft SQL Server 2000 Database

		Configuring Microsoft SQL Server for ImproNet

		Creating the SYSDBA User



		Connecting to the Database



		Configuring ImproNet for a Microsoft SQL Server 2005 (Standard Edition) Database

		Installing Microsoft SQL Server 2005

		Microsoft SQL Server Installation Wizard



		Creating a Login Account for SYSDBA

		Login – New Dialog



		Configuring Microsoft SQL Server for ImproNet

		Attaching the Database

		Properties Files





		Configuring ImproNet for a Microsoft SQL Server 2008 R2 (Express Edition) Database

		Installing Microsoft SQL Server 2008

		Microsoft SQL Server Installation Wizard - Part 1

		Microsoft SQL Server Installation Wizard - Part 2

		Microsoft SQL Server Installation Wizard - Part 3



		SQL Server Configuration Manager

		Creating the Blank Database for Attachment

		Creating a Login Account for SYSDBA

		Login – New Dialog



		Configuring Microsoft SQL Server for ImproNet

		Attaching the Database

		Properties Files





		Configuring ImproNet Modules for a WAN

		Advanced Engine Settings

		Connecting to the Database



		Using Routers Configuration

		Router Configuration

		Firebird Port

		Bandwidth Requirements





		System Concepts

		System Architecture Concepts

		Sites

		Controllers

		Location

		Zones



		System Building Blocks

		ImproNet Software Suite

		Supervisory Elements—Host PC

		System Buses

		Serial Peripheral Ports

		Host Interface Unit

		RH Interface Unit





		Software Installation Procedure

		New ImproNet Installation

		PC Hardware Requirements

		TCP/IP Network

		Installation Sequence



		Installing the Database Server

		Installing Firebird

		Firebird Installation Wizard





		ImproNet Installation Procedure

		Installing the Access or Engine Modules Only

		Installing ImproNet Access Only

		Installing ImproNet Engine Only

		Database Encoding

		Install USB Driver for USB Registration Reader Interface



		Upgrading an Existing Installation



		Pre-configuration Procedure

		Hardware Auto-ID

		Hardware Ping Test










 Part 3 – General Configuration 


PART 3 – GENERAL CONFIGURATION 







Part 3 – General Configuration 


2  January 2012 







Part 3 – General Configuration 


January 2012  3 


Contents 


PART 3 – GENERAL CONFIGURATION 1 


CONTENTS ............................................................................................................ 3 


CONFIGURATION OVERVIEW ................................................................................... 7 


Using ImproNet Access ............................................................................................. 7 


Common Interface Controls ...................................................................................... 8 


SYSTEM CONFIGURATION PARAMETERS ................................................................ 10 


Fixed Addresses.......................................................................................................11 


ENGINE FUNCTIONS ............................................................................................. 12 


Engine Menu Functions .......................................................................................... 12 


Engine Properties.................................................................................................... 15 


Advanced Properties ............................................................................................... 17 


Importing ECII Controllers ....................................................................................... 20 


System Configuration Procedure ............................................................................ 20 


SITES .................................................................................................................. 22 


Site Configuration.................................................................................................... 23 


Set Up the Host PC ................................................................................................. 25 


About Hardware Configuration ................................................................................ 25 


CONTROLLER ...................................................................................................... 26 


Controller Configuration .......................................................................................... 26 


Terminal Assignment ............................................................................................... 27 


TERMINALS ......................................................................................................... 31 


General Terminal Configuration .............................................................................. 31 


Terminal Mode Configuration .................................................................................. 33 


Inputs ...................................................................................................................... 34 


Outputs .................................................................................................................... 41 


Actions .................................................................................................................... 42 


Active System Events ............................................................................................. 43 







Part 3 – General Configuration 


4  January 2012 


ACCESS TIME PATTERNS ...................................................................................... 47 


Configure Access Time Patterns ............................................................................. 47 


AREAS ................................................................................................................ 49 


ACCESS GROUPS ................................................................................................ 51 


Configure Tagholder Access Groups ...................................................................... 52 


Configure Access Descriptions ............................................................................... 53 


TAGHOLDERS – ASSIGN ACCESS TO TAGS............................................................. 55 


Add or Edit a Tagholder........................................................................................... 55 


Quick Search for Tagholder .................................................................................... 55 


Configure Tagholder Details .................................................................................... 55 


Batch Enrollment of Tags ........................................................................................ 59 


Advanced Search .................................................................................................... 61 


DEVICE TIME PATTERNS ....................................................................................... 63 


HOLIDAYS ............................................................................................................ 66 


TIME TRIGGERED ACTIONS ................................................................................... 67 


ACTIONS ............................................................................................................. 68 


Edit and Delete Actions ........................................................................................... 68 


INPUTS ................................................................................................................ 70 


OUTPUTS ............................................................................................................ 71 


COMMON ZONES .................................................................................................. 72 


PREFERENCE CONFIGURATION ............................................................................. 73 


Setting Your Preferences ........................................................................................ 73 


MOVING EMPLOYEES (TAGHOLDERS) .................................................................... 75 


REPLACING CONTROLLERS AND TERMINALS ......................................................... 77 


Replacement of Controllers and Terminals over RS485 ......................................... 77 


Replacing Controllers and Terminals over Ethernet ............................................... 78 


DATABASE MAINTENANCE .................................................................................... 82 


Firebird General ...................................................................................................... 82 


Firebird Utilities ....................................................................................................... 83 


Database Backups .................................................................................................. 86 







Part 3 – General Configuration 


January 2012  5 


Database Restore ................................................................................................... 89 


Database Corruption ............................................................................................... 91 


Archiving Transactions ............................................................................................ 94 


Archiving Tagholders ............................................................................................... 94 


EVENTS AND ACTIONS .......................................................................................... 96 


 


  







Part 3 – General Configuration 


6  January 2012 


 


  







Part 3 – General Configuration 


January 2012  7 


Configuration Overview 


ImproNet Access is the software application used to configure an ImproNet Access Control 


System. 


 


 


Run the Auto-ID process in ImproNet Engine to find what hardware is installed and to assign 


addresses to the hardware. 


 


 


Ensure that the Unit Location Chart is correctly filled in when installing the Controllers. 


 


Using ImproNet Access 


The following panels comprise the ImproNet Access interface: 


 


 Menu Bar 


 Navigator Pane 


 Main Pane 


 


 
Figure 1 – ImproNet Access Interface 


  


MMeennuu  BBaarr  


The Menu contains drop-down lists that let you navigate to different screens in ImproNet Access 
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NNaavviiggaattoorr  PPaannee  


The Navigator provides an expanding hierarchical tree menu. It lets you view and navigate to 


different items.  The Navigation Tree consists of nodes that display components by connection. 


 


MMaaiinn  PPaannee  


Items selected in the Navigation Tree display their details in the Main Pane. 


 


Common Interface Controls 


The following types of controls let you interact with the ImproNet Access interface: 


 


BBuuttttoonnss  


Open another screen, window or dialog when clicked on.  They are usually different colours.  


Examples include the following: 


 


 


 


IIccoonnss  


Icons are similar in function to buttons except that Icons are located in the Navigation Tree.  


Examples include the following: 


 


 


 


RRaaddiioo  BBuuttttoonnss  


Use Radio Buttons to select an option.  Only one radio button in a group can be selected.  Click 


to enable or disable. 


 


 


 


CChheecckkbbooxxeess  


Use Checkboxes to select multiple options.  Any number of checkboxes in a group can be 


selected.  Click to enable or disable. 
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TTeexxttbbooxxeess  


Textboxes let you enter text such as an item name.  Click the checkbox and type some text. 


 


 


 


TTeexxtt  AArreeaass  


Same function as a textbox, except a text area displays multiple lines of text. 


 


 


 


DDrroopp--ddoowwnn  LLiissttss  


Use Drop-down Lists to select an option from a list.  Click the button with the arrow to display 


the list.  Then, click a list item to make your selection. 


 


 


 


RReeccoorrddss  


Records are rows of information displayed in a grid format.  A record is a collection of fields that 


correspond to column names.  In the following example, record number 1 is selected.  It has the 


following fields: No, Title, First Name, Last Name, Department and Employee No.  Click a 


record to select it. 


 


 


 


 


This Manual displays screenshots of various screens in ImproNet Access.  Some of the details 


displayed in a screenshot may not be available in your copy of ImproNet Access.  This is because 


some details are dependent on the hardware installed. 
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System Configuration Parameters 


Table 1 displays important configuration parameters for the ImproNet System.  Some 


parameters have additional requirements—these are indicated by notes. 


 


 


If a Site uses a combination of Controllers, it is limited by the lowest Controller’s parameters.  Only the 


number of transaction types that each Controller can buffer is independent.   


 


For Systems with preinstalled ImproX EC’s or IC’s, on addition of the ECII ensure the Systems configured 


for NO cross-controller communications (including Interleading Zone Routing). 


 


 


Table 1 – System Configuration Parameters 


 


 


Note 1—Up to 9 000 buffered transactions in the Controller Transaction Buffer at one time. 
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Note 2—This amount is relative to the number of Tags in the ImproNet Database, and the number of 


memory modules in the Controller. 


 


 


Note 3—A Terminal with two Fixed Addresses, such as the ImproX iTT, is treated as two separate 


Terminals. In the same way, a Terminal with 3 Fixed Addresses (that is the ImproX MfT), is treated as 


three Terminals by the Software. 


 


 


Note 4—In Anti-passback (APB) Mode, two Terminals per Location are required.  Therefore, if all 


locations are in Anti-passback (APB) Mode, the limit is 64 Locations per ImproX EC—assuming all 


Terminals have a single Fixed Address. 


 


 


Note 5—The ImproX ECII Controller generally has the same features as the ImproX EC Controller.  


However, the ImproX ECII does support more advanced functionality not supported in the EC. 


 


 


Note 6—All figures provided are the maximum. In some cases interdependence between parameters; 


that is the maximum number of Zones per Controller depends on how many Terminals are used per 


Location. 


 


 


Note 7—When using IXP300 or IXP400, we recommend a maximum of 6 Lifts (Elevators).  This 


enables one Access Group per Tag for normal access control requirements.  A maximum of 80 floors 


per Lift (Elevator) is supported. 


 


 


Note 8—When using IXP400i, we recommend a maximum of 15 Lifts (Elevators).  A maximum of 80 


floors per Lift (Elevator) is supported. 


 


Fixed Addresses 


Most Terminals (ImproX iTT, ImproX iTRT and the ImproX TA (with a Remote connected)) 


have two Fixed Addresses.   


 


Fixed Addresses limit how many physical units a device such as a Controller can connect to. 
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Engine Functions 


Engine Menu Functions 


ImproNet Engine has the following user-controlled functions: 


 


 Engine Start 


 Engine Stop 


 Full Upload 


 Auto-ID 


 Advanced 


 


 
Figure 2 – ImproNet Engine Started 


 


EEnnggiinnee  SSttaarrtt  


 


 


Run this only after you have performed an Auto-ID (setting up and configuring the Site using Access) 


and a Full Upload. 


 


Engine Start starts the Engine.  Transactions are downloaded from the Controllers and logged 


to the Database.  In addition, changes are uploaded to the Controllers. 


 


EEnnggiinnee  SSttoopp  


Stops all Engine processes and procedures. 
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FFuullll  UUppllooaadd  


 


 


During a Full Upload, the selected Site is on-line until the Upload process stops. 


 


Uploads all data in the ImproNet Database to the Controllers.  The Engine polls each Controller 


three times to verify its presence before starting the upload.  The engine stops when the upload 


is complete. 


 


 


Perform a Full Upload when the Terminals and Controllers are initially configured, and each time that 


major hardware changes are made to a Site. 


 


AAuuttoo--IIDD  


 


 


Stop the Engine before executing Auto-ID. 


 


 


 


If your Site consists of ECII Controllers (IXP400i), ensure that you run the Discovery Utility before 


running Auto-ID.   


 


 


If your Site consists of EC Controllers (IXP400) connected via UDP comms, ensure that you run the 


Ethernet Configuration Utility before running Auto-ID.   


 


Auto-ID is a process that polls Controllers to identify their type and their Logical Address.  


Similarly, other units such as Terminals are also polled and identified.  Newly connected units 


are assigned Logical Addresses.   


 


 
Figure 3 – Auto-ID Complete 
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CCoommmmss  QQuueeuuee  


ImproNet (V7.40 and later) now uses a Comms Queue for uploading data to Controllers.  The 


Queue allows preparation of a list of messages for each Controller that upload as each 


Controller becomes available.  If a Controller is down, this does not affect uploading to the on-


line Controllers.  The Queue acts independently for each device so when an off-line Controller 


comes back on-line, the Controller soon synchronises with all the other Controllers already 


updated. 


 


Before V7.40, a change uploaded repeatedly until all Controllers received the message. This 


caused problems on sites where it was difficult to keep all Controllers permanently on-line. A 


communications error on a single Controller affects all the other Controllers. 


 


The Engine displays a count of pending messages in the lower right-hand corner.  If this count 


is 0, then all uploads have been posted to all Controllers.  If there are pending messages, they 


process as Controllers become available.  You may view a Queue List showing the number of 


messages outstanding for each Controller, in Engine select Tools>Queue Status.  If the 


Engine’s running and the list is not decreasing, then the Engine is unable to communicate. 


 


If for some reason, the messages are no longer needed to be sent to a particular Controller 


(perhaps before performing a full upload); you may clear the Queue for that Controller by 


selecting the row and selecting Clear. 


 


AAddvvaanncceedd  


The Advanced function provides a Command Prompt that lets you manually enter and execute 


specific commands.  The Command prompt is illustrated in Figure 4, and is recommended for 


advanced users only.  Some common commands include the following: 


 


 Start AutoID—starts the Auto ID process. 


 Start Download 01—downloads data from Controller 1 to the ImproNet Database. 


 Start Upload 01 03 05—uploads data from the ImproNet Database to Controller 1, 


Controller 3, and Controller 5. 


 AlarmServer—starts the Alarms Server Software so that the Alarm Status of the System is 


displayed. 


 Estart—places the Site in Emergency Mode. 


 Estop—reverts the Site from Emergency Mode to Normal Mode. 


 APB Reset—resets the APB status of all Tags. 


 


 
Figure 4 – Advanced Screen Command Prompt 
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BBrrooaaddccaasstt  TTrraannssaaccttiioonnss  bbyy  UUDDPP  ttoo  aa  SSppeecciiffiieedd  IIPP  AAddddrreessss  


This feature allows broadcast of real-time transaction data as a UDP comma separated packet 


to an IP Address and Port Number named by you, the user.  The purpose of this is to allow third 


parties to pick up transactions and use the transactions as they wish (for example for Time 


Attendance or Alarms).  During broadcast (to either the Host PC or another named PC), the 


transactions still go into the Database as usual. 


 


Enable this feature as follows:  


 


Engine.properties File 


1. From C:\ImproNet, open the Engine.properties file. 


2. Set the engine.broadcast.udp.ip=<IP Address>:<Port> setting. 


 


 


In place of the <IP Address> placeholder fill in the IP Address of the Host PC or other named PC 


picking up the transactions. 


 


 


In place of the <Port> placeholder fill in the Port number of the Host PC or other named PC picking up 


the transactions.  Switch the UDP Broadcast feature off by setting the Port number to 0. 


 


3. From the File drop-down menu select Save. 


4. From the File drop-down menu select Exit. 


 


Start Engine 


1. In Windows®, click Start>Programs>ImproNet>Engine. 


2. Click on the  button. 


 


The format of the broadcast transactions is a list of comma separated values, in this order:    


 


Site Number,yyyy-mm-dd,hh:mm:ss,Transaction Sequence Number,Transaction Event 


Number,Terminal Super Logical Address,Terminal Name,Tag Code,Tag Type,Tagholder 


Name,Employee Number  followed by a carriage return and new line.  


 


 


Where no value exists, integer values appear as 0 and string values appear as a space. 


 


Engine Properties 


OOppeenn  AAddvvaanncceedd  PPrrooppeerrttiieess  


To open ImproNet Engine, Engine Properties, proceed as follows: 


 


1. In Windows®, click Start>Programs>ImproNet>Engine. 


2. From the Menu Bar, select Configuration>Engine Properties. 
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Figure 5 – Engine Properties 


 


The Engine Properties dialog lets you view and change the following settings: 


 


 


Settings described in this section are stored in the Engine.properties file. 


 


 Database Type—the name of the ImproNet Database type.  The default is Interbase—the 


name of the company that produced Firebird. 


 Database Driver—specifies the driver file for the ImproNet Database. 


 Database URL—specifies the location of the ImproNet Database. You can select mapped 


network drives from the Browse dialog, click the  button to browse. 


 Encoding Key—refers to the type of database driver used.  Jaybird is the default database 


driver.  In the Engine.properties file, the encoding key is lc_ctype. 


 Database Encoding—specifies the applicable database-encoding format as displayed in 


Table 2.   


 


Encoding format lc_ctype Encoding format charSet 


ISO8859_1 8859_1 


WIN1250 Cp1250 


UNICODE_FSS UTF_8 


Table 2 – Database Encoding Format 
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 Logging Mode—used for diagnostic purposes when there are communication problems 


between the Engine and Controllers. 


 Auto Start on Start-up—enables the Engine to Start when it is opened.  By default, you 


have to manually Start the Engine. 


 Auto Start Delay—specifies the amount of time to delay starting the Engine after it is 


opened.  For example, a setting of 5 000 ms delays the Engine starting by five seconds 


after it is opened. 


 Web Server on start—sets the Web Server to start when the Engine is started. 


 Inactivity Timeout—sets the time-out delay for a connected Web Server session. 


 Suspend Unused Tags—suspends Tags not used for a period of time. 


 Inactivity Period (Days)—specified number of days (where the Tag is not used) before the 


Tag is suspended. 


 Full Upload on First Pass—sets the Engine to perform a full upload on start-up. 


 Redirect to File—specifies that Error Messages are written to a Log file. 


 Delete Expired Tags—deletes expired Tags from the Database. 


 Validation on start—validate the ImproNet Database on start-up. 


 UDP Comms—enables the Engine to communicate on UDP Unicast (Ethernet enabled 


Controllers only).   


 Web Server User and Web Server Password—enforces logon (entry of a User Name and 


Password) when viewing Reports from a client PC. 


 Site SLA—the Site’s Logical Address. 


 


Advanced Properties 


The Advanced Properties window in ImproNet Engine enables you to fine-tune the timing 


between ImproNet Engine, the ImproNet Database, and System Hardware. 


 


 


We recommend that you do not change the Engine settings for a standard configuration.  You should 


only edit Engine settings to improve the efficiency of ImproNet across a WAN. 


 


OOppeenn  AAddvvaanncceedd  PPrrooppeerrttiieess  


To open ImproNet Engine Advanced Properties, proceed as follows: 


 


1. In Windows®, click Start>Programs>ImproNet>Engine. 


2. From the Menu Bar, select Configuration>Advanced Properties. 
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Figure 6 – Advanced Properties 


 


The Advanced Properties dialog lets you view and change the following settings: 


 


 


Time is measured in ms (milliseconds), unless stated otherwise.  1 000 ms = 1 second. 


 


 


 Controller Timeout—the length of time that the Engine will wait for a reply from a 


Controller.  The default time is 3 000.  Increase to 5 000 if Ethernet converters or radio 


modems are used.  Increase the value if Controller Dropped error messages display. 


 Controller Slow Poll Drop Time—the amount of time that a Controller is dropped from the 


poll sequence, if it times out.  The default is 180 000 (3 minutes).  After the drop time has 


passed, polling continues normally. 


 Challenge Timeout—amount of time allowed for detecting a Host Interface.  If a Host 


Interface is not detected within the Challenge Timeout time, the Not Authorised to Run 


error message is displayed.  The Default is 350.  If a valid Host Interface is connected and 


all connections are correct, you can extend the time to 800. 


 AutoID Time—amount of time a Controller allows to Auto-ID its Terminals.  The default is 1 


000.  Increase AutoID Time to 2 000 if there are Auto-ID problems over Ethernet, radio 


modem, or WAN. 


 AutoID All Antennas—forces the ImproX iTT to report back Fixed Addresses for both 


Reader 1 and 2, even if you've only connected Reader 1. 
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 Host Interface Fast Polling—enables fast polling of the Controllers by the Host Interface, 


and facilitates inter-Controller communication.  If Ethernet converters or radio modems are 


used, you can disable fast polling.  The default is true. 


 Terminal Bus Fast Polling—enables fast polling.  Default value = true. 


 Append Carriage Return to Fast Polling—enables more efficient fast polling, when you 


use a transmission device that terminates messages on a carriage return.  Enable this 


setting when you use serial to ethernet devices, radio modems and so on.  Default value = 


True. 


 Transmit Inter-controller Broadcast Twice—broadcasts all Inter-controller 


communications twice.  Only enable this setting when the communications channel is less 


reliable, dropping inter-controller messages.  Note, however, that communications are less 


efficient with this setting enabled. 


 Relax APB to Level 1 when Controllers go Offline—if a Controller goes off-line, the 


remaining Controllers remain on-line.  Only the off-line Controller disables Anti-passback 


(APB) for all Tags.    


 Relax APB to Level 2 when Controllers go Offline—if a Controller goes off-line, the Host 


Interface informs the remaining Controllers relaxing Anti-passback (APB) until ALL the 


Controllers come back on-line.  The original off-line Controller disables Anti-passback (APB) 


for all Tags.    


 Controller Bus Additional Timeout—increases the timeout duration for the Controllers 


and Host Interface fast polling.  The default is 0.  We recommend that you use the default 


value. 


 Terminal Bus Additional Timeout—increases the timeout duration for Fast Polling 


Terminals.  Default value is 0.  We recommend that you use the default value. 


 Uploader Cycle Delay—sets the delay between upload cycles to the Controllers.  Default is 


10 000.  If operating on a Wide Area Network (WAN), increase the Uploader Cycle Delay 


to 60 000 (1 minute) to reduce network traffic.  


 Uploader Inter Table Delay—time taken between processing Database tables in the 


Uploader.  Default value is 10.  Increase to 1 000 to reduce bandwidth usage on a Wide 


Area Network (WAN). 


 Uploader Daily Start Time—sets the start time for the upload cycle.  The default is 0000.  


Change this value to specify starting an upload during specific periods.  For example, 


running an upload after-hours does not reduce network usage during office hours. 


 Uploader Daily End Time—sets the end time for the upload cycle.  The default is 2400 


(midnight).  If uploading is limited to after-hours, set the Uploader Daily End Time to 0600 


– this ensures that upload cycles are stopped before the work day begins. 


 Poller Inter Poll Delay—sets the time between successive polls.  The default is 200.  


Increase to 2 000 to reduce network traffic over Ethernet converters on a WAN. 


 Poller Daily Start Time—specifies when the Engine starts polling Controllers.  The default 


is 0000.   


 Poller Daily End Time—specifies when the Engine stops polling Controllers.  The default is 


2400.   


 Uploader Database Connection Reset—limits amount of PC memory used by the 


Software. This value is reset periodically.  We recommend that you do not change it.  The 


default is 86400000 (once a day).   
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Importing ECII Controllers 


The Import Devices option lets you to import Fixed Addresses, Logical Addresses, IP 


Addresses, Hardware and PC Ports of ImproX ECII Controllers into the ImproNet System. 


Values write to the Database thus creating the IP to Logical Address mapping for the 


communications driver.  Import devices as follows: 


 


1. In Windows®, click Start>Programs>ImproNet>Engine. 


2. From the Menu Bar, select Configuration>Import Devices. 


 


 
Figure 7 – Advanced Properties 


 


3. From the Site drop-down list, select your Site.  This drop-down displays the Site 


corresponding to the Engine and is only active through Access. 


4. Alongside the File textbox, click the  button. 


5. Select the Discovery.txt file you exported from the Ethernet Discovery Utility. 


6. Click the Open button. 


7. Click the  button. 


8. At the Import Devices confirmation dialog, click the Yes button. 


 


System Configuration Procedure 


Perform the Configuration Procedure in the following order: 


 


1. Sites 


 Host PC 


 Hardware auto-detection 


2. Controller 


 Identify 


 Name 


 Configure 
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 Assign Terminals to Zones and Locations 


 Configure Zones and Locations 


3. Terminals 


 Identify 


 Name 


 Configure 


 Readers 


 Inputs 


 Outputs 


 Parameters 


4. Events and Actions 


5. Access Time Patterns 


6. Areas 


7. Access Groups 


 Time Patterns 


 Areas 


8. Tagholders 


 Tags 


 Assign Tags 


9. Time Triggered Actions 


 Actions 


 Inputs 


 Outputs 


10. Common Zones 


11. Messages 
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Sites 


To set up a Site, you need to configure the Host PC, Controllers, Terminals and Zones and 


Locations. 


 


OOppeenn  IImmpprrooNNeett  AAcccceessss  


To open ImproNet Access, proceed as follows: 


 


1. In Windows®, click Start>Programs>ImproNet>Access. 


2. Enter your Username (SYSDBA) and Password (masterkey). 


3. In the Navigator Pane, click the  icon to create a new Site.  A New Site node is added to 


the tree.   


4. Click the  icon.  The new Site’s details display in the Main Pane. 


5. The Host node expands displaying the Host PC icon.  Click the icon.  


6. In the Main Pane, enter the Host PC details. 


 


 


You can delete Sites, Controllers, Terminals, Zones, and Locations only, from the Navigator tree. Other 


node types cannot be deleted. When deleting a unit, you must first delete its child components. That is, 


to delete a Controller, you must first delete its Terminals, Zones, and Locations. Note, however, when 


deleting a Site the Access Module prompts you for confirmation on whether it must also delete the Sites 


child components. Delete a unit by simply selecting the unit and pressing Delete on your keyboard. 


 


 


ImproNet Access includes user-configurable data that is shared by other Modules; Deleting this 


data can result in other Modules functioning incorrectly. The following data is shared: Device 


Time Patterns (determine when a device is physically operational. A Device Time Pattern (DTP) 


determines when an electrical function or mechanical state on a hardware device is active. Device 


Time Patterns must be active for the same duration as all Access Time Pattern, and Tagholder Time 


Patterns that use a relevant device), Access Time Patterns (determine when Zones and Locations are 


accessible. An Access Time Pattern (ATP) determines when a Tagholder has access to an Area. When 


an Access Time Pattern and an Area are linked, they form an Access Description), Tagholder Access 


Groups and Areas. Do not delete Tagholder Access Groups or Areas unless you are sure that 


they are not required by other Site components. 


 


RRuunn  AAuuttoo--IIDD  ttoo  DDeetteecctt  HHaarrddwwaarree    


 


 


If ImproNet Engine and ImproNet Access are on different Host PCs, you must change the 


Engine.properties file.   


 


Before you can use ImproNet Access to configure hardware, you must run the Auto-ID function 


in the ImproNet Engine to detect the hardware.  To open ImproNet Engine and run Auto-ID, 


proceed as follows: 


 


1. In Windows®, click Start>Programs>ImproNet>Engine. 


2. Click the  button.   
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When hardware units are detected, they are added to the ImproNet Database and become 


available in the ImproNet Access tree.  Controllers are assigned default names that contain their 


logical addresses.  Each Controller has a node displaying its unassigned Terminals. 


 


Site Configuration 


 
Figure 8 – Main Pane Showing Site Configuration Details 


 


1. Select a Site in the Navigator Pane.   


2. On the Main Pane, in the Site group, complete the following fields: 


 Site Number—automatically assigned Site number. 


 Site Name—enter a name for the Site. 


 Site Seed (Comms)—used to encrypt communications. 


3. In the Daylight Savings Time group, configure the following settings: 


 If applicable, click the  button and enter a daylight savings Offset (seconds). 


 Enter the Start Date and Time. 


 Enter the End Date and Time. 


 


 


The Daylight Savings Time setting only works if the PC’s Operating System has the Daylight 


Savings Offset feature enabled. 


 


4. Leave the Socket Server Port Numbers group unchanged. 


5. Leave the Connection Type group unchanged. 


6. If you would like Tagholders to access Zones in a specific sequence, select the Enforce 


Zone Routing checkbox.  Refer to page 29 for more information. 


7. Indicate whether your Site is a Shared Site. 
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8. Select the UDP Comms checkbox if you want to map the IP Address to the Logical 


Address.  Once selected, refresh the Site and the IP Mapping table appears. 


 


 


Activating the Site Tag Mask checkbox reduces the number of bits the Controller checks when 


validating a Tag Code.  You may configure the Controller to ignore certain bits. 


 


9. In the Site Tag Mask group, configure the following settings: 


a. Select the Site Tag Mask checkbox, thus activating the feature.   


b. At the Warning dialog, click the Yes button. 


c. Click the  button. 


d. Complete the available fields as necessary. 


e. Select whether to Remove Bits with Zero Mask from Tag Code. 


f. Click the  button. 


 


For Validated Site (Facility) Code Group Options, you may set up to 64 Site Codes per Site.  


For your convenience, Site Codes may be copied between sites using the Copy Selected 


Codes (All Sites) and Copy Selected Codes (Selected Site) buttons.  Configure a list of 


accepted Site codes (affects HID
®
 Tags only): 


 


10. From the Validated Site (Facility) Codes group, click the Configure button. 


 


 
Figure 9 – Site Code Configuration 


 


11. Click the  button. 


12. In the Site Code textbox, enter a suitable code.   


13. Select either the Append to Existing Codes or Overwrite Existing Codes radio button. 


14. Click the  button.  


15. After updating the Main Pane, click the  button. 
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AAdddd  SSiittee  


To add a new Site, proceed as follows: 


 


1. In the Navigator Pane, click the  icon. 


2. In the Main Pane, click the  button.  The new Site is added to the Navigator tree. 


 


DDeelleettee  SSiittee  


To delete a Site, proceed as follows: 


 


1. In the Navigator Pane, click the  icon. 


2. In the Main Pane, select the row containing the Site to delete. 


3. Click the  button. 


4. Enter the ImproNet Access password confirming the action. 


 


Set Up the Host PC 


By default ImproNet Engine enters the Host PC’s IP address and Computer Name (network 


name) on opening.  View the Host information, by selecting the Host icon. 


 


For Sites using UDP Comms, you must enter the Port Number of the Host PC.  We suggest that 


you use the number 10002. 


 


 


About Hardware Configuration 


Each hardware unit is allocated a unique Fixed Address when it is built.  ImproNet Engine 


allocates a Logical Address to the unit for communication purposes. 


 


A Unit Location Chart is provided with every Controller.  Ensure the following information is 


recorded on the Unit Location Chart when a new hardware unit is received: 


 


 Fixed Address—supplied on a label included with the unit. 


 A unique description of the unit's physical Location. 
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Controller 


Controller Configuration 


GGeenneerraall  CCoonnttrroolllleerr  CCoonnffiigguurraattiioonn    


1. In the Navigator Pane, select a Controller by clicking the  icon. 


2. Change the default Controller Name to the name specified on the Unit Location Chart. 


 


 


Where you have ImproX iTT or iTRT Ethernet Terminals connected to your ImproX ECII Controller 


(Firmware V7.34 or above), set the Diagnostics Reporting Interval (minutes).  That is how often the 


Controller calculates the diagnostic statistics.  The minimum value is 1 minute and the maximum 60 


minutes (1 hour).  This setting does not indicate how often the communications diagnostic transaction 


goes through.  Rather the Controller recalculates the diagnostic transactions and compares the latest 


value to its last calculation.  If there is a notable difference, the Controller sends a new transaction.  


Refer to Part 4 – Reports for information on the Communications Diagnostic Report. 


 


3. Click the Edit Controller Parameters button.   


4. In the Enable Tag Types section, select the types of Tags to be used.  If HID Tags are used, 


enable them here. 


5. In the Terminal Port Baud Rate section, leave the default setting of 38 400. 


6. Click the  button to accept. 


 


Controller UDP Broadcast Configuration 


The IXP400i Controller can broadcast transactions as they happen to a defined list of IP 


Addresses. The Access Module lets you configure the IP Address that the Controller broadcasts 


transactions to.  Once this information uploads to the Controller, the Controller sends an ASCII 


string for each transaction to the IP Addresses (maximum 4) as defined in Access.   This is a 


Controller specific setting.  The format of the broadcast message is:  TransType=<either Access 


or Status>,DateTime=<Seconds since 1970>,EventCode=<Event Code>,TagType=<Tag 


Type>,TagCode=<Tag Code>,ReasonCode=<Reason Code>,ControllerLA=<Controller 


Logical Adress>,TerminalLA=<Terminal Logical Address>,Location=<Location>,Zone=<Zone> 


 


If a field is not applicable it lists with a value of zero. 


 


This feature gives users direct access to transactions as they happen on the Controller, users 


are therefore not forced to rely on the Engine being on-line all the time. 


 


1. In the Controller’s Main Pane, alongside the Third-party Broadcast label, click the 


Configure button. 
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Figure 10 – Controller Broadcast Dialog 


 


2. In the IP Address textbox, enter the IP Address for the device receiving the broadcasted 


data. 


3. In the Port textbox (located alongside the IP Address you entered previously), enter the Port 


number of the device receiving the broadcasted data. 


4. Repeat steps 2 and 3 if you wish to configure UDP Broadcasting for additional devices. 


5. Click the  button. 


 


GGeenneerraall  CCoonnttrroolllleerr  CCoonnffiigguurraattiioonn  CCoonnttiinnuueedd  


1. On the Controller’s Main Pane, indicate whether the Controller is installed on a LAN or WAN 


by selecting the WAN checkbox. 


 


 


Access does not allow editing of the IP Address and Port Numbers where the Controller resides on a 


LAN.  Where the WAN checkbox is selected, the IP Address and Port Number references refer to the 


Router’s IP Address and Port Number.  Change the Controller’s IP Address and Port Number using the 


Discovery Utility.  Refer to Part 8 – Utilities for more information. 


 


2. If not already selected, enable the Controller by selecting the Controller Enabled 


checkbox. 


3. Click the  button. 


 


Terminal Assignment 


The first step in configuring a Controller is to assign its Terminals to Zones and Locations.   


Terminals must be manually assigned to a Controller before they can be configured for Zones 


and Locations.  Unassigned Terminals are terminals that the Auto-ID process has identified, but 


not assigned to a Location.  To assign Terminals to a Controller, proceed as follows: 


 


1. In the Navigator Pane, select a Controller, an Unassigned Terminals node is displayed. 


 


 
Figure 11 – Unassigned Terminals 
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2. Double-click the  icon to expand the Unassigned Terminals node. 


3. Drag-and-drop unassigned Terminals onto a Controller. A new Zone containing a Location 


is created.  Terminals display in the Location.   


 


 
Figure 12 – Zones and Locations 


 


MMoovvee  aa  TTeerrmmiinnaall  


If you placed a Terminal in the wrong Location, drag-and-drop it to another Location. 


 


CCrreeaattee  NNeeww  ZZoonneess  aanndd  LLooccaattiioonnss  


 To add another Terminal to an existing Location, drag-and-drop an unassigned Terminal to 


that Location. 


 To create a new Location within an existing Zone, drag-and-drop an unassigned Terminal to 


the existing Zone. 


 


 


There is a limit of three Fixed Addresses per Location. 


 


 


A Terminal can be assigned to one Controller only. 


 


 


Name each Terminal and Location according to the Unit Location Chart. 


 


CCoonnffiigguurree  ZZoonneess  aanndd  LLooccaattiioonnss  


Locations in the same physically bounded vicinity are grouped into Zones.  The total number of 


Zones per Controller is dependent on the number of Locations per Zone.  


 


Configure Zones 


To configure Zones, proceed as follows: 


 


1. In the Navigator Pane, click a  icon to select a Zone.  The Zone’s settings display in the 


Main Pane. 


2. Enter a name for the Zone in the Zone Name textbox. 


3. Set the Anti-Passback (APB) mode. 


 None—APB off. 


 Relaxed—once a Tagholder has entered a Zone, they must exit the Zone using their 


Tag before they can re-enter.  However, Tagholders can use their Tags for multiple, 


consecutive exits in this mode. 
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 Strict—APB Zone rules are enforced for in and out directions.  A Tagholder cannot 


enter or exit a Zone consecutively. 


4. Supervisor Group for this Zone—specifies the Supervisor group that must have entered a 


Zone before a non-supervisor Tagholder is permitted access to that Zone.  The default value 


for this option is none (no value).  


5. Fully Nested within Zone—select an option from this drop-down list if the Zone is 


physically contained within another Zone.  This option is useful for Zone Routing. 


6. Part of Common Zone—select an option if the Zone is part of a Common Zone.  Due to 


Controller restrictions, you may only assign one Zone as a Common Zone per Controller.   


7. Relaxed Exit Conditions for this Zone—enables a Tagholder to exit a Zone even if the 


Access Time Pattern for the Zone has expired.  The default value is Yes. 


8. Zone Broadcast—used where the Registration Interface communicates with the Controller 


via RS485 and on large Sites, where Interleading Zone Routing works ineffectively.  The 


default is No. 


9. Anti-Passback Lockout Entry or Exit Delay—enter a time in minutes to enforce APB.  


Only available if Relaxed or Strict APB mode is selected.  Refer to point 3 above for APB 


details. 


10. Limit Tags Inside the Zone to—enter the maximum number of Tags permitted in the Zone 


at the same time.  Only available if Strict APB mode is selected. 


11. Alarm Zone—sets the Zone as an alarm arming Zone.  Activating the checkbox, allows 


arming and disarming of the Zone.   


 


 


When you select the Alarm Zone checkbox, Access creates a number of extra default Actions required 


by the Alarm Arming feature. 


 


Configure Locations 


A Location is a physical point of access.  Examples include doors, turnstiles, vehicle gates, and 


Time and Attendance points.  A Location can have a maximum of three Terminals, but can also 


host a non-scanner Terminal such as the I16 16 Channel Input Terminal.   


 


To configure Locations, proceed as follows: 


 


1. In the Navigator Pane, select a Location ( ).  The Location’s settings display in the Main 


Pane. 


2. Enter a descriptive Location Name. 


3. If the Location is a Time and Attendance point, select the Time and Attendance option from 


the Location Type drop-down list. 


4. If the Location accesses an Interleading Zone, select it from the Interleading Zone drop-


down list. 


5. Click Enforce Interleading Zone Routing if required. 


6. To specify Multiple Tag Access, select the 2 Tags option.  This option is a security feature 


that requires two Tagholders to access a Zone. 


 


Zone Routing 


Zone Routing ensures that a Tagholder accesses Zones in a specified sequence.   


 


To set up Zone Routing, proceed as follows: 


 


1. In the Navigator Pane, select a Site. 
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2. In the Main Pane, select the Enforce Zone Routing option. 


3. In the Navigator Pane, select a nested Zone. 


4. In the Main Pane, select a Zone from the Fully Nested Within Zone drop-down list to 


specify the selected outer Zone. 


 


 


Nested Zone must be configured on the same Controller. 
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Terminals 


General Terminal Configuration 


The Terminals screen enables you to configure a Terminal and set-up its Actions, Inputs, and 


Outputs.  To configure a Terminal, proceed as follows: 


 


1. In the Navigator Pane, click a Terminal to select it.  The Terminal tab displays. 


2. Enter a descriptive Terminal Name. 


3. Select whether the Reader is an Entry or Exit Reader. 


 


 


This step determines the default Actions assigned to the Reader. 


 


 


Where you have an ImproX iTT or iTRT Terminal selected, the Terminal tab displays the Terminal’s IP 


Address with a Ping button alongside.  After clicking the Ping button the ImproNet Software confirms 


the Hardware’s connected and working. 


 


4. Click the  button to save the settings. 


 


 
Figure 13 – Terminal Tab 
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EEddiitt  TTeerrmmiinnaall  PPaarraammeetteerrss  


 


 


Terminal Parameters are different for each Terminal type.  This section provides information on the 


most common parameters only.   


 


1. Click the Edit Terminal Parameters button.   


2. Select a Buzzer Volume. 


3. Enter the value for Same Tag Timeout in milliseconds—this is the minimum time that must 


elapse before the same Tag can be re-read at the Terminal. 


4. Select a Tag Validation option: 


 Controller Validation—the Tag is authenticated by the Controller.  This is the default 


setting. 


 Host Validation—the Tag is authenticated by the Host PC.  With this option, the 


Reader does not respond if the Host PC is off-line. 


 Terminal Validation when Controller Offline—during on-line operation, the Controller 


transfers its decision making tables to the ImproX iTT or iTRT.  Thus when the Door 


Controller goes off-line from the Controller the Door Controller can make "informed" 


access decisions.  Once the Door Controller comes back on-line, all transactions 


update.  During Full Off-line all functions are supported EXCEPT for the following:  Anti-


passback (APB), Supervisor Unlock, Alarm arming and disarming, No Zone, Common 


Zone or Interleading Zone related checks (including Zone Counting) are enforced  or 


Random Search.  


 


 


Where the off-line device is not local, Lift (Elevator) Control or Input Output Control will NOT function.   


 


On sites using IP communications, the ImproX iTT or iTRT can store and validate a 


maximum of 10 000 Tags.  For more than 10 000 Tags the IP Door Controller switches 


to Cached Off-line mode.  When using the Door Controller with RS485 communications 


and the number of Tags exceeds 1 000, then Full Off-line switches to Cached Off-line 


for the RS485 Door Controllers in the System. 


While off-line at least 10 000 transactions store for each Reader.  Once the buffer 


reaches capacity, new transactions overwrite oldest.   


5. Enter Random Search values if required.   


6. Click the  button to save the settings. 


 


 


The Host Validation option should only be enabled if third-party software is being used and requires 


validation. 


 


SSppeecciiaall  CCooddeess  


You can use Special Codes to manually activate specific Actions, such as opening a door or 


sounding a siren.   


 


 


Special Codes are only available on Terminals with a Keypad.  However, they are not available if the 


Terminal is configured for Personal Access Code (PAC) Mode. 


 


 


Restrict Special Codes to specific Tagholders. 
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In the Edit Terminal Parameters dialog, under Keypad Transaction Reporting select 


Activate Special Key Codes thus enabling this feature.   


 


The Special Code format has a maximum of five digits in the following configurations: 


 


 Three digits and a hash.  For example, 123#. 


 Four digits and a hash.  For example, 1234#. 


 Five digits up to the number 65535. 


 


DDuurreessss  CCooddeess  


Duress Codes generate an Alarm action when entered on a Keypad Terminal.  You can allocate 


them to Tagholders who have a PIN-code.  The Duress Code format is one digit higher or lower 


than the Tagholder’s PIN-code.  For example, if the PIN-code is 12345, the Duress Code is 


12344 or 12346. 


 


Terminal Mode Configuration 


 


 


Device Time Patterns must be set-up before Terminal Modes can be configured. 


 


Terminal Mode specifies the state of a Terminal during a selected Time Pattern.   The following 


Terminal Modes and access conditions are available: 


 


 Tag Mode—the Terminal requires a valid Tag to be accessible.  This is the default mode. 


 Locked Mode—the Terminal is Locked and access is denied, even to valid Tags. 


 Unlocked Mode—the Terminal is Unlocked. 


 Tag + PIN—the Terminal requires a Valid Tag and a PIN-code to be accessible. 


 Tag + Reason Code—the Terminal requires a Valid Tag and a Reason Code to be 


accessible. 


 Tag + PIN + Reason Code—the Terminal requires a Valid Tag and a PIN-code and a 


Reason Code to be accessible. 


 PAC—the Terminal requires a valid Personal Access Code (PAC) or Tag to be accessible. 


 


To configure Terminal Modes, proceed as follows: 


 


1. In the Main Pane, select the Terminal Mode tab. 


2. Select the Default Terminal Mode from the drop-down list. 


3. Click the  button to create a new Terminal Mode. 


4. Click the  button alongside the Select Device Time Pattern field. 


5. Select an existing Device Time Pattern record. 


6. Click the  button. 


7. Select a corresponding Terminal Mode from the Select Terminal Mode drop-down list. 


8. Select the Report checkbox to enable reporting of all access actions. 


9. Click the  button. 
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Figure 14 – Terminal Mode Configuration 


 


 


ImproNet supports up to 128 Device Time Patterns.  Each Terminal can have up to eight Device Time 


Patterns. 


 


Inputs 


The Inputs tab lets you configure the inputs on the ImproX I16, ImproX TA, ImproX iTT, 


ImproX MfT and ImproX iTRT Terminals.  However, Inputs can also be edited and assigned, 


directly from the Terminals tab.  Figure 15 shows the area of the Terminal tab where you can 


edit Inputs and assign Actions.  Configure Inputs for the following: 


 


 Request to Enter / Exit buttons 


 Door Open / Door Forced sensing 


 Inhibit Scanner function 


 Alarm monitoring 


 


 
Figure 15 – Terminal Input Configuration 







Part 3 – General Configuration 


January 2012  35 


EExxaammppllee  ooff  IInnppuutt  CCoonnffiigguurraattiioonn  


The following example demonstrates how to create an RTE configuration from the Terminal tab: 


 


 
Figure 16 – Input Configuration Field 


 


1. In the Input Configuration field, double-click a General Input that is Not Used.   


 


 
Figure 17 – Input Device Dialog 


 


2. In the Input Device dialog, in the Input Name textbox, enter RTE. 


3. From the Input Function drop-down list, select the Request to Enter/Exit Button option. 


4. Click the  button to save. 


 


IInnppuutt  CCoonnffiigguurraattiioonn  


To configure Terminal Inputs, proceed as follows: 


 


1. In the Main Pane, select the Input tab. 


2. Select an Input row. 


3. Click the  button.   
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Figure 18 – Input Device Dialog 


 


4. Enter an Input Name, or use the default name. 


5. Select an Input Function from the drop-down list.   


The following options are available: 


 Not Used—select if the input is unused. 


 Request to Enter/Exit Button—select if the input is connected to a Request To Enter 


or Exit (RTE) button. 


 Door Open Sensor—select if the input is connected to a Door Open Sensor (DOS). 


 Alarm Input—select this option if the Input is connected to a third-party alarm system. 


 Inhibit Scanner—disables a Tag Reader from reading Tags. 


 Emergency—switches on Emergency Mode. 


 Lockdown—switches on Lockdown Mode. 


 Alarm Armed—arms or disarms the Zone. 


 Alarm System Ready—puts the Zone into Ready Mode. 


 


EEnnaabbllee  TTiimmee  PPaatttteerrnnss  


Time Patterns determine when a Terminal Input is active.  To configure Time Patterns, proceed 


as follows: 


 


 
Figure 19 – Input Time Pattern Dialog 
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1. On the Input Device window, click the Enable Time Pattern button.  


2. Click on the  or  button. 


3. In the Device Time Patterns dialog, select the record. 


4. Click on the  button. 


5. Click the  button. 


6. Click the  button. 


 


IInnppuutt  PPaarraammeetteerrss  


The Input Parameter setting provides options for the selected Input Function.  Proceed as 


follows to configure Input Parameters: 


 


1. On the Input Device window, click the Input Parameters button. 


 


For the Request to Enter/Exit Button Input Function, the following options are available: 


 


 
Figure 20 – Request to Enter/Exit Input Parameters 


 


 Open Contact—the Door opens when the Input receives an open-contact signal. 


 Closed Contact—the Door opens when the Input receives a closed-contact signal. 


 


For the Door Open Sensor Input Function, the following options are available: 


 


 
Figure 21 – Door Open Sensor Input Parameters 


 


 Door Open is Open Contact—the Input reports that the Door is open when an open-


contact signal is received. 
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 Door Open is Closed Contact—the Input reports that the Door is open when a closed-


contact signal is received. 


 Door Open Sensing with End of Line Detection—enables the End-of-line Sensing 


option. 


 Click the  button to select the Logical Address of the Terminal Monitored. 


 


 


The Inhibit Scanner Input Function disables a Tag Reader from reading Tags.  For IXP400i 


Sites, using ImproNet V7.60 onwards, the Input Parameters dialog gives the added functionality 


of setting the inhibit function across MULTIPLE Tag Readers.  


 


 


The ability to inhibit multiple units, as shown in Figure 22, is only available on sites using ECII 


Controllers (IXP400i Sites).  In configurations using AC’s, IC’s or EC’s (IXP300 and IXP400 Sites) the 


dialog only lets you inhibit a single unit. 


 


 The following Inhibit Scanner options are available: 


 


 
Figure 22 – Inhibit Scanner Input Parameters 
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Inhibit Scanner Contact 


 Inhibit on Open Contact—the Reader does not read Tags if the Input detects a Door 


open-contact signal. 


 Inhibit on Closed Contact—the Reader does not read Tags if the Input detects a Door 


closed-contact signal. 


 


Scanner Selection Section 


For the first Logical Address of Scanner to Inhibit textbox, activating the Inhibit Scanner 


feature selects, by default, the Terminal being edited.  If selecting a Terminal (other than the 


default) click the  button to select the Logical Address to Inhibit. 


 


 


For the remaining Logical Address of Scanner to Inhibit textboxes, click the  button to select the 


Logical Address to Inhibit. 


 


 


The text fields remain blank until you select a Terminal’s Logical Address.   


 


 


Selecting the same Logical Address more than once only saves the Logical Address once.     


 


For the Alarm Input Function, the following options are available: 


 


 
Figure 23 – Alarm Input Parameters 


 


 Alarm on Open Contact—an Alarm event is generated if the Input receives an open-


contact signal. 


 Alarm on Closed Contact—an Alarm event is generated if the Input receives a closed-


contact signal. 


 Alarm on Change of Contact—an Alarm event is generated if the Input receives a 


change-in-contact-state signal. 


 Alarm on End of Line Detection—an Alarm event is generated if the Input receives an 


End-of-line-detection contact signal.  This option is recommended for the ImproX I16 


Terminal. 


 


2. Click the  button to accept. 


 


 


Ensure that you click the  button when you exit the Input Device window. 
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EEnndd--ooff--lliinnee  SSeennssiinngg  ffoorr  tthhee  IImmpprrooXX  iiTTTT  aanndd  iiTTRRTT  


End-of-line Sensing on the ImproX iTT and iTRT is only possible if Door Open Sensing is 


configured.  Only Inputs 1 and 3 on the ImproX iTT and iTRT have end-of-line sensing 


functionality.  Configure the Input as a Door Open Sensor, and select Door Open Sensing 


with End of Line Detection from the input parameters list.   


 


 
Figure 24 – Input Device Dialog 


 


 
Figure 25 – Input Parameters Dialog 
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Outputs 


The Outputs tab enables you to configure a Terminal’s LED and Relay states for different 


Terminal Modes. 


 


 


We recommend setting different LED states for different Terminal Modes, as this will help Tagholders 


identify Terminal Mode changes. 


 


To configure Terminal Outputs, proceed as follows: 


 


1. In the Main Pane, select the Output tab. 


2. Select an Output row. 


3. Click the  button.   


 


The content in the Output Device dialog is one of the following depending on the function of the 


selected output device. 


 


 General Relay 


 Status LED 


 


GGeenneerraall  RReellaayy  


If the output device is a General Relay, select a Relay Contact State for each of the following: 


 


 Relay during Locked Mode 


 Relay during Unlocked Mode 


 Relay during Tag Mode 


 Relay during Emergency Mode 


 Relay during Lockdown Mode 


 


Click either the associated Mode’s Query button or the Configure Outputs button to edit the 


available Relay Contact States.  The following Relay Contact States are available: 


 


 Do NOT Drive Relay in this Mode 


 Drive Relay in this Mode 


 


SSttaattuuss  LLEEDD  


If the output device is a Status LED, select a Status LED State for each of the following: 


 


 Status LED during Locked Mode 


 Status LED during Unlocked Mode 


 Status LED during Tag Mode 


 Status LED during Emergency Mode 


 Status LED during Lockdown Mode 


 


Click either the associated Mode’s Query button or the Configure Outputs button to edit the 


available Status LED States.  The Status LED States appear as shown in Figure 26. 
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Figure 26 – Output Parameters Dialog 


 


Actions 


AAbboouutt  AAccttiioonnss  


ImproNet enables you to define Actions for Terminals and in some cases, Controllers.  Actions 


are instructions stored in a Controller’s memory, and are triggered by Events or by the Time 


Triggered Actions function.  The following are examples of common Actions: 


 


 Driving a Relay 


 Sounding a Buzzer 


 Changing LED state 


 Displaying LCD message 


 


When a Terminal is assigned to a Location, default actions for the Terminal are created.     


Figure 27 displays the default actions created for the On Valid Tag event, and for the On 


Invalid Tag.  These Actions are executed when a Tag is presented at the Terminal.   


 


 
Figure 27 – Default Terminal Actions 


 


The On Valid Tag event encompasses all valid Tag Events.  Therefore, the On Valid Tag 


section on the Terminal tab enables you to configure actions to all valid Tag Events in a bulk 


procedure.  Similarly, the On Invalid Tag event encompasses all invalid Tag Events.  Therefore, 


the On Invalid Tag section on the Terminal tab enables you to configure actions to all invalid 


Tag Events in a bulk procedure.   
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To customize the settings of the default actions, proceed as follows: 


 


1. On the Terminal tab, click the  button next to the Action that you want to edit.   


2. Change the settings as necessary. 


3. Click the  button to accept. 


 


 


The Actions tab lists all Actions currently assigned to the selected Terminal and enables you to assign 


additional actions to the On Valid Tag and On Invalid Tag events. 


 


AAbboouutt  EEvveennttss  


System Events are activated by a Controller when a particular procedure or process is 


performed.   


 


For example, when a Reader detects a Tag, the Tag is validated by the Controller, and the Event 


Allowed_Normal_In or Allowed_Normal_Out is activated.  In this example, the actual Event 


depends on whether the Reader is an Entry or Exit Reader.   


 


When an Event is generated, the Controller executes the Actions linked to the Event. 


 


Active System Events 


The Active System Events Editor enables you to link Actions to Allowed Events and Denied 


Events.  You can have up to five of the following Action types per Event: 


 


 


An Action is not created for a Terminal if the hardware does not support the Action. 


 


Action Optional Description 


Buzzer × Created by default when you specify a 


Terminal as an Entry or Exit Reader. 


Status LED × Created by default when you specify a 


Terminal as an Entry or Exit Reader. 


Buzzer—Armed Out of Sequence × Created by default when you set up 


Alarm Arming (see Part 5 – Advanced 


Configuration for more information). 


Buzzer—Failed to Arm × 
Buzzer—Failed to Arm All Zones × 
Buzzer—No Arm Authority   × 
Buzzer—Zone Already Armed × 
Buzzer—Zone Armed × 
Buzzer—Zone Not Ready × 
LED—Armed Out of Sequence × 
LED—Failed to Arm × 
LED—Failed to Arm All Zones × 
LED—No Arm Authority   × Created by default when you set up 


Alarm Arming (see Part 5 – Advanced 


Configuration for more information). 


LED—Zone Already Armed × 
LED—Zone Armed × 
LED—Zone Not Ready × 
Buzzer—Already Disarmed × 
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Action Optional Description 


Buzzer—Disarm Failed × 
Buzzer—Disarmed Emergency Unlock × 
Buzzer—Disarmed out of Sequence   × 
Buzzer—No Disarm Authority × 
Buzzer—Zone Disarmed × 
LED—Already Disarmed × 
LED—Disarm Failed × 
LED—Disarmed Emergency Unlock × 
LED—Disarmed out of Sequence   × 
LED—No Disarm Authority × 
LED—Zone Disarmed × 
Relay × Created by default when you specify a 


Terminal as an Entry or Exit Reader. 


LCD  An LCD Action displays a user-


configurable text message on a 


Terminal or Controller with an LCD. 


Emergency Mode  Emergency Mode Actions are only 


executed on Controllers and Terminals 


that have been configured for 


Emergency Mode.   


Door Open Timer  The Door Open Timer Action is created 


by default for the ImproX TA, iTT and 


iTRT Terminals.  However, it is not 


enabled until a Terminal Input is 


configured as a Door Open Sensor 


(DOS).   


A Door Open Timer Action prevents a 


Door Forced Alarm Event from being 


activated if a Door is opened under the 


following conditions: 


 A valid Tag Event precedes the 


Door opening 


 A valid RTE Event precedes the 


Door opening 


Multiple Actions  A Multiple Action groups up to five other 


Actions together so that they execute as 


a single Action.  Multiple Actions are 


useful for Lift (Elevator) Control. 


Reset Digital Inputs  Resets Digital Inputs. 


Raise System Event  Raise Event triggering Action. 


Reset Zone Count  Resets the Zone count (count of 


Tagholders in the Zone). 


Arm Alarm System Relay × The Relay for use in arming the alarm 


system for the specified Zone. 


Disarm Alarm System Relay × The relay for use in disarming the alarm 


system for the specified Zone. 
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Action Optional Description 


Send SMS  Used for sending an outgoing SMS to 


the phone number(s) specified in the 


message. 


Table 3 – Actions 


 


CCoonnffiigguurree  AAccttiivvee  SSyysstteemm  EEvveennttss  


On the Actions tab, click the Active System Events button.  The Active System Events Editor 


enables you to assign up to five Actions to the On Valid Tag and On Invalid Tag events.  


Available Actions are listed in sequence.  If the middle block of an Action is empty, the action is 


unused.   


 


 
Figure 28 – Active Systems Event Editor 


 


To assign new Actions to an Event, proceed as follows: 


 


1. Click the number button to the right of an unused Action. 


2. Click an Action to select it. 


3. Click the  button. 
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AAddvvaanncceedd  AAccttiivvee  SSyysstteemmss  EEvveennttss  


The Active Systems Events window enables you to assign up to five Actions to any system 


Event.  To access this facility, click the Advanced button on the Active Systems Event Editor 


dialog, and select an Event from the Active System Event drop-down list. 


 


 
Figure 29 – Advanced Active Systems Events Editor Dialog 







Part 3 – General Configuration 


January 2012  47 


Access Time Patterns 


Access Time Patterns specify times when access is permitted.  Tagholders Access Groups are 


assigned one or more Access Time Pattern.  When an Access Time Pattern and an Area are 


linked, they form an Access Description.   


 


 


Terminal Modes override Access Time Patterns.  For example, if a Tagholder has access from 6 am to 


6 pm, but the Terminal is locked from 5:30 pm, the Tagholder will be denied in after 5:30 pm. 


 


 


Access Time Patterns regulate Tagholder access times, and have no start and end dates.  Device Time 


Patterns regulate Terminal operation times. 


 


Configure Access Time Patterns 


To configure an Access Time Pattern, proceed as follows: 


 


1. In the Navigator Pane, click the  icon.  In the Main Pane, the Default Access Time 


Pattern displays. 


2. Do one of the following: 


 Select an Access Time Pattern, and click the  button.  The Edit Access Time 


Pattern dialog displays. 


 Click the  button to create a new Access Time Pattern. 


 


 
Figure 30 – Edit Access Time Pattern Dialog 


 


3. Enter a Description for the Access Time Pattern. 


4. Enter a Start Time—this is the time of day when the Access Time Pattern becomes active. 
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5. Enter the Duration in hours and minutes—this is how long after the start time, the Access 


Time Pattern is active. 


6. Select the days of the week when the Access Time Pattern is enabled. 


7. Create as many Access Time Patterns as necessary. 


 


 


If a lockout period between regular access periods is required, you need to create two Access Time 


Patterns.  For example, to disable access during a lunch hour, you need to create an Access Time 


Pattern that ends when lunch starts, and another Access Time Pattern that starts when lunch ends. 
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Areas 


An Area consists of a number of Locations grouped together to form a logical unit.  An Area is 


not a physically bounded building or place; it is a collection of Locations that a group of 


Tagholders has access to. 


 


The purpose of an Area is to group Locations with the same access requirements together.  This 


enables you to assign the same access rights to multiple locations at the same time.  Figure 31, 


illustrates the concept of Areas.  In the schematic, Locations are assigned to the Management, 


Factory Workers, or Design Staff Areas.  Note that a single Location can be assigned to more 


than one Area. 


 


 
Figure 31 – Area Schematic 


 


SSeelleecctt  AArreeaa  


To select an existing Area, proceed as follows: 


 


1. In the Navigator Pane, click the  icon. 


2. Select an Area from the Area Name drop-down list. 


 


 


An Area that has no Locations assigned to it displays the  icon only.  A configured area displays a 


tree of locations.  If a Location is visible, then it is assigned to the selected Area. 
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CCrreeaattee  AArreeaa  


To create an Area, proceed as follows: 


 


1. In the Navigator Pane, click the  icon. 


2. In the Main Pane, click the  button. 


3. Enter an Area Name and Area Description. 


 


DDeelleettee  AArreeaa  


To delete an Area, proceed as follows: 


 


1. In the Navigator Pane, click the  icon. 


2. Select an Area from the Area Name drop-down list. 


3. Click the  button.  


4. Click the  button.  A confirmation dialog displays. 


5. Click Yes. 


 


AAssssiiggnn  LLooccaattiioonnss  ttoo  AArreeaass  


To assign Locations to an Area, proceed as follows: 


 


1. In the Navigator Pane, click the  icon. 


2. Select an Area from the Area Name drop-down list. 


3. Click the  button.  


4. In the Edit window, select a Location by clicking it—Select multiple Locations by holding 


down the Ctrl key while you click.   


 


 
Figure 32 – Assign Locations to Areas 


 


5. Click the  button to save.   
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Access Groups 


Each Tagholder in a Site is assigned to at least one Tagholder Access Group.  The purpose of 


Access Groups is to allocate Tagholder access permissions in bulk.  This saves you the trouble 


of configuring Tagholders one-at-a-time.   


 


 
Figure 33 – System Configuration Parameters 


 


AAcccceessss  DDeessccrriippttiioonnss  


An Access Description defines the Time and the Area where access is permitted. 


 


 
Figure 34 – Tagholder Access Group Breakdown 


 


There are two types of Tagholder Access Groups: 


 


 General—used for permanent staff. 


 Visitor—used for visitors. 
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Configure Tagholder Access Groups 


The Tagholder Access Group screen displays available Access Groups in the left-hand panel, 


and their Access Descriptions in the right-hand panel. 


 


SSeelleecctt  aa  TTaagghhoollddeerr  AAcccceessss  GGrroouupp  


To select an existing Tagholder Access Group, proceed as follows: 


 


1. In the Navigator Pane, click the  icon. 


2. Select a Tagholder Access Group from the General tab in the left-hand panel.  Alternatively, 


click the Visitors tab and select a Visitors Access Group. 


 


The selected Access Group’s Access Descriptions are displayed in the right-hand panel of the 


Tagholder Access Group screen 


 


CCrreeaattee  aa  TTaagghhoollddeerr  AAcccceessss  GGrroouupp  


To create a Tagholder Access Group, proceed as follows: 


 


1. In the Navigator Pane, click the  icon. 


2. In the Main Pane, click the  button. 


3. Enter a name in the Tagholder Access Group Name textbox. 


4. Click the  button to save. 


 


DDeelleettee  aa  TTaagghhoollddeerr  AAcccceessss  GGrroouupp  


 


 


Remove all Tags assigned to the Tagholder Access Group before you delete the Group. 


 


 


Remove all Access Descriptions from the Tagholder Access Group before you delete the Group. 


 


To delete a Tagholder Access Group, proceed as follows: 


 


1. In the Navigator Pane, click the  icon. 


2. Select a Tagholder Access Group. 


3. Click the  button.  A confirmation dialog displays. 


4. Click Yes.  


 


EEddiitt  aa  TTaagghhoollddeerr  AAcccceessss  GGrroouupp  


To edit a Tagholder Access Group, proceed as follows: 


 


1. In the Navigator Pane, click the  icon. 


2. Select a Tagholder Access Group. 


3. Click the  button.   
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Configure Access Descriptions 


The Access Descriptions dialog has three tabs—one for each Access Description per Access 


Group.  The Access Description 1 tab is displayed by default. 


 


 
Figure 35 – Access Descriptions Dialog 


 


AAssssiiggnn  AAcccceessss  TTiimmee  PPaatttteerrnnss  


1. Click the top Select button to assign an Access Time Pattern to the Access Description.  


The Access Time Patterns dialog displays. 


2. Click a Time Pattern Name to select it. 


3. Click the  button to accept. 


 


AAssssiiggnn  AArreeaass  


4. Alongside the Area textbox, click the Select button. 


5. Click a Time Pattern Name to select it. 


6. Click the  button to accept. 


 


 


Three Access Descriptions are available per Access Group.  However, you only need to configure one 


of them to save an Access Group. 


 


AAddvvaanncceedd  SSeettttiinnggss  


Click the Advanced Settings button on the Access Descriptions.  Additional settings are 


displayed on the following tabs: 


 


 Reporting—click the checkbox to log all transactions for the selected Access Description. 


 Start & Expiry Date—click the edit buttons and enter dates to control when the Access 


Description is active. 
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 Supervisor Unlock—select the Supervisor who is required to be inside the Area before 


other Tagholders are permitted entry. 


 


 


The Supervisor Unlock facility is only applicable to Areas comprising a single zone set to Strict Anti-


passback. 


 


 Actions—click the Select buttons to assign actions for when Tagholders are entering 


(Coming In), or exiting (Going Out) the Area specified in the Access Description. 


 Alarm Arming—(only available on Employee Tagholder Access Groups, when unlocked for 


Alarm Arming) select from the following options: 


 Allow Access for this Area—allows the user access to the Area. 


 


 


If Allow Access for this Area is deselected, and the Allow Arming and Allow Disarming options 


selected, the user could for example arm and disarm the System, but not physically enter the Zone. 


 


 Allow Arming of Alarm System for this Area—selecting this option gives the user 


permission to arm the Zone. 


 Allow Disarming of alarm System for this Area—selecting this option gives the user 


permission to disarm the Zone. 


 


VViissiittoorr  AAcccceessss  GGrroouupp  


Visitor Access Groups are displayed on the Visitors tab on the Tagholder Access Groups 


screen.  They operate the same as other Access Groups.  Note that Visitor Tags can be 


assigned to Visitor Access Groups only. 
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Tagholders – Assign Access to Tags 


A Tagholder is any person who uses a Tag to access a Site.  Visitors are Tagholders with 


restricted access rights.  Before you can assign access to a Tag, you must first assign the Tag to 


a Tagholder.  The Tagholder screen enables you to do the following: 


 


 Add Tagholders to a Site 


 Edit existing Tagholder information 


 Search for Tagholders 


 Read Tags 


 


 


In sites with low bandwidth requirements, or where you need to load Tagholders quickly, we 


recommend using pagination.  Refer to page 73 for instructions on activating this setting.      


 


Add or Edit a Tagholder 


To add or edit a Tagholder, proceed as follows: 


 


1. In the Navigator Pane, click the  icon. 


2. In the Main Pane, do one of the following: 


 Click the  button to add a Tagholder. 


 Click the  button to edit a Tagholder. 


 


Quick Search for Tagholder 


To search for a Tagholder, proceed as follows: 


 


1. In the Navigator Pane, click the  icon. 


2. Select the search criteria from the on Column drop-down-list.   


3. Enter the search text into the Find textbox. 


4. If you have pagination enabled, click the  button. 


 


Configure Tagholder Details 


The Edit Tagholder dialog enables you to create or edit a Tagholder’s information and assign 


Tags.  Only the First Name and Last Name fields are required.  However, we recommend 


entering as much information as possible. 


 


To create or edit a Tagholder, proceed as follows: 


 


1. Enter the Tagholder’s First Name and Last Name. 


2. Complete other personal information as necessary. 
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3. Select the Current checkbox to enable the Tagholder (selected by default).  If this Current 


checkbox is unchecked, the Tagholder is inactive in the system.   


4. Use the Notes text area to enter other information about the Tagholder. 


5. Enter a PIN-code of up to 5 digits if the Tagholder is required to use keypad-type Readers. 


 


 
Figure 36 – Edit Tagholder Dialog 


 


DDeeppaarrttmmeennttss  


Select the Tagholder’s Department from the Department drop-down list.  To add new values or 


to edit the Department list, proceed as follows: 


 


1. Click the Departments button.  The Department Editor dialog displays. 


 


 
Figure 37 – Department Editor Dialog 
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2. Do one of the following: 


 Click the  button to add a new Department. 


 Click the  button to display Tagholders belonging to the selected Department. 


 Select a Department and click the  button to edit it. 


 Select a Department and click the  button to delete it. 


 


CCuussttoomm  FFiieellddss  


This feature lets you create any extra fields you may need.  For example, there is no field in 


Access where you may enter the Tagholders home address or telephone number.   


 


Add Custom Fields 


1. In the Edit Tagholders dialog, click on the Custom Fields button. 


2. In the Custom Fields dialog, click on the Advanced button. 


3. Click the  button. 


4. In the Field Name field, type in a name for your custom field. 


5. In the Field Description field, type in a description of your custom field. 


6. Click the Required Field checkbox, if this field’s information is required for every Tagholder 


entry.  


7. Click the  button to accept. 


8. Click on the  button. 


 


Now when you click on the Custom Fields button, the Custom Fields dialog displays your newly 


created fields.   


 


Edit Custom Fields 


1. In the Field Creator dialog, double click on the fields name. 


2. Edit the details as necessary. 


3. Click the  button to accept. 


4. Click on the  button. 


 


TThhiirrdd--ppaarrttyy  AApppplliiccaattiioonnss  


Once a single Third-party Application is assigned, pressing this button launches a third-party 


application from Access.   


 


 


This button only appears in the Edit Tagholder dialog.   


 


1. In the Edit Tagholder dialog, click on the  button. 


2. In the Third-party App dialog, select the  button alongside the Path field. 


3. Choose the exe or bat file you wish to run. 


4. Click the Open button. 


5. Click the  button to accept. 


 


The path entered above is stored in the Access Properties file.  If you want to change the path, 


either edit the Properties file or, in the Edit Tagholder dialog, hold down the Ctrl key and click on 


the  button. 
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UUsseerr  PPrrooffiillee  


User Profiles are configured when Operator Security is required.   


 


CCoonnffiigguurree  TTaagg  DDeettaaiillss  


A Tagholder can have 4 Tags assigned to them in IXP300 or IXP400 Systems and 8 Tags 


assigned in IXP400i Systems.   


 


To assign Tags to a Tagholder, proceed as follows: 


 


1. On the Edit Tagholder dialog, click any of the New Tag buttons.   


2. On the Tag Details dialog, select one of the following Tag Options: 


 Normal—normal employee. 


 Suspend—Tag is suspended from all access on the Site. 


 Blacklist—Tagholder is blacklisted and denied access to the Site. 


 Special Event 1—Tag raises an Event when presented to the Reader – in this case 


Special Event 1.  The Event can be linked to a specific Action. 


 Special Event 2—Tag raises an Event when presented to the Reader – in this case 


Special Event 2.  The Event can be linked to a specific Action. 


3. Configure the following: 


 APB Override—Tags are not subject to APB rules. 


 Report Always—All Transactions for the Tag are written to the Database. 


4. Assign the Tagholder to a Site by selecting a value from the Site Assigned drop-down list. 


5. Assign the Tagholder to one or more Tagholder Access Groups by selecting values from the 


Group1 to 10 drop-down lists.   


 


 


At least one Tagholder Access Group must be assigned for the Tag to have any access rights. 


 


Repeat procedure for additional Tags if necessary. 


 


RReeaadd  tthhee  TTaagg  


1. Present a Tag to an Enrollment Reader and click the Read Tag button.  The Tag Type is 


usually detected automatically. 


2. If the Tag Type is not displayed when the card is read, or if you are entering a Tag code 


manually, select the Tag Type from the drop-down list.   


 


When ImproNet detects a Tag, a Tag number displays in the Tag Code textbox. 


 


 


To create a Personal Access Code (PAC) only, select the Personal Access Code option from the Tag 


Type drop-down list and enter the PAC in the Tag Code textbox. 


 


 


Multiple Tags do not work in an Anti-Passback Zone; if you enter a Zone with one Tag, and exit the 


Zone using a different Tag, APB is not enforced. 
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SSppeecciiffyy  SSttaarrtt  aanndd  EEnndd  DDaatteess  


1. If the Tagholder is temporary, click the Pick Start Date and Pick End Date buttons to select 


a Start Date and Expiry Date.    To select dates, proceed as follows: 


 Select a Month and a Year using the  and  arrow buttons 


 Select a Day by clicking it.  Alternatively, click Zero Date to set no date 


2. Click the  button to accept. 


 


SSeett  tthhee  DDeeffaauulltt  CCaarrdd  TTeemmppllaattee  


When configuring a Tagholder, this facility allows you to select, from a library of Card Templates, 


the template to be used as the default when printing Credit Card Tags for that Tagholder. 


 


 


The procedure for Setting the Default Card Template is described in Part 6 – Modules, of this manual, 


in the Card Designer chapter. 


 


Batch Enrollment of Tags 


The Batch Enrollment feature enables you to rapidly assign multiple Tags to a Site, without 


entering Tagholder details. 


 


SSttaarrtt  BBaattcchh  EEnnrroollllmmeenntt  


Proceed as follows to open Batch Enrollment and start adding Tags: 


 


1. On the ImproNet Access Menu, select Configuration>Batch Enrollment.   


 


 
Figure 38 – Batch Enrollment Dialog 
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2. Select a Site to assign the Tags to. 


3. Select a Department if necessary. 


4. Select the Employee checkbox if the Tags are for employees.  Or deselect the Employee 


checkbox if the Tags are for Visitors. 


5. Select an Access Group. 


6. Enter a Start Tag Reference number if required.  The Start Tag Reference number is any 


number or identification that you can use to temporarily identify the Tags. 


7. Select one of the following to start the Batch Enrollment process:  


 Batch Mode Auto Read 


 Manual Read 


 Non-read Tags  


 


BBaattcchh  MMooddee  AAuuttoo  RReeaadd  


This Mode enables you to scan a batch of Tags in quick succession. 


 


1. Select the Batch Mode Auto Read option. 


2. Click the Start button. 


3. Present Tags to the Enrollment Reader one at a time. 


4. Click the Stop button. 


5. Once the Apply button becomes enabled, click Apply. 


 


MMaannuuaall  RReeaadd  MMooddee  


Manual Mode lets you scan a batch of Tags one at a time.  It is useful if an Enrollment Reader is 


not within reach of the Host PC. 


 


1. Select the Manual Mode option. 


2. Present a Tag to the Enrollment Reader. 


3. Click the Read button.  The Tag is read when its number displays in the Tag Code textbox. 


4. Click the Add button. 


5. Repeat steps 1 to 4 for additional Tags. 


6. After you’ve scanned all the Tags, click Apply. 


 


NNoonn--rreeaadd  TTaaggss  MMooddee  


This Mode enables you to add a batch of sequential Tag codes. 


 


1. Select the Non-read Tags option. 


2. In the Tag Start Code textbox, type in the Tag code for the first Tag in the sequence. 


3. In the Tag End Code textbox, type in the Tag code for the last Tag in the sequence. 


4. Once the Apply button becomes enabled, click Apply. 


 


 


Use this feature when enrolling a group of Tags in sequence.  For example where you have 5 Tags, 


(1011, 1012, 1013, 1014 and 1015).  Enter Tag code 1011 into the Tag Start Code textbox and Tag 


code 1015 into the Tag End Code textbox.   
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CCoonnvveerrtt  SSlliimm  TTaaggss  ttoo  AASSCCIIII  TTyyppee  


To convert a batch of Slim Tags to the ASCII Tag type, continue as follows: 


 


First Tag 


1. Select the Apply Conversion to all Tags checkbox. 


2. Select the Manual Read radio button. 


3. Present a Slim Tag to the Enrollment Reader and click the Read button. 


4. From the Tag Type drop-down list, select the Ascii, Biometric, Magstripe option. 


5. When the dialog pops up, select the required option from the following: 


 Accept Full Tag Code 


 Convert Code to Slim Tag Without Customer Code (32 bits) 


 Convert Code to 32 bit Wiegand Without Site Code (24 bits) 


 Convert Code to 26 bit Wiegand Without Site Code (16 bits) 


6. Click the Add button. 


 


Remaining Tags 


1. Select the Batch Mode Auto Read radio button. 


2. Click the Start button.   


3. Present each Tag individually to the Enrollment Reader. 


 


 


At this stage you may present various Tag types to the Enrollment Reader.  The ―Convert Slim Tags to 


ASCII Type‖ change only affects the Slim Tags. 


 


4. Click the Stop button. 


5. Click the Apply button. 


 


Advanced Search 


Where you have not implemented the pagination feature, search for a specific Tagholder as 


follows: 


 


1. In the Navigator Pane, click the  icon. 


2. In the Main Pane, click the  button.  The Select dialog displays. 


 


 
Figure 39 – Select Search Dialog 


 


3. In the Select By field, select the required field from the drop-down list. 


4. From the Middle drop-down, select the required option.  Refer to the section Search 


Operators for more information. 


5. In the Right-hand textbox, capture the search text. 


6. Click the Select button to begin the search. 
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SSeeaarrcchh  OOppeerraattoorrss  


 = means the same as—use = to search for exact matches to your keyword 


 != means not equal to—use != to search for Tagholders that do not match your keyword.  


For example, use != to search for Tagholders that are not in a particular Department 


 LIKE means same first character—use LIKE to search for Tagholders if you are unsure of 


a spelling.  For example, if you know that a Tagholders Last Name is Johnson, but you are 


unsure how to spell it, enter the character J into the keyword textbox.  All Tagholder records 


that have Last Names beginning with a J are returned 


 


AAvvaaiillaabbllee  SSeeaarrcchh  FFiieellddss  


The first drop-down list in the Select Search window contains the following fields: 


 


Field Name Description Search Criteria 


No Tagholder’s unique ID assigned by ImproNet Number 


Title Tagholder’s title.  For example, Mr, Mrs, or Prof. Text 


First Name Tagholder’s first name Text 


Second Name Tagholder’s second or middle name Text 


Last Name Tagholder’s last name Text 


Suffix Tagholder’s name suffix. For example, John Doe Jr Text 


ID Number of Tagholder’s ID Document or Passport Number 


Gender Male or Female M or F 


Pin PIN-code for use with Keypad Terminals Number 


Type Tagholder type, 0 (Employee) or 1 (Visitor) Number 


Current Employee The Tagholder is currently employed, that is 0 (Not 


Current) or 1 (Current) 


Number 


Position Tagholder’s status in the company Text 


Department Tagholder’s department Text 


Employee Number Tagholder’s number assigned by their company Number 


Table 4 – Available Search Fields 
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Device Time Patterns 


A Device Time Pattern (DTP) determines when a device is physically operational.  Create 


Device Time Patterns on the Device Time Pattern screen, and assign them when you set up 


Terminals.  You can also link Device Time Patterns to other functions including the following: 


 


 Time Triggered Actions 


 Inputs 


 Random Search 


 


A Device Time Pattern has the following settings: 


 


 DTP Name—unique name. 


 Start Date—date when DTP starts operating. 


 End Date—date when DTP stops operating. 


 Start Time—time of day when DTP starts operating, configurable on a per day basis. 


 Duration—the length of time when the DTP is active. 


 Day of the Week—the days of the week when the DTP is active. 


 


 
Figure 40 – Editing Device Time Pattern Dialog 
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CCrreeaattee  aa  DDeevviiccee  TTiimmee  PPaatttteerrnn  


To create a new Device Time Pattern, proceed as follows: 


 


1. In the Navigator Pane, click the  icon. 


2. In the Main Pane, click the  button.   


3. Configure the new Device Time Pattern as specified in the Configure Device Time Patterns 


section on page 64. 


 


OOppeenn  aa  DDeevviiccee  TTiimmee  PPaatttteerrnn  


To open a Device Time Pattern, proceed as follows: 


 


1. In the Navigator Pane, click the  icon. 


2. In the Main Pane, select a Time Pattern Name. 


3. Click the  button.   


4. Configure the new Device Time Pattern as specified in the section below, Configure Device 


Time Patterns. 


 


CCoonnffiigguurree  DDeevviiccee  TTiimmee  PPaatttteerrnnss  


To configure the Device Time Patterns, proceed as follows: 


 


1. Create a new Device Time Pattern, or open an existing one. 


2. Enter a Description that describes the Device Time Pattern. 


 


CCoonnffiigguurree  DDaatteess  


If the Device Time Pattern is not required permanently, you can specify a start date and an end 


date.  The default value for Start Date and End Date is Zero Date—this means that the Device 


Time Pattern begins immediately and does not expire.  


 


 Specify a Start Date as follows: 


 


 
Figure 41 – Change Date Dialog 







Part 3 – General Configuration 


January 2012  65 


1. Click the Change button for the Start Date.   


2. Select a Month and a Year using the  and  arrow buttons. 


3. Select a Day by clicking it. 


4. Alternatively, click the Zero Date button to enable the default value. 


5. Click the  button to accept. 


 


Now, Specify an End Date as follows: 


 


1. Click the Change button for the End Date.   


2. Select a Month and a Year using the  and  arrow buttons. 


3. Select a Day by clicking it. 


4. Alternatively, click the Zero Date button to enable the default value. 


5. Click the  button to accept. 


 


CCoonnffiigguurree  TTiimmeess  


Configure operating times as follows: 


 


1. Enter a Start Time—this is the time of day when the Device Time Pattern becomes active. 


2. Enter the Duration in hours and minutes—this is how long after the start time, the Access 


Time Pattern is active. 


 


CCoonnffiigguurree  DDaayyss  


Configure days as follows: 


 


1. Select the days of the week when the Device Time Pattern is enabled. 


2. Click the  button to accept the Device Time Pattern. 


 


MMuullttiippllee  DDeevviiccee  TTiimmee  PPaatttteerrnnss  


You can create up to 128 Device Time Patterns per Site.  Additionally, multiple Terminals can 


share a single Device Time Pattern. 
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Holidays 


Holidays are days or periods when access to a Site is restricted to Administrators.  If the 


Holiday checkbox in an Access Time Pattern is selected, then Tagholders assigned to that 


Access Time Pattern have access to a Site on or during Holidays. 


 


AAdddd,,  EEddiitt,,  oorr  DDeelleettee  aa  HHoolliiddaayy  


To add, edit, or delete a Holiday, proceed as follows: 


 


1. In the Navigator Pane, click the  icon. 


2. In the Main Pane, do one of the following: 


 Click the  button to Add a Holiday. 


 Click the  button to Delete a Holiday. 


 Click the  button to Edit a Holiday. 


 


CCoonnffiigguurree  HHoolliiddaayyss  


 


 
Figure 42 – Add Holiday Dialog 


 


The Add Holidays dialog enables you to select the day or days to specify as a Holiday.  To do 


this, proceed as follows: 


 


1. Enter a Holiday Name. 


2. Enter a Holiday Description. 


3. Select a Month and a Year using the  and  arrow buttons. 


4. Click the Period button to select a period of more than one day. 


5. Select a Day by clicking it.   


6. Click the  button to accept. 
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Time Triggered Actions 


Time Triggered Actions are actions triggered by a Controller at the Start Time of a specified 


Device Time Pattern.  They continue for the duration of the Device Time Pattern.  To specify a 


Time Triggered Action you must assign a Device Time Pattern and an Action. 


 


AAdddd  aa  TTiimmee  TTrriiggggeerreedd  AAccttiioonn  


 
Figure 43 – Create Time Triggered Action Dialog 


 


To add a Time Triggered Action, proceed as follows: 


 


 


Ensure that the information captured below is correct, as you cannot edit this information after capture. 


 


1. In the Navigator Pane, click the  icon. 


2. In the Main Pane, click the  button. 


3. In the Create Time Triggered Action dialog, edit the default Action Name. 


4. Click on the  button alongside the Trigger Time field. 


5. Select and click on a Device Time Pattern record from those displayed. 


6. Click the  button. 


7. Click on the  button alongside the Execute Action field. 


8. Select and click on an Action record from those displayed. 


 


 


After linking one or more Actions to a Time Triggered Action, ensure that you do NOT change the 


Readers Position setting (that is Entry or Exit).  Changing this setting after linking results in an Error 


dialog displaying. 


 


9. Click the  button. 


10. In the Create Time Triggered Action dialog, click the  button. 


 


DDeelleettee  aa  TTiimmee  TTrriiggggeerreedd  AAccttiioonn  


To delete a Time Triggered Action, proceed as follows: 


 


1. In the Navigator Pane, click the  icon. 


2. In the Main Pane, select a Time Triggered Action and click the  button.  


3. Confirm the deletion. 
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Actions 


When a Terminal is assigned to a Location, default Actions are created and linked to default 


Events.  For example, the Normal Allowed In Event is automatically linked to the  


Action Relay Allowed In. 


 


ImproNet Access enables you to create additional Actions and link them to Events.   


 


 


Most Actions are created and configured on the Action tab of the Terminals screen.  Refer to the 


Actions section on page 42 for details. 


 


 


It is possible for Events on one Terminal to activate Actions on other Terminals. 


 


Edit and Delete Actions 


Actions are created when Terminals are assigned to Locations.  Therefore, the Actions screen 


only enables you to edit or delete Actions.   


 


To open the Actions screen, click the  icon in the Navigator Pane. 


 


EEddiitt  aann  AAccttiioonn    


To edit an Action, proceed as follows: 


 


1. In the Main Pane, select an Action row. 


2. Click the  button.   


 


 
Figure 44 – Edit Action Window 


 


3. Edit the Action Name if necessary. 


4. Click the Action Parameters button.  An Action Parameters window corresponding to the 


Action type displays. 


5. Edit the parameters as required. 


6. Click the  button to accept. 


7. In the Edit Action dialog, click the  button to apply the changes. 
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DDeelleettee  AAccttiioonn  


 


 


There is no undo for this procedure.   


Deleting an Action can result in a Terminal or Location functioning incorrectly. 


 


To delete an Action, proceed as follows: 


 


1. In the Main Pane, select an Action row. 


2. Click the  button.  A delete confirmation dialog box displays. 


3. Click Yes. 
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Inputs 


When a Terminal is assigned to a Location, default Inputs Functions are created.  For example,  


if a Terminal has a Request to Exit (RTE) facility, a General Input for the Terminal is created. 


 


The Inputs screen enables you to configure existing Inputs created during Terminal assignment.   


 


 


We recommend using the Inputs tab on the Terminal screen to configure Inputs.  Refer to the Inputs 


section on page 34 for details. 
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Outputs 


When a Terminal is assigned to a Location, default Output Functions are created.  For example, 


an Output function that controls the Terminal’s LED status is created. 


 


The Outputs screen enables you to configure existing Outputs created during Terminal 


assignment.   


 


 


We recommend using the Outputs tab on the Terminal screen to configure Outputs.  Refer to the 


Outputs section on page 41 for details. 


 


 


 


 







Part 3 – General Configuration 


72  January 2012 


Common Zones 


Terminals on different Controllers can be assigned to Common Zones.  However, you must first 


create a Common Zone in the Common Zones screen before it is available in the Terminal 


screen. 


 


Refer to Part 5, Advanced Configuration, for details on Common Zones. 
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Preference Configuration 


The Preferences Dialog features page tabs that let you set the following: 


 


 General Tab—lets you set general configuration settings, including the pagination 


rules observed by the ImproNet Software.  


 Enrollment Tab—select from either Tag Type is Ignored when Validating a Tag or 


Tag Type is Taken into Consideration when Validating a Tag.  By selecting Tag 


Type is Ignored when Validating a Tag, you activate the AnyTag Mode.  In this Mode, 


the ImproNet Software stores the Tag Code and adjusts the Tag Type to Any Tag.   


 


Setting Your Preferences 


From the Main Menu, select File>Preferences. 


 


GGeenneerraall  TTaabb  


1. Select the General tab. 


2. In the Tagholder Max Rows textbox, enter a number in the range of 1 to 99.  The number 


you select is the maximum number of rows displayed when using pagination. 


 


 


Switch off pagination by entering a 0 in the Tagholder Max Rows textbox. 


 


EEnnrroollllmmeenntt  TTaabb  


1. Select the Enrollment tab. 


 


 
Figure 45 – Preference Configuration Dialog – Enrollment Tab Selected 
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In the Tag Type Group selecting Tag Type is Ignored when Validating a Tag (Any Tag), 


activates the AnyTag Mode.  In this Mode, the ImproNet Software stores the Tag Code and not 


the Tag Type.  Pre ImproNet V7.60 Service Pack 3 you enrolled each ImproX (QT) Quad 


Transmitter Tag twice (once for RF and once for the Passive Tag), using AnyTag Mode, you only 


enroll the Tag once.  


  


2. By default, Tag Type is Taken into Consideration when Validating a Tag is selected.  To 


change this setting, select the Tag Type is Ignored when Validating a Tag (Any Tag) 


radio button.   


 


 


Where you select  Tag Type is Taken into Consideration when Validating a Tag, but fail to select a 


Tag type, ImproNet converts existing ―Any Tags‖ to Slim Tags. 


 


In the Tag Code Truncation Options Group set the Tag Code Truncation, in effect, allowing 


enrollment of the Tag using the same truncation rules as applied by the Reader (using DIP-


switch settings) out in the field, as follows: 


 


3. Select a Tag Type for editing and click the Tag Types Truncation button. 


4. From the Tag Format drop-down list, make your selection  from the following:   


 Full Tag Code. 


 Standard 16-bit. 


 Standard 24-bit. 


 Standard 32-bit. 


 26-bit Normal. 


 26-bit Raw. 


 37-bit Normal (UK). 


 37-bit Raw (UK). 


 H10302 37-bit Raw 35-bit Tagcode (US). 


 H10304 37-bit Raw 19-bit Tagcode (US). 


 Custom—in most cases on selection of the Custom option, the Tag Code Masking 


and Drop Zero Bits options activate.  However, for 3
rd


 Party (Other) or HID Tag, 


selecting the Custom option lets you set Site Code Masking allowing you to set a 


custom mask.   


5. Click the  button. 


6. Close the Preference Configuration dialog by clicking the  button. 
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Moving Employees (Tagholders) 


This dialog lets you move employees (Tagholders) from one Site to another, if for example you 


added an employee (Tagholder) to the wrong Site. 


 


 
Figure 46 – Moving Employees Dialog 


 


1. In Access, from the Menu Bar, select Configuration>Moving Employees. 


2. In the Moving Employees dialog: 


a. Select the Site the employees are currently on, from the From Site drop-down list. 


b. Select the Site you want to move the employees to, from the To Site drop-down list. 


3. Select the department you want the employees to join, from the To Department drop-down 


list. 


4. From the From Site table, select the Employees you would like to move. 


 


 


Use Ctrl select or Shift select when selecting multiple employee names. 


 


5. Click on the  button. 


6. Confirm the move. 


 


 


If you selected the Keep Existing Groups checkbox (in the upper left-hand side of the Moving 


Employees dialog), the Moving Tags – Site: dialog will NOT appear.  Instead all existing Tagholder 


Access Groups for the Tags remain. 
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If the employee already had Tags assigned, the Moving Tags – Site: dialog appears.   


 


 
Figure 47 – Moving Tags – Site: Dialog 


 


 


Once you apply your changes to a Tag, the Tag no longer appears on the Tags drop-down list (see 


Figure 47).  With this in mind, make sure of your changes before clicking the  button.    


 


7. From the Tags drop-down list, select the Tag Code. 


8. If the employee has multiple Tags, select the Edit All Tags checkbox. 


 


 


The Edit All Tags checkbox allows you to select groups for each Tag individually instead of assigning 


default groups across all the Tags for that employee. 


 


9. Assign the Groups from the Group1 to Group3 drop-down lists. 


 


 


Ensure that you click the  button for each Tag when selecting groups.  If you scroll to the next 


employee, without applying your changes, the settings are lost.     


 


 


The previous and next buttons allow you to scroll between the various employees you selected for 


moving. 


 


 


The Moving Tags – Site: dialog closes once you’ve edited all the Tags (and employees) selected and 


clicked the  button for your last Tag. 


 


10. When you return to the Moving Employees dialog, click on the  button. 
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Replacing Controllers and Terminals 


 


Keep ImproNet Engine running when you replace a unit. 


 


Replacement of Controllers and Terminals over RS485 


RReeppllaaccee  CCoonnttrroolllleerr  


1. Remove the old Controller from the Controller bus. 


2. Connect the new Controller to the Controller bus. 


3. In Windows®, click Start>Programs>ImproNet>Access. 


 


 
Figure 48 – Replacing the Controller 


 


4. In the Navigator Pane, click the old Controller to select it. 


5. Right-click the Controller and select the Replace Unit option.   


6. From the Unit Type drop-down list, select the new Controllers unit type. 


7. Enter the new Controllers Fixed Address. 


8. Click the  button. 


9. In Engine, click the  button.  


10. Click on the  button. 


11. Click on the  button. 
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RReeppllaaccee  TTeerrmmiinnaall  


 


 


Ensure that the replacement Terminal is of the same type as the original Terminal.     


 


1. Remove the old Terminal from the Terminal bus. 


2. Connect the new Terminal to the Terminal bus. 


3. In Windows®, click Start>Programs>ImproNet>Access. 


4. In the Navigator Pane, click the old Terminal to select it. 


5. Right-click the Terminal and select the Replace Unit option.   


6. Enter the new Terminals Fixed Address. 


7. Click on the  button. 


 


Replacing Controllers and Terminals over Ethernet 


 


 


Settings for the replacement (NEW) hardware MUST remain as recorded from the OLD hardware.   


 


1. Remove the old Controller or Terminal from the network. 


2. Connect the new Controller or Terminal to the network. 


3. In Windows®, go to Start>Programs>ImproNet>Utils>Ethernet Discovery Utility. 


4. On the menu bar, go to Action>Search Local Subnet. 


5. If the Discovery Utility fails to find any Devices, at the Device Not Found dialog, click the 


OK button. 


6. On the menu bar, go to Action>Advanced Local Search. 


7. At the Select Network Interface dialog, select the relevant Network Interface, if more than 


one displays. 


8. Click the  button. 


9. In the Enter Subnet Mask dialog, enter the Subnet Mask for your network. 


10. Click the  button. 


11. Wait for the Controllers and Terminals to display. 


 


IIPP  CCoonnffiigguurraattiioonn  


1. In the Discovery Utility window, select the Controller or Terminal for configuration. 


2. On the menu bar, go to Action>Configure IP. 


3. In the Device Password dialog, enter your password. The Controller’s default password is 


impro and the Terminal’s default password is masterkey.   


4. Click on the  button. 


 


SSuubbnneett  AAssssiiggnnmmeenntt  


Assign the Controller or Terminal to EITHER a local or non-local Subnet as follows: 


 


Assignment to a Local Subnet 


 


 


If you assign an invalid IP Address, the Controller or Terminal may no longer be able to 


communicate.   
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In this case restore factory defaults (Refer to the Hardware Installation Manual for more 


information). 


 


1. In the Device IP Address textbox, enter a Device IP Address. 


2. Tick the checkbox to set the IP Address to static. 


3. In the Gateway IP Address textbox, enter a Gateway IP Address.   


4. Tick the checkbox to set the Gateway IP Address to static. 


5. Continue with ONE of the procedures Subnet Mask or Subnet Host Bits: 


 


Subnet Mask 


1. Select the Subnet Mask radio button. 


2. In the textbox, alongside, enter the Subnet’s Address.   


3. Tick the checkbox to set the Subnet Mask to static. 


 


Subnet Host Bits 


1. Select the Subnet Host Bits radio button. 


2. Enter the number of bits in the textbox. 


 


6. Enter a Device Name.  Use the same site prefix to name devices belonging to the 


same site.  Example: ―Site 1 – Factory‖, ―Site 1 – Testing‖. 


7. Ensure the Force Update checkbox is UNCHECKED.  If the Force Update checkbox 


remains UNCHECKED, the Controller or Terminal tries to change the IP address and 


test communication on the new address.  If successful, the update becomes final; 


otherwise, the Controller or Terminal reverts to its old settings.  Changes to the IP 


Configuration result in the Controller or Terminal rebooting on acceptance of the 


change.  The Configuration Settings dialog remains open during this time, allowing the 


Controller or Terminal to reboot. On closure of the Configuration Settings dialog, the 


Discovery Application again searches for the Controller or Terminal and if successful, 


displays the updated Controller or Terminal details. 


8. Click the Update button. 


 


Assignment to a Non-local Subnet 


Only perform this action if you want to assign the Controller or Terminal to a non-local subnet.  


After performing the step, the Discovery Utility will NOT detect the Controller or Terminal on the 


local subnet.  Therefore ensure that you assign the Logical Address BEFORE changing the IP 


Address.  Finally physically move the Controller or Terminal to the required location.  To change 


an IP Address to an IP Address outside the local subnet, continue as follows: 


 


1. In the Device IP Address textbox, enter a Device IP Address. 


2. Tick the checkbox to set the IP Address to static. 


3. In the Gateway IP Address textbox, enter a Gateway IP Address.   


4. Tick the checkbox to set the Gateway IP Address to static. 


5. Select the Subnet Mask radio button. 


6. In the textbox, alongside, enter the Subnet’s Address.   


7. Tick the checkbox to set the Subnet Mask to static. 


8. Tick the Force Update checkbox (the Controller or Terminal adopts the new settings 


regardless). 


9. Click the Update button. 
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CCoonnffiigguurraattiioonn  ooff  tthhee  PPoorrtt  NNuummbbeerr  aanndd  MMeemmoorryy  SSiizzee  


1. Select the Controller or Terminal for configuration. 


 


 


All Controllers on the same site MUST have the same Memory Size Configuration. 


 


2. On the menu bar, go to Configuration>Set Configuration. 


3. In the Device Password dialog, enter your password. The Controller’s default password is 


impro and the Terminal’s default password is masterkey.   


4. Click on the  button. 


5. In the Engine Listener Port textbox, change the Port Number (Controller listens to 


Engine on this Port).  The default Port Number is 10002.  Only change the default Port 


Number, if it clashes with other devices or services on your network. 


6. In the Terminal Listener Port textbox, change the Port Number (Controller listens to 


Terminals on this Port).  The default Port Number is 10008.  Again, only change the default 


Port Number, if it clashes with other devices or services on your network. 


7. If necessary when setting the Configuration for a Controller, in the Memory Size textbox, 


change the Memory Size Configuration. The default Memory Size Configuration is       


100 000 Tags and  1 000 000 Transactions.   


 


 


Enable Safe IP only AFTER configuring and setting up the whole system.  Once you set Safe IP 


you can only change or query the Logical Address using the Discovery Utility on the Engine PC.    


 


8. Select the Safe IP check-box. 


9. Click the  button to confirm. 


10. Wait while the Controller re-boots (about 15 seconds). 


 


GGrroouuppiinngg  CCoonnttrroolllleerrss  aanndd  TTeerrmmiinnaallss  


 


 


It is unnecessary to give a group name to a Controller if it has no IP Terminals. 


 


1. Select the Controller and the Terminals it should control. 


2. On the menu bar, go to Configuration>Add to Group. 


3. In the Enter Group Name dialog, enter a suitable group name. 


4. In the Device Password dialog, enter your password. The Controller’s default password is 


impro and the Terminal’s default password is masterkey.   


5. Click on the  button. 


6. Click the  button.  


 


 


Alternatively add Terminals to Existing Controller Groups as follows: 


 


1. Select the Terminal(s) to be added to the Group. 


2. On the menu bar, go to Configuration>Add to Group.  


3. In the Select the Group Name dialog, double-click on your chosen group name row. 


4. In the Device Password dialog, enter your password. The Controller’s default password is 


impro and the Terminal’s default password is masterkey.   
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5. Click on the  button. 


6. Click the  button. 


 


HHaarrddwwaarree  EExxcchhaannggee  


In Windows®, click Start>Programs>ImproNet>Access. 


 


Replace Controller 


1. In the Navigator Pane, click the old Controller to select it. 


2. Right-click the Controller and select the Replace Unit option.   


3. From the Unit Type drop-down list, select the new Controllers unit type. 


4. Enter the new Controllers Fixed Address. 


5. Click the  button. 


 


Replace Terminal 


 


 


Ensure that the replacement Terminal is of the same type as the original Terminal.     


 


1. In the Navigator Pane, click the old Terminal to select it. 


2. Right-click the Terminal and select the Replace Unit option.   


3. Enter the new Terminals Fixed Address. 


4. Click on the  button. 
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Database Maintenance 


Firebird General 


GGeenneerraall  


Firebird is a powerful, compact client or server SQL relational database management system 


offering many ANSI SQL standard features and can run on various server and client operating 


systems.  Firebirds officially supported platforms are Windows and Linux.  Firebird will, 


however, also run on operating systems, such as FreeBSD and Apple Macintosh OS/X.  


Firebird offers excellent concurrency, high performance, and powerful language support for 


stored procedures and triggers. 


 


Firebird features a higher level of SQL standards compliance than most other industrial-strength 


client or server database management systems on the market today.  Firebird also carries out 


some powerful language features in the vendor-specific sphere of procedure programming. 


 


Firebird 1.5 is a full-featured SQL database engine.  Firebird is powerful, yet lightweight, with 


the smallest possible configuration and administration needs.  It's easily scalable from single-


user, single-database use up to company-wide enterprise purposes.  A single Firebird server 


can handle multiple independent databases, each with multiple client connections.  And best of 


all: it’s true Open Source, thus free of any license fees even for commercial use. 


 


We publish all our Software with the Firebird Database as our standard offering. The ImproNet 


Software suite also offers support for Windows SQL Server 2000 and 2005.  The purpose of this 


document is to aid you in running Systems on the Firebird Database.  Administrators running 


Systems on the Windows SQL Server must have the right training for the administration of 


those Databases. 


 


This section will address the following topics: 


 


 Firebird Utilities 


 Database Backups 


 Database Restore 


 Database corruption 


 General Impro Database maintenance 


 


SSuuggggeesstteedd  MMaaiinntteennaannccee  SScchheedduullee  


We recommend regular database maintenance.  The schedule of maintenance depends on how 


critical transactions are to the organisation, the size of the database, as well as the number of 


transactions written to the database daily.  An organisation that uses the transactions for export 


to payroll may choose to make daily backups of the database.  Whereas the small office with 20 


employees may choose perform a backup once a month or even every 2 to 3 months. 


Irrespective of the above factors, carry out the following for database maintenance: 


 







Part 3 – General Configuration 


January 2012  83 


1. Perform regular backups using the tools and techniques described under the section 


Database Backups. 


2. Perform regular test restores on the backup files, using the tools and techniques described 


under the section Database Restore. 


3. At regular intervals, take the working database off-line and carry out a Backup and restore.  


This ensures that the working database does not contain any corrupt data or tables. Refer 


to the section Recovering a Corrupt Database for more information. 


 


Following these steps will not guarantee the Database will not corrupt in time, but they will 


ensure the odds of corruption occurring are greatly minimised and the least possible 


subsequent data loss. 


 


Figure 49 below shows an example of a monthly maintenance schedule:  This organisation 


needs daily backups as data is critical. 


 


 
Figure 49 – Example of a Monthly Maintenance Schedule 


 


In the event the Database does not restore on the 25
th
, you have 2 choices: 


 


1. Try and recover the Database using the steps described in the section Recovering a 


Corrupt Database, or 


2. Resort to the previous day’s backup and restore that file. 


 


Firebird Utilities 


There are many Database Management Utilities available for maintaining Firebird Databases.  


Many of these are open source utilities and are available at www.firebirdsql.org.  These utilities 


include IBEasy
 
(Freeware), IBExpert (commercial and open source personal editions), 



http://www.firebirdsql.org/
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IBFirstAid (commercial) and IBConsole (open source).  We ship IBConsole as the Database 


Management Utility. 


 


AAnn  IInnttrroodduuccttiioonn  ttoo  IIBBCCoonnssoollee  


IBConsole is a relational database management utility allowing connection to and administration 


of multiple Firebird Servers and Databases.  The entire functionality of IBConsole is beyond the 


scope of this document; however administrators of Impro Access Control Databases may find 


the following roles within IBConsole useful: 


 


 Database maintenance in the form of database sweeps and checking for errors. 


 Backup and Restores of the database. 


 Review of the database structure, allows addition of extra tables for third-party 


integration. 


 


The first step in connecting to an Impro Database is registering the Database Server.  The 


following examples refer to the default Database impronet.fdb used by the ImproNet Software 


suite.  The default locations for the Databases and the IBConsole Utility varies dependant on 


the Access Control System used. 


 


Start the IBConsole Software 


In Windows®, go to Start>Programs>ImproNet>Utils>IBConsole. 


 


Register the Server 


 


 


You need only perform these steps once.  After registration, the settings remain and you are only 


required to login to the Server. 


 


 
Figure 50 – Register Server and Connect Dialog 


 


1. From the Server drop-down menu, select the Register choice. 


2. In the Register Server and Connect dialog, click the Remote Server radio button. 
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3. In the Server Name textbox, assign the Server a name.  In this example, we used 


LOCALHOST. 


 


 


Rather than assigning the Server a name in the Server Name textbox, you may use the PC’s IP 


Address. 


 


4. In the Network Protocol textbox, select TCP/IP from the drop-down list. 


5. In the Alias Name textbox, assign a meaningful name. 


6. Leave the remaining fields unchanged. 


7. Click the OK button. 


 


Login to the InterBase Server 


1. From the Hierarchical Tree, select your InterBase Server (based on the example in Figure 


50 select Local Server). 


2. From the Server drop-down menu, select the Login choice. 


3. In the Server Login dialog, enter the Username and Password. 


 


 


The default username is SYSDBA.  The default password is masterkey. 


 


4. Click the Login button. 


 


Register the Database 


 
Figure 51 – Register Database and Connect Dialog 


 


1. From the Database drop-down menu, select the Register choice. 


2. In the Register Database and Connect dialog, In the Database textbox, enter the full file 


path to your Database (see Figure 51). 
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3. Click your mouse pointer in the File textbox, the Database’s file name automatically 


appears. 


4. Leave the remaining fields unchanged. 


5. Click the OK button. 


 


 


The default Database path for the ImproNet Software suite is:  C:\ImproNet\databse\impronet.fdb. 


 


6. In the Hierarchical Tree, double-click on the Impronet.fdb file, starting the Database. 


 


Database Backups 


Administrators of Impro Access Control Systems have various options for making a backup of 


their Access Control Database.  The simplest option employed, is copying the Database.  


 


 


Copying the Database simply copies the Database irrespective of whether there is corruption of the 


Database or not. 


 


 


Before making a copy of the Database ensure that you shut down the Access Control Software.   


 


The preferred method of making a backup is to use the built in (automatic) backup features in 


the ImproNet Software.  


 


SScchheedduulliinngg  tthhee  bbaacckkuupp  ooff  aann  IImmpprrooNNeett  DDaattaabbaassee  


1. In Windows®, go to Start>Programs>ImproNet>Engine. 


2. From the Configuration drop-down menu, select Backup. 


 


 
Figure 52 – Backup Dialog 
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3. In the Backup dialog, alongside the Backup Path textbox, click on the  button. 


 


 


The backup path automatically defaults to the local workstation.  For storage purposes, ensure that you 


change this backup path to a remote server.  Engine does not allow the use of spaces within the 


backup path. 


 


4. In the Number of Backups to keep in Backup Folder textbox, enter a suitable number. 


5. From the Schedule group specify the days and times you wish to perform the backups. 


6. Click on the  button. 


 


 


Ensure that you schedule the backups when Engine is open and running. 


 


7. Shutdown and restart the Engine module for the changes to take effect. 


 


During the backup procedure, the backup utility takes a snapshot of the working database, the 


snapshots compacted and a new file created.  The resulting backup file has an fbk file 


extension.   


 


 


Note, a backup does not guarantee that your ImproNet Database is free from corruption.  Ensure that 


you carry out regular database maintenance, thus ensuring that your ImproNet Database is not corrupt. 


 


For unscheduled backups use either of the following choices: 


 


 Backup the ImproNet Database using IBConsole. 


 Backup the ImproNet Database using a Batch File. 


 


BBaacckkuupp  tthhee  IImmpprrooNNeett  DDaattaabbaassee  uussiinngg  IIBBCCoonnssoollee  


1. In Windows®, go to Start>Programs>ImproNet>Utils>IBConsole. 


2. From the Database drop-down menu, select Maintenance>Backup / Restore>Backup. 


 


 
Figure 53 – Database Backup Dialog 
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3. In the Database group, from the Alias drop-down list, select the Database for backup. 


4. In the Backup File(s) group, in the Alias textbox, provide a name for the backed up 


Database. 


 


 


Ensure that your backed up file has an FBK file extension. 


 


5. In the Backup File(s) group, in the Filename(s) textbox, provide the directory path and file 


name for the backup Database.  We suggest C:\ImproNet\Database\ImproNet.fbk. 


6. Leave the remaining values as they are. 


7. Click on the OK button. 


8. In the Information dialog, click on the OK button. 


9. Close the Database Backup dialog. 


 


BBaacckkuupp  tthhee  IImmpprrooNNeett  DDaattaabbaassee  UUssiinngg  aa  BBaattcchh  FFiillee  


Create the ―.bat‖ File 


1. Capture the following text into a text file (for example Notepad). 


 


 
Figure 54 – Backup Using a Batch File 


 


 


Settings explained: 


 


 @SET ISC_USER=SYSDBA—this sets the user name as SYSDBA, thus ensuring the backup 


utility connects to the Database. 


 @SET ISC_PASSWORD=MASTERKEY—this sets password.  If you changed the default 


password, ensure that you use the new password. 


 @SET PATH=%PATH%;C:\Program Files\Firebird\Firebird_1_5\bin—indicates the path to 


the GBAK backup utility.  If the GBAK backup utility does not appear in this directory, set the 


path accordingly. 


 gfix -m -f impronet.fdb—repairs minor database corruption. 


 gbak -b -g -v -z impronet.fdb impronet.fbk—creates the backup file impronet.fbk.  To 


change the name of the target database, simply change the impronet.fbk file to another name, 


keeping the fbk file extension. 


 


2. Save the text file as a ―.bat‖ file. 
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Run the ―.bat‖ Batch File 


1. In Windows®, click Start>Programs>Accessories>Run. 


2. In the Run dialog, click on the Browse button. 


3. In the Browse dialog, select the ―.bat‖ file you created. 


4. Click on the Open button. 


5. In the Run dialog, click on the OK button. 


6. Follow the on-screen prompts. 


 


 


This backup process may take some time on large Databases.  Once the backups complete, ensure 


that you copy the resulting backup file to a different PC or on to removable media for storage. 


 


Database Restore 


Perform a Database restoration for the following reasons: 


 


 Your original ImproNet Database becomes corrupt. 


 Your PCs hard drive is damaged for any reason. 


 To ensure that Database backups are not corrupt, a successful restoration suggests a 


sound Database. 


 


RReessttoorriinngg  tthhee  IImmpprrooNNeett  DDaattaabbaassee  UUssiinngg  IIBBCCoonnssoollee  


Disconnect from the Database 


1. In Windows®, go to Start>Programs>ImproNet>Utils>IBConsole. 


2. From the Hierarchical Tree, click on the Impronet.fdb file. 


3. From the Database drop-down menu, select Maintenance>Shutdown. 


 


Restore the Backup 


1. In IBConsole, from the Database drop-down menu, select Maintenance>Backup / 


Restore>Restore. 


 


 
Figure 55 – Database Restore Dialog 
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2. In the Backup File(s) group, in the Alias textbox, select the name of the backed up 


Database.   


 


If IBConsole does not auto complete the remaining fields continue as follows, otherwise 


continue with point 4: 


 In the Backup File(s) group, in the Filename(s) textbox, provide the directory path and 


file name for the backup database.  We suggest C:\ImproNet\Database\ImproNet.fbk. 


 In the Database group, from the Server drop-down list, select the server in which the 


Database will remain. 


 In the Database group, from the Alias drop-down list, select the Database to restore 


to. 


 In the Database group, in the Filename(s) textbox, provide the directory path and file 


name for the restored Database.  We suggest C:\ImproNet\Database\ImproNet.fdb. 


 


3. From the Options group, select the Overwrite record. 


4. From the Overwrite drop-down list, select True. 


5. Click on the OK button. 


6. Close the Database Restore dialog when you see the comment ―Service Ended‖. 


 


Reconnect to the Database 


1. In IBConsole, from the Hierarchical Tree, click on the Impronet.fdb file. 


2. From the Database drop-down menu, select Maintenance>Restart. 


 


RReessttoorriinngg  tthhee  IImmpprrooNNeett  DDaattaabbaassee  UUssiinngg  aa  BBaattcchh  FFiillee  


Create the ―.bat‖ File 


1. Capture the following text into a text file (for example Notepad). 


 


 
Figure 56 – Restore Using a Batch File 


 


 


Settings explained: 


 


 @SET ISC_USER=SYSDBA—this sets the user name as SYSDBA, thus ensuring the backup 


utility connects to the Database. 


 @SET ISC_PASSWORD=MASTERKEY—this sets the password, if you changed the default 


password, ensure that you use the new password. 
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 @SET PATH=%PATH%;C:\Program Files\Firebird\Firebird_1_5\bin—indicates the path to 


the GBAK backup utility.  If the GBAK backup utility does not appear in this directory, set the 


path accordingly. 


 gbak -p 8192 –c -v impronet.fbk impronetNEW.fdb—restores the impronet.fbk file to the 


name of impronetNEW.fdb. 


 


2. Save the text file as a ―restore.bat‖. 


 


Run the ―restore.bat‖ File 


1. In Windows®, click Start>Programs>Accessories>Run. 


2. In the Run dialog, click on the Browse button. 


3. In the Browse dialog, select the ―.bat‖ file you created. 


4. Click on the Open button. 


5. In the Run dialog, click on the OK button. 


6. Follow the on-screen prompts. 


 


 


This restore process may take some time on large Databases.  This process restores the new 


Database to the same directory as where the batch file ran from.  Once the restore process is 


complete, close all applications connected to the original Database.  Rename the existing Database as 


impronetOLD.fdb and rename the impronetNEW.fdb Database to impronet.fdb. 


 


Database Corruption 


 


 


Lessen data loss if Database corruption occurs, by making regular Database back-ups.  It is essential 


that these regular backups are made and kept on removable media, or on a networked drive. Storing 


backups on the local disk will not prevent data loss if the hard drive fails. 


 


A Corrupt Database does not always mean a loss of data.  Usually, you can recover the 


Database using a combination of the tools described earlier, as well as the Pump Utility shipped 


with ImproNet.   


 


There are various indicators of a corrupt Database: 


 


 The Software may not start up. 


 The Engine may hang or not upload transactions. 


 


CCaauusseess  ooff  DDaattaabbaassee  CCoorrrruuppttiioonn::  


Database corruption can result from various causes beyond the scope of this document, the list 


below outlines the common causes of database corruption: 


 


1. Abnormal or incorrect shutdown of the server, especially during power failures.  Ensure 


that the server has a working uninterrupted power supply. 


2. Server defects and hardware faults, especially with hard disk drives, disk controllers, 


main memory of the PC and cache memory of raid controllers. 


3. Copying the Database while the servers running.  


4. Hard disk drive or Operating System corruption. 


5. Poor Database design by third-party integrators. 
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6. Sharing the Database folder (allowing access over the network) is a security risk, and 


increases the chance of database corruption.   Firebird cannot tolerate other applications 


locking sectors of the Database file.   


 DO NOT use Windows Explorer (or command line 'Copy' or 'Xcopy') when copying the 


Database file on a live Database.  In practice, these utilities may lock the sector they’re 


copying.  So merely copying the impronet.fdb file with Windows Explorer is enough to 


corrupt the Database. 


 DO NOT use any arbitrary backup tool or archiving tool to make a backup copy of the 


Database.  The only safe way to make a backup copy of the Database is to use the 


backup facility we provided with ImproNet, or use Firebird's GBAK tool.  This creates a 


'.gbk' or '.fbk' backup file, suitable for safe copying after finishing the backup process.  


Alternatively, the Firebird Server on the server must be stopped to copy the '.fdb' file, 


and it must be restarted afterwards. 


7. Check for other processes trying to read the Database file. These are typically Virus 


and Spy-ware scanners, common on corporate PC's.  


8. The bigger the size of the Database file, the more likely is it to become corrupt because 


of one of the reasons mentioned above. 


 


If you suspect your ImproNet Database is corrupt, carry out an immediate backup and restore 


on the Database. 


 


CChheecckkiinngg,,  RReeppaaiirriinngg  aanndd  RReeccoovveerriinngg  ffrroomm  MMiinnoorr  DDaattaabbaassee  CCoorrrruuppttiioonn  


Follow these steps when checking, repairing and recovering from minor corruption: 


 


 


Carry out these steps regularly, for example every 2 or 3 months. 


 


1. Close all applications connected to the Database. 


2. Copy the Database to a separate directory. 


3. In the same directory, capture the following text into a text file (for example Notepad). 


 


 
Figure 57 – ―repair.bat‖ Batch File 


 


4. Save the file as ―repair.bat‖. 
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Run the ―repair.bat‖ File 


1. In Windows®, click Start>Programs>Accessories>Run. 


2. In the Run dialog, click on the Browse button. 


3. In the Browse dialog, select the ―.bat‖ file you created. 


4. Click on the Open button. 


5. In the Run dialog, click on the OK button. 


6. Follow the on-screen prompts. 


 


 


This process mends and backs-up the Database to the same directory as where the batch file ran from.  


Once complete, the restore process runs resulting in an impronetNEW.fdb Database file.  If successful, 


you may use the restored Database as a direct replacement for the existing Database.   


 


Run the Database Pump Utility 


The Pump Utility lets you flush out and correct a ―muddled‖ or overloaded Database.  When 


executed, the Pump takes all the Tagholders, Visitors and Transaction data and pumps this into 


a fresh Database.   


 


 


Before using the Pump Utility, ensure that you close all other applications. For large Databases carry 


out the Pump action over a quiet period, as completion could take many hours. 


 


1. In Windows®, go to Start>Programs>ImproNet>Utils>Pump. 


2. Enter your Username and Password (The default username is SYSDBA and the default 


password is masterkey). 


3. Click on the OK button. 


4. In the Pump Database dialog, click the Start button. 


 


 
Figure 58 – Logon to Database Dialog 


 


5. In the Message dialog, click the OK button. 


 


AAnn  IInnttrroodduuccttiioonn  ttoo  IIBBFFiirrssttAAIIDD  


For Firebird Database corruption that you cannot correct with GFIX, you may buy advanced 


Firebird database recovery tools from the IB Surgeon web site.   


 


Accessing the IB Surgeon Web Site 


1. Open your chosen Internet browser.  


2. In the Address bar, type in the URL:  http://www.ib-aid.com/. 



http://www.ib-aid.com/
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3. On the Home page, select the Products tab. 


4. From the Recovery or Optimization Products group, click on the IBFirstAID link. 


 


From here you may read up on the Software, or buy a copy for use. 


 


Archiving Transactions 


The maximum recommended Database size for ImproNet is 2 GB. 


 


To keep your Database, below this limit, we recommend that you archive transactions using the 


ImproNet’s Archive Utility. 


 


This Archive action has two major benefits: 


 


 Manages the size of the Database, freeing up space on the PC 


 Keeps a cleaner, uncluttered Database 


 


For full details on using the Archive Utility go to Part 8–Utilities. 


 


Archiving Tagholders 


The Archive Tagholders choice lets you archive Employee and Visitor Tagholder and 


transaction information.    


 


To do this, continue as follows: 


 


AArrcchhiivvee  EEmmppllooyyeeee  TTaagghhoollddeerrss  


1. In Access, from the Menu Bar, select Configuration. 


2. Click on the Maintenance menu choice. 


3. Select the Archive Tagholders radio button. 


4. Click the  button to accept. 


 


 
Figure 59 – Archive Master Records Dialog 
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5. In the Archive Master Records dialog, select the Employee tab. 


6. Select either a single Tagholder or multiple Tagholders from the list of displayed records. 


7. Click the Archive button. 


 


 


The same steps apply when you archive Visitor Tagholders, however, instead of selecting the 


Employee tab, select the Visitor tab. 


 


IImmppoorrtt  EEmmppllooyyeeee  TTaagghhoollddeerrss  


1. From the Menu Bar, select Configuration. 


2. Click on the Maintenance menu choice. 


3. Select the Archive Tagholders radio button. 


4. Click the  button to accept. 


5. In the Archive Master Records dialog, select the Employee tab. 


6. Click the Import button. 


7. In the Please Select a Tagholder Archive dialog, double-click on the Archive folder. 


8. Double-click the Tagholders folder. 


9. Select the Tagholder for importing. 


10. Click the Open button. 


 


 
Figure 60 – Import Transactions Dialog 


 


11. In the Import Transactions dialog, confirm whether to import the Tagholders transactions, 


click either the Yes or No button.  


 


 


The same steps apply when you import Visitor Tagholders, however, instead of selecting the 


Employee tab, select the Visitor tab. 
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Events and Actions 


Many of the Events referred to in the text have multiple value possibilities.  Not every Event is 


repeated below, as it would entail printing a repeated increasing value for such events.  


Therefore, the first of the series has the value limits stated such as ―Door open too long 1 to 16‖.  


This means there are in fact, 16 different events available. 


 


Event Statement Event Description 


EV_Allowed_Exceptional_In Tagholder allowed IN. 


EV_Allowed_Exceptional_Out Tagholder allowed OUT. 


EV_Allowed_Normal_In Tagholder allowed IN. 


EV_Allowed_Normal_Out Tagholder allowed OUT. 


EV_Allowed_Normal_On Manually added clocking added by T&A systems. 


EV_Allowed_Normal_Off Manually added clocking added by T&A systems. 


EV_Allowed_Keyboard_Clock_On Manually added clocking added by T&A systems. 


EV_Allowed_Keyboard_Clock_Off Manually added clocking added by T&A systems. 


EV_Allowed_Keyboard_Allowed_In Manually added clocking added by T&A systems. 


EV_Allowed_Keyboard_Allowed_Out Manually added clocking added by T&A systems. 


EV_Allowed_APB_Override_In Allowed APB Override IN, if Ignore APB until 


Future Date is set on the Controller. 


EV_Allowed_APB_Override_Out Allowed APB Override OUT, if Ignore APB until 


Future Date is set on the Controller. 


EV_Allowed_APB_Violation_Out Allowed APB Violation OUT, if the zones been set 


to relaxed APB. 


EV_Allowed_Time_or_Day_Violation_Out Allowed Time or Day Violation OUT, while the 


Tagholders in a zone and the ATP ends. 


EV_Allowed_Visitor_In Visitor allowed IN. 


EV_Allowed_Visitor_Out Visitor allowed OUT. 


EV_Allowed_Duress_In Tagholders allowed entry by pressing a duress 


code after presenting a Tag.  


EV_Allowed_Duress_Out Tagholders allowed exit by pressing a duress 


code after presenting a Tag. 


EV_Authentication_Failure Tag not authenticated by the Controller. 


EV_Counter1_Threshold_In Counter reached threshold IN level. 


EV_Counter1_Threshold_Out Counter reached threshold OUT level. 


EV_Counter2_Threshold_In Counter reached threshold IN level. 


EV_Counter2_Threshold_Out Counter reached threshold OUT level. 


EV_Counter3_Threshold_In Counter reached threshold IN level. 


EV_Counter3_Threshold_Out Counter reached threshold OUT level. 


EV_Counter1_Has_Zeroed_In Counter reached zero IN level. 


 







Part 3 – General Configuration 


January 2012  97 


Event Statement Event Description 


EV_Counter1_Has_Zeroed_Out Counter reached zero OUT level. 


EV_Counter2_Has_Zeroed_In Counter reached zero IN level. 


EV_Counter2_Has_Zeroed_Out Counter reached zero OUT level. 


EV_Counter3_Has_Zeroed_In Counter reached zero IN level. 


EV_Counter3_Has_Zeroed_Out Counter reached zero OUT level. 


EV_Counter1_Is_Zeroed_In Counter is zero IN level. 


EV_Counter1_Is_Zeroed_Out Counter is zero OUT level. 


EV_Counter2_Is_Zeroed_In Counter is zero IN level. 


EV_Counter2_Is_Zeroed_Out Counter is zero OUT level. 


EV_Counter3_Is_Zeroed_In Counter is zero IN level. 


EV_Counter3_Is_Zeroed_Out Counter is zero OUT level. 


EV_Denied_APB_In Denied Access IN, APB active, no access with 
Tag. 


EV_Denied_APB_Out Denied Access OUT, APB Active, Tag already 
used. 


EV_Denied_Interleading_Zone_Routing_In Denied Access IN, Tag requires Zone route 
sequence to be followed. 


EV_Denied_Location_In Denied Location IN, Tagholder does not have 
access to that specific location. 


EV_Denied_Location_Out Denied Location OUT, Tagholder cannot exit from 
that specific location. 


EV_Denied_No_Supervisor_In Denied No Supervisor IN, Supervisor Unlock, 
Tagholder denied because there is no supervisor 
in the zone. 


EV_Denied_Last_Supervisor_Out Denied Last Supervisor OUT, No supervisor to 
validate exit. 


EV_Denied_Tag_Blacklisted_In Denied IN, Tag blacklisted. 


EV_Denied_Tag_Blacklisted_Out Denied OUT, Tag blacklisted. 


EV_Denied_Tag_Suspended_In Denied IN, Tag suspended. 


EV_Denied_Tag_Suspended_Out Denied OUT, Tag suspended. 


EV_Denied_Tag_Expired_In Denied IN, Tag expired 


EV_Denied_Tag_Expired_Out Denied OUT, Tag expired 


EV_Denied_Time_or_Day_In Denied IN, Tagholder out of range of their Access 
Time Pattern for their Access Group. 


EV_Denied_Time_or_Day_Out Denied OUT, Tagholder out of range of their 
Access Time Pattern for their Access Group. 


EV_Denied_Zone_Count_Exceeded_In Tagholder denied access if the zone is at its 
maximum capacity of Tagholders. Initiate Zone 
count first. 


EV_Denied_Site_In Tagholder does not have access to this site. 


EV_Denied_Site_Out Tagholder does not have permission to exit this 
site.  


EV_Denied_External_In Reserved for R/W, not currently used.  


EV_Denied_External_Out Reserved for R/W, not currently used.  


EV_Denied_No_Host_for_Visitor_In Denied entry because Host has not entered first.  


EV_Denied_No_Host_for_Visitor_Out Denied exit because Host has not entered first.  
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Event Statement Event Description 


EV_Denied_Multiple_Tags_Req_In More than one Tag is required for access.  


EV_Denied_Multiple_Tags_Req_Out  More than one Tag is required for access.  


EV_Denied_Unknown_Tag_In Denied IN, unrecognised Tag, this Tag does not 
exist in the Database. 


EV_Denied_Unknown_Tag_Out Denied OUT, unrecognised Tag, this Tag does not 
exist in the Database. 


EV_Denied_Location_Locked_In Denied IN, Entry unit locked. 


EV_Denied_Location_Locked_Out Denied Out, Exit unit locked. 


EV_Denied_Location_No_Tag_Time_In Reserved for R/W, not currently used. 


EV_Denied_Location_No_Tag_Time_Out Reserved for R/W, not currently used. 


EV_Denied_Inhibited_by_Input_In The event is raised when an input is configured to 
block a scanner, and a Tag is presented at the 
Reader. The input may for example be connected 
to a vehicle detector embedded into the road. 


EV_Denied_Inhibited_by_Input_Out The event is raised when an input is configured to 
block a scanner, and a Tag is presented at the 
Reader. The input may for example be connected 
to a vehicle detector embedded into the road. 


EV_Denied_Unknown_In Random Tagholder denied access. 


EV_Denied_Unknown_Out Random Tagholder denied access. 


EV_Denied_Pin_In Tagholder denied entry, incorrect PIN-code 
entered on the keypad. 


EV_Denied_Pin_Out Tagholder denied entry, incorrect PIN-code 
entered on the keypad. 


EV_Denied_Wrong_Routing_In Tagholder has not followed routing sequence. 


EV_Denied_Wrong_Routing_Out Tagholder has not followed routing sequence. 


EV_Biometric_Allowed_In For use in third-party validation. 


EV_Biometric_Allowed_Out For use in third-party validation. 


EV_Biometric_Denied_In For use in third-party validation. 


EV_Biometric_Denied_Out For use in third-party validation. 


EV_Single_Key_Pressed Single Key Pressed, reserved – not currently 
used. 


EV_Dual_Key_Pressed Dual Key Pressed, reserved – not currently used.  


EV_Special_Key_Code_1 Raised when a Terminal specific PIN-codes been 
typed in. Each Terminal can have two PIN-codes. 


EV_Special_Key_Code_2 Raised when a Terminal specific PIN-codes been 
typed in. Each Terminal can have two PIN-codes. 


EV_Anti_Tamper A units being tampered with. 


EV_Terminal_Timeout A Terminals off-line. 


EV_Host_Timeout Hosts off-line. 


EV_Unit_Power_up Units received power. 


EV_RTE_1-16 Request To Enter 1-16, Button pressed 
requesting access. 


EV_DOS_Door_Forced_1-16 Door Open Sensor, Door Forced 1-16. 


EV_DOS_Door_Open_Too_Long_1-16 Door Open Too Long 1-16. 


EV_DOS_Door_Open_Normal_1-16 Door Open Normally 1-16. 
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Event Statement Event Description 


EV_DOS_Door_Not_Opened_1-16 Door Not Opened 1-16. 


EV_Input_Alarm_1-16 Input Alarm 1-16. 


EV_Raised_Event_1-16 Raised Event 1-16. 


EV_Zone_Count_Is_Zero_1-64 Zone 1-64: Count is Zero. 


EV_Zone_Count_Is_NonZero_1-64 Zone 1-64: Count is Non Zero. 


EV_Zone_Count_Is_Max_1-64 Zone 1-64: Count is maximum – Count at its limit. 


EV_Zone_Count_Is_MaxMinusOne_1-64 Zone 1-64: Count is maximum minus one.  


EV_Reason_Code_0-99 Reason Code 0-99.  


EV_DOS_Door_Closed_1-16 Door Closed 1-16.  


 


EV_Host_Allowed_Normal_In Host Allowed Normal IN.  
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EV_Host_Allowed_Normal_Out Host Allowed Normal OUT.  


EV_Host_Allowed_APB_Override_In Host Allowed APB Override IN. 


EV_Host_Allowed_APB_Override_Out Host Allowed APB Override OUT.  


EV_Host_Allowed_APB_Violation_Out Host Allowed APB Violation OUT.  


EV_Host_Allowed_Time_Day_Violation_Out Host Allowed Time Day Violation OUT.  


EV_Host_Allowed_Exceptional_In Host Allowed Exceptional IN.  


EV_Host_Allowed_Exceptional_Out Host Allowed Exceptional OUT.  


EV_Host_Allowed_Vistor_In Host Allowed Vistor IN.  


EV_Host_Allowed_Visitor_Out Host Allowed Visitor OUT.  


EV_Host_Allowed_Duress_In Host Allowed Duress IN.  


EV_Host_Allowed_Duress_Out Host Allowed Duress OUT.  


EV_HFB_Allowed_Normal_In Host not available, Host Fall Back to 
Controller allows IN. 


EV_HFB_Allowed_Normal_Out Host not available, Host Fall Back to 
Controller allows OUT. 


EV_HFB_Allowed_APB_Override_In Host not available, Host Fall Back to 
Controller allows APB override IN. 


EV_HFB_Allowed_APB_Override_Out Host not available, Host Fall Back to 
Controller allows APB override OUT. 


EV_HFB_Allowed_APB_Violation_Out Host not available, Host Fall Back to 
Controller allows APB violation OUT. 


EV_HFB_Allowed_Time_Day__Violation_Out Host not available, Host Fall Back to 
Controller allows Time/Day violation 
OUT. 


EV_HFB_Allowed_Exceptional_In Host not available, Host Fall Back to 
Controller allows Tag exception IN. 


EV_HFB_Allowed_Exceptional_Out Host not available, Host Fall Back to 
Controller allows Tag exception OUT. 


EV_HFB_Allowed_Visitor_In Host not available, Host Fall Back to 
Controller allows Visitor Tag IN. 


EV_HFB_Allowed_Visitor_Out Host not available, Host Fall Back to 
Controller allows Visitor Tag OUT. 


EV_HFB_Allowed_Duress_In Host not available, Host Fall Back to 
Controller allows Duress code IN . 


EV_HFB_Allowed_Duress_Out Host not available, Host Fall Back to 
Controller allows Duress code OUT.  
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Event Statement Event Description 


EV_Allowed_Special_1_In Allowed Special 1 IN – Property set on Tag.  


EV_Allowed_Special_1_Out Allowed Special 1 OUT – Property set on Tag.  


EV_Allowed_Special_2_In Allowed Special 2 IN – Property set on Tag.  


EV_Allowed_Special_2_Out Allowed Special 2 OUT – Property set on Tag.  


EV_Tables_Initialised Raised when the Controller initiates all internal 
tables. They all become blank.  


EV_Tables_Corrupt Raised when the Controller detects a corrupt 
table.  


EV_Trans_Buffer_75_Full Transaction buffer in the Controllers 75% full. 


EV_Trans_Buffer_90_Full Transaction buffer in the Controllers 90% full. 


EV_Trans_Buffer_100_Full Transaction buffer in the Controllers 100% full. 


EV_3
rd


_Party_Event_1-16 Action of a third-party event. 


EV_Inter_Controller_Comms_Error Inter Controller Comms Error. 


EV_Bell_Button Bell Button pressed on the KMA Antenna Reader. 


EV_Input_Cut_1-16 Input Cut 1-16. 


EV_Input_Shorted_1-16 Input Shorted 1-16. 


EV_Denied_Biometric_In Denied Biometric IN. 


EV_Denied_Biometric_Out Denied Biometric OUT. 


EV_Scanner_Inhibited Scanner Inhibited. 


EV_Scanner_Enabled Scanner Enabled. 


EV_Pending_Allowed_Normal_In Dual Tag Pending, Allowed Normal IN. 


EV_Pending_Allowed_APB_Override_In Dual Tag Pending, Allowed APB Override IN. 


EV_Pending_Allowed_Normal_Out Dual Tag Pending, Allowed Normal OUT. 


EV_Pending_Allowed_APB_Override_Out Dual Tag Pending, Allowed APB Override OUT. 


EV_Pending_Allowed_TimeDay_Violation_
Out 


Dual Tag Pending, Allowed Time or Day Violation 
OUT. 


EV_Pending_Allowed_APB_Violation_Out Dual Tag Pending, Allowed APB Violation OUT. 


EV_Allowed_Interleading_In Allowed Interleading IN. 


EV_Allowed_Interleading_Out Allowed Interleading OUT. 


EV_Controller_Timeout Controller Timeout. 


EV_Input_Emergency_Mode_On Input Emergency Mode ON. 


EV_Input_Emergency_Mode_Off Input Emergency Mode OFF. 


EV_Input_Lockdown_Mode_On Input Lockdown Mode ON. 


EV_Input_Lockdown_Mode_Off Input Lockdown Mode OFF. 


EV_Input_Alarm_Restore_1-16 Input Alarm Restored 1-16. 


EV_Power_Failure Power Failure. 


EV_Power_Restored Power Restored. 


EV_Battery_Low Battery Low. 


EV_Battery_Ok Battery OK. 


EV_Arm_No_Authority The Tag used does not have zone arming 
authority. 
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Event Statement Event Description 


EV_Arm_Already_Armed Zone already armed. 


EV_Arm_Zone_Not_Ready Zone not ready for arming. 


EV_Arm_Zone_Armed Raised on successful arming operation. 


EV_Arm_Failed Arm operation failed, zone not armed. 


EV_Arm_Failed_Arm_All Failure arming all zones. 


EV_Arm_Request Places the Controller in the middle of an arming 
sequence, and tries to Arm the zone (carries out 
the 'Arm Alarm System Relay' action). 


EV_Arm_Out_Of_Sequence Raised when the 'Armed Input' activates suddenly 
(with no Arming Request), the zone immediately 
goes into Armed Mode. 


EV_Disarm_No_Authority The Tag used does not have disarm authority for 
the zone. 


EV_Disarm_Already_Disarmed Zone already disarmed. 


EV_Disarm_Zone_Disarmed Raised on successful disarm operation. 


EV_Disarm_Failed The disarm operation failed, zone not disarmed. 


EV_Disarm_Emergency_Unlock Raised when a zone is in Armed Mode and an 
Emergency Unlock request is made.  Emergency 
Unlock has a higher priority than Armed Mode.  
No disarm request is made to the Alarm Panel.  
All Readers exit Armed Mode and go into 
Emergency Unlock Mode. 


EV_Disarm_Request Places the Controller into the middle of a 
disarming sequence and tries to disarm the zone.  
Carries out the 'Disarm Alarm System Relay' 
action. 


EV_Disarm_Out_Of_Sequence Raised when the 'Armed Input' suddenly 
becomes inactive (with no Disarming Request).  
The zone immediately exits Armed Mode. 


EV_Denied_Terminal_Armed_In Terminal denies entry while in Armed Mode. 


EV_Denied_Terminal_Armed_Out Terminal denies exit in Armed Mode. 


EV_SMS_Action_Performed This status transaction keeps a record of actions 
performed via SMS. 


EV_Comms_Message_Failure Raised when sending a template to a B-SHO 
Terminal fails. 


EV_Comms_Diagnostics Reports the round trip time (in milliseconds) and 
the number of failures. 


EV_Rogue_Controller Reports the IP Address of the conflicting 
Controller. 


Table 5 – Table of Events and Actions 


 


 
USER NOTES 
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Introduction 


Overview 


The ImproNet Software lets you compile Reports on functions and transactions within the 


ImproNet System.   


 


As these Reports are essentially Web Reports, so you can compile Reports for one or more 


Sites over LAN or WAN networks.  The Reports Software for ImproNet V7.40 onwards allows 


selection of single or multiple Sites, allowing management of both.  


 


You may use the Web Reports Module with Windows® Internet Explorer 7 (and above) or 


alternatively Firefox 2 (and above).   


 


Starting up the Web Reports Module 


Open ImproNet Access as follows: 


 


1. In Windows®, click Start>All Programs>ImproNet>Access. 


2. Enter your Username and Password. 


 


 


The default administrator username is SYSDBA, and the default password is masterkey.  The 


Password is case-sensitive. 


 


3. Click the  button. 


4. From the Menu Bar, select Reports>Web Reports. 


5. From the displayed records, select a Host. 


6. Click the OK button. 


 


 


Alternately using a separate PC workstation, with Engine running on the Database Server,  start up the 


Module as follows: 


 


1. Using your Internet browser in the Address Bar, enter the phrase Localhost (and if necessary 


the Port Number).  


2. At the landing page, select the  (Web Reports) icon. 


 







Part 4 – Reports 


6  January 2012 


User Interface 


 


If your Web Report does not render correctly, set your monitor screen resolution to 1 024 x 768 pixels. 


 


 


Set the following when printing Reports displaying graphics: 


 


Internet Explorer 


1. From the Explorer toolbar, select Tools>Internet Options. 


2. Select the Advanced Tab. 


3. Scroll down to the Printing settings. 


4. Select the Print Background Colours and Images checkbox. 


5. Click the OK button. 


 


Firefox 


1. From the Firefox toolbar, select File>Print Preview. 


2. Click the Page Setup button. 


3. Select the Format and Options Tab. 


4. Under Options, select the Print Background (Colours and Images) checkbox. 


5. Click the OK button.  


 


The ImproNet Web Report System includes two types of Report Screen Formats, namely 


Tabbed and Non-tabbed Reports. 


 


Non-tabbed Reports 


 
Figure 1 – Typical Non-tabbed Report Screen 
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In Non-tabbed Reports, select parameters using the set of filters displayed on the screen.  


These filters may consist of information fields (occasionally), drop-down menus, checkboxes or 


calendars. 


  


Non-tabbed Report screens include an Include all Sites filter checkbox at the top left of the 


screen.  When checked, a drop-down menu displays giving you access to all Shared Sites 


(Shared Sites are described later in this section).  


 


Clicking on Back to the Web Reports Home Page at the top left of the screen, Returns you to 


the Web Reports Home Page from a Non-tabbed Report.  Click on the Submit button to view a 


report after capturing the filter data. 


 


Tabbed Reports 


 
Figure 2 – Typical Tabbed Report Screen 


 


In Tabbed Reports, make your selection of parameters according to a set of tabs displayed on 


the screen.  For ease of reference active Tab Titles appear in black, inactive Tab Titles appear in 


grey.     


Check the appropriate checkbox(es) at the left of the screen under the header “Select Tabs to 


be seen”, converting inactive Tabs to active Tabs. 


 


Using the Prev and Next buttons, select the required tabs.  Then using the fields displayed on 


the screen, enter data into the various Tab Categories.  Change these fields by typing in 


information (sometimes), or by using drop-down menus, calendars or checkboxes as provided. 


 


 


Most of the operations available in a Tabbed Report are described under the section Access Reports, 


Employee Transaction Report on page 16. 


 


 


The Site field is mandatory when using Tabbed Reports. 
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Report Selection 


Select Reports from either the Web Reports screen or from within any individual Report screen. 


 


 
Figure 3 – Web Reports Screen 


 


SSeelleeccttiioonn  UUssiinngg  TThhee  WWeebb  RReeppoorrttss  SSccrreeeenn  


Select the various categories of Reports using the Menu Bar at the top of the Web Reports 


screen (see Figure 3). 


 


Once you have chosen a category (for example, Person Reports), a screen showing the 


Reports in that category displays (see Figure 4). 


 


 
Figure 4 – Person Reports Screen 
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Each Report available under Person Reports lists in the Person Reports screen (Figure 4), 


along with a brief description of the attributes of the Report.  Clicking on the required Report 


Title displays the Report.   (For example, clicking on Access Reports displays the screen shown 


in Figure 5). 


 


 
Figure 5 – Access Report Screen 


 


SSeelleeccttiioonn  UUssiinngg  TThhee  RReeppoorrttss  MMeennuu  


 


 


The Reports Menu shown in Figure 6 and Figure 7 is available from ANY individual Report screen. 


 


1. Display the Reports Menu by clicking on Open Menu on the vertical bar at the left of the 


screen (see Figure 6). 


 


 
Figure 6 – Open Menu Bar Location 
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Figure 7 – Close Menu Bar Location 


 


2. Select any Report by clicking on the report title in the Reports Menu. 


3. Return to the main Web Reports screen by clicking on Main Page in the Reports Menu. 


4. Close the Reports Menu: 


 click on the vertical bar at the right of the menu (highlighted in Figure 7), or  


 click on Close Menu at the top of the Report Menu. 


 


Webreports.properties Settings 


 
Figure 8 – Webreports.properties File Screenshot 
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Settings in the Webreports.properties File (Figure 8) are as follows: 


 


#REPORT LOG 


If = -1 (default) this function is disabled. 


If = 1, function is enabled, and a CSV file is created in the ImproNet>Log folder. 


 


This is a log of the following concerning accessing of reports for the current date: 


Date; time accessed; time closed; report name; IP address of computer; description of log 


event; time difference between access and closing times. 


 


#MESSAGE BOARD REPORTS 


(This function was moved from the Engine.properties file to Webreports.properties in V7.4 of the 


ImproNet Software). 


 


#LAST ACCESS REPORT 


The refresh rate for this report can be set here; 60 000 = 1 minute. 


 


#DATABASE (FOR MSSQL SERVER ONLY) 


This function refers to the DATABASE Tab on the Reports main page.  It permits changing from 


the current database to any ImproNet SQL Server Database on the network. 


 


#CUSTOM REPORTS (DEBUG) 


If = -1 (default), this facility is disabled. 


If = 1 this facility is enabled. When enabled, the query that is used by a Custom Report is written 


to the Engine.log file. 


 


Selecting the Database 


When using an archived Database on which to base your Reports, continue as follows: 


 


1. Using the Menu Bar at the top of the Web Reports screen select the Database option.   


2. From the drop-down list, select the archived Database on which you can base your Reports 


(see Figure 9). 


 


 
Figure 9 – Select Database Drop-down Menu 
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Single and Cross-Site Reporting 


Two features in the Reports Software allow data in Web Reports to be limited.  


The first is the option to define a Site as Shared or Non-shared.   


 


If a Site is shared, you can draw up a Report with data from that Shared Site, by connecting to 


the Web Reports Server of ANY Site.  


 


If a Site is a Non-shared Site, a Report can only be generated for that Site by connecting to that 


Non-shared Sites Web Reports Server.  


 


The second data-limiting feature is Operator Security.  Operator Security overrides Shared 


and Non-shared Sites. 


 


That means that if a Site is configured as a Non-shared Site, and another Site is set to use 


Operator Security, by connecting to the Web Reports Server of the Site that uses Operator 


Security, a Report can be drawn up on the Non-shared Site.  (If the Operator Security Group 


that the user belongs to, allows data from that specific Non-shared Site to be viewed). 


 


In short, the Shared and Non-shared Sites selection feature is a simple, fast and easy way to 


protect a Site's data.  Operator Security is a more advanced feature that controls which Reports 


are accessible, from which Web Reports Server they are accessible, and which Sites data can 


be seen on the Report.  Operator Security is more complex to configure, but offers a 


customisable way to protect the accessibility of data. 


 


The way that the two features described above are implemented is slightly different for Tabbed 


and Non-tabbed Reports. 


 


TTaabbbbeedd  RReeppoorrttss  


In a Tabbed Report it is compulsory to select a Site. The Report always only shows data for the 


Site the user selected.  Where Shared and Non-shared Sites, and Operator Security come into 


play, is in the limitation of the Sites available for selection and the Tagholder information that’s 


for display. 


 


Shared and Non-shared Sites 


As an example, consider an installation with three Sites, Site RED, Site GREEN and Site 


ORANGE.   


 


 Site RED – Non-shared Site 


 Site GREEN – Non-shared Site 


 Site ORANGE – Shared Site 


 


Tagholders from Site RED have access to Site ORANGE. Tagholders from Site GREEN have 


access to Site ORANGE.  If a user connects to the Web Reports Server of Site RED and draws 


up an Employee Transaction Report:  


 


 Only Site RED and Site ORANGE will appear in the Site select drop-down menu (as Site 


GREEN is a Non-shared Site). 
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 If the user selects Site RED from the Site drop-down menu, only information for Employees 


from Site RED will be shown on the department, Employees, Tag (and so on) selection 


tabs. This is because there are no Employees from Site GREEN or Site ORANGE that 


have access to Site RED. 


 If the user selects Site ORANGE from the Site drop-down menu, information for Employees 


from Site ORANGE and Employees from Site RED, who have access to Site ORANGE, 


will be shown on the department, Employees, Tag (and so on) selection tabs. Site GREEN 


is a Non-shared Site. This means that information for the Employees from a Non-shared 


Site will be hidden unless: 


 


 The user is viewing reports by connecting to the Web Reports Server of that specific 


Non-shared Site. 


 The user is connected to the Web Reports Server of a Site, where Employees from 


Non-shared Sites have access. 


 


In the above situation, by connecting to the Web Reports server of Site GREEN, the user will 


get similar results but will see Employees from Site GREEN instead of Employees from Site 


RED. If a user is connecting to the Web Reports server of Site ORANGE, the user will see the 


information for Employees from Site ORANGE and the Employees from Site RED and Site 


GREEN who have access to Site ORANGE. 


 


Operator Security 


Operator Security works in the same way as the Shared and Non-shared Sites selection 


feature.  The difference is that the Sites which a user’s Operator Security Group has access to 


view become the equivalent of Shared Sites, and those that it does not have access to view 


become the equivalent of Non-shared Sites. 


 


NNoonn--ttaabbbbeedd  RReeppoorrttss  


It is not mandatory to select a Site for Non-tabbed Reports.  This means that the main difference 


between Tabbed and Non-tabbed Reports is the data that they can display. 


 


Non-tabbed reports can either: 


 


 show data from multiple Sites at the same time (the Tagholder Access Group Configuration 


Report that shows Access Groups from all Sites), or 


 can show a summary of activity on all Sites (the Access Pattern Report shows the first time 


in and last time out across all Sites, where the first time in could have been on Site RED 


and the last time out could have been on any other Site). 


 


Shared and Non-shared Sites 


Taking the same configuration from the example in Tabbed reports: 


 


 Site RED – Non-shared Site 


 Site GREEN – Non-shared Site 


 Site ORANGE – Shared Site 


 







Part 4 – Reports 


14  January 2012 


Tagholders from Site RED have access to Site ORANGE. Tagholders from Site GREEN have 


access to Site ORANGE. If a user connects to the Web Reports Server of Site RED and draws 


a Department Hours Worked in APB Zones Report: 


 


 Only data pertaining to Site RED will show.  (Departments and Zones defined on Site RED, 


and the transactions that were made on Site RED). 


 If the user selects the Include All Sites check-box, data pertaining to Site RED (the Site 


that the user connected to) and Site ORANGE (all Shared Sites) will show.  This includes 


the Employee, Department, Zones (and so on) drop-down menus and the transactions that 


are used to create the Report. 


 Only Site RED and Site ORANGE will appear in the Site Selection drop-down menu (as 


Site GREEN is a Non-shared Site). 


 By selecting a Site from the Site drop-down menu, transactions filter allowing only 


transactions from the selected Site. The data in the drop-down menus stays as it was. 


 


As with Tabbed Reports, Employees from Non-shared Sites (Site RED and Site GREEN) will 


show if they have access to the Site to which the user connects. The user still has to select 


Include All Sites to view this information.  Information about a Non-shared Site, that is, the 


configuration of the Site itself is still not visible.  The only data that is visible from a Non-shared 


Site is the information on Tagholders who have access to a Site for which a user is drawing up a 


Report. 


 


In the example above, by connecting to the Web Reports server of Site GREEN, the user gets 


similar results, but sees Employees from Site GREEN instead of Employees from Site RED.  If 


a user connects to the Web Reports Server of Site ORANGE to view reports, the user sees 


information for Employees from Site ORANGE, as well as the Employees from Site RED and 


Site GREEN who have access to Site ORANGE. 


 


Operator Security 


Operator Security works in the same way as the Shared and Non-shared Sites selection option. 


The difference is that the Sites which a user's Operator Security Group has access to view 


become the equivalent of Shared Sites and those that the user’s Operator Security Group does 


not have access to view become the equivalent of Non-shared Sites. 


Reports can, with configuration, use the Operator Security facility.  When using Operator 


Security, you can create Operator Security Groups with access to certain reports only. 


 


Reports can further be configured by Operator Security Group showing only certain data within 


the Reports concerned. 


 


 


When using Operator Security on a Site, ensure the following:  Within the Engine.properties file, set 


the engine.webserver.enforcelogon = setting to True. 


 


 


When using Operator Security, the Include All Sites checkbox on Non-tabbed Reports is NOT 


displayed, and the Site Drop-down menu displays automatically (see the section Non-tabbed Reports 


on page 6). 


 


 


For an Operator Security Group that does not have access to a given Site, that Site will NOT appear in 


the Site Drop-down menu. 
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If a Site is Non-shared, it will NOT appear in the Site Drop-down menu, unless the viewer is connected 


to that Site’s Engine. 


 


Shared Site Selection 


If Operator Security is NOT used, Reports get filtered as Shared or Non-shared Sites.  


 


Set the Shared Sites property in Access by checking the Shared Site checkbox on each 


individual Site dialog (see Figure 10).   


 


 


Selecting the appropriate Site icon in the Navigator Pane displays the Site information. 


 


 
Figure 10 – Shared Site Selection 
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Report Categories 


The available Report categories are: 


 


Report Category Description 


Access Reports Provides access data for all Tagholders at all selected Sites. 


Person Reports Provides transaction data relating to a specific person or persons 


having access to the Site(s) concerned. 


System Reports Provides data about system occurrences, such as alarms, Terminal 


time-outs, frequency of door access, and so on. 


Configuration Reports Provides data such as Terminals that a given Tagholder has access 


to, Terminals in each Area, and Actions available at each Terminal. 


Tagholders Reports Provides data about Employee and Visitors’ Tags, Tags not used, 


Tag Expiry, and so on. 


Alarm Arming Reports Provides data about Employees with Alarm Arming access rights, 


Tagholder Access Groups with Alarm Arming access rights and 


Alarm Arming transactions.  


Custom Reports Reports that can be created by the user according to specific 


administration needs. 


Select Database This configuration option permits the selection of an archived 


database to allow the compilation of reports on archived data when 


required. 


Table 1 – Report Categories 


 


Access Reports 


MMeessssaaggee  BBooaarrdd  RReeppoorrtt        


 The Message Board (Non-tabbed) Report shows the latest IN and OUT Transaction 


Information for each Tagholder on the selected Site(s).  


 Filter the Report by:  Department and/or IN and OUT transactions and select whether to 


Include all Sites. 


 


LLaasstt  AAcccceessss  RReeppoorrtt      


 The Last Access (Non-tabbed) Report provides information on the Last Access (in-


clockings and/or out-clockings) by a selected person at a selected door during a 


period from a selected date to the current time.    


 Filter the Report by:  Name and/or Door, IN and OUT transactions, Period (Date), Employee 


Number and Department and select whether to Include all Sites. 


 


EEmmppllooyyeeee  TTrraannssaaccttiioonn  RReeppoorrtt        


 The Employee Transaction (Tabbed) Report displays a detailed report on all the 


Transactions made by Employees.   



file://iserv/manual/SHANNON%20FRANCES/MANUALS/$%20ImproNet/English%20Manuals/LATEST%20ISSUE/net.impro.impronet.web.webreports.LastAccess

file://iserv/manual/SHANNON%20FRANCES/MANUALS/$%20ImproNet/English%20Manuals/LATEST%20ISSUE/net.impro.impronet.web.webreports.LastAccess

file://iserv/manual/SHANNON%20FRANCES/MANUALS/$%20ImproNet/English%20Manuals/LATEST%20ISSUE/net.impro.impronet.web.webreports.EmpTransactionReport





Part 4 – Reports 


January 2012  17 


 Filter the Report by:  Site, Date and Time, Person, Tag Code, Department, Event and 


Vicinity.   


 


TTrraannssaaccttiioonn  RReeppoorrtt        


 The Transaction (Non-tabbed) Report displays all Tagholders’ transactions for a specific 


date.   


 Filter the Report by:  Name and Door and select whether to Include all Sites. 


 


AAuuddiitt  TTrraaiill  RReeppoorrtt        


 The Audit Trail (Non-tabbed) Report displays all Tagholders’ Transactions for a specific 


date.   


 Filter the Report by:  Period and Audit Type (including User Logon/Logoff, APB Reset, 


Access Time Pattern Edited, Added a New Employee, Added a New Visitor, Area Deleted, 


Area Edited, Deleted Security template, Deleted User Login, Deleted User Profile and 


Device Time Pattern Edited) and select whether to Include all Sites. 


 


SSaaggeemm  IIddeennttiiffyy  RReeppoorrtt        


 The Sagem Identity (Non-tabbed) Report displays the transactions per Sagem Reader.   


 Filter the Report by:  Department, Serial Number, Start and End Date and select whether to 


Include all Sites. 


 


FFiirrsstt  AAcccceessss  RReeppoorrtt        


 The First Access (Non-tabbed) Report displays all Tagholders’ First Access transaction 


for a specific day.   


 Filter the Report by:  Name, Door, Date, Employee Number and Department and select 


whether to Include all Sites. 


 


LLaasstt  AAcccceessss  ffoorr  DDaayy  RReeppoorrtt        


 The Last Access for Day (Non-tabbed) Report displays all Tagholders’ Last Access 


Transactions for a specific day.   


 Filter the Report by:  Name, Door, Date, Employee Number and Department and select 


whether to Include all Sites. 


 


VViissiittoorr  TTrraannssaaccttiioonn  RReeppoorrtt        


 The Visitor Transaction (Tabbed) Report displays a detailed Report on all the Transactions 


made by Visitors.  


 Filter the Report by:  Site, Date and Time, Person, Tag Code, Department, Event and 


Vicinity. 


 


RReeaassoonn  CCooddee  TTrraannssaaccttiioonn  RReeppoorrtt        


 The Reason Code Transaction (Tabbed) Report displays all Employees that have used 


Reason Codes.   


 Filter the Report by:  Site, Date and Time. 
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EEvveenntt  TTrraannssaaccttiioonn  RReeppoorrtt        


 The Event Transaction (Non-tabbed) Report displays which events where triggered by an 


input.   


 Filter the Report by:  Input Name and Date and select whether to Include all Sites. 


 


Person Reports 


 


 


To ensure the necessary records display on your Report, before running these Person Reports, 


activate Anti-passback (APB) for the Zone:  


 


 Hours Worked in APB Zones Report  


 Zone Occupancy Report  


 Zone Occupancy (Common Zones) Report 


 Access Pattern Report 


 Department Access Pattern and Time Report 


 Department Hours worked in APB Zone Report   


 


 


 


Zone Occupancy Reports do NOT make allowance for Interleading Zones. 


 


PPeerrssoonn  RReeppoorrtt        


 The Person (Non-tabbed) Report displays Transactions for individual Employees.   


 Filter the Report by:  Employee and Start and End Dates and select whether to Include all 


Sites. 


 


ZZoonnee  OOccccuuppaannccyy  RReeppoorrtt        


 The Zone Occupancy (Non-tabbed) Report displays details of Tagholders in a specific 


Zone.   


 Filter the Report by:  Zone and select whether to Include all Sites. 


 


AAbbsseenntteeeeiissmm  RReeppoorrtt        


 The Absenteeism (Non-tabbed) Report details Employees absent on a specified date.   


 Filter the Report by:  Date and Department and select whether to Include all Sites. 


 


AAcccceessss  PPaatttteerrnn  RReeppoorrtt        


 The Access Pattern (Non-tabbed) Report displays a selected individual Employee’s Time 


In, Time Out and Hours at Work (Last Out - First In).   


 Filter the Report by:  Employee and Start and End Date and select whether to Include all 


Sites.  Alternatively, a Summary option is available for viewing. 
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HHoouurrss  WWoorrkkeedd  iinn  AAPPBB  ZZoonneess  RReeppoorrtt        


 The Hours Worked in APB Zones (Non-tabbed) Report calculates hours worked from the IN 


and OUT Transactions of all APB Zones.   


 Filter the Report by:  Employee and Start and End Dates and select whether to Include all 


Sites. 


 


PPeerrssoonn  DDeettaaiilleedd  AAcccceessss  RReeppoorrtt        


 The Person Detailed Access (Non-tabbed) Report provides detailed information of all 


Locations, Zones and Controllers, and provides a list of Tagholders with access to them.   


 Filter the Report by:  Controller, Zone or Door and select whether to Include all Sites. 


 


PPeerrssoonn  DDeettaaiillss  RReeppoorrtt        


 The Person Details (Non-tabbed) Report displays all captured details for a selected 


individual Tagholder.   


 Filter the Report by:  Employee and Start and End Date and select whether to Include all 


Sites.   


 


ZZoonnee  OOccccuuppaannccyy  ((CCoommmmoonn  ZZoonneess))  RReeppoorrtt        


 The Zone Occupancy (Common Zones) (Non-tabbed) Report displays Tagholders 


currently in the selected Common Zone.   


 Filter the Report by:  Zone and select whether to Include all Sites. 


 


DDeeppaarrttmmeenntt  RReeppoorrtt        


 The Department (Non-tabbed) Report displays Transactions for Employees in a specific 


Department.   


 Filter the Report by:  Department, Site, Start and End Date and select whether to Include all 


Sites. 


 


DDeeppaarrttmmeenntt  AAcccceessss  PPaatttteerrnn  aanndd  TTiimmee  RReeppoorrtt        


 The Department Access Pattern and Time (Non-tabbed) Report is a summary of Daily 


Hours Worked and Total Hours Worked, grouped by Department.   


 Filter the Report by:  Person, Department, Company, Start and End Date and select 


whether to Include all Sites. 


 


DDeeppaarrttmmeenntt  HHoouurrss  wwoorrkkeedd  iinn  AAPPBB  ZZoonnee  RReeppoorrtt        


 The Department Hours Worked in APB Zone (Non-tabbed) Report is a summary of the, 


daily Hours worked in APB Zones, grouped by Department.   


 Filter the Report by:  Employee, Department, Employer, Zone and Start and End Date and 


select whether to Include all Sites. 


 


HHoolliiddaayy  RReeppoorrtt        


 The Holiday (Non-tabbed) Report displays details of public and other company holidays.   


 Select whether to Include all Sites. 
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System Reports 


SSttaattuuss  RReeppoorrtt        


 The Status (Tabbed) Report displays all the status transactions from Controllers and 


Terminals on a selected date.  That is Terminal timeouts; tables corrupt and Request to 


Enter/Exit information.   


 Filter the Report by:  Site, Event, Door and Logical Address. 


 


DDoooorr  AAcccceessss  RReeppoorrtt        


 The Door Access (Non-tabbed) Report displays the frequency of access at each Door.   


 Filter the Report by:  Period and Site and select whether to Include all Sites. 


 


AAllaarrmm  RReeppoorrtt        


 The Alarm (Tabbed) Report displays all Alarms generated by the System.   


 Filter the Report by:  Site, Date and Time. 


 


CCoommmmss  DDiiaaggnnoossttiicc  RReeppoorrtt        


 The Comms Diagnostic (Non-tabbed) Report displays all diagnostic transactions from IP 


Terminals for a specific date.   


 Filter the Report by:  Date, Controller, Door and Logical Address and select whether to 


Include all Sites. 


 


CCoonnfflliiccttiinngg  CCoonnttrroolllleerr  CCoommmmss  RReeppoorrtt        


 The Conflicting Controller Comms (Non-tabbed) Report displays all conflicting Controller 


communication transactions reported by Ethernet Terminals.  


 Filter the Report by:  Date and select whether to Include all Sites. 


 


Configuration Reports 


AAcccceessss  RReeppoorrtt        


 The Access (Tabbed) Report displays all Locations that a Tagholder/Tag has access to.   


 Filter the Report by:  Site, Person, Tag Code, Department and Vicinity.  


 


TTeerrmmiinnaall  AAccttiioonn  RReeppoorrtt        


 The Terminal Action (Non-tabbed) Report displays of all Terminals and their available 


Actions.   


 Filter the Report by:  Terminal and Event and select whether to Include all Sites. 


 


AArreeaa  RReeppoorrtt      


 The Area (Tabbed) Report displays all Terminals within each Area of a Site.   


 Filter the Report by:  Site.  
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Tagholders’ Reports 


EEmmppllooyyeeee  RReeppoorrtt        


 The Employee (Tabbed) Report includes details of all Employees that have valid Tags in 


the System.   


 Filter the Report by:  Site and/or by Department.  


EEmmppllooyyeeeess  wwiitthhoouutt  TTaaggss  RReeppoorrtt        


 The Employees without Tags (Tabbed) Report includes details of all Employees that DO 


NOT have valid Tags in the System.  


 Filter the Report by:  Site and/or by Department.  


 


EEmmppllooyyeeeess  TTaaggss  wwiitthhoouutt  AAcccceessss  RReeppoorrtt        


 The Employees Tags Without Access (Tabbed) Report includes details of Employees that 


have NO Tagholder Access Group assigned to them.  


 Filter the Report by:  Site and/or by Department.  


 


TTaaggss  NNoott  uusseedd  RReeppoorrtt        


 The Tags Not Used (Non-tabbed) Report Lists Tags NOT used since a selected date.  


 Select whether to Include all Sites. 


 


TTaagghhoollddeerrss  CCoonnffiigguurraattiioonn  RReeppoorrtt        


 The Tagholders Configuration (Tabbed) Report provides detailed information on all the 


Tagholder Access Groups.   


 Filter the Report by:  Site.  


 


VViissiittoorr  RReeppoorrtt        


 The Visitor (Tabbed) Report displays details of Visitors with valid Tags in the System.   


 Filter the Report by:  Site and/or by Department.  


 


VViissiittoorrss  WWiitthhoouutt  TTaaggss  RReeppoorrtt        


 The Visitors Without Tags (Tabbed) Report displays details of Visitors that DO NOT have 


valid Tags in the System.  


 Filter the Report by:  Site and/or by Department.  


 


VViissiittoorrss  TTaaggss  WWiitthhoouutt  AAcccceessss  RReeppoorrtt        


 The Visitors Tags Without Access (Tabbed) Report includes details of Visitors that have 


NO Tagholder Access Group assigned to them.   


 Filter the Report by:  Site and/or by Department.  


 


TTaagg  EExxppiirryy  RReeppoorrtt        


 The Tag Expiry (Non-tabbed) Report Lists details of Tags that have expired and that will 


expire as of the current date.   
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 Filter the Report by:  Start and End Date and select whether to Include all Sites. 


 


TTaagghhoollddeerrss  AAcccceessss  GGrroouupp  CCoonnffiigguurraattiioonn  RReeppoorrtt        


 Tagholders Access Group Configuration (Non-tabbed) Report provides detailed information 


on configuration of all the Tagholder Access Groups.   


 Select whether to Include all Sites. 


 


BBiioommeettrriicc  TTaagg  RReeppoorrtt        


 The Biometric Tag (Non-tabbed) Report lists details of valid EMPLOYEE Tagholders with 


Biometric Templates.    


 Filter the Report by:  Employee and Tag Type and select whether to Include all Sites. 


 


VViissiittoorr  BBiioommeettrriicc  RReeppoorrtt        


 The Visitor Biometric (Non-tabbed) Report lists details of valid VISITOR Tagholders with 


Biometric Templates.    


 Filter the Report by:  Visitor and Tag Type and select whether to Include all Sites. 


 


Alarm Arming Reports 


AAllaarrmm  AArrmmiinngg  AAcccceessss  RReeppoorrtt        


 The Alarm Arming Access (Non-tabbed) Report displays details of Tagholders with Alarm 


Arming rights.  The Report also indicates which Tagholders have PIN-codes and the 


Tagholder Access Group(s) they belong to.   


 Filter the Report by:  Person, Access Group and Access Rights and select whether to 


Include all Sites. 


 


AAllaarrmm  AArrmmiinngg  TTrraannssaaccttiioonnss  RReeppoorrtt        


 The Alarm Arming Transactions (Non-tabbed) Report displays details of all Alarm Arming 


transactions.  


 Filter the Report by:  Event, Date and Time and select whether to Include all Sites. 


 


AAllaarrmm  TTaagghhoollddeerr  AAcccceessss  GGrroouuppss  RReeppoorrtt        


 The Alarm Tagholder Access Groups (Non-tabbed) Report displays details of all Tagholder 


Access Groups with Alarm Arming rights.   


 Select whether to Include all Sites. 


 


Custom Reports 


 


 


Because of the complexities of this feature, only approved Distributors or Impro Technical Support Staff 


can design Custom Reports.  Therefore, please contact your Impro Distributor for support. 


 


This option provides access to any Custom Reports developed by the user. 
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Typical Sample Reports 


This section outlines one Report from each category, thus providing insight into use of the 


Reports. 


 


Access Reports 


EEmmppllooyyeeee  TTrraannssaaccttiioonn  RReeppoorrtt  


 
Figure 11 – Employee Transaction Report Initial Set-up Screen 


 


Details of the Tab Filters follow: 


 


Select Site Tab 


The Site Tab (Figure 12) allows selection of the Site required, using the Site drop-down list. 


 


 
Figure 12 – Site Selection 
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Date & Time Tab 


The Date & Time Tab (Figure 13) allows selection of a date and time range, thus filtering the 


Report results. 


 


 
Figure 13 – Select Date and Time Dialog 


 


Display the calendar shown in Figure 14, by clicking on the Date From  (calendar) button. 


 


 
Figure 14 – Calendar Dialog 


 


Select the required date, as follows: 


 


1. Click on the  or  arrowheads to move between Years. 


2. Click on the  or  arrowheads to move between Months. 


3. Finally, select the required date. 


 


Person Tab 


The Person Tab allows selection of an Employee (Figure 15) if none is selected; data for all 


Employees listed is shown. 


 


 
Figure 15 – Employee Selection Screen 
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Employee Drop-down Menu Filter 


The ringed symbol in Figure 15 opens a drop-down menu filter (see Figure 16) for Employees, 


click on the symbol to open the dialog. 


 


 
Figure 16 – Employee drop-down Menu Filter 


 


Name Sort By allows sorting (in either Ascending (ASC) or Descending (DESC) order) by: 


 


 Default 


 First Name 


 Last Name 


 Employee Number 


 


Name Filter By allows filtering by: 


 


 Department 


 Employer 


 


Click Refresh to update the drop-down menu. 


 


Tag Code Tab 


This tab allows the selection of a Tag Code from those displayed (Figure 17). 


 


 
Figure 17 – Tag Code Selection 


 


 


If an Employee is NOT selected on the Employee Filter screen, all Tag numbers display.  If an 


Employee was selected, only that Employees Tag numbers display. 
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Employer Tab 


The Employer Tab allows selection of an Employer from those displayed (Figure 18). 


 


 
Figure 18 – Select Employer Screen 


 


Department Tab 


The Department Tab (Figure 19) allows filtering of data by Department. 


 


 
Figure 19 – Department Selection Screen 


 


Event Tab 


The Event Tab (Figure 20) allows filtering of data by Event. 


 


 
Figure 20 – Event Selection 
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Vicinity Tab 


The Vicinity Tab (see Figure 21) allows filtering of data by specifying a particular Site, Zone and 


Location (Vicinity). 


 


 
Figure 21 – Vicinity Tab selection 


 


Click on the required Site, Zone, Location (Vicinity or Door). 


 


Group By Tab 


The Group By Tab allows the grouping of Employee Transactions by choosing ONE of the 


categories shown in the Figure 22. 


 


 
Figure 22 – Group By selection 


 


Report Tab 


Clicking on the Next button displays the Report. 


 


 


The filters used in the selection of parameters for the Report shown in Figure 23 were Date, Employee 


and Location. 
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Figure 23 – Sample Employee Transaction Report 


 


The sort order of data in this Report is by Date.  However, the column headings in this Report 


also allow the sorting of the data.  Click on the required column heading, and the results will 


display in alphabetical or numerical order as appropriate.  On sorting the data, a triangular 


symbol displays in the column heading of the sorted column (highlighted in Figure 24). 


 


 
Figure 24 – Data Sorted by Column Heading 


 


Report Menu Bar (Export CSV, Print and Filter) 


Three menu choices appear at the right of the screen just under the Tabs. Details of these menu 


choices follow: 


 


Export CSV (Comma Separated Value) 


 


 


When exporting a Report to a CSV file, if the results of the Report are greater than 200 000 records, an 


error occurs.  To avoid this, draw smaller Reports when exporting. 


 


The Export CSV menu option allows export of the Report file (this is possible  for all Reports) in 


CSV format: 
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Figure 25 – Report options 


 


1. Click on Export CSV. 


 


 


Figure 26 – CSV File Download Dialog 


 


2. Select the button option you want: 


 Open – Opening the file causes a screen similar to Figure 27 to display.  In this case 


the file was opened in Microsoft Excel. 


 Save 


 Cancel 


 


 
Figure 27 – Employees Report Exported in CSV Format 
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Print  


The second menu choice allows you to print the Report as it appears on the screen. 


 


 
Figure 28 – Print Option 


 


Click on Print (see Figure 28). 


 


Filters 


 


 
Figure 29 – Filter Tab 


 


1. Return to the Filters screen, by clicking on Filter tab (see Figure 29). 


 


 


 
Figure 30 – Filters Data Display Option 


 


2. To display data on the Filters used, click on Filter (see Figure 30).   


 


This displays Filter data similar to the information shown in Figure 31. 


 


 
Figure 31 – Filter Data 


 


Person Reports 


PPeerrssoonn  DDeettaaiillss  RReeppoorrtt  


The Person Details Report displays a report of transactions for individual Employees.  You may 


filter the data by Employee, Start and End Dates.  Select either the current Site or all Sites. 
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1. Select the required Person from the drop-down menu. 


2. Select the required Start and End Dates using the calendars provided (see page 24 for 


details of how to use the calendars). 


3. Click on Submit. 


 


 
Figure 32 – Typical Person Details Report 


 


CSV (Comma Separated Value) Export 


 


 


The Export CSV button displays after you submit the filter data. 


 


 


When exporting a Report to a CSV file, if the results of the Report are greater than 200 000 records, an 


error occurs.  To avoid this, draw smaller Reports when exporting. 


 


Use the Export CSV button when exporting Non-tabbed Reports in CSV format.  


 


 
Figure 33 – Non-tabbed Report CSV Export 
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System Reports 


DDoooorr  AAcccceessss  RReeppoorrtt  


Displays how frequently each Door has been accessed (Figure 34).  You may filter data by 


Date.   Select either the current Site, or all Sites. 


 


 
Figure 34 – Typical Door Access Report 


 


Configuration Reports  


AAcccceessss  CCoonnffiigguurraattiioonn  RReeppoorrtt  


The Access Configuration Report displays all Locations that a Tagholder has access to.  You 


may filter the data by Site, Person, Tag Code, Department, and Vicinity.  Refer to Figure 35.  


 


 
Figure 35 – Access Configuration Report 
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Tagholders’ Reports 


EEmmppllooyyeeee  TTaagghhoollddeerr  RReeppoorrtt  


Figure 36 shows a typical Employee Tagholder Report. 


 


 
Figure 36 – Typical Employee Report 


 


Alarm Arming Reports 


AAllaarrmm  AArrmmiinngg  AAcccceessss  RReeppoorrtt  


Figure 37 shows a typical Alarm Arming Access Report. 


 


 
Figure 37 – Typical Alarm Arming Report 


 


Other Reports 


The other Reports available are all conceptually similar to one or other of the Reports described 


previously. 
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USER NOTES 
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Unlock on First Tag 


Purpose of this Feature 


Unlock on First Tag feature provides the facility of unlocking selected door(s) when the first 


valid Tag is presented during a specified time period.  The door remains unlocked for that time 


period, but is locked outside that time period, opening only on presentation of a valid Tag. 


 


Example 


In the following example procedure, activate the Unlock on First Tag feature only on weekdays 


from 7 am to 5 pm.  This means that you must create the following Device Time Patterns (in 


Access) for the Terminal(s) concerned: 


 


 A Device Time Pattern from 7 am until 5 pm on weekdays (Monday to Friday).  This is the 


period for which the Unlock on First Tag feature must be enabled. 


 A Device Time Pattern from Sunday until Friday, 5 pm until 12 am.   This is the remaining 


time on each of the above days during which the Unlock feature must be disabled. 


 A Device Time Pattern from Sunday until Friday, 12 am until 7 am.  The Sunday period 


covers the time from midnight to 7 am on Monday. 


 A Device Time Pattern called Deactivate Relay at 17:00.  Set the start time to 5 pm and 


select Monday to Friday. 


 A Device Time Pattern for Saturday, Sunday and public holidays for the full 24 hours.  


These are the days on which the feature must be disabled. 


 


Procedure 


DDeevviiccee  TTiimmee  PPaatttteerrnn  SSeettuupp  


1. In Access, in the Navigate Pane (from the Hierarchical Tree) select the  icon. 


2. In the Main Pane, click the  button. 


 


 
Figure 1 – Adding Device Time Pattern Dialog 
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3. In the Description textbox, enter a name for the Device Time Pattern. 


4. If required, complete the Start Date and Stop Date textboxes. 


5. In the Start Time field, enter 0700. 


6. In the Duration field, enter 1000. 


7. Select the Monday through Friday checkboxes. 


8. Repeat the processes mentioned in steps 2 to 7 for the remaining Device Time Patterns.  


 


 
Figure 2 – Completed Device Time Patterns 


 


RReellaayy  AAccttiioonn  SSeettuupp  


New Action - Mon-Fri 07:00-17:00 Device Time Pattern 


1. Select the Actions tab, for the output relay on the Terminal controlling the door strike. 


2. In the Main Pane, click the  button. 


3. In the Action Name textbox, assign your action the name Enable Relay Indefinitely. 


4. Alongside the Time Pattern textbox, click the  button. 


5. From the list of displayed Device Time Patterns, select the Mon-Fri 07:00-17:00 record. 


6. Click the  button. 


 


 
Figure 3 – New Relay Action – Enable Relay Indefinitely 


 


7. At the New Action dialog, click the  button. 


8. In the Action Parameters dialog, set the Duration (0.1s) to 65535. 


 


 


This Action enables the relay for an indefinite period. 
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Figure 4 – Set Relay Action Duration to “Infinite” 


 


9. Click the  button. 


 


New Action - Sat, Sun, Hol 24hrs Device Time Pattern 


1. In the Main Pane, click the  button. 


2. In the Action Name textbox, assign the action a name (for example Drive Relay 4 


Seconds). 


3. Alongside the Time Pattern textbox, click the  button. 


4. From the list of displayed Device Time Patterns, select the Sat, Sun, Hol 24 Hrs record. 


 


 
Figure 5 – New Relay Action – Drive Relay 4 Seconds 


 


5. Click the  button. 


6. At the New Action dialog, click the  button. 
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7. In the Action Parameters dialog, set the Duration (0.1s) to 40 (4 seconds). 


8. At the Action Parameters dialog, click the  button. 


 


Edit Action - Sun-Fri 17:00-00:00 Device Time Pattern 


1. In the Main Pane select the existing Relay – Allowed In Action.   


2. Click the  button. 


3. In the Action Name textbox, assign the action a new name (for example Sun-Fri 1700-


0000). 


4. Alongside the Time Pattern textbox, click the  button. 


5. From the list of displayed Device Time Patterns, select the Sun-Fri 17:00-00:00 record. 


6. Click the  button. 


 


 
Figure 6 – Edit Relay – Allowed In Action 


 


7. At the Edit Action dialog, click the  button. 


 


New Action - Sun-Fri 00:00-07:00 Device Time Pattern 


1. In the Main Pane, click the  button. 


2. In the Action Name textbox, assign your action a name (for example Sun-Fri 0000-0700). 


3. Alongside the Time Pattern textbox, click the  button. 


4. From the list of displayed Device Time Patterns, select the Sun-Fri 00:00-07:00 record. 
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Figure 7 – New Relay Action – Sun-Fri 00:00-07:00 


 


5. Click the  button. 


6. At the New Action dialog, click the  button. 


7. At the Action Parameters dialog, click the  button. 


 


New Action - Deactivate Relay at 17:00 Device Time Pattern 


1. In the Main Pane, click the  button. 


2. In the Action Name textbox, assign your action a name (for example Deactivate Relay). 


3. Alongside the Time Pattern textbox, click the  button. 


4. From the list of displayed Device Time Patterns, select the Deactivate Relay at 17:00 


record. 


 


 
Figure 8 – New Relay Action – Deactivate Relay at 17:00 
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5. Click the  button. 


6. At the New Action dialog, click the  button. 


7. In the Action Parameters dialog, set the Duration (0.1s) to 65535. 


8. At the Action Parameters dialog, click the  button. 


 


New Action - All Relays  


1. In the Main Pane, click the  button. 


2. From the Select Action Type drop-down list, select the Multiple Actions option. 


3. In the Action Name textbox, assign your action a name (for example All Relays). 


 


 
Figure 9 – New Relay Action – Deactivate Relay at 17:00 


 


4. In the Action Parameter dialog, for the First Action, click the 1 button. 


5. From the list of displayed actions, select the Sun-Fri 1700-0000 action created earlier. 


6. For the Second Action, click the 2 button. 


7. From the list of displayed actions, select the Sun-Fri 0000-0700 action created earlier. 


8. For the Third Action, click the 3 button. 


9. From the list of displayed actions, select the Enable Relay Indefinitely action created 


earlier. 


10. For the Fourth Action, click the 4 button. 


11. From the list of displayed actions, select the Drive Relay 4 Seconds action created earlier. 


12. Click the  button. 


13. At the Action Parameters dialog, click the  button. 


 


AAccttiivvee  SSyysstteemm  EEvveennttss  EEddiittoorr  


1. In the Main Pane, click the Active System Events button. 


 


On opening, under Actions for Allowed Events, the First Action appears as Sun-Fri 1700-


0000, add the remaining actions as follows: 
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Figure 10 – Active System Events Editor Dialog 


 


2. Under Actions For Allowed Events, replace the First Action, by clicking the 1 button. 


3. From the list of actions displayed, select the All Relays action you created earlier. 


4. Click the  button. 


5. At the Active System Events Editor dialog, click the  button. 


6. At the Confirm Save dialog, click the Yes button. 


 


TTiimmee  TTrriiggggeerreedd  AAccttiioonn  SSeettuupp  


1. In Access, in the Navigate Pane (from the Hierarchical Tree), select the  icon. 


2. In the Main Pane, click the  button. 


3. In the Action Name textbox, give your Time Triggered Action a meaningful name (for 


example Deactivate Relay 1). 


4. Click the Trigger Time’s associated  button. 


5. From the list of displayed Device Time Patterns, select the Deactivate Relay at 17:00 


record. 


6. Click the  button. 


7. Click the Execute Action’s associated  button. 


8. From the list of displayed actions, select the Deactivate Relay action created earlier. 


9. Click the  button. 


10. At the Create Time Triggered Action dialog, click the  button. 
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Lift (Elevator) Control 


Purpose of this Feature 


This feature lets you setup Lift (Elevator) Control in your Access Control System. 


 


Example 


The following example procedure shows the use of this feature. 


 


Procedure 


RReellaayy  SSeettuupp  


1. In Access, in the Navigator Pane (from the Hierarchical Tree), select the  icon selecting 


the ImproX O16 Terminal's Zone. 


2. In the Navigator Pane, from the Hierarchical Tree, select the ImproX O16 Terminal. 


3. In the Main Pane, on the Terminal tab, from the Position group, select the Exit radio button. 


4. Select the Actions tab. 


5. On the Main Pane, click the  button. 


6. From the Select Action Type drop-down list select the Relay option. 


7. In the Action Name textbox, assign your action a name (for example Elevator Access). 


8. Click on the  button. 


9. In the Action Parameters dialog, from the Relay Activate/Deactivate group, select the 


Activate Relay radio button.  


10. From the Select Relays group, select the required Relay. 


 


 


You may select more than 1 Relay. 


 


 


To change the Duration value, click in the field and type in the required time duration (10 = 1 second).  


If, for example, wheelchair access is required, it may be necessary to extend this time. 


 


11. Click on the  button. 


 


CCoonnffiigguurree  tthhee  AArreeaa  


 


 


Remember, a Lift (Elevator) Area CANNOT co-exist in another physical Area as well as its own Area. 


 


An Area is a user-defined grouping of Locations to assist with access allocation.  Configure the 


Area as follows: 


 


1. In the Navigator Pane (from the Hierarchical Tree) select the  icon. 
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2. In the Main Pane, click the  button. 


 


 
Figure 11 – Add Dialog 


 


3. In the Area Name field, enter a name for the new Area. 


4. In the Area Description field, enter a unique description of the new Area. 


5. On the Location tree, click on the specific Location where you set up the Lift (Elevator). 


6. Click on the  button. 


 


 


The newly defined Area displays, showing details of the included Zones and their Locations. 


 


 


Select the  button to display the full tree in order to select or deselect Locations, thus forming an 


amended Area. 


 


CCoonnffiigguurree  tthhee  TTaagghhoollddeerr  AAcccceessss  GGrroouuppss  


1. In the Navigator Pane (from the Hierarchical Tree) select the  icon. 


 


 


The Main Pane defaults to the General (Employees/Staff) tab, if Visitors is required; select that tab 


before proceeding further. 


 


2. In the Main Pane, click the  button. 
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Figure 12 – Access Descriptions Dialog 


 


3. In the Tagholder Access Group Name field, assign a meaningful name (for example  


Central Elevator Access). 


4. Click the  button, activating the Access Description. 


5. Alongside the Access Time Pattern field, click the Select Button. 


6. From the displayed records, choose the required Time Pattern. 


7. Alongside the Area field, click the Select button. 


8. From the displayed records, choose the required Area. 


9. Click the Advanced (1) button. 


 


 
Figure 13 – Advanced Settings Dialog 


 


10. Select the Actions tab. 


11. Alongside the Action (Coming In) field, click the Select button. 


12. From the Actions at Locations drop-down list, select the required Location. 


13. Following with the example we used in the section Relay Setup (on page 13), select the 


ImproX O16 Terminal's Elevator Access action. 


14. Click the  button. 


15. In the Advanced Settings dialog, select the Start & Expiry Date tab. 
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16. Edit the dates as necessary. 


17. Click  the button. 


18. Close the Access Descriptions dialog by clicking on the  button. 


 


AAssssiiggnn  AAcccceessss  ttoo  TTaagghhoollddeerrss  


1. In the Navigator Pane (from the Hierarchical Tree) select the  icon. 


2. From the records displayed in the Main Pane select a Tagholder who requires access to the 


Lift (Elevator). 


3. With the Tagholder's record selected, click the  button. 


4. In the Edit Tagholder dialog, click the Tag (1-8) button associated to the Tag for editing. 


5. From the Tagholder Access Groups Available for Site group, from the next available 


Group (1-10) drop-down list, select the Central Elevator Access group that you created 


earlier. 
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Interleading Zone Routing 


Purpose of this Feature 


 


 


Select the Strict Anti-passback (APB) Zone setting, when enforcing Interleading Zone Routing. 


 


The purpose of Interleading Zone Routing is to force people to follow a logical path of tagging 


IN and OUT.  Interleading Zone Routing is used mostly with Time and Attendance Software 


where it’s necessary for Tagholders to clock in and out of their work area for payment purposes.  


For example the Work Area Zone lies within a larger access controlled Perimeter Zone.  A 


Tagholder’s normal tagging route for a work-day is: 


 


1. IN at the Perimeter Zone. 


2. IN at the Work Area Zone. 


3. OUT of the Work Area Zone. 


4. OUT of the Perimeter Zone. 


 


Once inside the Perimeter Zone, the Tagholder is allowed to freely tag-in and tag-out of the 


Work Area Zone.  However, the Tagholder is prevented from tagging-out of the Perimeter Zone 


if currently tagged into the Work Area Zone.  This means the following sequence is NOT 


allowed: 


 


1. IN at the Perimeter Zone. 


2. IN at the Work Area Zone. 


3. OUT of the Perimeter Zone (Denied Interleading Zone Routing). 


 


A Tagholder must also have tagged into the Perimeter Zone otherwise access to the Work Area 


Zone is denied.  There may be several perimeter access points on different Controllers but all 


the Perimeter Zones MUST belong to a Common Zone.  There may be several work area 


access points on different Controllers but, again, all the Work Area Zones MUST belong to a 


Common Zone.  You MUST set the entry and exit locations for the Work Area Zones to 


interlead to one of the Perimeter Zones. 


 


Example 


 
Figure 14 – Interleading Zone Routing 
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We want Tagholders to tag-in at Door 1 and THEN tag-in at Door 2, and not to tag-in at Door 2 if 


they have not tagged-in at Door 1.  In reality somebody may climb through the window, and try 


tagging-in through door 2 without tagging-in at door 1. 


 


Procedure 


Let’s look at it from an ImproNet point of view: 


 


IInntteerrlleeaaddiinngg  ZZoonneess  


 
Figure 15 – Interleading Zone Routing 


 


We configured the System using 2 zones, and a minimum of 4 Readers.  Two Readers for each 


access point, 1 IN and 1 OUT for Anti-passback (APB).  So when Tagholder A presents their Tag 


at Reader 1, Tagholder A’s considered to be inside the Perimeter Zone.  At this point Tagholder 


A has two available transactions: OUT at Reader 2 or IN at Reader 3. 


 


This routing thus prevents Tagholder A from passing their Tag back through the gate for use by 


another person trying to enter at Reader 1.  Tagholder A’s also prevented from passing their Tag 


through a window to the Internal Zone for a person trying to exit at Reader 4. 


 


In summary, the Gate (Perimeter Zone) is in one zone, and the Office Door (Internal Zone) is 


another zone.  To get into the internal office area, you need to go through the gate and through 


the door.  


 


To set up this scenario: 


 


1. In Access, select the Site in the Navigator Pane. 


2. Select the Enforce Zone Routing checkbox. 
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Figure 16 – Enforce Zone Routing Checkbox 


 


3. Click on Location: Office Door. 


4. And in the Interleading to Zone drop-down list, select the Perimeter Zone.    


5. Select the Enforce Interleading Zone Routing checkbox. 


 


 
Figure 17 – Interleading to Zone and Enforce Interleading Zone Routing Options 


 


 


Always interlead your INTERNAL ZONE to your EXTERNAL ZONE. 


 


CCoommmmoonn  ZZoonneess  ffoorr  AAnnttii--ppaassssbbaacckk  ((AAPPBB))  


Needed when zones belonging to different Controllers must have Anti-passback (APB) controls 


applied as these zones form a single physical work area.  If Anti-passback is set, then tagging-in 


to any of the zones belonging to a common zone prevents entry to any of the zones until 


tagging-out of the common zone has taken place.  In this scenario, the Controllers must 
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communicate with one another, and update each other on presentation of the Tag.  Zones can 


only be specified as common if they exist on different Controllers. 


 


 


Each Controller can have only ONE configured Common Zone. 


 


CCoommmmoonn  ZZoonneess  ffoorr  IInntteerrlleeaaddiinngg  RRoouuttiinngg  


You may also apply Interleading Zone Routing to Common Zones.  Consider the following: 


 


 
Figure 18 – Interleading Zone Routing 


 


Consider 2 internal zones (Office 1 and Office 2) on different Controllers belonging to a common 


zone.  Each zone must be separately configured to interlead to the same Perimeter Zone.  If 


there are several Perimeter Zones all belonging to a common zone then choose any one of 


those zones to interlead all the internal zones to. 


 


 


If interleading to a zone on a different Controller then ensure that that zone is a member of a Common 


Zone even if it is the only member. 


 


Location for Office Door 1 


1. In Access, click on Location: Office Door 1. 


2. In the Main Pane, in the Interleading to Zone drop-down list, select the Perimeter Zone.    


3. Select the Enforce Interleading Zone Routing checkbox. 


 


Location for Office Door 2 


1. Click on Location: Office Door 2. 


2. In the Main Pane, in the Interleading to Zone drop-down list, select the Perimeter Zone.    


3. Select the Enforce Interleading Zone Routing checkbox. 
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Troubleshooting 


 
Figure 19 – Interleading Zone Routing 


 


 
Figure 20 – Interleading Zone Routing 


 


In the scenario outlined in Figure 19 and Figure 20: 


 


 The Red area represents a Common Zone.   


 This Common Zone includes 2 double sets of Turnstiles, each controlled by their own 


Controller.   


 The Time and Attendance points also have their own Controller. 


 Zone Broadcast is enabled on each of the Zones. 


 Interleading Zone Routing is set up and the Time and Attendance points interlead to the 


Turnstiles. 


 


In this scenario, create another Common Zone for the Time and Attendance points, ensuring 


that the 2 Common Zones communicate with one another.   
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Random Search 


Purpose of this Feature 


When Random Search is active, the System randomly selects a Tagholder for searching.   The 


System can select ANY Tagholder.  When the System selects the Tagholder for searching, a red 


light shines, an external buzzer sounds and the IN and OUT Antenna Readers prevent other 


Tagholders gaining access.   Security officials must then take the selected Tagholder aside, and 


then present their ―security‖ Tag to the Override Antenna Reader on the turnstile.  This Tag 


presentation unlocks the inhibited IN and OUT Antenna Readers allowing normal traffic flow.  


 


There is a chance the searched Tagholder may be selected again when they re-present their 


Tag at the IN or OUT Antenna Reader.  This is possible and some inconvenience may arise. 


 


Example 


 


 


This example procedure and Figure 21 refer to connections using the ImproX iTT.  You may however 


use other Terminals from the ImproX family, including the ImproX MfT, ImproX iTRT or ImproX I16. 


 


 
Figure 21 – Random Search Connection Details 
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Procedure 


IInniittiiaall  SSeettuupp  


 


 


Set up and name the Terminals and Readers as shown in Figure 21 and Figure 22. 


 


 
Figure 22 – Random Search Setup 


 


1. In Access, select the Site in the Navigator Pane. 


2. Select the Location, Turnstile 1. 


3. Select the Terminal, Turnstile 1 In. 


4. Select the Edit Terminal Parameters button. 


5. In the Random Search textbox, enter a suitable value. 


 


 


A low value here selects more often, a high value selects less frequently. 


 


6. Click the  button. 


7. Select the Terminal, Turnstile 1 Out. 


8. On the Main Pane, click the Edit Terminal Parameters button. 


9. In the Random Search textbox, enter a suitable value. 


10. Click the  button. 


 


IInnppuutt  SSeettuupp  


Next setup the Door Inhibiting Inputs on the ACCESS iTT, do this for both Antenna Readers: 


 


Turnstile 1 In 


 


 


This step is important, if not carried out correctly; you could inhibit the wrong Antenna Reader. 
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1. In the Navigator Pane, select the Terminal, Turnstile 1 In. 


2. In the Main Pane, select the Inputs tab. 


3. On the Main pane, select the General Input 1 record. 


4. Click the  button. 


 


 
Figure 23 – Input Device Dialog 


 


5. In the Input Name field, assign the Input a name. 


6. From the Input Function drop-down list, select Inhibit Scanner. 


7. Click the Input Parameter button. 


 


 


The ability to inhibit multiple units, as shown in Figure 24, is only available on sites using ECII 


Controllers (IXP400i Sites).  In configurations using IC’s or EC’s (IXP300 and IXP400 Sites) the dialog 


only lets you inhibit a single unit. 


 


 
Figure 24 – Input Parameters Dialog 
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8. Based on the connections shown in Figure 21, in the Input Parameters dialog, select the 


Inhibit on Closed Contact radio button. 


9. Ensure the Logical Address of Scanner to Inhibit textbox displays the correct scanner to 


inhibit, if incorrect, click the  button alongside the textbox and make your selection 


accordingly. 


10. Close the Input Parameters dialog by clicking the  button. 


11. Close the Input Device dialog by clicking the  button. 


 


Turnstile 1 Out 


1. In the Navigator Pane, select the Terminal, Turnstile 1 Out. 


2. In the Main Pane, select the Inputs tab. 


3. On the Main pane, select the General Input 1 record. 


4. Click the  button. 


5. In the Input Name field, assign the Input a name. 


6. From the Input Function drop-down list, select Inhibit Scanner. 


7. Click the Input Parameter button. 


8. Based on the connections shown in Figure 21, in the Input Parameters dialog, select the 


Inhibit on Closed Contact radio button. 


9. In the Input Parameters dialog, alongside the first available Logical Address of Scanner to 


Inhibit textbox, click the  button. 


10. From the dialog, select the record associated to Turnstile 1 Out. 


11. Click the  button. 


12. Close the Input Parameters dialog by clicking the  button. 


13. Close the Input Device dialog by clicking the  button. 


 


SSeettttiinngg  uupp  AAccttiioonnss  


Next set up an action on the Random iTT, for driving a relay when the Tagholders selected: 


 


Scanners Disabled Action 


1. In the Navigator Pane, select the Terminal, Turnstile 1 Random Override. 


2. In the Main Pane, select the Actions tab. 


3. Click on the  button. 


 


 
Figure 25 – New Action Dialog 


 


4. From the Select Action Type drop-down list, select Relay. 


5. Assign the Action a name, such as Scanners Disabled. 


6. Click the  button. 
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Figure 26 – Action Parameters Dialog 


 


7. In the Action Parameters dialog, set the Duration to 65535, to drive the relay indefinitely. 


8. Click the  button. 


 


Relay Allowed In Action 


1. In the Main Pane, on the Actions tab, select the action Relay Allowed In. 


2. Click the  button. 


 


 
Figure 27 – Edit Action Dialog 


 


3. In the Edit Actions dialog, click on the Action Parameters button. 


4. From the Relay Activate/Deactivate group, select the Deactivate Relay radio button. 


5. Set the Duration (0.1s) to 65535, to drive the relay indefinitely. 


6. Close the Action Parameters dialog by clicking the  button. 


7. Click the  button. 


 


Scanners Enabled Action 


1. In the Navigator Pane, select the Terminal, Turnstile 1 Random Override. 


2. In the Main Pane, select the Actions tab. 


3. Click on the  button. 


4. From the Select Action Type drop-down list, select Relay. 


5. Assign the Action a name, such as Scanners Enabled. 
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6. Click the  button. 


7. In the Action Parameters dialog, select the Deactivate Relay radio button. 


8. Click the  button. 


 


Buzzer Action 


1. In the Navigator Pane, select the Terminal, Spare. 


2. In the Main Pane, on the Actions tab, click the  button. 


3. From the Select Action Type drop-down list, select the Relay option. 


4. Assign your action a suitable Action Name (for example Buzzer). 


5. Click the  button. 


6. From the Relay Activate/Deactivate group, select the Activate Relay radio button. 


7. Click the  button. 


 


Now, tell the Antenna Readers, that if a Tagholder’s denied by Random Search, the Random 


Turnstile iTT must drive it’s relay Inhibiting the Scanners. 


 


Turnstile 1 In 


1. In the Navigator Pane, select the Terminal, Turnstile 1 In. 


2. In the Main Pane, select the Actions tab. 


3. At the bottom left-hand side of the Main Pane, click the Active System Events button. 


 


 
Figure 28 – Active System Events Editor Dialog 


 


4. At the bottom right-hand side of the Active System Events Editor dialog, click the Advanced 


button. 
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Figure 29 – Active System Events Editor (Advanced) Dialog 


 


5. From the Active System Event drop-down list, select Denied Random Search In. 


6. Select the next unassigned action. 


7. Click the action’s associated numeric button. 


8. In the Action Selector dialog, select the Scanners Disabled action created earlier. 


9. Click the  button. 


10. Select the next unassigned action. 


11. Click the Actions numeric button. 


12. In the Action Selector dialog, select the Buzzer action created earlier. 


13. Click the  button. 


14. Close the Active System Events Editor dialog by clicking on the  button. 


 


Turnstile 1 Out 


1. In the Navigator Pane, select the Terminal, Turnstile 1 Out. 


2. In the Main Pane, select the Actions tab. 


3. At the bottom right-hand side of the Main Pane, click the Active System Events button. 


4. At the bottom right-hand side of the Active System Events Editor dialog, click the Advanced 


button. 


5. From the Active System Events drop-down list, select Denied Random Search Out. 


6. Select the next unassigned action. 


7. Click the action’s associated numeric button. 


8. In the Action Selector dialog, select the Scanners Disabled action created earlier. 


9. Click the  button. 


10. Select the next unassigned action. 


11. Click the action’s associated numeric button. 


12. In the Action Selector dialog, select the Buzzer action created earlier. 


13. Click the  button. 


14. Close the Active System Events Editor dialog by clicking on the  button. 


 


Turnstile 1 Random  


1. In Access, select the Site in the Navigator Pane. 


2. Select the Location, Turnstile 1 Random. 


3. Select the Terminal, Turnstile 1 Turnstile 1 Random Override. 
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4. In the Main Pane, select the Actions tab. 


5. At the bottom right-hand side of the Main Pane, click the Active System Events button. 


6. Under Actions For Allowed Events, click the Relay – Allowed In’s associated numeric button. 


7. In the Action Selector dialog, select the Scanners Enabled action created earlier. 


8. Click the  button. 


9. Close the Active System Events Editor dialog by clicking on the  button. 
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Messages 


Purpose of this Feature 


Devices fitted with an LCD, such as a Time and Attendance Reader, can display a Message.  


Messages can be activated by Events and Time Triggered Events.  The Message screen in 


ImproNet Access enables you to create up to 63 Messages for assignment to suitable 


hardware. 


 


Procedure 


CCrreeaattee  aa  MMeessssaaggee  


To create a new Message, proceed as follows: 


 


1. In the Navigator pane, click the  icon.   


2. In the Main pane, select a Message number from the No drop-down list.  The default value 


is 1. 


3. Enter the Message content in the Message textbox. 


4. Click the  button to save. 


5. Repeat steps 1 to 4 to create additional messages.   


 


 


Remember to select an unused Message Number each time; otherwise the original Message will be 


overwritten. 


 


UUssiinngg  MMeessssaaggeess  


To use the Messages you created, proceed as follows: 


 


Create the Action 


1. In the Navigator pane, select the Terminal or Remote you want to display the Message.  


2. In the Main pane, select the Actions tab. 


3. Click the  button. 


4. In the New Action dialog, from the Select Action Type drop-down list, select LCD. 


5. In the Action Name textbox, give the Action a suitable name. 


6. Click the  button. 


7. In the Action Parameters dialog, in the Text Message Number textbox enter the 


appropriate message number.  For example based on the Figure 30, enter 2 to display 


―Welcome‖. 


 


 


Only complete the Line and Column textboxes when using an ImproX DL. 


 


8. In the Duration field, enter the duration for displaying the Message.  The default duration is 


40. 
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9. In the LCD Mode group, select the Clear Display checkbox. 


10. Click the  button. 


 


Assign the Action 


1. On the Actions tab, click the Active System Events button. 


2. In the Active System Events Editor dialog, from the Actions for Allowed Events group, click 


the numeric button alongside the next available unused Action.   


3. In the Action Selector dialog, select the appropriate LCD Action type. 


4. Click the  button. 


5. Click the  button. 


6. In the Confirm Save dialog, click the Yes button. 


 


 


The ImproX TA, iTA, TAR and iTAR range of Terminals and Readers only display 16 characters.  


Messages longer than 16 characters will NOT display in their entirety. 


 


DDeelleettee  aa  MMeessssaaggee  


To Delete a Message, proceed as follows: 


 


1. In the Navigator pane, click the  icon.   


2. In the Main pane, click a Message to select it. 


 


 
Figure 30 – Messages Screen 


 


3. Click the  button.   
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Emergency Door Open 


Purpose of this Feature 


The Emergency Door Open feature provides an exit route in the unlikely event of an 


emergency. 


 


Example 


The fire panel provides an output linked up to an input on the Access Control System. 


 


Procedure 


 
Figure 31 – Main Pane Showing the Inputs Tab Selected 


 


CCoonnffiigguurree  tthhee  IInnppuuttss  


1. Select the specific Terminal that must receive the output from the Fire Panel. 


2. Click on the Inputs tab. 


3. Select either Input 1 or Input 2. 


4. Click the  button. 
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Figure 32 – Input Device Dialog 


 


5. In the Input Name field, type in a name for the Input.  


6. From the Input Function drop-down list, select Emergency. 


 


 


Ensure that your input parameters are correct. Either open or closed state. 


 


7. Click the  button. 


 


CCoonnffiigguurree  tthhee  OOuuttppuuttss  


1. Click on the Outputs tab. 


2. Click the  button. 


 


 
Figure 33 – Output Device Dialog 
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3. In the Output Name field, type in a name for the Output.  


4. Alongside Relay During Emergency Mode click the Configure button. 


 


 
Figure 34 – Output Parameters Dialog 


 


5. Select the Drive Relay in this Mode radio button. 


6. Click the  button, to return to the Output Device Dialog. 


7. Click the  button. 


 


 


Repeat the output procedure on all doors that must open in case of emergency. 
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Lockdown Terminal Mode  


Purpose of this Feature 


Lockdown Terminal Mode locks selected doors in such a way that no Tagholder can gain 


access through those doors.  This Mode can be used, for example, when intruders are in the 


area concerned, and they are to be denied exit through a selected Door or group of Doors.  You 


may select this Mode at Controller or Terminal level. 


 


Example 


An intruder is detected in the company Strong Room. The Operator decides to place the Strong 


Room door in Lockdown Terminal Mode. 


 


Procedure 


LLoocckk--ddoowwnn  OOnn  MMooddee  


 


 


Start the Engine thereby ensuring that the Site is on-line before continuing further. 


 


1. In Access, Navigator Pane: 


 select the appropriate Site icon. 


 under the Host icon, select the Strong Room Exit Terminal. 


2. With the Terminal (Reader) selected Right-click your mouse, opening the menu below. 


 


 
Figure 35 – Lock-down Menu 


 


3. Select Lock-down On. 


4. In Windows®, select Start>Programs>ImproNet>Graphics Runtime. 


5. Enter your Username and Password. 


 


 


The default username is SYSDBA. The default password is masterkey.  The Password is case-


sensitive. 
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6. Select the Door Status tab. 


 


The Strong Room Door displays in Lock-down Mode see Figure 36. 


 


 
Figure 36 – Lockdown Mode at Terminal Level 


 


You may apply the same procedure at Controller level, in which case all Terminals connected to 


that Controller are placed in Lock-down Mode.  Figure 37 shows the Door Status display in 


Graphics Runtime when Lock-down Mode is applied at Controller 1 (Controller 00533FD4). 


 


 
Figure 37 – Lockdown Mode Applied at Controller Level 


  


  







Part 5 – Advanced Configuration 


January 2012  39 


LLoocckk--ddoowwnn  OOffff  MMooddee  


 


 


Start the Engine thereby ensuring that the Site is on-line before continuing further. 


 


1. In Access, Navigator Pane: 


 select the appropriate Site icon. 


 under the Host icon, select the Strong Room Exit Terminal. 


2. With the Terminal selected Right-click your mouse, opening the menu below. 


 


 
Figure 38 – Lock-down Menu 


 


3. Select Lock-down Off. 


4. In Windows®, select Start>Programs>ImproNet>Graphics Runtime. 


5. Select the Door Status tab. 


 


 


In Graphics Runtime, view the Door Status by selecting View>Door Status>Show Lockdown 


Mode. 


 


 


If you apply Lock-down Mode to a Terminal, you can switch the Mode off either at Terminal level or at 


Controller level.  However, when you apply Lock-down Mode to a Controller, you can only switch off the 


Mode at Controller level. 
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Force Upload of Hardware or Tagholder 
Data 


Purpose of this Feature 


The Force Upload of Hardware or Tag Data feature is used to force the upload of data from 


the Engine to the Controllers, without disrupting normal access control operation.  The Feature 


operates at Host level.  The Feature could be used, for example, where you have edited a large 


number of Tags, or you have made other configuration changes. 


 


Example 


Changes have been made to Tagholders Groups for a large building with several Controllers, 


and it is necessary to make this data available to the Controllers. 


 


Procedure 


1. In Access, select Configuration>Force Upload from the Menu Bar.  


 


 
Figure 39 – Tagholder Data Selection 


 


2. Select either Hardware Data or Tagholder Data.  (For this example, we selected the 


Tagholder Data option). 


 


 
Figure 40 – Site Selection Dialog 
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3. In the Select Site dialog select the required Site. 


4. Click the OK button. 


5. The selected data uploads (if Engine is running). 
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Device Time Patterns (DTP’s) supported in 
Actions 


Purpose of this Feature 


The Device Time Patterns (DTP’s) Supported in Actions Feature allows Device Time 


Patterns to be associated with system Actions.  When a Device Time Pattern is attached to an 


Action, this makes the Action active only during the period specified by the Device Time Pattern. 


 


Example 


For example, adding a Device Time Pattern to a Relay Action.  In this case, the Action is to be 


enabled between the hours of 7 am to 5 pm, Sunday to Friday, and during those hours the 


Relay duration is required to be 2 minutes to permit handling of goods at that Location. 


 


Procedure 


1. In Access, select Device Time Patterns from the Navigator Pane. 


2. In the Main Pane click the  button. 


 


 
Figure 41 – Adding Device Time Pattern Dialog 


 


3. In the Description textbox, enter a name for the Device Time Pattern. 


4. In the Start Time field, enter 0700. 


5. In the Duration field, enter 1000. 


6. Select the Monday through Friday checkboxes. 
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7. Click the  button. 


8. Select the required Terminal in the Navigator Pane. 


9. Select the Actions tab for the Terminal. 


10. Select the Relay – Allowed In action.   


11. Click the  button. 


12. In the Edit Action dialog, add the Mon-Fri 0700-1700 device time pattern to the action. 


 


 
Figure 42 – Modify Relay – Allowed In Action 


 


13. Click on the Action Parameters button. 


 


 
Figure 43 – Modify Relay – Allowed In Action Parameters 


 


14. Set the Relay Duration to 120 seconds (10 = 1 second). 


15. Close the Action Parameters dialog by clicking on the  button. 


16. Close the Edit Action dialog by clicking on the  button. 
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Anti-passback (APB) Lockout Entry and 
Exit Delays 


Purpose of this Feature 


The Anti-passback Lockout Entry and Exit Delays feature lets you set delay periods 


enforcing Anti-passback (APB) Entry and/or Exit Lockout restrictions after the presentation of a 


Tag.  This prevents multiple presentations of a Tag to the same Terminal during the delay 


period.  And so provides extra protection against a Tag being passed back to another person for 


unauthorized access. 


 


Procedure 


1. Select the Zone required. A screen similar to Figure 44 displays in the Main Pane. 


 


 
Figure 44 – Zone Selected 


 


2. When either Relaxed APB or Strict APB is selected, the Anti-Passback Lockout fields 


enable. 


3. In the Anti-passback Locked Entry Delay and/or Anti-passback Locked Exit Delay 


fields, enter the required time in minutes. 


4. Click the  button to accept these changes. 
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Operator Security 


Purpose of this Feature 


The ImproNet Software Suite offers full User and Operator Security.  Previously, the third-party 


database utility, IBConsole, was required to administer usernames and passwords.  Now, 


ImproNet facilitates administration of usernames and passwords.   


 


Any User or Operator can be configured to have access to any part of the ImproNet Software.  It 


is possible to restrict Operator access to specific Tagholders and ImproNet Applications. 


 


Procedure 


To open the Operator Security screen, proceed as follows: 


 


 
Figure 45 – Operator Security Selection 


 


In Access, select Configuration>Operator Security. 


 


SSyysstteemm  AAddmmiinniissttrraattoorr  GGrroouupp  


By default, the Operator Security screen displays the System Administrator group.  This group 


has full access to all ImproNet Software applications and all Tagholders.   
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The System Administrator group cannot be edited or deleted.  SYSDBA is the only user that is a 


member of the System Administrator operator group.  


  


CCrreeaattee  GGrroouupp  


To create a new Operator Group, proceed as follows: 


 


1. In Access, select Configuration>Operator Security. 


2. Click the  button. 


3. Enter an Operator Group Name. 


4. Click OK. 


 


OOppeerraattoorr  SSeeccuurriittyy  SSeeccttiioonnss  


The Operator Security screen consists of the following sections; configure each section for each 


Operator Group that you create. 


 


 Security Access—the Security Access section defines the Software interfaces that 


different Users have access to.  The Full Security access template is enabled by default.  


To change this, choose from a list of preset access template, or click the Advanced button 


to configure a new access template in the Security Control Panel. 


 Users—add Users to the database BEFORE assigning them to an Operator Group. 


 Tagholder Access Groups—the Tagholder Access Groups section specifies the Access 


Groups that the selected Operator has access to. 


 User Profiles—when adding Tagholders to the database, you may assign them to a User 


Profile.  However, you must create User Profiles in the Operator Group screen BEFORE 


you can assign Tagholders to them. 


 


SSeeccuurriittyy  AAcccceessss  SSeeccttiioonn  


Change Template 


1. To change to a different template, click the  button. 


2. Select another template from the drop-down list. 


3. Click the  button. 


 


Templates 


You can select default, pre-configured templates from the Security template name drop-down-


list.  These templates are not editable but are useful for standard Users.  Alternatively, create a 


new template as follows: 


 


1. Click the Advanced button. 


2. Click the  button.   
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Figure 46 – Add New Template Dialog 


 


3. In the Add New Template dialog, enter a Security template name. 


4. Select one of the following options as a starting point: 


 Deny All—all parts of ImproNet Access are restricted.  Use this option if you are only 


enabling a few items. 


 Full Access All—all parts of ImproNet Access are accessible.  Use this option if you 


are only restricting a few items. 


 Existing Template—the new template settings are the same as an existing template.  


Use this option if you are designing a template that is similar to an existing template and 


has only a few differences. 


5. Click the  button. 


 


Using the Security Control Panel 


The Security Control Panel lets you restrict access to almost every screen, section, or object in 


ImproNet Access.  Figure 47 shows the Security Control Panel.  ImproNet applications list in 


the left-hand pane.  When you select an application, its features display on tabs in the main 


Security Control Panel pane.   


 


To customize a template proceed as follows: 


 


1. Select each application one at a time. 


2. In the Main Pane, carry out one of the following: 


 Click the Full Access option to enable access to all items. 


 Click the Denied Access option to deny access to all items. 


 Click an item to toggle its accessibility—the Customised Access option is selected 


3. Click the  button to save. 
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Figure 47 – Security Control Panel 


 


UUsseerrss  SSeeccttiioonn  


Add Users to the database BEFORE assigning them to an Operator Group.   


 


To add users to the database, proceed as follows: 


 


1. In the Users panel, click the Advanced button.  The first time the Advanced button is 


clicked, the following dialog box displays. 


 


 
Figure 48 – Security Database Properties Dialog 


 


Use this window to specify or confirm the location of the Security Database that you are 


connecting to.  A default path is shown if a Database exists. 
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2. If no Database file path displays in the textbox, click the  button. 


3. Browse to the location of the Security Database (C:\Program Files\Firebird\Firebird_1_5). 


4. Select the security.fdb file. 


5. Click Open. 


 


 


The Security Database is installed to c:\program files\firebird\firebird_1_5 by default.  However, if 


the default directory does not exist, consult the person who installed the Firebird Database Server. 


 


6. Click the Test Connection button. 


7. If Access connects to the Security Database successfully, the  button turns green to let 


you save the setting. 


 


 


The location of the Security Database is saved in the Access.properties file.  Therefore, if the 


location of the Security Database changes, you must edit the last line of the Access.properties 


file to reflect the change. 


 


Add and Delete Users 


In the Users Panel, click the Advanced button. 


 


 
Figure 49 – Add/Edit Users Dialog 


 


In the Add/Edit Users dialog, do one of the following: 


 


 Click the  button to add a User. 


 Select a User and click the  button to delete them. 


 


  







Part 5 – Advanced Configuration 


52  January 2012 


Change Password 


In the Add/Edit Users dialog, proceed as follows to change a User’s password: 


 


1. Select a User. 


2. Click the  button. 


3. In the Old Password textbox, enter the OLD Password. 


4. Click the  button. 


5. In the New Password textbox, enter a NEW Password. 


6. In the Re-enter Password textbox, re-enter the NEW Password in confirmation. 


7. Click the  button. 


 


Assign Users 


1. Click the  button.  The Select Group’s Users dialog displays. 


2. Select users in the Available Users section. 


3. Click the  button to move them to the Assigned Users section. 


4. Click the  button. 


 


 


Use the  button to move all users at once. 


 


TTaagghhoollddeerr  AAcccceessss  GGrroouuppss  SSeeccttiioonn  


To edit the available Tagholder Access Groups, proceed as follows: 


 


1. Click the  button.  


 


 
Figure 50 – Tagholder Access Groups Dialog 
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2. In the Tagholder Access Groups dialog, select Access Groups in the Available Items 


section. 


3. Click the  button to move them to the Assigned Items section. 


4. Click the  button. 


 


 


Use the  button to move all Access Groups at once. 


 


UUsseerr  PPrrooffiilleess  SSeeccttiioonn  


A Tagholder assigned to a User Profile is visible and editable only to Security Users who are 


configured for the particular User Profile.   


 


For example, Andrew Young is an Operator Security User.  He belongs to an Operator Group 


called Operator Group 2—refer to Figure 51.  Andrew is assigned the Contract Staff and 


Casuals User Profiles.  This means that when Andrew uses Access, he can only see and edit 


Tagholders who are assigned to one of these groups.  Andrew will not see Tagholders belonging 


to other User Profiles. 


 


 
Figure 51 – User Profile Example 
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Create User Profile 


To create a User Profile, proceed as follows: 


 


1. In the User Profile section, click the Advanced button. 


2. From the Select Site drop-down menu, select a site. 


3. Click the  button. 


4. In the User Profile dialog, click the  button. 


5. Enter a User Profile Name. 


6. Click the  button. 


7. At the Confirm Insert dialog, click the No button.  (Clicking the Yes button adds the user 


profile to all operator groups). 


8. Click the  button. 


 


Assign User Profiles to Users 


Ensure that you select the correct Operator Group Name, then proceed as follows: 


 


1. In the User Profiles section, click the  button.   


2. Select User profiles in the Available Items section.   


3. Click the  button to move them to the Assigned Items section. 


4. Click the  button. 


 


 


Use the  button to move all User Profiles at once. 


 


Assign Tagholders 


Assign User Profiles to Tagholders in the Edit Tagholder screen.   


 


To do this, proceed as follows: 


 


1. In the Access, Navigator pane, click the  button. 


2. In the Main pane, select a Tagholder. 


3. Click the  button.  The Edit Tagholder screen displays. 


4. From the User Profile drop-down list, select a User Profile. 


5. Click the  button to save. 


 


 


If the All value is selected, the Tagholder is visible to Operator Security Users who are assigned any 


User Profile. 
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SMS Support on Events and Actions 


Purpose of this Feature 


The SMS Support on Events and Actions Feature allows an ImproX ECII Controller to send 


and respond to received SMS messages when certain trigger events occur.   


 


Example 


OOUUTTGGOOIINNGG  SSMMSS  ffrroomm  YYoouurr  IImmpprrooNNeett  SSyysstteemm  


You may only create this SMS action on the Controller; however, you may link the SMS action to 


ANY event on the Controller or any of its Terminals.   


An outgoing SMS sent by your ImproNet System could alert you of an alarm being triggered, 


such as a door forced, Anti-tamper, power failure, Emergency Mode on or Lock-down Mode on.   


 


IINNCCOOMMIINNGG  SSMMSS  ttoo  YYoouurr  IImmpprrooNNeett  SSyysstteemm  


Alternately an incoming SMS sent to your ImproNet System’s Controller, could activate or 


remove certain modes before you arrive at your site.  These SMS instructions could include, 


removing Lock-down Mode or Emergency Mode, or driving a relay thereby opening a door. 


 


Procedure 


 


 


Ensure that you unlock your ImproX RH for SMS support before continuing. 


 


Connect the USB GSM Modem to the ImproX ECII Controller. 


 


SSeett  GGSSMM  MMooddeemm  CCoonnffiigguurraattiioonn  


1. Open the Ethernet Discovery Utility. 


2. On the menu bar, go to Action>Search Local Subnet. 


3. Wait for the Controllers to display. 


 


 


On display of the Controllers and Terminals, the following icons appear:  the  icon represents 


unlinked Controllers.  The  icon represents Terminals and the  icon represents Controllers with 


linked Terminals.  On expanding the Controller tree, the  icon displays, with the linked Terminals 


displaying below.   


 


4. Select the Controller for configuration. 


5. On the menu bar, go to Action>Set GSM Modem Configuration. 


6. In the Device Password dialog, enter your password. 
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The default password is impro. 


 


7. Click on the  button. 


 


 
Figure 52:  Set GSM Modem Configuration Dialog 


 


In the Set GSM Modem Configuration dialog, configure the following: 


 


1. Device—depends on the Modem used. When using the Falcom Samba 75 Modem, select 


the /dev/ttyACM0 option.  When using the Falcom Samba 3G Modem, select the 


/dev/ttyUSB0 option. 


2. SMS Action Password—set this password for use when sending SMS messages.  This 


password prevents unauthorized applications from using the GSM service. 


3. Optional PIN (for SIM card)—enter your SIM card’s PIN if using one. 


4. Delay Interval—the interval in seconds between checking for SMS messages.  Change this 


setting only to ensure the best possible operation. 


5. Maximum Number of Pending Outgoing Messages—this setting limits the buffer in case 


an event repeatedly creates false messages.  Change this setting only to ensure the best 


possible operation. 


6. Initialisation String—depends on the Modem used.  Select AT+CPMS=”SM”,”SM”,”SM” 


recommended for both the Falcom Samba 75 Modem and the Falcom Samba 3G Modem. 


7. Click the  button to confirm. 


8. Close the Ethernet Discovery Utility. 


 


OOuuttggooiinngg  MMeessssaaggee  SSeettuupp  


Create a Message 


 


To create a new Message in Access, proceed as follows: 


 


1. In the Navigator Pane, click the  icon.   
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Figure 53:  Set GSM Modem Configuration Dialog 


 


2. In the Main Pane, click the Create SMS button. 


3. Select the required Phones to SMS radio button.  That is: 


 1—sends the message to a single cellular telephone. 


 2—sends the message to two cellular telephones. 


 3—sends the message to three cellular telephones. 


4. Based on the selection you made above, complete the highlighted Phone Number(s) text 


boxes. 


 


 


Specify the 2-digit country code (in the textbox directly after the ―+‖ symbol) even when the cellular 


telephone operates within the same region. 


 


5. Enter the Message content in the Message textbox.   


 


 


Ensure that your Message is NOT preceded by a numeric digit.  Numeric digits may however appear in 


the middle and at the end of your Message. 
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6. Click the  button. 


7. In the Message Exists dialog, make your selection: 


 Yes—overwrites the message selected when you pressed the Create SMS button.  The 


Message No confirmation dialog informs you of the message number used. 


 No—selects the next un-used message number and stores the message.  The 


Message No confirmation dialog informs you of the message number used.   


 Cancel—cancels the create sms process. 


 


Create an Action 


1. In the Navigator Pane, select an ECII Controller by clicking the  icon. 


2. In the Main Pane, select the Actions tab. 


3. Click the  button. 


4. From the Select Action Type drop-down list, select the SEND SMS option. 


5. In the Action Name textbox, assign your action a suitable name. 


6. Select the Time Pattern by clicking on the  button. 


7. Click the  button. 


8. In the New Action dialog, click the  button. 


9. In the Action Parameters dialog, select the Message number by clicking on the  button. 


10. Select a Message from the records displayed. 


11. Click the  button. 


12. In the Action Parameters dialog, click the  button. 


 


Link Action to an Event 


 


 


You may link the SMS action to any event on the Controller (or any of its Terminals).  When the event 


triggers (for example door forced) the SMS action takes place and an SMS sends to the cellular 


telephone numbers listed in the Message. 


 


1. In the Navigator Pane, select an ECII Controller by clicking the  icon. 


2. In the Main Pane, select the Actions tab. 


3. Click on the Active System Events button. 


4. From the Active System Event drop-down list, select an event. 


5. Alongside your first available action, (for example First Action, Second Action and so on), 


click the numeric Select Action button. 


 


 


In the Action Selector dialog, click on the Global button for a larger search result. 


 


6. From the Action Selector dialog, select the SMS action (created on the Controller). 


7. Click the  button. 


8. At the Active System Events Editor dialog, click the  button. 


 


When the event occurs, the SMS transmits (according to your action and Time Pattern settings) 


to your cellular telephone.     
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IInnccoommiinngg  MMeessssaaggee  SSeettuupp  


To set up incoming Messages for direction to your GSM Modem, continue as follows: 


 


1. From your cellular telephone, type your SMS. 


 


 


Ensure that your Message structure is as follows:   


<Action Number>,<Password>,<Confirm>,<Description>  


For example:  10,1234,c,Open Reception IN. 


Broken down, the Message structure is explained as follows: 


 Action Number—the number of the Action you want performed by the Controller. 


 Password—this is the SMS Action Password set up in the Ethernet Discovery Utility (refer to 


the section Set GSM Modem Configuration on page 55). 


 Confirm—enter the character ―c‖ if you want a confirmation SMS returned, or leave the field 


blank if you don’t want confirmation (for example:  10,1234,,Open Reception IN). 


 Description—this field is optional and is ignored by the ImproNet Software.  Use the 


Description field as a reminder as to what the Action does. 


 


2. Send the SMS to your GSM Modem (SIM Card). 
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Alarm Arming 


Purpose of this Feature 


The Alarm Arming feature, incorporated in ImproNet V7.60 upwards, monitors relays and 


drives digital inputs of third-party alarm panels.   


 


This feature therefore lets you arm and disarm your third-party alarm system direct from your 


ImproX Keypad Antenna Reader or Keypad Remote Reader.   


 


While your alarm panel is in an armed state, ImproNet denies access by Tagholders into or out 


of the armed Zone.   


 


Alarm Arming offers the following setup options:       


 


 Single Controller Configuration 


 Multiple Controller Configuration 


 


While using the Alarm Arming feature, you may still arm or disarm your alarm from your third-


party alarm panel. 


 


Example 


 


 


Ensure that you unlock your ImproX Registration Reader for Alarm Arming support before continuing. 


 


 


The Alarm Arming feature only works on sites using ImproX ECII Controllers.  On mixed sites using 


ImproX IC’s and EC’s, the feature is disabled. 


 


 


Figure 54  and Figure 55 show sample connections using the ImproX iTT.  You may however use other 


Terminals from the ImproX family, including the ImproX MfT (Firmware V7.18 and upwards only), 


ImproX iTRT, ImproX I16 or ImproX O16. 
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Figure 54:  Alarm Arming -  Single Controller Configuration 
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Figure 55:  Alarm Arming -  Multiple Controller Configuration 


 


Procedure 


 


 


The following procedure is for Alarm Arming setup using SINGLE CONTROLLER configuration.  For 


extra instructions relating to Alarm Arming across MULTIPLE CONTROLLERS, refer to the sections 


marked as being specific to Alarm Arming using Multiple Controllers. 


 


1. In Access, select the Zone in the Navigator Pane. 


2. Select the Alarm Zone checkbox. 


3. Click the  button. 







Part 5 – Advanced Configuration 


64  January 2012 


 


When you select the Alarm Zone checkbox, Access creates several extra default Actions needed by 


the Alarm Arming feature. 


 


If you remove Alarm Arming from a zone or common zone, deselecting the Alarm Zone checkbox only 


removes the extra Alarm Arming actions. Therefore, manually delete the Arm and Disarm relays and 


inputs making the Allowed Normal Relays available. 


 


Removing the Alarm Zone setting from a zone in a Common Zone, all zones in the common zone lose 


their Alarm Zone setting and their extra Alarm Arming actions. 


 


AAccttiioonn  SSeettuupp  


 


 


You may only set up one Arm Alarm System and one Disarm Alarm System Relay per Zone.   


 


 


Remember, all Zones under a Common Zone are treated as one Zone.  Therefore, you may only create 


one Arm Alarm System and one Disarm Alarm System Relay per Common Zone.    


 


 


Once a Relay is set up for Alarm Arming, you cannot use it for anything else.  Note also that you cannot 


edit the outputs for that Relay.   


 


Action 1 – Arm Alarm System Relay 


1. Select the Terminal that will control the Alarm Panel. 


2. In the Main Pain, select the Actions tab. 


3. Click the  button. 


4. From the Select Action Type drop-down list, select Arm Alarm System Relay. 


5. Give your action a suitable name. 


6. Click the  button. 


 


 
Figure 56:  Action Parameters Dialog 
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7. The Action Parameter settings vary according to the brand of third-party alarm panel in use.  


Please consult your alarm panel’s user manual for settings specific to your installation. 


8. Click the  button. 


 


 
Figure 57:  Warning Dialog 


 


9. At the Warning dialog, click the Yes button. 


 


Action 2 – Disarm Alarm System Relay 


1. In the Main Pain, select the Actions tab. 


2. Click the  button. 


3. From the Select Action Type drop-down list, select Disarm Alarm System Relay. 


4. Give your action a suitable name. 


5. Click the  button. 


 


 
Figure 58:  Action Parameters Dialog 


 


6. The Action Parameter settings vary according to the brand of third-party alarm panel in use.   


Please consult your alarm panel’s user manual for settings specific to your installation. 


7. Click the  button. 


 


 


Before deleting an Arm or Disarm Relay from a Zone or Common Zone that has Alarm Armed  or  


Alarm System Ready inputs, ensure that you delete the Alarm Arming Inputs and or Time Triggered 


Actions first.  Failure to delete the Alarm Arming Inputs and or Time Triggered Actions results in the 


appearance of an Error dialog. 
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IInnppuutt  SSeettuupp  


 


 


You may only set up one Alarm Armed and one Alarm System Ready input per Zone. 


 


 


Remember, all Zones under a Common Zone are treated as one Zone.  Therefore, you may only create 


one Alarm Armed and one Alarm System Ready input per Common Zone.    


 


General Input 1 


1. From the Main Pane, select the Input tab. 


2. From the displayed records, select General Input 1. 


3. Click the  button. 


4. At the Input Device dialog, in the Input Name textbox, assign your input a suitable name, 


for example Alarm Ready. 


5. From the Input Function drop-down list, select Alarm System Ready. 


6. Click the Input Parameters button. 


 


 
Figure 59:  Input Parameters Dialog 


 


7. The Input Parameter settings vary according to the brand of third-party alarm panel in use.   


Please consult your alarm panel’s user manual for settings specific to your installation. 


8. Click the  button. 


9. At the Input Device Dialog, click the  button. 


 


General Input 2 


1. From the displayed records, select General Input 2. 


2. Click the  button. 


3. At the Input Device dialog, in the Input Name textbox, assign your input a suitable name, 


for example Alarm Armed. 


4. From the Input Function drop-down list, select Alarm Armed. 


5. Click the Input Parameters button. 


6. The Input Parameter settings vary according to the brand of third-party alarm panel in use.   


Please consult your alarm panel’s user manual for settings specific to your installation. 


7. Click the  button. 


8. At the Input Device Dialog, click the  button. 


 


 


Failure to assign the Location or Zone an Alarm Arm or Disarm Alarm System Relay Action results in 


display of the Actions Required warning  dialog. 
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SSiittee  SSeettuupp  


1. From the Navigator Pane, select the  icon. 


2. In the Main pane, click on the Alarm Arming Settings button. 


 


 
Figure 60:  Alarm Arming Settings Dialog 


 


3. In the Alarm Arming Settings dialog, adjust the following settings: 


 Arming Delay (seconds)—the amount of time between issuing the arming request and 


ImproNet arming the alarm panel. 


 Arming Timeout (seconds)—if the alarm panel is not armed within the time period 


specified, the arming instruction fails. 


 Disarming Timeout (seconds)—if the alarm panel is not disarmed within the time 


period specified, the disarming instruction fails. 


 Pin Lockout Time (seconds)—the Terminal ―locks‖ for the specified time period, on 


successive entry of 3 incorrect PIN-codes. 


 Disarm Request (pin)—Select either Required or Not Required, thus indicating 


whether PIN-code entry is required or not required when disarming the alarm panel. 


4. Click the  button. 


 


 


You may NOT move a Terminal or Location with Alarm Armed or Alarm System Ready Inputs to 


another Zone with the same Inputs.  Attempting this move, results in the appearance of an Arming 


Conflict warning dialog. 


 


SSppeecciiffiicc  ttoo  AAllaarrmm  AArrmmiinngg  aaccrroossss  MMUULLTTIIPPLLEE  CCOONNTTRROOLLLLEERRSS  


Create the Common Zone 


1. From the Hierarchical Tree, select the  icon. 


2. From the No drop-down menu select an unused number. 


3. In the Name textbox, enter in a name for the Common Zone.  Alarm Common Zone is the 


preferred name. 


4. Complete the Description textbox. 


5. Click the  button. 


 


Create a New Alarm Zone 


1. On a separate Controller, create a new Alarm Zone. 


2. On the Main Pane, select the Alarm Zone checkbox. 
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Making this new Alarm Zone common with an existing Zone (that already has the Arm and Disarm 


Alarm System Relay Actions) means you cannot add these Actions to the new Alarm Zone. 


 


 


A common Alarm Zone performs in the same way as a stand-alone Alarm Zone; therefore, you can 


only control a single alarm panel within the common Zone. 


 


Setup the Common Zone 


1. From the Hierarchical Tree, select the Zone for which you created the relays Arm Alarm 


System Relay and Disarm Alarm System Relay, see Action Setup on page 64. 


2. In the Main Pane, from the Part of Common Zone drop-down menu, select the Common 


Zone you created earlier (that is Alarm Common Zone). 


3. Click the  button. 


 


AAcccceessss  TTiimmee  PPaatttteerrnn  SSeettuupp  


Setup your required Access Time Patterns, as follows: 


 


1. In Access in the Navigator Pane, click the  icon. 


2. Do one of the following: 


 Select an Access Time Pattern, and click the  button 


 Click the  button to create a new Access Time Pattern 


3. Enter a Description for the Access Time Pattern. 


4. Enter a Start Time. 


5. Enter the Duration in hours and minutes. 


6. Select the days of the week when the Access Time Pattern is enabled. 


 


AArreeaa  SSeettuupp  


1. In the Navigator Pane, click the  icon. 


2. In the Main Pane, click the  button. 


3. Enter an Area Name and Area Description. 


4. From the Hierarchical Tree select locations by clicking on them.    


5. Click the  button. 


 


TTaagghhoollddeerr  AAcccceessss  GGrroouupp  SSeettuupp  


 


 


The following settings do NOT apply to Visitor Tagholder Access Groups, therefore visitors do NOT 


have arming or disarming rights. 


 


1. In the Navigator Pane, click the  icon. 


2. In the Main Pane, click the  button. 


3. Enter a name in the Tagholder Access Group Name textbox.  


 


 


If you call your Tagholder Access Group “Reception” for example, we suggest you add the phrase 


With Arming to the name.  This will assist you when you assign the Tagholder Access Group later. 
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Figure 61:  Access Descriptions Dialog 


 


4. Alongside the Access Time Pattern textbox, click the Select button. 


5. From the list of records select an Access Time Pattern. 


6. Click the  button. 


7. Alongside the Area textbox, click the Select button. 


8. Select the Area you created earlier under Area Setup.  


 


 


The Area selection includes access and arming rights. 


 


9. Click the  button. 


10. Click the Advanced (1) button. 


11. In the Advanced Settings dialog, select the Alarm Arming tab. 


 


 
Figure 62:  Advanced Settings Dialog 
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12. On the Alarm Arming tab, select from the following options: 


 Allow Access for this Area—allows the user access to the area. 


 


 


If Allow Access for this Area is deselected, and the Allow Arming and Allow Disarming option is 


selected, the user could for example arm and disarm the System, but not physically enter the Zone. 


 


 Allow Arming of Alarm System for this Area—selecting this option gives the user 


permission to arm the Zone. 


 Allow Disarming of alarm System for this Area—selecting this option gives the user 


permission to disarm the Zone. 


13. Click the  button. 


14. At the Access Descriptions dialog, click the  button. 


 


 
Figure 63:  Access Window Showing Access Descriptions Summary 


 


The Access Descriptions pane highlighted in Figure 63 shows a summary of the settings you’ve 


applied earlier.  This Access Description information is read only.   


 


Edit your Tagholder Access Group by selecting the Tagholder Access Group record and 


clicking the  button.  Figure 63 shows record number 4 selected.    


 


TTaagghhoollddeerr  SSeettuupp  


1. In the Navigator Pane, click the  icon. 


2. In the Main Pane, do one of the following: 


 Click the  button to add a Tagholder. 


 Click the  button to edit a Tagholder. 


3. Enter the Tagholder’s First Name and Last Name. 


4. Complete other personal information as necessary. 


5. Select the Current checkbox to enable the Tagholder (selected by default).  


6. Use the Notes text area to enter other information about the Tagholder. 


7. In the PIN textbox, enter a PIN-code of up to 5 digits (required for disarming the alarm 


panel). 


8. Select the Tagholder’s Department from the Department drop-down list.   


9. On the Edit Tagholder dialog, click any of the New Tag buttons.   


10. On the Tag Details dialog, select one of the following Tag Options: 


 Normal—normal employee. 


 Suspend—Tag is suspended from all access on the Site. 
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 Blacklist—Tagholder is blacklisted and denied access to the Site. 


 Special Event 1—Tag raises an Event when presented to the Reader – in this case 


Special Event 1.  The Event can be linked to a specific Action. 


 Special Event 2—Tag raises an Event when presented to the Reader – in this case 


Special Event 2.  The Event can be linked to a specific Action. 


11. Configure the following: 


 APB Override—Tags are not subject to APB rules. 


 Report Always—all transactions for the Tag are written to the Database. 


12. Assign the Tagholder to a Site by selecting a value from the Site Assigned drop-down list. 


13. Assign the Tagholder to one or more Tagholder Access Group.  From the next available 


Group (1-10) drop-down list, select the Tagholder Access Group you created under the 


heading Tagholder Access Group Setup on page 68.  (For example Reception With 


Arming). 


 


 


At least one Tagholder Access Group must be assigned for the Tag to have any access rights. 


 


14. Present a Tag to an Enrollment Reader and click the Read Tag button.   


15. If the Tag Type is not displayed when the card is read, or if you are entering a Tag code 


manually, select the Tag Type from the drop-down list.   


16. Click the  button. 


17. Click the  button. 


18. At the Add or Edit Tagholder dialog, click the  button. 


19. Click the  button. 


 


FFuullll  UUppllooaadd  


Upload all data in the ImproNet Database to the Controllers:  


1. In Engine, click the  button. 


2. Click the  button. 


3. At the Confirm Upload dialog, click the Yes button. 


4. Click the button. 


 


AArrmmiinngg  aanndd  DDiissaarrmmiinngg  


 


 


Only arm or disarm the alarm from locations that you have rights to arm or disarm from. 


 


 


You may arm or disarm the Alarm using a Time Triggered Action.  See Part 3 – General Configuration 


for details on adding a Time Triggered Action. 


 


Zone Arming 


 


 


The * used below, represents the * button on either your Keypad Antenna Reader or Keypad Remote 


Reader.  Where the instructions state ** or *** this indicates that you must press the * button the 


respective number of times. 


 


 Arm Zone—* + present Tag. 


 Arm ALL Zones on the Controller—** + present Tag. 


 Arm ALL Zones on the Site—*** + present Tag. 
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Zone Disarming 


 


 


The # used below, represents the # button on either your Keypad Antenna Reader or Keypad Remote 


Reader.  Where the instructions state ## or ### this indicates that you must press the # button the 


respective number of times. 


 


 Disarm Zone—# + present Tag + enter PIN-code + #. 


 Disarm ALL Zones on the Controller—## + present Tag + enter PIN-code + #. 


 Disarm ALL Zones on the Site—### + present Tag + enter PIN-code + #. 


 


 


If during Site Setup (see page 67) you selected Not Required for the Disarm Request (pin) setting, 


you are NOT required to enter a PIN-code when disarming the alarm.  Please note however you are 


still required to press the # key after presenting your Tag. 


 


ZZoonnee  AArrmmiinngg  SSttaattuuss  


The Zone Arming Status dialog that indicates the Zones status: 


 


 
Figure 64:  Zone Arming Status Dialog 


 


Access the dialog, by right-clicking your mouse over the  icon and selecting Zone Arming 


Status from the shortcut menu. 


 


 When the lock icon is BLACK, this indicates the Zone is NOT READY. 


 When the lock icon is GREEN, this indicates the Zone is READY. 


 When the lock icon is RED, this indicates the Zone is ARMED. 


 


AAccttiioonn  BBuuzzzzeerr  aanndd  LLEEDD  SSttaatteess  


Table 1 below shows the buzzer and LED states for the following actions: 


 


Action State 


Buzzer—Armed Out of Sequence  Medium (60 seconds) 


Buzzer—Failed to Arm  High (20 seconds)


Buzzer—Failed to Arm All Zones  High (20 seconds)


Buzzer—No Arm Authority    High (20 seconds)


Buzzer—Zone Already Armed  Medium (20 seconds) 


Buzzer—Zone Armed  Medium (40 seconds) 


Buzzer—Zone Not Ready  High (20 seconds) 


LED—Armed Out of Sequence  Green Strobe Red (60 seconds) 
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Action State 


LED—Failed to Arm  Red (20 seconds) 


LED—Failed to Arm All Zones  Red (20 seconds) 


LED—No Arm Authority    Red (20 seconds) 


LED—Zone Already Armed  Green Strobe Red (20 seconds) 


LED—Zone Armed  Green (40 seconds) 


LED—Zone Not Ready  Red (20 seconds) 


Buzzer—Already Disarmed  Medium (20 seconds) 


Buzzer—Disarm Failed  High (20 seconds) 


Buzzer—Disarmed Emergency Unlock  Medium (60 seconds) 


Buzzer—Disarmed out of Sequence    Medium (60 seconds) 


Buzzer—No Disarm Authority  High (20 seconds) 


Buzzer—Zone Disarmed  Medium (40 seconds) 


LED—Already Disarmed  Green Strobe Red (20 seconds) 


LED—Disarm Failed  Red (20 seconds) 


LED—Disarmed Emergency Unlock  Green Strobe Red (60 seconds) 


LED—Disarmed out of Sequence    Green Strobe Red (60 seconds) 


LED—No Disarm Authority  Red (20 seconds) 


LED—Zone Disarmed  Green (40 seconds) 


Table 1 – Action Buzzer and LED States 


 


 


  







Part 5 – Advanced Configuration 


74  January 2012 


  







Part 5 – Advanced Configuration 


January 2012  75 


Supervisor Unlock 


Purpose of this Feature 


The Supervisor Unlock feature prevents general Tagholders from entering a Zone without prior 


entry by the Supervisor Tagholder. 


 


Procedure 


 
Figure 65:  Zone Configuration 


 


ZZoonnee  SSeettuupp  


1. In Access from the Navigator Pane, select the Zone for configuration. 


2. From the Anti-passback radio buttons, select the Strict choice. 


3. Click the  button. 


 


AArreeaa  SSeettuupp  


Supervisor Area 


1. From the Navigator Pane, select the  icon. 


2. Click the  button. 


3. In the Area Name textbox assign your Area a name (for example Supervisor Area). 


4. Assign a suitable Area Description. 


5. Select the zone you want to configure for Supervisor Unlock. (You may also add any other 


required zones at this point). 


6. Click the  button. 


 


General Area 


1. From the Navigator Pane, select the  icon. 


2. Click the  button. 


3. In the Area Name textbox assign your Area a name (for example General Area). 


4. Assign a suitable Area Description. 


5. Select ONLY the zone you want to configure for Supervisor Unlock.  


 


 


Ensure that this area contains only a single zone, otherwise Supervisor Unlock will NOT work. 
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6. Click the  button. 


 


TTaagghhoollddeerr  AAcccceessss  GGrroouupp  SSeettuupp  


Supervisor Tagholder 


 


 
Figure 66:  Access Descriptions Dialog 


 


1. From the Navigator Pane, select the  icon. 


2. Click the  button. 


3. Enter a name in the Tagholder Access Group Name textbox (for example Supervisor 


Access Group) 


4. Click the  button. 


 


Assign Access Time Pattern 


1. Click the top Select button to assign an Access Time Pattern to the Access Description.  


2. Click a Time Pattern Name to select it. 


3. Click the  button. 


 


Assign Area 


1. Click the bottom Select button to assign an Area to the Access Description.  


2. From the Area Name drop-down list, make your selection (for example Supervisor Area). 


3. Click the  button. 


 


5. Close the Access Descriptions dialog by clicking the  button. 
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General Tagholder 


 
Figure 67:  Access Descriptions Dialog 


 


1. From the Tagholder Access Groups Main Pane, click the  button. 


2. Enter a name in the Tagholder Access Group Name textbox (for example General 


Access Group). 


3. Click the  button. 


 


Assign Access Time Pattern 


1. Click the top Select button to assign an Access Time Pattern to the Access Description.  


2. Click a Time Pattern Name to select it. 


3. Click the  button. 


 


Assign Area 


1. Click the bottom Select button to assign an Area to the Access Description.  


2. From the Area Name drop-down list, make your selection (for example General Area). 


3. Click the  button. 


 


Advanced Configuration 


1. Click the Advanced (1) button. 


 


 
Figure 68:  Advanced Settings Dialog 
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2. Select the Supervisor Unlock tab. 


3. From the Select Supervisor Group for Unlocking Zone drop-down list, select the 


Supervisor Access Group you created earlier. 


4. Click the  button. 


5. Close the Access Descriptions dialog by clicking the  button. 


 


TTaagghhoollddeerr  SSeettuupp  


From the Navigator Pane, select the  icon. 


 


Supervisor Tagholder 


1. Open the appropriate Tagholder record for editing. 


2. Select the Tag for editing. 


3. Assign the Tagholder to the Supervisor Tagholder Access Group by selecting Supervisor 


Access Group from the next available Group (Group1 to Group 10) drop-down list. 


4. Click the  button. 


5. Click the  button. 


6. Close the Edit Tagholder dialog by clicking the  button. 


 


General Tagholder 


1. Open the appropriate Tagholder record for editing. 


2. Select the Tag for editing. 


3. Assign the Tagholder to the General Tagholder Access Group by selecting General Access 


Group from the next available Group (Group1 to Group 10) drop-down list. 


4. Click the  button. 


5. Click the  button. 


6. Close the Edit Tagholder dialog by clicking the  button. 


 


ZZoonnee  CCoonnffiigguurraattiioonn  


 
Figure 69:  Zone Configuration 


 


1. In Access from the Navigator Pane, select the Zone you configured earlier. 


2. From the Supervisor Group for this Zone drop-down menu, select the Supervisor 


Access Group option you created earlier. 


3. Click the  button. 
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Door Strike Lock Setup 


Purpose of this Feature 


The Door Strike is the usual mechanical type of lock but with an electromechanical action 


enabling it to be actuated by the presence or absence of a current flowing through an internal 


solenoid.   


 


Follow the procedure below in order to setup your Door Strike Lock in the ImproNet Software. 


 


Procedure 


 
Figure 70:  Access Dialog 


 


IInnppuutt  CCoonnffiigguurraattiioonn  


1. Select the specific Terminal that will control the Strike Lock (for example Gate 01 IN as 


highlighted in Figure 70). 


2. In the Main Pane, select the Inputs tab. 


3. Click the  button. 


4. In the Input Device dialog, assign your input a name (for example Door Open Sensing). 


5. From the Input Function drop-down list, select the Door Open Sensor choice. 


6. Click the Input Parameters button. 


7. In the Input Parameters dialog, select the Door Open is Open Contact radio button. 


8. Click the  button. 


9. At the Input Device dialog, click the  button. 


 


AAccttiioonn  CCoonnffiigguurraattiioonn  


1. In the Main Pane, select the Actions tab. 


2. Click the  button. 


3. In the New Action dialog, from the Select Action Type drop-down list, select Relay. 


4. Assign your action a meaningful name (for example Stop Relay Drive Entry). 
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5. Assign your action a meaningful time pattern. 


6. Click the  button. 


 


 
Figure 71:  Action Parameters Dialog 


 


7. From the Relay Activate/Deactivate group, select the Deactivate Relay radio button. 


8. In the Duration (0.1s) textbox, set the duration to 65535. 


9. Click the  button. 


10. Click the  button. 


11. In the Main Pane, click the Active System Events button. 


12. Click the Advanced button. 


 


Door Open Sensing Door Open Normal 1 


1. From the Active System Event drop-down list, select Door Open Sensing Door Open 


Normal 1. 


 


 
Figure 72:  Active System Events Editor Dialog 
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2. Alongside the First Action textbox, click the 1 button. 


3. From the list of displayed action records, select the action you created under Action 


Configuration in 4 (Stop Relay Drive Entry).  


4. Click the  button. 


 


Door Open Sensing Door Open Too Long 1 


1. From the Active System Event drop-down list, select Door Open Sensing Door Open 


Too Long 1. 


 


 
Figure 73:  Active System Events Editor Dialog 


 


2. Alongside the First Action textbox, click the 1 button. 


3. From the list of displayed action records, select the action you created under Action 


Configuration in 4 (Stop Relay Drive Entry).  


4. Click the  button. 


5. At the Active System Events dialog, click the  button. 


 


 


USER NOTES 
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Chapter 1:  Web-based QuickTag Module 


Introduction 


GGeenneerraall  


The web-based QuickTag Module is intended for use for example, by an operator using a PC at 


a location remote from the System‘s Access Host PC.  This Module requires no extra ImproNet 


software installation, simply installing Java Runtime Environment V1.60 and above allows any 


member of your staff access to the Module.     


 


The Module‘s basic function is enrolling Tags so employee Tagholders and visitor Tagholders 


may access selected areas at named times.  As this is an enrolment Module, each PC running 


the web-based QuickTag Module must connect to a Registration Reader.  The benefit of running 


this now entirely web-based Module, is less bandwidth usage promoting improved network 


speed.   You may use the web-based QuickTag Module with Windows® Internet Explorer 7 (and 


above) or alternatively Firefox 2 (and above).   


 


IInnssttaalllliinngg  JJaavvaa  RRuunnttiimmee  EEnnvviirroonnmmeenntt  ((JJRREE))  


1. Using your Internet browser enter the following URL:  www.java.com. 


2. On the Home Page, click on the Free Java Download button. 


 


 


Alternatively, open the JRE folder on your ImproNet installation CD.  Double-click your mouse pointer 


over the jre-6u7-windows-i586-p.exe file starting the installation on the client machine. 


 


3. At the Internet Explorer – Security Warning dialog, click the Install button. 


4. At the Java Setup – Welcome dialog, click the Accept > button. 


5. At the Java Setup – Complete dialog, click the Finish button. 


6. Close your Internet browser. 


7. Restart your PC. 


 


PPrrooppeerrttiieess  FFiillee  


The properties file is PC (workstation) specific, meaning that the file location is hard coded.  The 


properties file lets you change the number of records displayed per page.  Change this setting 


as follows: 


 


 


If you change the property settings, while working in the Web-based QuickTag Module, shut down the 


Browser for the changed settings to take effect. 


 


 


The settings referred to in the following paragraph refer to a default installation. 


 


1. From C:\ImproNet\quicktag open the QuickTag.properties file. 


2. Change the quicktag.loading.records.show= setting to a number between 1 and 200. 


3. Save the properties file. 



http://www.java.com/
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Starting up the Web-based QuickTag Module 


 


Ensure that you do NOT open more than 1 instance of this Module per PC workstation. 


 


 


Where your Controllers connect via RS485, do NOT run the Enrollment Client on the same PC as the 


Engine Module. 


 


 


If the Web Server resides on a Port other than Port 80, the URL becomes:  


http://localhost:XX/quicktag/thin_client.html.  The XX highlighted in the URL refers to the new Port 


number, for example 82, 83 or 84 and so on. 


 


To open ImproNet Access, continue as follows: 


 


1. In Windows®, click Start>Programs>ImproNet>Access. 


2. Enter your Username and Password. 


 


 


The default username is SYSDBA.  The default password is masterkey.  The Password is case-


sensitive. 


 


3. From the Menu Bar, select the Web Clients>QuickTag. 


 


 


Alternately using a separate PC workstation, with Engine running on the Database Server, start up the 


Module as follows: 


1. Using your Internet browser in the Address Bar, enter the phrase Localhost (and if necessary 


the Port Number).  


2. At the landing page, select the  (Web Enrollment) icon. 


 


4. In the Warning – Security dialog, select the Always Trust Content from this Publisher 


checkbox. 


5. Click the Run button. 


 


 
Figure 1 – Warning – Security Dialog 


 



http://localhost:XX/quicktag/thin_client.html
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Restarting the Module (on that specific client PC) for future use will NOT display the Warning – Security 


dialog. 


 


6. At the Login dialog, enter your Username and Password. 


 


 
Figure 2 – Logon Dialog 


 


 


The default username is SYSDBA and the default password is masterkey.  The Password is case-


sensitive. 


 


7. Click the OK button. 


 


 
Figure 3 – Web-based QuickTag – Employees Tab 
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UUsseerr  IInntteerrffaaccee  


below is a brief description of all the fields associated with the web-based QuickTag Module, the 


information displayed in these fields and button functions:  


 


The standard buttons: Search, Add, Edit and Refresh are available at the bottom of the 


screen.  Move between Tagholder records by using the back and forward buttons displayed at 


the bottom of Figure 3. 


 


Item Description 


Site Allows the selection of another Site, to enable Site specific 


Tagholders to be viewed. 


Show Current Tagholders 


Only 


When checked, only current Tagholders display; if not checked, all 


past Tagholders also display. 


Read Tag Button Allows the Tag code of a Tag presented to the Tag Registration 


Reader to be read and then displayed in the cell adjacent to the 


button. If the Tagholder exists in the table, the Tagholder's record 


is selected in the table. 


Tag Type Indicates the type of Tag read. 


Employees Tab  


No System assigns the next logical number. 


Title Tagholder‘s title that is Mr., Miss or Dr and so on. 


First Name Tagholder first name displays in this field. 


Last Name Tagholder last name displays in this field. 


Department Tagholder‘s Department name displays in this field. 


Employee No Tagholder‘s employee number displays in this field. 


Find (Field) Enables search for specific name. 


On Column Allows searching by: No, Title, First, Second Name, Last Name, 


ID and so on. 


Table 1 – Web-based QuickTag – Employees Tab Screen 


 


The Employees‘ tab displays by default, displaying data about all Tagholders related to the Site 


(see Figure 3).   


 


 Select another Site by making your selection from the Site drop-down list. 


 The Employees’ (and Visitors’) tab defaults to show all current Tagholders only.  To show 


past and current Tagholders, uncheck the Show Current Tagholders Only checkbox. 


 Check Tag numbers by clicking the Read Tag button.  The Tag code displays in the textbox 


alongside the button.  The grid selection moves to the Tagholder to whom the Tag belongs 


(if it finds one). 


 To find Tagholder information, from the on Column drop-down list, select in which column to 


search. 


 In the Find field type-in the required text.  The program searches for the closest match to 


the entered text (incremental search). 


 Click the Refresh button to update data changed in the Employees‘ and Visitors‘ tabs. 


 You may set the sort order of the records by right-clicking your mouse over any column 


header and selecting either Sort Ascending or Sort Descending. 


 You may show or hide columns, by right-clicking your mouse over any column header and 


select the Column option.  Select or deselect the checkboxes to show or hide the columns 


as you require. 
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Employee Tagholder Configuration 


To configure QuickTag data, continue as follows: 


 


AAddddiinngg  ((oorr  EEddiittiinngg))  aa  TTaagghhoollddeerr  


On the Employees tab, click the  (or ) button.     


 


 
Figure 4 – Add or Edit Tagholder Dialog 


 


Add/Edit Tagholder 


 


 


The minimum information needed for the System to accept the data is the First Name and Last Name 


fields. 


 


1. Enter the Tagholder‘s First Name and Last Name. 


2. Complete other personal information as necessary. 


3. Select the Current checkbox to enable the Tagholder (selected by default).  If this Current 


checkbox is unchecked, the Tagholder is inactive in the system.   


4. Use the Notes text area to enter other information about the Tagholder. 


5. Enter a PIN-code of up to 5 digits, if required. 


6. In the Department field select the required Department from the drop-down list.   
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Add Department 


1. Click the Departments button.  


 


 
Figure 5 – Add New Department Dialog 


 


2. In the Department Editor, click the  button. 


 


 
Figure 6 – Department Editor Dialog 


 


3. In the Departments field, type-in the new Department Name. 


4. Click the  button to accept the new Department into the System. 


5. Return to the Add/Edit Tagholder dialog by clicking the  button. 


 


Adding a Tagholder Image 


1. Click on the Browse button. 


2. From the Choose File dialog, navigate to and select your image file. 


3. Click the Open button. 


 


 


Where you insert an image smaller than 200 x 170 pixels, the image keeps its dimensions.  Where you 


insert an image larger than 200 x 170 pixels, the image shrinks to 200 x 170 pixels. 
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Add New Tag 


1. To save the Tagholders details, click the  button.   


2. Click the New Tag button.   


 


 


In an IXP400 System, 4 New Tag buttons activate, allowing allocation of up to 4 Tags to the same 


person.  In an IXP400i System, 8 New Tag buttons activate, allowing allocation of up to 8 Tags to the 


same person.     


 


 
Figure 7 – Tag Details Dialog 


 


3. On the Tag dialog, select one of the following Tag Options: 


 Normal—normal employee. 


 Suspend—Tag is suspended from all access on the Site. 


 Blacklist—Tagholder is blacklisted and denied access to the Site. 


 Special Event 1—Tag raises an Event when presented to the Reader. 


 Special Event 2—Tag raises an Event when presented to the Reader. 


4. Configure the following: 


 APB Override—Tags are not subject to APB rules. 


 Report Always—all transactions for the Tag are written to the Database. 


5. From the Site Assigned to drop-down list, assign the Tagholder to a Site. 


6. From the Group1 to 10 drop-down lists, assign the Tagholder to a Tagholder Access Group.  


 


 


At least one Tagholder Access Group must be assigned for the Tag to have any access rights.  In an 


IXP400 System a Tagholder can have up to 3 different Tagholder Access Groups.  In an IXP400i 


System a Tagholder can have up to 10 different Tagholder Access Groups.   


 


7. Present a Tag to an Enrollment Reader and click the Read Tag button.   


8. Select the Tag Type from the drop-down list.   


 


 


To create a Personal Access Code (PAC) only, select the Personal Access Code option from the Tag 


Type drop-down list and enter the PAC in the Tag Code textbox. 


 


 


The Start Date field can remain blank for indefinite validity.   
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Start Date Configuration 


a. In the Tag dialog, select the Start Date textbox.   


b. Select the Year using the  and  arrow buttons. 


c. Select a Month using the  and  arrow buttons.  


d. Click on the Date required in the grid. 


 


Expiry Date Configuration 


a. In the Tag dialog, select the Expiry Date textbox.   


b. Select the Year using the  and  arrow buttons. 


c. Select a Month using the  and  arrow buttons.  


d. Click on the Date required in the grid. 


 


 


From the Tag dialog, remove a Tag from the System by selecting the Tag and clicking the  button. 


 


9. At the Tag dialog, click the  button. 


10. Click the  button. 


11. At the Add/Edit Tagholder dialog, click on the  button.  


12. Click the  button. 


 


SSeeaarrcchhiinngg  ffoorr  TTaagghhoollddeerrss  


 
Figure 8 – Tagholder Search Facility 


 


1. In the on Column drop-down list, select the Search Category. 


2. In the Find field, type in the relevant Tagholder data. 


3. Click the  button. 


 


DDeelleettiinngg  aa  TTaagghhoollddeerr  


 


 


Hide Tagholders from display by making them non-current. 


 


A user cannot delete any Tagholder data because of the Systems reporting requirements.  The 


Tagholders data is maintained in the database for security, Tag history and personnel history 


reasons.  You may however, delete or reassign the Tags themselves to another user.   
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Visitor Tagholder Configuration 


Click the Visitors’ tab.  The QuickTag – Visitors‘ tab displays all data concerning all visitor 


Tagholders related to the Site.  When you want to select another Site, make your selection from 


the Site drop-down list. 


 


 
Figure 9 – Web-based QuickTag – Visitors Tab 


 


Visitors Tab Item Description 


No System allocates the next logical number. 


Title Tagholder‘s title for example Mr., Miss or Dr and so on. 


First Name Tagholder‘s first name is displayed in this field. 


Last Name Tagholder‘s last name is displayed in this field. 


Company Visitor‘s company name is displayed in this field. 


Hosted Checkbox indicating whether visitor is hosted or not. 


Table 2 – Web-based QuickTag – Visitors Tab Screen 


 


 


Refer to Table 1 for field and button descriptions not listed here (fields are identical). 
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AAddddiinngg  ((oorr  EEddiittiinngg))  aa  TTaagghhoollddeerr  


The configuration procedures for Visitors Tags are similar to that of the Employees Tags, except 


that some additional data is required as described below.  Refer to the section Adding (or 


Editing) a Tagholder on page 9 for procedures not found here.  To add (or edit) a Visitors 


Tagholder, continue as follows: 


 


On the Visitors tab, click the  (or ) button.   


 


 
Figure 10 – Add or Edit Tagholder Dialog 


 


Add/Edit Tagholder 


 


 


The minimum information needed for the System to accept the data is the First Name and Last Name. 


 


1. Enter the Tagholder‘s First Name and Last Name. 


2. Complete other personal information as necessary. 


3. Select the Current checkbox to enable the Tagholder (selected by default).  If this Current 


checkbox is unchecked, the Tagholder is inactive in the system.   


4. Use the Notes text area to enter other information about the Tagholder. 


5. Enter a PIN-code of up to 5 digits, if required. 


6. In the Department field select the required Department from the drop-down list. 
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For details of adding extra departments, refer to the section Add Department on page 10 for more 
information. 
 
For details of adding an image, refer to the section Adding a Tagholder Image on page 10 for more 
information. 
 


Adding a Company Name 


If the Company name does not exist, continue as follows: 


1. Click the  alongside the Company drop-down list. 


2. In the Company dialog, click the  button. 


3. In the Company textbox, enter a company name. 


4. Click the  button. 


5. Select the company name from the display pane. 


6. Click the  button. 


 


 


Delete a Company Name by clicking on the  button, selecting the company name and clicking 


the  button. 


 


Add/Edit Tagholder  


1. Select the Was Hosted checkbox. 


2. From the Hosted By drop-down list, select an employee name. 


 


 


This Host must precede the visitor at each Location, presenting their Tag before the Visitor presents 


their Tag.  About 10 seconds is allowed between presentation of the two Tags. 


 


3. To save the Tagholders details, click the  button.   


4. Click one of the New Tag buttons.   


5. On the Tag dialog, select one of the following Tag Options: 


 Normal—normal employee. 


 Suspend—Tag is suspended from all access on the Site. 


 Blacklist—Tagholder is blacklisted and denied access to the Site. 


 Special Event 1—Tag raises an Event when presented to the Reader. 


 Special Event 2—Tag raises an Event when presented to the Reader. 


6. Configure the following: 


 APB Override—Tags are not subject to APB rules. 


 Report Always—all transactions for the Tag are written to the Database. 


7. From the Site Assigned to drop-down list, assign the Tagholder to a Site. 


8. From the Group 1 to 10 drop-down lists, assign the Tagholder to a Tagholder Access 


Group.  


 


 


At least one Tagholder Access Group must be assigned for the Tag to have any access rights.  In an 


IXP400 System a Tagholder can have up to 3 different Tagholder Access Groups.  In an IXP400i 


System a Tagholder can have up to 10 different Tagholder Access Groups.  


 


9. Present a Tag to an Enrollment Reader and click the Read Tag button.   


10. Select the Tag Type from the drop-down list.   


 


For Start Date configuration details, refer to the section Start Date Configuration on page 12 for 


more information.   
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For Expiry Date configuration details, refer to the section Expiry Date Configuration on page 12 


for more information. 


 


 


Ensure the Start Date and Expiry Date are not more than 7 years apart. 


 


11. At the Tag dialog, click the  button. 


12. Click the  button. 


13. At the Add/Edit Tagholder dialog, click on the  button.  


14. Click the  button. 


 


For information on searching for visitor Tagholders, refer to the section Searching for 


Tagholders on page 12. 


 


For information on deleting visitor Tagholder information, refer to the section Deleting a 


Tagholder on page 12. 
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Chapter 2:  QuickTag Module 


Introduction 


The QuickTag Module is for use, for example, by an operator using a PC remote from the 


System‘s Access Host PC.  This Module could typically be installed on a PC in the Reception 


Area.   


 


The QuickTag Module is a rapid Tagholder/Tag entry Module for enrolling both Employees and 


Visitors into the Access Control System.  This Module‘s basic function is to add Tags so 


Employees and persons visiting the company may have access to selected areas at named 


times. 


 


This Module also allows the Supervisor to disable certain editing features, thus improving the 


security of this Module.  By disabling these features, the operator has limited access and 


therefore cannot change any sensitive setting in the System.  Each button within the application 


can be disabled. 


 


The QuickTag Software Module has been designed with user-friendliness as a major design 


criterion.  The Application Window has a menu at the top and two Tabs below.  The System 


defaults to Employees Tab, where the relevant Tagholder data is displayed in the panel.  The 


Visitors Tab displays only visitor Tagholder data in its panel.   


 


It is assumed that after installing the QuickTag Utility Software that this application will run 


continuously 24 hours a day.  However, if the application is shutdown or the PC needs rebooting 


continue as outlined below, Starting up the QuickTag Module. 


 


Starting up the QuickTag Module 


To run the Software, proceed as follows:   


 


 


In sites with low bandwidth requirements, or where you need to load Tagholders quickly, we 


recommend using pagination.   


 


When running QuickTag on a PC separate from the Access PC, edit the access.properties file 


(tagholders.max.rows=0 setting).  By default the setting is 0, indicating pagination is not activated.  


Activate pagination, by entering a number in the range of 1 to 99.  The number you select is the 


maximum number of rows displayed where using pagination.   


 


For more information on this feature, refer to Part 3 – General Configuration.     


 


1. Click on Start>Programs>ImproNet>QuickTag. 


2. Enter your Username (SYSDBA) and Password. (masterkey).  The Password is case-


sensitive. 
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For the security of the database the software installer may have changed the QuickTag Module‟s 


default Password (using IBConsole).  This may not be a problem on a separate PC. 


 


3. Click the  button. 


 


 
Figure 11 – QuickTag – Employees Tab Screen (with Pagination Enforced) 


 


UUsseerr  IInntteerrffaaccee  


below is a brief description of all the fields associated with the QuickTag Module, the information 


displayed in these fields, and button functions: 


 


The standard buttons: Search, Add, Edit and Refresh are available on the screen. 


 


Item Description 


Site Allows the selection of another Site, to enable Site specific 


Tagholders to be viewed. 


Show Current Tagholders 


Only 


When checked, only current Tagholders display; if not checked, all 


past Tagholders also display. 


Read Tag Button Allows the Tag code of a Tag presented to the Tag Registration 


Reader to be read and then displayed in the cell adjacent to the 


button. If the Tagholder exists in the table, the Tagholder's record 


is selected in the table. 


Employees Tab  


No System assigns the next logical number. 


Title Tagholder‘s title that is Mr., Miss or Dr and so on. 


First Name Tagholder first name is displayed in this field. 


Last Name Tagholder last name is displayed in this field. 
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Item Description 


Department Tagholder‘s Department name is displayed in this field. 


Employee No Tagholder‘s employee number is displayed in this field. 


Find (Field) Enables search for specific name. 


On Column Allows searching by: No, Title, First, Second Name, Last Name, 


ID and so on. 


Select Button Allows Tagholders to be chosen in subsets that is Names, 


Department, Gender and so on. 


Table 3 – QuickTag Associated Fields 


Employee Tagholder Configuration 


To configure QuickTag data, continue as follows: 


 


The Employees‘ tab is the default.  The QuickTag – Employees‘ tab similar to Figure 11, 


displays all data about all Tagholders related to the Site.  When you want to select another Site, 


make your selection from the Site drop-down list. 


 


 The Employees and Visitors tabs default to show all current Tagholders only.  To show 


past and current Tagholders, uncheck the Show Current Tagholders Only checkbox. 


 For Tag numbers to be checked click the Read Tag button.  This number will be displayed in 


the box next to the button.  The grid selection moves to the Tagholder to whom the Tag 


belongs, if it finds one. 


 To find Tagholder information in the on Column field, click the arrow button to view the 


drop-down list.  From the drop-down list select the column to search. 


 In the Find field type-in the required text.  The program searches for the closest match to 


the entered text (incremental search).  It will only search the subset available on the screen 


(i.e. the subset selected by the filtering facility). 


 Click the Refresh button to update data that has been changed in the Employees and 


Visitors tabs. 


 


AAddddiinngg  aa  TTaagghhoollddeerr  


Table 4 details the fields associated with the Add Tagholders dialog: 


 


Item Description 


Picture Frame Photograph of Tagholder, if available. 


Title Tagholder‘s title for example Mr., Miss or Dr and so on. 


First Name Tagholder‘s first name. 


Middle Name Tagholder‘s middle name. 


Last Name Tagholder‘s last name. 


Suffix Tagholder‘s letters that is Jr. PhD, CA. 


ID Tagholder‘s personal Identity Number. 


PIN Pin code, if required (minimum of four digits and a maximum 5 


digits). 


Gender Tagholder‘s gender. 


Current Makes the Tagholder current or not current. 


Department Department selection for Tagholder. 
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Item Description 


User Profile Related to Operator Security, this drop-down lets you assign 


Tagholders to Operator Groups. 


Tagholder Type This value, once captured in the master table, lets the third-


party Time and Attendance Software determine who to 


calculate and who not to calculate.  For Sites using third-party 


Time and Attendance Software we therefore recommend that 


you select the Access and Time option, for all other 


installations select the Access Only option. 


Employee No Tagholder‘s employee number. 


Employer No Company employer number. 


Position Tagholder position within the company. 


Notes Comments about the Tagholder. 


New Tag Buttons Allows creation of a new Tag for the Tagholder. 


Departments Button Allows a new Department to be added. 


Custom Fields Button Lets you create any extra fields you may need.  For example, 


there is no field where you may enter the Tagholders home 


address or telephone number.   


User Profile Allows selection of a User Profile from drop-down list. 


Table 4 – Add Tagholder Fields 


 


 
Figure 12 – Add Tagholder for Employees Dialog 


 


To add a new Employee Tagholder, continue as follows: 


 


1. In QuickTag, on the Employees tab, click the  button.   


2. Complete as many of the fields shown as are required.   


 


 


The minimum information needed for the System to accept the data is the First Name and Last Name 


fields and selection of a Department. 


 


3. In the Department field select the required Department from the drop-down list.  If a 


Department list exists advance direct to step 8, or if not, continue with step 4. 
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4. Click the Departments button.  


 


 
Figure 13 – Add New Department Dialog 


 


5. In the Department Editor, click the  button. 


 


 
Figure 14 – Department Editor Dialog 


 


6. In the Departments field, type-in the new Department Name. 


7. Click the  button to accept the new Department into the System. 


 


 


Delete a Department from the list by highlighting the Department concerned in the Department Editor 


screen, and then clicking the  button.   


 


8. Return to the Add Tagholder dialog by clicking the  button. 


9. To save the Tagholders details, click the  button.   


10. Click the New Tag button.   


 


 


In an IXP400 System, 4 New Tag buttons activate, allowing allocation of up to 4 Tags to the same 


person.  In an IXP400i System, 8 New Tag buttons activate, allowing allocation of up to 8 Tags to the 


same person.     
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Figure 15 – Tag Details Dialog, New Tag Read 


 


Item Description 


Normal Normal Employee. 


Suspend Checked – if all access for a particular Tag is suspended. 


Blacklist Checked – if Tagholder is to be denied access to the company. 


Special Events, 1 and 2 Used where Tagholders are admitted for specific events, such 


as a demonstration. 


APB Override APB override enables the Tagholder to override the APB 


constraint condition on the doors to which he or she has 


access. 


Report Always Checked – Reports all transactions. 


Site Assigned Allows the selection of the applicable Site. 


Tagholder Access Group  


Group 1 to 10 Access Group/s assigned to the Tag. 


Tag Type The type of Tag selected. 


Tag Code Displays the unique Tag code number of the current Tag. 


Read Tag Button Allows the Tag code of a Tag presented to the Tag reader 


(ProxMate) to be read and then displayed in the Tag Code field. 


Copy Existing Tag Code 


Button 


Copies the Tag code for use in sites with Tags and biometric 


facilities, thus upholding Anti-passback (APB) rules. 


Biometric Enrollment Button Opens the Biometric Enrollment dialog. 


Start Date Displays the date when the Tag will be activated– yyyy mm dd.  


(0 = Indefinite). 


Pick Start Date Button Allows start date to be set. 


Expiry Date Displays the date when the Tag will expire – yyyy mm dd.        


(0 = Indefinite). 


Pick End Date Button Allows end date to be set. 


Expiry Time Allows the expiry time to be set (in hours). 


Table 5 – Edit Tag Details 


 


11. Click the appropriate checkboxes to select any of the functions as listed 


12. In the Site Assigned field select the required Site from the drop-down list.   


13. In the Tagholder Access Groups field.  Select the required access group/s from the drop-


down list. 
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In an IXP400 System a Tagholder can have up to 3 different Tagholder Access Groups.  In an IXP400i 


System a Tagholder can have up to 10 different Tagholder Access Groups. 


 


 


If a Sagem Fingerprint Reader is installed then select Sagem Reader from the Tag Type. Use the ID No 


to insert into the Tag Code Field, and then click Read Tag.  The Sagem Reader will read the 


Fingerprint and store the coding required.  Similar alteration may be required for the Handkey or the 


Bioscrypt Readers.   Refer to the Impro publication „IXP System-compatible Biometric Readers 


Installation and User Guidelines‟. 


 


14. Place the Tag in the recess of the Tag Enrollment Reader and then click the Read Tag 


button.   


 


 


The Tag‟s code number and type display in the Tag Type and Tag Code Fields. 


 


 


The Start Date field can remain blank for indefinite validity.   


 


Start Date Configuration 


 
Figure 16 – Calendar Dialog 


 


a. In the Tag Details dialog, click the Pick Start Date button.   


b. Select a Month and a Year using the  and  arrow buttons. 


c. Click on the Date required in the grid. 


 To clear the selected date in the grid, click the Clear button. 


 To specify an indefinite time period, click the Zero Date button (not recommended). 


d. Click the  button. 


 


Expiry Date Configuration 


a. In the Tag Details dialog, click the Pick End Date button.   


b. Select a Month and a Year using the  and  arrow buttons. 


c. Click on the Date required in the grid. 


 To clear the selected date in the grid, click the Clear button. 


 To specify an indefinite time period, click the Zero Date button (not recommended). 


d. Click the  button. 
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In the Tag Details dialog, remove a Tag from the System by first selecting the Tag for deletion and then 


clicking the  button. 


 


15. Click the  button to accept the new Tagholder data. 


16. Click the  button to return to the Add Tagholder for Employees dialog. 


17. Click on the  button to accept the complete record for the new Tagholder.    


18. Click the  button to return to the QuickTag – Employees Tab Screen. 


 


QQuuiicckk  SSeeaarrcchh  ffoorr  TTaagghhoollddeerr  


To search for a Tagholder, proceed as follows: 


 


1. Select the search criteria from the on Column drop-down-list.   


2. Enter the search text into the Find textbox. 


3. If you have pagination enabled, click the  button. 


 


 


Visitor Tagholder Configuration 


Click the Visitors’ tab.  The QuickTag – Visitors‘ tab displays all data concerning all visitor 


Tagholders related to the Site.  When you want to select another Site, make your selection from 


the Site drop-down list. 


 


 
Figure 17 – QuickTag – Visitors’ Tab  (with Pagination Enforced) 


 


Visitors Tab Item Description 


No System allocates the next logical number. 


Title Tagholder‘s title for example Mr., Miss or Dr and so on. 
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Visitors Tab Item Description 


First Name Tagholder‘s first name is displayed in this field. 


Surname Tagholder‘s last name is displayed in this field. 


Company Visitor‘s company name is displayed in this field. 


Hosted Employees name is displayed in this field. 


Table 6 – Visitors Tab Items 


 


 


Refer to QuickTag – Employees Tab screen for field and button descriptions not listed here as the 


fields are identical. 


 


AAddddiinngg  aa  TTaagghhoollddeerr  


The configuration procedures for Visitors Tags are similar to that of the Employees Tags, except 


that some additional data is required as described below.  Refer to the section Adding a 


Tagholder on page 19 for procedures not found here.  To add a new Visitors Tagholder, continue 


as follows: 


 


1. In the Visitors tab click the  button.   


 


The Add Tagholder for Visitors dialog similar to that shown below displays.  The screen and 


procedure is similar to that for Employees.  The difference is the three items mentioned below: 


 


 
Figure 18 – Add Tagholder for Visitors Dialog 


 


Item Description 


Company Visitor‘s company name. 


Was Hosted Checked – if visitor is to be escorted by an employee. 


Hosted By Employees name is displayed in this field. 


Table 7 – Add Tagholder Screen 
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Figure 19 – Company Dialog 


 


2. Click on the  button alongside the Company drop-down list. 


3. In the Company dialog click the  button. 


4. In the Company field type in the name of the visitor‘s company.   


5. Click the  button.  


 


 


Delete a Company Name by clicking on the  button and highlighting the name (see Figure 19), and 


then clicking the  button. 


 


6. Select the Was Hosted checkbox. 


7. From the Hosted By drop-down list, select an employee name. 


 


 


This Host must precede the visitor at each Location, presenting their Tag before the Visitor presents 


their Tag.  About 10 seconds is allowed between presentation of the two Tags. 


  


Advanced Search 


Where you have not implemented the pagination feature, search for a specific Tagholder as 


follows: 


 


 
Figure 20 – Select Search Dialog 


 


1. Click on  button. 
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2. In the Select By field, select the required field from the drop-down list. 


3. From the Middle drop-down, select the required option.  Refer to the section Search 


Operators for more information. 


4. In the Right-hand textbox, capture the search text. 


5. Click the Select button to begin the search. 


 


SSeeaarrcchh  OOppeerraattoorrss  


 = means the same as—use = to search for exact matches to your keyword 


 != means not equal to—use != to search for Tagholders that do not match your keyword.  


For example, use != to search for Tagholders that are not in a particular Department 


 LIKE means same first character—use LIKE to search for Tagholders if you are unsure of 


a spelling.  For example, if you know that a Tagholders Last Name is Johnson, but you are 


unsure how to spell it, enter the character J into the keyword textbox.  All Tagholder records 


that have Last Names beginning with a J are returned 


 


AAvvaaiillaabbllee  SSeeaarrcchh  FFiieellddss  


The first drop-down list in the Select Search window contains the following fields: 


 


Field Name Description Search Criteria 


No Tagholder‘s unique ID assigned by ImproNet Number 


Title Tagholder‘s title.  For example, Mr, Mrs, or Prof. Text 


First Name Tagholder‘s first name Text 


Second Name Tagholder‘s second or middle name Text 


Last Name Tagholder‘s last name Text 


Suffix Tagholder‘s name suffix. For example, John Doe Jr Text 


ID Number of Tagholder‘s ID Document or Passport Number 


Gender Male or Female M or F 


Pin PIN-code for use with Keypad Terminals Number 


Type Tagholder type, 0 (Employee) or 1 (Visitor) Number 


Current Employee The Tagholder is currently employed, that is 0 (Not 


Current) or 1 (Current) 


Number 


Position Tagholder‘s status in the company Text 


Department Tagholder‘s department Text 


Employee Number Tagholder‘s number assigned by their company Number 


Table 8 – Available Search Fields 
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Editing Tagholders  


EEmmppllooyyeeeess  TTaagghhoollddeerr  


 
Figure 21 – Edit Tagholders for Employees Dialog 


 


 


The descriptions of the fields in the top pane, and bottom row of buttons are the same as for the Add 


Tagholder for Employees dialog.  The only difference between the dialogs is the addition of the Third-


party Application button to the Edit Tagholders for Employees dialog.  Clicking on this button runs a 


third-party application such as WordPad.  Holding down the Ctrl button while clicking on the Third-party 


Application button lets you change the application selection. 


 


To edit an existing Employee Tagholder, continue as follows: 


 


1. In the Employees tab, click the  button.   


2. Click on the First, Previous, Next and Last buttons to navigate through the Tagholder‘s data.  


3. To edit the existing Tag in this example, click on the Tag 1 button.   


4. To edit the Tagholder Access Groups, click on the arrow icon of the appropriate drop-


down list. 


5. To edit the Site Assigned applicable to this Tag, click on the arrow icon of the Site Assigned 


drop-down list. 


6. You may also edit other parameters such as Suspend, Report Always, Blacklist, APB 


Override and Start/End Dates. 


 


 


To remove a Tag from the System, first select the Tag to be Deleted and then click on the  button. 


 


7. Click on the  button to accept the changed Tagholder data, and the  button to return to 


the Edit Tagholder for Employees dialog. 


8. Click on the  button to accept the changes to the record for the updated Tagholder. 


9. Click the  button. 


 


 


When adding another new Tag for this Tagholder, click on the New Tag button in the Edit Tagholder for 


Employees dialog.   
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VViissiittoorrss  TTaagghhoollddeerr  


The edit procedures for Visitors Tags are similar to that of the ―Employees Tags‖, except for 


Company, Was Hosted and Hosted By fields. 


 


 
Figure 22 – Edit Tagholders for Visitors Dialog 


 


To edit an existing Visitors Tag, continue as follows: 


 


In the Visitors tab, click on the  button.   


 


To check descriptions for fields and buttons refer to the section Adding a Tagholder on page 19.  


For editing procedures, refer to the section Editing Tagholders, Employees Tagholder on page 


28. 


 


EEddiittiinngg  aa  DDeeppaarrttmmeenntt  NNaammee  


To edit an existing Department follow the procedure described in the section Adding a Tagholder 


on page 19. 


 


DDeelleettiinngg  aa  TTaagghhoollddeerr  


A user cannot delete any Tagholder data because of the reporting requirements of the System.  


The Tagholders data is maintained in the database for reasons such as security, Tag history and 


personnel history.  However, the Tags themselves can be Deleted and/or reassigned to another 


user.   


 


 


To hide Tagholders from the normal grid display they should be made non-current. 
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Chapter 3:  Visitors Module 


Introduction 


The Visitor Module is designed to be used, for example, by an operator using a PC remote from 


the Systems Access Host PC.  This Module could typically be installed on a PC in the Reception 


Area.   


 


The Visitor Module is a rapid Tagholder/Tag Entry Module for enrolling visitors into the Access 


System.  It is intended to be a front-desk, Reception area, application.  This Module‘s basic role 


is to add Tags so persons visiting the company may have access to selected areas at specified 


times. 


 


This Module also has the facility of setting up Visitor‘s Tags.  Using Visitor Tags prevents visitors 


from gaining access to a door unless a Host Employee first presents a Tag.  After presentation 


of the Host Employees Tag, the visitor must present their Visitor Tag within ten seconds.  This 


facility improves security by not allowing visitors to walk freely into sensitive non-visitor areas. 


 


The Visitor Software Module has been designed with user-friendliness as a major design 


criterion.  The application window has a Menu at the top and two Tabs below.  The module 


defaults to Panel View Tab, where Tagholders can be added.  The Visitors Tab lists all visitors to 


the Site. 


 


It is assumed that after the installation of the Visitor Utility Software that this application will run 


continuously 24 hours a day.  However, if the application is required to be shutdown or the PC 


needs to be switched off and restarted continue with the following: 


 


Starting the Visitor Module 


To run the Software, continue as follows: 


 


1. Click on Start>Programs>ImproNet>Visitor. 


2. Enter your Username and Password. 


 


 


The default username is SYSDBA.  The default password is masterkey.  The Password is case-


sensitive. 


 


When the Visitor Module installation is complete, the Password should be changed to uphold 


the security of the database within the System. 
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VViissiittoorrss  SSccrreeeenn  FFiieellddss  aanndd  BBuuttttoonnss  


Panel View 


 
Figure 23 – Visitor Access – Panel View Screen 


 


Table 9 offers a brief description of all the fields associated with the Visitor Access screen, the 


information displayed in these fields and what are the button‘s functions. (The standard 


Movement, Add, Edit, Refresh and Cancel button descriptions are not repeated): 


 
 


Panel View Tab Data 


Picture Frame Photograph of the Tagholder (if available). 


MST SQ Number Tagholder number (Master Sequence Number). 


Title Tagholder‘s title that is Mr., Miss or Dr and so on. 


First Name Tagholder‘s first name. 


Middle Name Tagholder‘s middle name. 


Surname Tagholder last name. 


Suffix Visitors Letters that is Jr, PhD and so on. 


Company Visitors company name. 


Department Tagholder‘s Department name. 


Gender Tagholder‘s gender. 


ID Number Tagholder‘s personal identity number. 


PIN Number 
Pin code number, to be added, if necessary, for security (minimum 


of 4 digits and a maximum 5 digits). 


Panel View Site SLA Displays the Site on to which visitors are being added or edited. 


Table 9 – Panel View Tab 
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Grid View 


 
Figure 24 – Grid View Screen – Visitor Tagholders 


 


Grid View Tab  Description 


Show Current Tagholders 


Only 


When Checked only current Tagholders are displayed; if unchecked 


all past Tagholders will also be displayed. 


Read Tag 


Allows the Tag code of a Tag presented to the Tag reader 


(ProxMate) to be read and then displayed in the cell alongside the 


button. 


On Column Allows searching by: first name, surname, title, Department and so 


on. 


Visitors Tab  


No System gives the next logical number. 


Title Tagholder‘s title that is Mr., Miss or Dr and so on. 


First Name Tagholder‘s first name is displayed in this field. 


Surname Tagholder‘s last name is displayed in this field. 


Company Visitors company name. 


Hosted Employees name is displayed in this field. 


Table 10 – Grid View Tab 
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Visitors Tagholder Configuration 


To configure Visitor data, proceed as follows: 


 


The Panel View screen is the default however you may use the Grid View screen if preferred.  


There is no difference in the final entry details.   


 


1. Visitors tabs, default to show all current Tagholders only.  To show past and current 


Tagholders, uncheck the Show Current Tagholders Only box. 


2. For Tag numbers to be checked click on the Read Tag button.  This number will be 


displayed in the box next to the button. 


3. To find Tagholder information in the on Column field, select the column in which to search 


from the drop-down list. 


4. In the Find field type-in the required text.  The program searches for the closest match to 


the entered text (incremental search).  It will only search the subset available on the screen 


(that is the subset selected by the filtering facility). 


5. Click on the  button to update data that has been changed in the Employees and Visitors 


tabs. 


 


Adding a Visitors Tagholder 


 
Figure 25 – Add Visitors Tagholder Dialog 


 


Item Description 


Picture Frame Photograph of Tagholder, if available. (Use Jpeg format). 


Title Tagholder‘s title for example Mr, Miss or Dr and so on. 


First Name Tagholder‘s first name. 


Middle Name Tagholder‘s middle name. 


Last Name Tagholder‘s last name. 


Suffix Tagholder‘s Letters that is Jr, PhD. 


ID Tagholder‘s personal identity number (PIN) when applicable. 
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Item Description 


PIN Allocated Access Pin code number (maximum 5 digits). 


Gender Tagholder‘s gender. 


Current Show past and current Tagholders. 


Department Department selection for Tagholder. 


Company Visitor‘s company name. 


Was Hosted Checked - If a visitor is to be escorted by an employee. 


Hosted By Allows selection of employee names for Host. 


Notes Comments about the Tagholder. 


New Tag Buttons Allows assigning of new Tags to the Tagholder. 


Departments Button Allows a new Department to be added. 


Company Button Allows a new company to be added. 


User Profile Allows a User Profile to be selected from a drop-down list. 


Table 11 – Add Visitor Tagholder Fields 


 


To add a new Visitors Tagholder, continue as follows: 


 


1. In Visitors, in either Grid view or Panel view, click the  button.   


2. Complete as many of the fields shown as are required.   


 


 


The minimum information required for the System to accept the data is the First Name and Last Name 


fields. 


 


3. In the Department field select the required Department from the drop-down list.  If a 


Department list exists advance direct to step 8, or if not, continue with step 4. 


4. Click the Departments button.  


5. In the Department Editor, click the  button. 


6. In the Departments field, type-in the new Department Name. 


7. Click the  button to accept the new Department into the System. 


 


 


Delete a Department from the list by highlighting the Department concerned in the Department Editor 


screen, and then clicking the  button.   


 


8. Return to the Add Tagholder dialog by clicking the  button. 


9. To save the Tagholders details, click the  button.   


10. Click the New Tag button.   


 


 


In an IXP400 System, 4 New Tag buttons activate, allowing allocation of up to 4 Tags to the same 


person.  In an IXP400i System, 8 New Tag buttons activate, allowing allocation of up to 8 Tags to the 


same person.     


 


11. In the Tag Details dialog, click the appropriate checkboxes. 


12. In the Site Assigned field select the required Site from the drop-down list.   


13. In the Tagholder Access Groups field.  Select the required access group/s from the drop-


down list. 


 


 


In an IXP400 System a Tagholder can have up to 3 different Tagholder Access Groups.  In an IXP400i 


System a Tagholder can have up to 10 different Tagholder Access Groups. 
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14. Place the Tag in the recess of the Tag Enrolment Reader and then click the Read Tag 


Button.   


 


 


The Tag‟s code number and type display in the Tag Type and Tag Code Fields. 


 


 


The Start Date field can remain blank for indefinite validity.   


 


Start Date Configuration 


 
Figure 26 – Calendar Dialog 


 


a. In the Tag Details dialog, click the Pick Start Date button.   


b. Select a Month and a Year using the  and  arrow buttons. 


c. Click on the Date required in the grid. 


 To clear the selected date in the grid, click the Clear button. 


 To specify an indefinite time period, click the Zero Date button (not recommended). 


d. Click the  button. 


 


Expiry Date Configuration 


a. In the Tag Details dialog, click the Pick End Date button.   


b. Select a Month and a Year using the  and  arrow buttons. 


c. Click on the Date required in the grid. 


 To clear the selected date in the grid, click the Clear button. 


 To specify an indefinite time period, click the Zero Date button (not recommended). 


d. Click the  button. 


 


 


In the Tag Details dialog, remove a Tag from the System by first selecting the Tag for deletion and then 


clicking the  button. 


 


15. Click the  button to accept the new Tagholder data. 


16. Click the  button to return to the Add Tagholder for Employees dialog. 


17. Click on the  button to accept the complete record for the new Tagholder.    


18. Click the  button to return to the QuickTag – Employees Tab Screen. 
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SSeelleecctt  FFuunnccttiioonn  


Reduce the number of Tagholders viewed at one time, to a chosen subset, using the  button. 


 


EEddiittiinngg  VViissiittoorr  TTaagghhoollddeerrss  


To edit an existing Visitors Tagholder, select the name from the list, click the  button, and then 


continue as described previously. 


 


DDeelleettiinngg  TTaagghhoollddeerrss  


A user cannot Delete any Tagholder data.  Tagholder data is maintained in the database due to 


the reporting requirements.  The Tagholders data is stored in the database for reasons such as 


security, Tag history, personnel history and visitor history.  However the Tags can be Deleted 


and/or reassigned to another user.   


 


 


To hide Tagholders from the normal grid display they should be made non-current. 


 


TTrraannssllaattiioonn  --  LLooccaalliissaattiioonn  


This application is provided with English text.  If Localisation of the text is required, it may be 


dynamically translated making use of the locale and translate functions.  Translated text is 


stored in property resource files, which should then be distributed with the application. 


 


 


The translation changes only take effect after you close and re-open the Visitor Module. 
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Chapter 4:  Transaction Viewer Module 


Introduction 


The Transaction Viewer Software Module has been designed with user-friendliness as a major 


design criterion.   


 


The Transaction Viewer client gives a live real-time view of Access in the System.  It displays 


the names of the access points and details of the person who entered or exited that location.  


The process can be set to monitor the whole Site, or just a selected zone or access point.  It 


supports imaging functionality as well.   


 


The Transaction Server must be running on the Engine (this is the default setting) to enable the 


Transaction Viewer Client application.  This is set in the properties file on the line 


engine.Site.Site.startTransactionServer = true (set false to disable the service).   


 


The Transaction Viewer client process may be run on any machine on the network, and more 


than one client can run simultaneously. 


 


 


The Transaction Viewer is only a live real-time application.  It does not retain and later display any 


historical transactions should the Transaction Viewer have been switched off for any reason. 


 


We assume that after the installation of the Transaction Viewer Utility Software that this 


application will run continuously 24 hours a day.  However, if the application is shutdown or the 


PC needs rebooting, proceed as follows: 


 


Starting the Transaction Viewer Module 


To run the Software, proceed as follows: 


 


1. Click on Start>Programs>ImproNet>Transaction Viewer. 


2. Enter your Username and Password. 


 


 


The default username is SYSDBA.  The default password is masterkey.  The Password is case-


sensitive. 


 


When the Database installation is complete, the Password should be changed for the security of 


the Database. 


 


1. From the Transaction Host Selection dialog, select the required host. 
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Figure 27 – Transaction Host Selection Dialog 


 


Item Description 


Host Name of Host PC. 


I.P. Host PC address. 


Site Site name or number. 


Table 12 – Transaction Host Selection 


 


2. Select the Host and click the OK button. 


 


 


If the Engine is not running an error message “Could not locate server” displays and the program 


closes.   


 


 
Figure 28 – Transaction Viewer Real-time Screen Example 


 


 


Colouration:  


Alarm Transactions appear in Red. 


Denied Transactions appear in a Red/Pink mix. 


Status Transactions appear in Blue.   
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TTrraannssaaccttiioonn  VViieewweerr  SSccrreeeenn  FFiieellddss  aanndd  BBuuttttoonnss  


Below is a brief description of all the fields associated with the Transaction Viewer Module, the 


information displayed in these fields and the button‘s functions: 


 


Fields and Buttons Description 


Type Type of event. 


Time Time when event occurred. 


Event Name of the event. 


Terminal Name of the Terminal. 


First Name Tagholders first name. 


Last Name Tagholders surname. 


Tag No Permanent number assigned to Tag. 


Freeze Button Stops further transactions from appearing. 


Connected to Site Displays the currently connected Site. 


Filters Show transactions occurring for this Zone, Location or 


Terminal. 


Transaction Types Show particular transaction types.  Filters show or hide 


transactions types Access, Alarm or Status. 


Access Only Access transactions. 


Alarm Only Alarm transactions. 


Status Only Status transactions. 


Display Image Checked – will display a photograph of Tagholder. 


Close Button This button closes the screen. 


On-Line Mode Toggles between online and freeze modes. 


Advanced Messaging Used to display messages to a third-party display panel.   


Table 13 – Transaction Viewer Screen Fields 


 


CCoonnffiigguurriinngg  TTrraannssaaccttiioonn  VViieewweerr  PPrroocceedduurreess  


To configure Transaction Viewer data, proceed as follows: 


 


The Transaction Viewer Real-time Screen similar to that shown in Figure 28 is the default 


screen.  This screen displays real-time data concerning all transactions related to the Site 


selected in the Transaction Host Selection Dialog shown on the previous page. 


 


1. In the Connected to Site field, the Site that was selected (Site: 01000000) in the 


Transaction Host Selection Dialog similar to that shown earlier displays. 


2. In the Zones field select the required zone from the drop-down list. 


3. In the Locations field select the required location from the drop-down list. 


4. In the Terminals field select the required Terminal from the drop-down list. 


5. In the Transaction Type field click the appropriate checkboxes to select any of the following 


types of transactions: 


 Access—all access transactions display. 


 Alarm—all alarm transactions display. 


 Status—all status transactions display. 


 


 


The two greyed out checkboxes are not available in this release. 
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6. To display photographs of the Tagholders.  Click the Display Image checkbox. 


 


 


To select another Tagholder click the required name from where the real-time transactions are being 


displayed. 


  


7. Click the Advanced Messaging checkbox.  If there is no default message refer to 


Configure Messaging Data on a Display Unit on page 42. 


8. The Freeze button toggles between Freeze and Online.   


 


 


To stop more transactions from appearing on the screen click the Freeze button; the button‟s name 


changes to Online.  No other transactions will display, allowing the user to inspect certain Tagholders 


data.  To enable the real-time viewing click the Online button. 


 


9. To shut down the Transaction Viewer, click the Close button. 


 


Configure Messaging Data on a Display Unit  


To configure Messaging data on a Display Unit, proceed as follows: 


 


1. From the menu bar select Configuration. 


2. Click Message Settings.  


 


 
Figure 29 – Display Message Setting Dialog 


 


Fields Description 


Display Number 1 - 15 (The number of units allowed). 


Select the DL Unit Type of unit and its logical address. 


Select Terminal Name of selected terminal. 


Display Name Name given to a display unit. 


Display Address Displays units address (Polycomp Display). 


Default Message - 


Line 1 – 3 


A predefined message associated with the display. 


Table 14 – Display Message Setting Fields 
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3. In the Display Number field select the Display Number from the drop-down list. 


4. Click the Display Name field and type in an appropriate name for the display unit. 


5. In the Select DL Unit field select the unit from the drop-down list. 


6. Click the Display Address field and type the address of the display unit. 


7. In the Select Terminal field select the Terminal from the drop-down list. 


8. The Default Message field represents what the unit (Polycomp) will display when no 


messages are being sent to it. 


9. Click the Apply button to accept the changes to the message settings. 


10. Click the Close button to reject the changes to the message settings and return to the 


Transaction Viewer real-time display. 


 


EEddiittiinngg  aa  DDeeffaauulltt  MMeessssaaggee  


1. From the menu bar, select Configuration. 


2. Click Message Settings.   


3. In the Display Number field select the required number from the drop-down list. 


4. Click the Edit button, this enables all fields of the selected display number to now be edited.   


 


 


Only click the Edit button when you want to edit the DL and then select the combo boxes. 


 


5. Click the Apply button to accept the changes to the message settings. 


6. Click the Close button to reject the changes to the message settings and return to the 


Transaction Viewer Real-time display. 


 


DDeelleettiinngg  aann  EExxiissttiinngg  MMeessssaaggee  


1. From the menu bar, select Configuration. 


2. Click on Message Settings.   


3. In the Display Number field select the required message number of the message for 


deletion. 


4. Click the Delete button. 


5. Click the Close button to return to the Transaction Viewer Real-time Screen. 
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Chapter 5:  Access/QuickTag Options 


Introduction 


This chapter includes added Modules common to both Access and QuickTag not described 


elsewhere in the Software Installation Guide. 


 


Live Video Image Capture  


PPuurrppoossee  ooff  tthhiiss  FFaacciilliittyy  


The Live Video Image Capture feature enables capture of photographs (recommended 


resolution 640 x 480 pixels) of Tagholders using live video from a web camera. The camera is 


connected to the Host PC used for registration or enrollment. Photographs captured in this way 


are inserted into the stored Tagholders data and displayed in the Add Tagholder or Edit 


Tagholder screens for that Tagholder.  Photographs (in suitable formats, with a recommended 


resolution of 640 x 480 pixels) can also be loaded from files and inserted in the same way. 


PPrroocceedduurree  


To add a picture of the employee: 


 


1. Open either the Add Tagholder or Edit Tagholder dialog. 


2. Click anywhere inside the picture frame at the left of the dialog.   


 


 
Figure 30 – Photograph Edit Menu 
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The Photograph Edit Menu offers the following options: 


 


Option Description 


Capture Allows capture of image from suitable video device. 


Load from file Allows loading of image from file (Jpeg, Gif or Tiff format only). 


Edit Allows editing of the Tagholder image. 


Clear Image Settings Removes any saved edit operations that result from using the Image 


Editor. 


Delete Deletes the image from the Database. 


Table 15 – Photograph Edit Menu Options 


 


Capture an image from video: 


 


3. From the Photograph Edit Menu, select Capture. 


4. If this is the first time this web camera is being used, the dialog shown below appears: 


 


 
Figure 31 – Detect Capture Device Dialog 


 


5. From the next Select Capture Device dialog, from the Available Devices drop-down list, 


select the required device. 


6. From the Select Format drop-down list, select the format required.   


 


 
Figure 32 – Select Format 


 


 


After the camera has been set up as described, the first window that appears when Capture is selected 


in the Tagholders dialog will be the Capture window. 
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Figure 33 – Capture Window 


 


7. In the Capture window click the  button to capture the image.   


8. Click the  button. 


9. Click the  button to save the Tagholder‘s information. 


 


 


If you select the  button in the Capture window, the dialog with the Select Format drop-down list 


appears. 


 


Adding a Photograph 


 


 


By selecting the Load From File option, you may also load a suitable digital picture (640 x 480 pixels) 


from a file.  The picture appears in the box in the Add (or Edit) Tagholder dialog, in the same way as a 


captured video picture. 


 


 
Figure 34 – Photograph Added to Tagholder Data 
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Tag Expiry Time  


PPuurrppoossee  ooff  tthhiiss  FFaacciilliittyy  


The Tag Expiry Time feature lets you set the expiry time on a given Tag to the nearest hour if an 


expiry dates selected. 


 


EExxaammppllee  


A contractor has been issued with a Tag for access from 07 November 2007 to 31 December 


2007. The expiry time for this Tag is to be set to 10 pm on the 31 December 2007. 


 


PPrroocceedduurree  


 
Figure 35 – Tag Expiry time setting 


 


 


Similar details apply when you edit an existing Tagholder‟s information. 


 


1. In Access, in the Navigator Pane select the  icon. 


2. For the purpose of the above example, in the Main Pane, select the Visitors tab. 


3. In the Add Tagholders dialog, complete, at minimum, the First Name and Last Name 


details. 


4. Click the  button. 


5. Click the New Tag button. 


6. In the Tag dialog, complete the Tag Options, Tagholder Access Groups and Tag Code 


information. 


7. Click the Pick Start Date button. 


8. Select a start date from the Calendar. 


9. Click the button. 


10. Click the Pick End Date button. 


11. Select an end date from the Calendar. 


12. Click the button. 
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13. For the purpose of the above example, scroll the Expiry Time field to 22. 


14. Click the  button. 


15. Click the  button. 


16. Click the  button. 


 


Inputs support triggering of Emergency and Lockdown Modes  


PPuurrppoossee  ooff  tthhiiss  FFeeaattuurree  


This feature allows you to set the Emergency or Lockdown Mode using an input to any 


selected Terminal. 


 


EExxaammppllee  


A storeroom containing archive files is full, and there is no need for regular access, and, 


because of confidentiality requirements, a need to prevent normal access.  Set Input 1 of the 


Entry Terminal to Lockdown Mode to prevent access by all Tagholders. 


 


PPrroocceedduurree  


 
Figure 36 – Input Selection 


 


1. In Access, in the Navigator Pane select the required Terminal. 


2. In the Main Pane select the Inputs tab for that Terminal. 


3. Select the required input. 


4. Click the  button. 
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Figure 37 – Input Device Dialog 


 


5. From the Input Function drop-down list, select Lockdown Mode. 


6. Click the  button. 


 


 


The procedure for allocating Emergency Mode to an input is similar. 
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Chapter 6:  Graphics Designer Module 


Introduction 


The Impro Graphics Designer Software lets you create a graphic representation of the 


physically installed hardware on your Site.    


 


We suggest that Graphics Designer be installed on a secure PC to limit the possibility of the 


setup being tampered with.  


 


RReeqquuiirreemmeennttss  


 
Figure 38 – Optional Client Software Modules (Graphics Designer, Graphics Runtime) 


 


 


Installing on Windows® NT, Windows® 2000, Windows® XP Professional or Windows® Vista 


(Business or Ultimate) requires that the Installer log-on to the PC with Administrator privileges. 


 


Before installing and implementing the Graphics Designer Software there are some important 


requirements: 


 


 The Graphics display needs access to the System Database to identify and access the 


available ImproX units.  This implies that you can remotely situate the Graphics PC, as long 


as it has a LAN connection to the ImproNet Database.  


 Before installing and configuring Graphics Designer, ensure that you prepare the Base plan, 


Ground plan and Building Floor plans. 


 The plans needed must be in Jpeg or .gif format.  These do not have to be intricate detailed 


architectural drawings.  They can be roughly drawn or scanned images.  What is important 


is the location of the various devices that are to be monitored  must be accurately named 


and located. 
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 You may install Graphics Designer on any one, or more, computers which are part of an 


ImproNet access control network.  Graphics Designer does not have to be installed on the 


server that handles the Firebird Database.  It does, however, need access to the server via 


the network to maintain contact with the Database from which the names, numbers and 


activity of the installed units derive. 


 


Configuration of the Software 


 


To ensure that your ImproNet Database is updated, ensure that Access is started and configuration is 


complete before starting Graphics Designer. 


 


 


When upgrading your System, please ensure the Database is updated using the Database Upgrade 


facility. 


 


GGrraapphhiiccss..PPrrooppeerrttiieess  


There are several files in the ImproNet Installation that have to have a common address.  These 


are the ‗properties‘ files which in the case of the Graphics designer are stored as a text file 


called ‗graphics.properties‘ in the directory C:\Impronet. 


 


Of these the graphics.database.interbase.url entry, =jdbc\: firebirdsql.…. etc, is important.  Each 


of the programs installed as part of the System has a properties file and in each the address 


must be the same in order that the same database is referenced.  In addition the 


graphics.database.interbase.encoding entry must reference the same encoding type.  In the 


above case UTF8 is the default. 


 


For most installation actions the properties files are automatically installed and will be correct.  


If, though, for instance, you change the Database PC or you move the Database to another PC, 


and the Graphics PC is a different computer, then the addressing will need verification and 


possibly change.  Only in exceptional cases will there be any need to corroborate any of the 


other entries. 


 


 


Activate the Custom Application and Message features by changing the graphics.startCustom 


Actions = false entry to true in the Graphics.Properties file.  See page 62 for more information. 


 


DDaattaabbaassee  SSeettttiinnggss  


This information is supplied for reference only; the Access Control System should already be 


configured for the correct database encoding.  You will notice the Software CD references three 


versions of the Database.   


   


 Western Europe and North America use the ISO 8859_1 encoding. 


 Eastern Europe uses Cp1250.  


 And the Far East uses Unicode UTF8.  


 


These were originally supplied for different regions of the world, however now all regions default 


to UTF8.  The default database installs to the directory c:\?????\database.  The question marks 


indicate the installation directory (typically and by default, this is called ‗Impronet‘).   
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If you wish to use a different encoding, copy one of the databases found in the 


"c:\????\database\empty databases" folder into c:\????\database folder, overwriting the UTF8 


database already located there (this is NOT recommended).   


Make this alteration before starting up the Software.  If the Database is changed for a different 


encoding, then reset the Software controls to use the encoding of the Database.  


 


SSttaarrttiinngg  GGrraapphhiiccss  DDeessiiggnneerr  


1. Click on Start>Programs>ImproNet>Graphics Designer. 


2. Enter your Username (SYSDBA) and Password (masterkey).  The Password is case-


sensitive. 


 


Operation of the Software 


 
Figure 39 – Startup Screen 


 


AAllllooccaattiioonn  ooff  PPllaannss  


Allocate the Plans according to the following sequence: 


 


1. Base Plan—the practical purpose of the Base Plan is to locate the physical placing of the 


Site (Buildings and Ground Plans) in relation to the city, town or industrial area where the 


Access Control System is sited.  Therefore, we would typically use a representation from a 


street map.  Such a map enables the visual integration of Buildings and Ground Plans into a 


geographic Base Plan. 
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2. Ground Plans—the Ground Plan defines an open area (that is, not inside a building) where 


Access Control can be monitored by Impro Graphics.  This plan could include a parking lot 


or the access points to a building complex.  The Plan is single level, two-dimensional Plan 


serving to locate equipment positions in the surrounding geography.   The point of the 


Ground Plan is to be more specific than the Base Plan.  You may have more than one 


Ground Plan per Base Plan. 


3. Buildings—adding a Building onto the Base Plan identifies a particular installation. The 


Building is the primary location for placing Floor Plans.  The Building represents a three-


dimensional area and you may add as many floors as are needed.  Remember that you 


may place more than one Building on any Base Plan. 


4. Floor Plans— the Floor Plan is the working Graphics Display of the Building Access 


Control System.  Using Graphics Designer Software you may place the units that form the 


Access Control System into the Floor Plan.  The preparation of a Floor Plan makes the 


procedure of installation and configuring much easier.   


5. Site Plan (optional)—for multiple Sites you have the option of adding a Site Plan.  The Site 


Plan should detail the perimeter area of ALL your Sites.     


 


 


If there is more than one Floor Plan, then insert these sequentially. 


 


AAddddiinngg  aa  BBaassee  PPllaann  


 
Figure 40 – Base Plan 


 


 


You may use Any picture as this Base Plan.  However, part of a local street map is most practical.   


 


1. In the Project Settings dialog, click the Choose button to select your Base Plan image. 


2. In the Image Name field, type in a name for the graphic display (for example the companies 


name). 


3. Click on the  button. 
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AAddddiinngg  aa  GGrroouunndd  PPllaann  


Now place the Ground Plan Into this Base Plan: 


 


1. From the Main icon palette, select the  (Ground Plan) icon. 


2. Click and hold, and then drag the Ground Plan icon over to the position where you want to 


place the Ground Plan. 


3. Once in position release the mouse button. 


 


 
Figure 41 – Add a Ground Plan Dialog 


 


4. In the Icon Name field, assign the Icon‘s name. 


5. In the Image Name field, assign the Image‘s name (in this example we used ―Impro Ground 


Plan‖). 


6. Click the Choose button. 


7. From the Directory, select the image you need. 


 


AAddddiinngg  aa  BBuuiillddiinngg  


Now place the Building on to the Base Plan: 


 


1. From the Main icon palette, select the  (Building) icon. 


2. Drag and drop the Building icon into position on the Base Plan.   


3. In the Input dialog, enter a Building name (for this example we used ―Impro‖). 


4. Click OK. 
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Figure 42 – Ground Plan and Building Assigned 


 


After adding the Ground Plan and the Building, we arrive at the image above. 


For the sake of simplicity, what follows concentrates on the Floor Plan.  Remember that you can 


position access control units into both the Ground Plans and the Floor Plans of both buildings.  


The only limiting factors are the number of units entered into the System Database and their 


relationship to each other. 


 


AAddddiinngg  aa  FFlloooorr  PPllaann  


1. Right-click over the Building icon and select Add Floor. 


2. In the Add a Floor Plan to a Building dialog: 


 In the Floor Name field type in a name for the Floor Plan. 


 In the Level field, select the level from the drop-down list. 


3. Click the  button. 


 


 


In our illustrations we have, for simplicity, inserted only one Building.  You could, however, insert 


multiple Buildings and Ground Plans. 


 


 
Figure 43 – Add a Floor Plan to a Building 
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CCoonnffiigguurriinngg  tthhee  FFlloooorr  PPllaann  


Select the Floor Plan 


 


1. Right-click over the Building icon.   


2. From the menu, click Select Floor. 


 


 
Figure 44 – Select Floor Plan Dialog 


 


3. Click the  button. 


 


Add the Controllers 


1. From the H/W icon palette, click and drag a Controller on to the selected position. 


2. From the Select Controller dialog, select the required Controller. 


3. Click the  button. 


 


Graphics Designer places the Controller icon and its name, on the screen in colour.  In the 


same fashion, add any additional Controllers. 


 


Adding Readers and Non-Readers to the Controllers 


1. From the H/W icon palette, click and drag a Reader onto the selected position. 


2. From the Reader Terminals dialog, select the required Reader. 


3. Click the  button. 


 


Graphics Designer places the Reader icon and its name on the screen in colour.  In the same 


fashion, add the other Readers. 


 


 


After dragging and placing, each unit that has been allocated will be removed from the list of units 


available. 


 


If all icons have been placed and a change has to be made, then by right-clicking on an icon the 


following options become available: 


 


Altering an Icon 


Right-click on the Icon that needs alteration, and select one of the following options: 


 


 Details—displays the Name, Logical Address, Fixed Address, Zone and Location 


parameters of the unit.  These parameters are derived from the Database. 







Part 6 – General Software Modules 


58 January 2012 


 Rename—lets you apply a more meaningful name to the unit, in relation to its operation or 


location. 


 Delete—removes the icon from the layout.  When the unit is deleted using this method, the 


unit is restored to the list of the available units and a new unit can be placed. 


 


 


If you incorrectly place an icon, hold down the Shift Key while dragging the icon to its new location. 


 


Adding Non-Reader Terminals 


There are various other units that function within the System assisting in access control 


applications.  These are the Digital Input and Output Units, Door Terminals, CCTV Cameras, 


Clock, and Time and Attendance Terminals.  


 


Adding Inputs 


This option enables linking of the representation of an Input to the associated Digital Input 


Terminal.  What is done here does not affect the Access Control configuration, as it is only a 


representation of an action in the physical location.  


 


 
Figure 45 – Adding an Input Unit 


 


1. Right-click over the Digital Input Unit and select the Inputs/Outputs option.  A Red circle 


appears around the Input Unit. 


2. The  icon activates, indicating the number of available inputs.  


3. Drag and drop the  icon onto the Floor Plan.  (The available Inputs display in the Input 


Editor dialog). 


 


 
Figure 46 – Input Editor Dialog 
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4. Select the Input record required, in this case only one is available. 


5. Click the  button. 


 


The input is placed on the screen as shown below (DOS 1). 


 


 
Figure 47 – Input Displayed 


 


 


Note, you can only place Inputs, configured as Alarm Inputs in Access, in Graphics Designer. 


 


Adding Outputs 


In a similar fashion, you can now drag and drop outputs.  Again, what happens here does not 


affect the Access Control configuration; it is only a representation of an action in the physical 


location.  


 


Adding Cameras  


CCTV Cameras, if fitted, enable surveillance of specific areas of access.  These can be placed 


as with other units to represent their position in the Building or Ground Plan.  With Cameras 


there is a restriction of the number of Cameras that can be connected to any PC.  Refer to the 


Camera Documentation.  In terms of Graphics Design and Runtime display, the Camera will be 


configured to run as required via the Camera Setup on the PC and Access Software.  


 


Configuring Alarms 


All Alarms detected by the Engine are reported, and can be displayed on the Floor or Ground 


Plans alongside the associated access control unit.  In Graphics Designer you can select the 


way the Alarm is represented on the screen.   


As long as you placed the Alarm icon in Graphics Designer, a default Alarm icon appears in 


Graphics Runtime.  Follow this procedure to change the default Alarm icon. 


 


 Change the Alarm icon for a particular event: 
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Figure 48 – Configure Alarms:  General 


 


Tools>Configure Alarms>General—from the General tab an alarm, such as Anti-Tamper can 


be represented by one of the alternatives on the display.    


 


 
Figure 49 – Alarm Selection 


 


1. Click Anti-Tamper for example and then select the Alarm Icon by pressing Play ( ). 


2. By using the Change button, you may select an alternative Alarm icon.   


3. Click the  button. 


 


 Change the Alarm icon for a particular event on a particular Terminal: 


 


Tools>Configure Alarms>Advanced—click Choose to select the Terminal to be configured.  


The following Screen displays: 


 







  Part 6 – General Software Modules 


January 2012  61 


 
Figure 50 – Alarms, Advanced Selection 


 


In the Advanced setup the Installer can select the various Terminals (Units) needing Advanced 


configuring and the way the Alarms display for each. 


 


1. From the All Currently Placed Terminals dialog select the Terminal. 


2. Click the  button. 


 


The screen returns to select the Alarm Event and Alarm Icon as illustrated on page 61.   


 


 
Figure 51 – Advanced Selection, Alarm Event 


 


Select for each of the Terminals, the Alarm Event and Alarm Type to display via the Play ( ) 


button and choose an Alarm Icon.  See the example below. 
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Figure 52 – Advanced Alarm Selection 


 


3. Click the  button. 


 


Repeat the process for each Alarm for configuration.   


 


To change the Alarm icon used: 


 


1. On the General or Advanced Alarm dialog, click Change. 


2. Click the radio button corresponding to the icon you want to use. 


3. Click the  button. 


 


 


We suggest that you use the Alarm icons as follows: 


 for Fire Alarms and Tamper Alarms. 


 for Boom Forced Alarms 


 for Door Forced Alarms 


 for Door Open Alarms 


 for Duress Alarms 


 


Adding Custom Application Integration 


This advanced feature lets you (through Graphics Runtime) launch a third-party application on 


the users PC.  That is, during a specified event, instructions could dictate that the user launch 


the third-party program from the Runtime Application.  This third-party software then performs 


the appropriate action. 


 


1. In the Graphics.properties file, change the graphics.startCustomActions=false setting to 


true.  Go to page 52 for more information on configuring the Graphics.Properties file.   


2. From the Custom icon palette, click and drag the Custom Application icon to the selected 


position on your Floor Plan. 


3. In the Custom Application dialog, click the Browse button. 


4. Select the application file. 


5. Complete the Application Parameters and Icon Name fields. 
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Test that the third-part application opens correctly by clicking the Test button.  


 


6. Click the  button. 


 


 


Select a custom Icon for your Custom Application, as follows: 


 


1. Right-click over the Custom Application icon and select the Custom Icon option.   


2. Click the New button. 


3. Select a suitable graphic file (maximum file size 5 kb). 


4. Click the OK button. 


 


Adding Custom Action Integration 


This advanced feature lets you (from within Graphics Runtime) run any of the actions created in 


the ImproVision Integration Server. 


 


 


Setup Actions within the ImproVision Integration Server prior to using the Custom Action Integration 


feature.  See Part 7 – Advanced Software Modules for more information on the ImproVision Integration 


Module. 


 


1. In the Graphics.properties file, change the graphics.startCustomActions=false setting to 


true.  Go to page 52 for more information on configuring the Graphics.Properties file. 


2. From the Custom icon palette, click and drag the Custom Action icon to the selected 


position on your Floor Plan. 


3. In the Custom Action dialog, from the displayed list of Actions, make your selection. 


4. Click the  button. 


 


 


Select a custom Icon for your Custom Action, as follows: 


 


1. Right-click over the Custom Action icon and select the Custom Icon option.   


2. Click the New button. 


3. Select a suitable graphic file (maximum file size 5 kb). 


4. Click the OK button. 
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Adding CaddX Alarms 


GGeenneerraall    


The Graphics Designer software provides for the positioning of icons for CaddX System alarm 


sensors by dragging and dropping them on to Floor Plans as shown. 


 


 
Figure 53 – Floor Plan with CaddX Icons in Position 


 


 


Only Zones added using the CaddX Server Software will appear on the Floor Plan(s). 


 


CCaaddddXX  IIccoonnss  


The icon, labelled Port 1 in the diagram above, represents the CaddX Panel. The Port number 


indicates which port is in use for CaddX data. The icon, labelled Zone 1, represents a CaddX 


System Alarm Sensor. 


 


 


The CaddX icons are only visible in Graphics Designer.  In Graphics Runtime they remain hidden, 


except when an alarm condition presents.  During the alarm condition this animated icon ( ) displays 


in the Graphics Runtime display in the Zone in which the sensor activated. 


 







  Part 6 – General Software Modules 


January 2012  65 


Adding Ziton Alarms 


GGeenneerraall  


The Graphics Designer Software provides for the positioning of icons for the Ziton System Fire 


Alarm Sensors by dragging and dropping them on to Floor Plans. 


 


 


Before using this facility, ensure that the required Loops, Sensors and Zones are defined in the Ziton 


Server Software. 


 


 
Figure 54 – Location of the Ziton Icons at the Side of the Floor Plan and an Icon Positioned                       


on the Floor Plan 


 


AAddddiinngg  aa  ZZiittoonn  FFiirree  AAllaarrmm  PPaanneell  ttoo  tthhee  FFlloooorr  PPllaann  


1. From the Fire icon palette, drag the selected Fire Alarm Panel icon to the desired position 


on the Floor Plan.  


 


 
Figure 55 – Add Fire Panel dialog 
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2. From the Add Fire Panel dialog, select the required entry. 


3. Click OK to accept. 


 


AAddddiinngg  aa  ZZiittoonn  FFiirree  AAllaarrmm  SSeennssoorr  ttoo  tthhee  FFlloooorr  PPllaann  


1. From the Fire icon palette, drag the selected Fire Alarm Sensor icon to the desired position 


on the Floor Plan.  


 


 
Figure 56 – Add Fire Sensor dialog (Ziton) 


 


2. From the Add Fire Sensor dialog, select the required entry. 


3. Click OK to accept. 


 


DDeelleettiinngg  oorr  RReennaammiinngg  aa  ZZiittoonn  FFiirree  AAllaarrmm  SSeennssoorr  oorr  PPaanneell  iiccoonn  


1. Right-click on the icon. 


2. A menu displays providing these options. 


 Delete  


 Rename—enter the name in the New Name field, and click the  button. 
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Figure 57 – Rename Unit Dialog 


 


 


Ziton icons do not appear in the Graphics Runtime display. Only when an alarm occurs will an icon 


display in the relevant position. 


 


Modifying a Site 


At any time in the future the design program can be rerun for modification purposes. 


In the case where a unit has failed and has to be replaced, the suggested procedure is as 


follows. 


 


1. Start the Graphics Designer program and load the project. 


2. Delete the unit from the graphics screen.   


3. Shut down Graphics Designer. 


4. Close the ImproNet Software.   


5. Make your unit replacements and complete reconfiguration of the Database. 


6. Restart both the ImproNet and Graphics Designer Software Suites.  The new unit will now 


be available and will be displayed in the Icon display. 


7. Reconfigure the new unit into Graphics Designer. 
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Chapter 7:  Graphics Runtime Module 


Introduction 


We designed the Graphics Software Suite with user-friendliness as a major design criterion. 


Initial set-up is made via the Graphics Design Software.  At Runtime the operator chooses 


which Ground Plan or Floor Plan to display.  Thereafter the operating instructions limit to 


responding to any alarm displays, finding the last known position of a Tagholder, displaying 


transactions, and others as listed below.  


 


Configuration of the Software 


At start-up, the Software locates the System database.  The target database URL (Universal 


Resource Locator) reads from the Graphics Properties file. 


 


SSttaarrttiinngg  GGrraapphhiiccss  RRuunnttiimmee  


 


Ensure that you start ImproNet Engine before running Graphics Runtime.  If Engine is NOT running, the 


error message” Server Not Found” displays. 


 


1. Click on Start>Programs>ImproNet>Graphics Runtime. 


2. Enter your Username (SYSDBA) and Password (masterkey).  The Password is case-


sensitive. 


 


Operation of the Software 


HHoosstt  SSeelleeccttiioonn    


 


 


If only one Host is applicable then the Software automatically loads the available Host.   


 


If more than one Host is available then the Software requests a Host selection: 


 


1. From the Alarm Host Selection dialog, select the IP Address. 


2. Click OK. 


3. In the Select Site dialog, select the Site to view. 


4. Click the  button. 


 


The Base Plan appears with the Ground Plan and Building Icons in position (See Figure 58). 
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Figure 58 – Base Plan with Icons 


 


GGrroouunndd  PPllaann,,  BBuuiillddiinngg  aanndd  FFlloooorr  PPllaann  SSeelleeccttiioonn  


1. Select a Ground Plan, by double-clicking the Ground Plan Icon.   


2. Select a floor to display, by right-clicking on the Building Icon and choosing the Select Floor 


option. 


3. In the Select Floor Plan dialog, click on the selected floor. 


4. Click the  button. 


 


 
Figure 59 – Floor Plan Display 
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UUsseerr  IInntteerrffaaccee  


Screen 


The screen is divided into two, Top and Bottom.  The Top section shows the graphic display of 


the Floor Plan of the Building.  The bottom section displays the runtime messages showing, 


what‘s happening in the System.  


 


The Bottom section displays four tabs, namely, Transactions, Alarms, Messages and Door 


Status. 


 


 Transactions tab—displays details of any transaction (entry, exit) as well as Status 


Transactions. 


 Alarms tab—displays details of the most recent alarm states. Only 20 alarms can display.  


These list in the order of the last 20 unacknowledged alarms.  If there are less than 20 


unacknowledged alarms the remaining space is filled up to the maximum of 20 lines with 


recent acknowledged alarms. 


 Messages tab—displays a list of running messages. 


 Door Status tab—displays details of open, locked or unlocked Doors, Terminal, Zone, 


Location, Status and Duration. 


 


When you use the CaddX Server Software, two extra tabs display (to the right of the Door 


Status tab) for the setting-up of CaddX Alarms (refer to the User Interface section on page 80 


for more information on these tabs).  


Similarly, when you use Ziton Server Software, one extra tab displays, namely the Ziton Alarms 


tab (refer to the User Interface section on page 81 for more information on this tab). 


 


Menu Bar 


The Menu Bar choices listed are:  File, View, Tools and Help. 


 


 File—offers you a selection of four options, namely Locale, Translate, Properties and Exit. 


 Exit—stops Graphics Runtime and returns you to the Windows® Desktop. 


 Locale and Translate—offers the choice of Area and enables the translation of various 


menu options into another language.   


 Properties—takes you to the Project Properties dialog, offering you the options of 


Alarm Acknowledgement (Requires Tag, Requires Password and Requires Textual 


Response) and Other (Shutdown Requires Password). 


 


 View—offers you the following options:  Show Non-readers, Show Inputs, Auto Resize and 


Icon Text. 


 Show Non-Readers—by clicking in the box next to the ‗Non-reader‘ those units which 


are not readers are shown or hidden (that is Door Control Units, I/O terminals and so 


on). 


 Show Inputs—setting this option displays or hides all Inputs. 


 Auto Resize—place all the graphics on to one page.  This option is useful for a 


complete overview but may present too cluttered a screen for some users. 


 Icon Text—this option provides the alternatives to show or hide the icon text; to display 


the text above or below the icon and to change the highlighting colour.  The default is to 


have the text above the icons and highlight these in yellow.  You can choose which 


alternatives you prefer. 
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 Tools—offers you the following options, namely Find Tagholder and Manual Alarm 


Navigation. 


 Find Tagholder—gives you the facility of searching through the building to find out the 


last Reader to which a person presented their Tag.  The response will also state if an 


Access Denied event occurred. 


 Manual Alarm Navigation—use this to select whether Graphics Runtime should 


automatically switch to the Plan on which an alarm occurs.  Or, if the user is going to 


navigate from Plan to Plan not taking notice of the Plans with alarms on them.  This is 


particularly useful when you have a guard interested in a particular Plan, who is not 


taking heed of alarms taking place elsewhere. 


 


 Help—About displays the Version, Operating System Software and Copyright details of the 


Graphics Runtime Software.  


 


Icons 


You may display the Base Plan at any time, by clicking on the  icon (in the upper left-hand 


side of the screen).  The Base Plan displays as shown in Figure 60.   Remove the Base Plan by 


clicking the Close icon, in the upper right-hand side of the Base map). 


 


Return to the Base Plan level by pressing the  icon.   


 


 
Figure 60 – Display Base Plan 
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Sub-menu 


  


 


The menus are slightly different for Reader, Non-reader, Controller, Input and Camera, however, most 


have a Details tab. 


 


Right-clicking the mouse over any of the Map Icons (Reader, Non-reader, Controller, Input and 


Camera icons) displays a Sub-menu.  The available menu options are:  Details, Emergency 


Mode, Reset Zone Count, Open Door, Monitor Door and Monitor Location.    


 


Details—displays the following unit information:  Type, Name, Logical Address, Fixed 


Address, Zone and Location. 


 


Further information on the menu options; Emergency mode, Reset APB, Open Door and 


Monitor Door is available in the section on page 73. 


 


Controller Sub-menu—right-clicking on a Controller displays the following available options:  


Details, Reset Anti-Passback (APB) for Controller and Site, Emergency Mode and Lockdown 


Mode. 


 


Non-reader Sub-menu—right-clicking on a Non-reader such as the ImproX O16 Output 


Terminal displays a different set of options, in this case:  Details, Emergency Mode and Reset 


Zone Count. 


 


Special Functions 


EEmmeerrggeennccyy  MMooddee  


 
Figure 61 – Emergency Mode Selection 
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Figure 62 – Emergency Mode on Terminal 


 


1. The example shown above shows the result of selecting a unit, right-clicking and selecting 


Emergency Mode.  The display shows that Emergency Mode is active for that Terminal 


only.   The dialog also permits Emergency Mode to be selected for All Terminals for that 


Controller, or for the Entire Site.   


2. Select the Status, On or Off radio buttons.  


3. Click the  button to implement the Access Control predefined Emergency action.  


4. Click the  button. 


 


RReesseett  ZZoonnee  CCoouunntt  


 
Figure 63 – Reset Zone Count 


 


Reset the Zone Count, by right-clicking over a selected unit and selecting Reset Zone Count 


menu option.  This function lets you make necessary corrections to the count of Tagholders in a 


particular Zone. 


 


RReesseett  AAnnttii--ppaassssbbaacckk  ((AAPPBB))  


Selecting and activating Reset APB (reset Anti-passback) resets every Tagholder in the System 


to the ‗normal‘ state.  Anti-passback still applies but the System resets allowing access for all 


Tagholders on their next transaction.   This function can be made for either the Controller or the 


full site. 
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OOppeenn  DDoooorr  


 
Figure 64 – Open Door Selection 


 


Selecting Open Door, as shown above, activates the ‗Allowed Actions‘, if pre-defined in the 


access control, for the relevant door.  The action as setup applies and the door opens.   


MMoonniittoorr  DDoooorr  


 
Figure 65 – Monitor Door Dialog 


 


When you select Monitor Door you will notice a Green ring appears around the Reader 


controlling the monitored door.  As soon as a Tagholder presents a Tag to the Reader, a 
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message appears on Graphics Runtime giving the name of the person, the department they are 


attached to, and the time of the occurrence as illustrated above.   


If applicable a picture of the Tagholder is displayed.  Click the << Less button to display only the 


picture information.  Click the Stop Monitoring button to remove the message from the screen. 


 


MMoonniittoorr  LLooccaattiioonn  


The Monitor Location function is similar to that of Monitor Door.  The function monitors all the 


Access points allied to that Location.  When any event is detected then a message displays on 


Graphics Runtime, as illustrated in Figure 65. 


 


AAllaarrmmss  


All Alarms occurring report from the Engine.  The way the Alarm displays to the operator is set-


up during the design stage.   


 


With ImproNet V7.4 Software you will notice extra Alarm States: 


 


 Red Bell symbol—this symbol signifies that the unit is still in an alarm state, and that the 


alarm is not yet acknowledged. 


 Orange Bell symbol—this symbol applies to input alarms only.  It signifies that the unit is 


no longer in an alarm state, but that the alarm is not yet acknowledged. 


 Orange Tick symbol—this symbol signifies that the unit is still in an alarm state, but that 


the alarm is acknowledged. 


 Green Tick symbol—this symbol signifies that the unit is no longer in an alarm state, the 


alarm is acknowledged. 


 


 


Activation of these extra Alarm States requires that you upgrade to Controller Firmware V7.12 or 


upwards. 


 


When an Alarm occurs, you can select that any of the following events take place:  


 


 If you installed and set-up a CCTV camera the screen displays the camera picture.  You 


must enable the CCTV System and the Engine.properties file entry must be 


engine.system.cctv_enabled=true.  (Restart the engine after making this change). 


 The Alarm panel comes to the front displaying the Alarm, with an animated icon. 


 The background section of the display on the monitor turns Red. 


 If the particular application was minimised it restores to view. 


 If you fit a sound card and loudspeaker to the computer the alarm sounds (a generalised 


alarm type beep, beep, beep). 


 


Some of the above is not displayed in Figure 66. 
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Figure 66 – Alarm Displayed 


 


The Access point affected changes colour and the animated Icon indicates the problem.  The 


Alarm List indicates the Alarm by a red bell and a description of the Alarm (Anti Tamper Alarm). 


 


When the alarm has been cleared, which can only be done by rectifying the problem as 


discussed below, then the Red Alarm Status is replaced by a Green tick. 


 


AAcckknnoowwlleeddggiinngg  AAllaarrmmss  


By Right-clicking on the icon displaying the Alarm the operator can carry out a single Alarm 


Acknowledgement.  After acknowledgement of the Alarm the icon returns to normal and the 


alarm bell in the Alarm State List changes to a green tick. 


 


By selecting ‗Details‘ and then acknowledging ‗All‘ then all Alarms of the same type for that unit 


reset.  If other type Alarms for the same unit have occurred then you must acknowledge each of 


these Alarms separately, as also for Alarms on differing units.  


 


By clicking on Properties on the File Menu, the Administrator can define the requirements for 


Tagholders authorised to acknowledge Alarms. The operator, or designated authority, must then 


either: 


 


 Present their access Tag to the Tag Verification Reader. 


 Type in the valid password. 


 Type in the required textual response to be acknowledged. 
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The default password for this feature is masterkey. 


 


 
Figure 67 – Project Properties Dialog 


 


AAllaarrmm  UUsseerr  RReessppoonnssee  


 


 


The User can respond to an alarm by entering any details noted in the Acknowledge text field.  This 


enables creation of a more coherent alarm log. 


 


The following screen shows an example of the ‗Acknowledge‘ response: 


 


 
Figure 68 – Alarm Indication Display 


 


Once you corrected the problem, and acknowledged the Alarm, the System restores itself to 


normal and the Status of the Alarm reverts to ‗Clear‘.   
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Alternatively, to acknowledge an alarm, the operator can double click on the row that indicates 


the alarm and the same acknowledge window displays.  This option is useful when an alarm is 


indicated in the Alarm screen but not shown in the graphics window.  (As, for example, if the 


Alarm was not placed when the graphics were installed in Design Mode, or the case where the 


Alarm Graphics are on another plan). 


 


MMeessssaaggeess  


You may use various Messages on the System.  These Messages are displayed for information 


or for verifying that an action occurred.  Specific Messages are concerned with Anti-passback 


(APB), Emergency Mode and Open Door.   


 


Activating the Messages tab, displays any such Messages. 


 


CCuussttoomm  AApppplliiccaattiioonn  IInntteeggrraattiioonn  


This advanced feature lets you launch a third-party application through Graphics Runtime.  That 


is, during a specified event, instructions could dictate that the user launch the third-party 


application from Graphics Runtime.  This third-party application then performs the appropriate 


action. 


 


Launch the third-party application by right-clicking on the Custom Application icon and selecting 


the Run Application option. 


 


CCuussttoomm  AAccttiioonn  IInntteeggrraattiioonn  


This advanced feature lets you (from within Graphics Runtime) run any of the actions created in 


the ImproVision Integration Server. 


 


Launch the custom Action by right-clicking on the Custom Action icon and selecting the Run 


Application option. 
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CaddX Alarms 


The Software only displays CaddX Alarms if the Software is unlocked for the CaddX Panel and 


Server option. 


 


UUsseerr  IInntteerrffaaccee  


To display information from the CaddX Alarm System via the CaddX Server Software, two extra 


Tabs appear in the Runtime Window; these are the CaddX Alarms Tab and the CaddX Partitions 


Tab. 


 


 CaddX Alarms tab—provides the following fields:  Date, Time, Map, Panel, Partition, 


Zone and Event.  When you select a row, and right-click the mouse a sub-menu offers you 


the following two choices: 


 Acknowledge—removes the selected line from the Alarm table, as well as the Alarm 


icon from the Floor Plan.  However, it does not affect the CaddX Panel status. 


 Go to Map—the display changes to the Floor Plan for the Alarm concerned. 


 


 


CaddX icons remain hidden in Graphics Runtime, except when an alarm condition presents.   When an 


Alarm condition presents, this ( ) animated icon displays in the Graphics Runtime display in the Zone 


in which the sensor activated. 


 


 CaddX Partitions tab—provides the following fields:  Port, Partition and Armed.  When 


you select a row, and right-click the mouse a sub-menu offers you the following choices:   


 Arm—arms the selected Partition. 


 Disarm—disarms the selected Partition. 


 Disarm and acknowledge—disarms the selected Partition, and acknowledges alarms 


in the ImproNet Database for that Partition. 


 Arm All—arms all Partitions monitored by the CaddX NXE-8 Panel connected to the 


communications port selected. 


 Disarm All—disarms all Partitions for that Port. 


 Zone Bypass—permits the bypassing of selected Zones. This means that Zones can, 


in effect, disconnect from the System. 


 


 


You cannot bypass a Zone while the Partition(s) that include that Zone is (are) armed. 


 


 


If an Arming attempt is unsuccessful at first, it may be because the Partition is not „ready‟.  Wait a few 


seconds and then retry. 


 


Ziton Alarms 


The Ziton Alarms only display if the Software is unlocked for the Fire panel integration. 


 


 


Only those Alarms added in the Ziton Server and Graphics Designer software, as part of the 


configuration, appear in Graphics Runtime. 
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UUsseerr  IInntteerrffaaccee  


To display information from the Ziton Alarm System via the Ziton Server Software, the Ziton 


Alarm tab has been added to the Runtime window.  The Tab provides the following fields:  Date, 


Time, Panel, Loop, Device Address and Zone.   


    


ZZiittoonn  AAllaarrmm  IInnddiiccaattiioonn  


When a Ziton Fire Alarm occurs, the details display in the Ziton Alarms tab.  At the same time, 


the background to the Floor Plan window turns red, and a Fire Alarm icon displays at the 


location of the sensor concerned. 


 


 
Figure 69 – Ziton Alarm Tab, with Alarm Indications 


 


An important concept for the ImproNet interface with the Ziton System is that of a ―double-


knock‖ alarm indication.  This occurs when at least two different sensors trigger at the same 


time (the sensors may be in the same Zone or in different Zones). 


 


When a ―double-knock‖ Alarm Indication is received, the Emergency Mode dialog shown below 


appears. 


 


 
Figure 70 – Emergency Mode Dialog 
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The Yes option is timed, allowing the Operator 180 seconds to set the site into Emergency 


Mode.  If Yes is not selected within that time, the Yes option is automatically enforced, and the 


Site goes into Emergency Mode.  


 


The Emergency Mode Timeout can be changed (from 180 seconds) from the 


graphics.properties file using parameter Ziton.emergency.timeout = 180.   Disable this 


function by setting this parameter to 0. 


 


When the Site is in Emergency Mode, the Door Status tab displays information of the form 


shown in Figure 71. 


 


 
Figure 71 – Emergency Mode Indications, Door Status Tab 


 


At this time the Messages tab displays the message Emergency Mode On – Entire Site. 


 


Acknowledging the Alarm and selecting the alarm in the Ziton Alarms tab results in a sub-menu 


offering the following two choices: 


 


 Acknowledge—removes the selected line from the Ziton Alarms list. 


 Go to Map—the display changes to the Floor Plan for the Alarm concerned. 


 


 


Once you have acknowledged all current alarms, the Ziton Panel silences automatically via the Ziton 


Server Software. 


 


CCTV 


CCTV is supported; however, implementation differs slightly for each integration. 


 


iiNNeettDDVVRR  SSyysstteemm    


If the CCTV iNetDVR System has been installed and configured then you can view the various 


Alarms in Runtime.  Certain limits apply as the System has limited bandwidth.  


 


The camera records only according to the motion detection and alarm setup, this limits 


resources.  When viewing playback the default mode is slow motion.  You may increase the 


speed by holding down the ‗Play‘ button. 


 


Right-clicking on the camera provides some options for access to searching and/or real-time 


video.  The alarm search facility provides a list box with the entries for that camera.  This list is 


similar to that in the DVR alarm list.   


 


To view recorded material for a particular Alarm, right-click on the Alarm itself. 
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Communication Failure 


In the unlikely event that the Software loses connection to Engine or the Database, the following 


communication failure messages appear:    


 


EEnnggiinnee  


If you lose the connection to the Engine the following massage displays.  Once Engine 


reconnects, press the  button. 


 


 
Figure 72 – Socket Connection Lost Message 


 


DDaattaabbaassee  


If you lose the connection to the Database, a message displays, stating DB Connection Lost.  


You may select whether to exit Graphics Runtime, or wait for automatic reconnection to take 


place. 


 


Advanced Graphics Module Features 


GGeenneerraall  


This chapter describes several extra advanced Graphics Module features. 


 


MMaannuuaall  AAllaarrmm  NNaavviiggaattiioonn  


The default set-up for Alarms in Graphics Runtime is that, when an Alarm occurs, the onscreen 


display automatically switches to the Floor Plan for the area in which an Alarm is located. 


 


In some situations, this may not be desirable. If you wish to disable this feature, continue as 


follows: 


 


1. Select the Tools option on the Graphics Runtime menu. 


2. Select Manual Alarm Navigation. 


3. If an Alarm occurs anywhere on the Site, the onscreen display will remain as selected by 


the Operator. 


4. To switch to the Floor Plan for the Alarm area, double-click on the Alarm in question on the 


Alarms tab at the bottom of the Graphics Runtime screen. 
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Figure 73 – Tools drop-down menu 


 


AAccttiivvaattiioonn  oorr  ddeeaaccttiivvaattiioonn  ooff  RReellaayyss  ffrroomm  tthhee  FFlloooorr  PPllaann  IIccoonn  


Relay outputs on ImproX units can be activated or deactivated from a Floor Plan icon. This is a 


manual facility, and allows the Operator to switch the selected relay from the Floor Plan when 


requested to do so. There is no need for any access control transaction to take place. 


 


Example 


There is a requirement for the Operator to be able to switch on the internal light in the company 


Strongroom when required. To achieve this, a relay output on the exit reader for the Strongroom 


has been connected in-line with the emergency light in the strong room. 


 


When requested to switch on the light for, say, a ten-minute period, the Operator will use the 


procedure described next. 


 


Procedure 


In Access: 


 


1. Select the required Terminal (Strongroom OUT in this example). 


2. Select the Outputs tab for that Terminal in the right-hand pane. 


3. Select the required output relay (Relay 1 in this example). 


4. Select Edit. 
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Figure 74 – Access Relay Output Parameter Selection 


 


In Graphics Designer: 


1. Right-click on the required Terminal (Strongroom OUT in this example). 


 


 
Figure 75 – Pop-up menu 


 


2. Select Inputs or Outputs. 


3. The outputs, as configured in Access for that Terminal, can now be dragged from the 


toolbar.  This will show all outputs enabled in ‗Access for that Terminal. 


 







Part 6 – General Software Modules 


86 January 2012 


 
Figure 76 – Terminal selected 


 


4. Select the Outputs icon at the left of the screen, and drag-and-drop it to the required 


location on the Floor Plan. In this example, it is placed in the Accounts Office. 


5. Select Relay 1. 


6. Click the  button. 


 


 
Figure 77 – Outputs Screen 
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In Graphics Runtime: 


1. Restart Graphics Runtime. 


2. Right-click on the Relay icon.   A pop-up menu will appear, with three options: 


 Activate (2 sec)—activates the relay for 2 seconds, returns to deactivated state. 


 De-activate (2 sec)—deactivates the relay for 2 seconds, returns to activated state. 


 Configurable…………*—permits activation or de-activation configuration for the 


desired time period. 


 


Configurable from Software V7.4 onwards: 


 
Figure 78 – Pop-up menu 


 


1. According to this example, select the Configurable... menu option. 


 


 
Figure 79 – Configure Relay Dialog 


 


2. Select Activate. 


3. Set the Duration to 10 minutes (6 000 x 0.1 seconds). 


4. Select Apply. 


 


The light in the strong room switches on, and remains on for 10 minutes. The System then 


returns to its original state.  Any further Relay output settings have to be set up as required.  


The Configure Relay dialog shows the current status of the relay in the Relay State field. 
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Chapter 8:  Card Designer Module 


Introduction 


The Impro Card Designer Software Module lets you design and store templates for printing 


information on adhesive labels or directly onto Credit Card Tags.  When used with the System 


Database, a design could typically provide information such as the Tagholders Name, 


Department, Tag Code, and so on. 


 


RReeqquuiirreemmeennttss  


 
Figure 80 – Standard Software Modules (Engine, Access (including Card Designer), QuickTag, 


Visitor, Transaction Viewer, Alarms Client) 


 


Starting the Card Designer Module 


To open ImproNet Access, continue as follows: 


 


1. In Windows®, click Start>Programs>ImproNet>Access. 


2. Enter your Username (SYSDBA) and Password (masterkey).  The Password is case-


sensitive. 


3. From the Menu Bar, select the Configuration drop-down list. 


4. From the drop-down list, select Card Designer. 


 


 


The New Template dialog displays the first time a templates designed. The Select Template dialog 


displays after that when the Software‟s used.  For a new installation, continue from point 5 below.  For 


an existing installation select one of the templates shown in the Select Template dialog and click the  


 button. 
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Figure 81 – New Template Dialog 


 


5. In the Enter template name dialog, enter a name for your template. 


6. Using the Portrait or Landscape radio buttons, select the orientation of your template. 


7. Click the  button. 


 


Operation of the Software 


 
Figure 82 – New Blank Template 


 


The Card Designer principles of operation are similar to other drawing application packages, 


and are largely intuitive. If you have experience of these and wish to start designing 


immediately, skip to the section titled Designing a Typical Template on page 94. 
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MMeennuu  BBaarr  


File 


Option Description 


New Creates a new blank template. 


Open Opens an existing template from a list provided. 


Rename Renames the open template. 


Delete Lets you permanently delete a single template. 


Import Lets you import templates into Card Designer. 


Export Lets you export your templates created in Card Designer. 


Choose Locale Allows the choice of the area and language for translation purposes. 


Translate Displays a list of all terms used in the Card Designer Module for translation. 


Print Preview Lets you preview your print job prior to printing. 


Properties Allows setting of the printer settings (including printer options (card or label 


layout),  print margins, and units of measurement). 


Exit Exits the Card Designer Module. 


Table 16 – File Menu Options 


 


Edit 


Option Description 


Undo Undoes the previous action. 


Redo Restores the previously cancelled action. 


Table 17 – Edit Menu Options 


 


Database 


Option Description 


Base Query Allows users with experience in SQL Syntax to custom configure fields.  You 


may then drop these custom fields onto the card template. 


Table 18 – Database Menu Options 


 


View 


Option Description 


Grid Allows you to display or hide the background grid. Note, however, that 


elements still align to the gridlines even when the grid‘s hidden. 


Zoom Allows the selection of three magnification settings: Small, Medium and 


Large.  (Large is the default setting on start-up). 


Table 19 – View Menu Options 


 


Options 


Option Description 


Snap to Grid With the menu item checked, drawing elements line up to the nearest grid 


lines.  With the menu item unchecked, place drawing elements freely. 


Grid Interval Allows the selection of grid intervals (in pixels) of 5, 10 or 15.  (10 is the 


default setting on start-up). 


Default Text 


Font 


Sets the default font style, colour or size for future placement of text fields. 


Card Colour Allows a choice, from 255 colours, as to the background colour of the printed 


card. 


Table 20 – Options Menu Options 
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Format 


The Format drop-down list activates when you select more than one object. 


 


Option Description 


Align  (Top, Middle, Bottom, Left, Centre, Right) enables alignment of objects. 


Same Size  (Vertical, Horizontal) enables matching of object sizes. 


Table 21 – Format Menu Options 


 


Help 


Option Description 


Help Activates Card Designers on-line Help. 


About Tells you about the Card Designer version running. 


Table 22 – Help Menu Options 


 


TToopp  TTooooll  PPaanneell  


At the top of the Card Designer Screen the following icons appear (from left to right): 


 


Symbol Icon Name Description 


 
Reverse Card  Allows the selection of the front or back of a card. 


 
Undo Undoes previous action (except delete). 


 
Redo Restores previous action (except delete). 


 
Zoom Increases or decreases magnification. 


 
Refresh Refreshes screen contents. 


Table 23 – Top Tool Panel 


 


SSiiddee  TTooooll  PPaanneell  


The Side Panel Icons control the generation of Fields.  To place a field: 


 


1. Select one of the field types from the Side Tool Panel.  


2. Then drag an area on the card representing the area for the field.  


 


Symbol Icon Name Description 


 
Pointer Allows the selection of any object in the template. 


 
Line Draw Allows drawing of horizontal or vertical lines. 


 
Rectangle Allows drawing of rectangles. 


 
Ellipse Allows drawing of ellipses. 


 
Text Allows entry of text. 


 
Image Allows importation of an image (such as a logo) in JPEG or 


GIF format. 


 
Database Allows the insertion of database fields. 


 
Barcode Allows the display of a barcode in one of several formats. 
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Symbol Icon Name Description 


 
Date Provides the date (YYYY-MM-DD) of issue.  This field‘s 


format is configurable. 


Table 24 – Side Tool Panel 


 


Each of the above icons allows the creation of a ―field‖.  Each such field is a defined area on the 


card that contains the data specified by the icon when the card prints from the System Software.  


 


For example, a Text field contains text included by you, the designer; a Database field contains 


specified information from the System Database, such as the Tagholder‘s name. 


 


Database Fields 


The standard Database Fields available in the ImproNet System include:  


 


Item Description 


MST_SQ Seldom used – for database maintenance only. 


MST_TITLE The Tagholder‘s title (Mr, Mrs, etc). 


MST_FIRST NAME The Tagholder‘s first name. 


MST_MIDDLE NAME The Tagholder‘s middle name. 


MST_LAST NAME The Tagholder‘s last name. 


MST_SUFFIX The Tagholder‘s suffix. 


MST_ID The Tagholder‘s access ID number. 


MST_GENDER The Tagholder‘s gender. 


MST_PIN The Tagholder‘s access PIN number. 


MST_TYPE System data determining whether a Tagholder is an employee or a 


visitor. 


MST_CURRENT System data which determines whether a Tagholder is still valid. 


EMP_EMPLOYEENO The Tagholder‘s employee number. 


EMP_EMPLOYER The Tagholder‘s employer‘s name. 


EMP_POSITION The Tagholder‘s position in the employer‘s organisation. 


DEPT_NAME The name of the Tagholder‘s Department. 


SITE_SLA Site address. 


IMG_IMAGE The Tagholder‘s photograph. 


MSTNT_MEMO General information specific to the Tagholder. 


Table 25 – Database Fields 


 


Barcode Fields 


The Barcode icon gives you access to the same database fields as the Database icon. 


Database items chosen for barcoding depend on your requirements.  A typical example could 


be an ID number, if this is available in the Database for the System concerned.  You could use 


the ID barcode for example, if a barcode reader controls access to a company car park. 


 


Modifying Field Properties 


To change the properties of a field: 


 


1. Using the Pointer icon, select the field for editing. 


2. Right-click the mouse over the field.  


3. Select Properties from the menu.  


4. Edit the settings as necessary. 
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Designing a Typical Template 


GGeenneerraall  


Card Designer lets you define where on the card data prints.  A card template typically contains: 


 


 One Image field. 


 One or more Text fields. 


 One database Image field (for example the Tagholder‘s photo). 


 Several other Database fields (for example the Tagholder‘s name, and so on). 


 


 


Text fields and Image fields contain information common to all cards for printing using a given 


template, while Database fields contain information specific to a Tagholder. 


 


The typical steps in designing a template are: 


 


1. Show or hide the Grid. 


2. Select Snap to Grid ON or OFF. 


3. Select the Grid spacing. 


4. Insert and format Text Fields. 


5. Set the card colour. 


6. Insert, define and format Database Fields. 


7. Insert Image Fields. 


8. Insert a Barcode Field. 


9. Draw the outlines required (such as the card outline, and frames for images, etc). 


10. Print Preview the card. 


11. Alter the template elements as required. 


12. Test Print the card. 


13. Batch Print the cards. 


 


TTyyppiiccaall  EExxaammppllee  TTeemmppllaattee  


The typical example template, used below, is that for the Manufacturing Department for a 


company called Excel Services. 


 


 


Card Designer saves templates automatically; therefore Card Designer has no Save button. 


 


 


The dimensions of the outer edges of the Grid are the same as those of an ISO Credit Card Tag. 
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Figure 83 – Typical Example Template 


 


Show or Hide the Grid 


1. From the Menu Bar, select the View drop-down menu. 


2. From the View drop-down menu, select the Grid option. 


 


 


A tick mark alongside the Grid option shows the Grid options active.  No tick mark alongside the Grid 


option shows the Grid options NOT active. 


 


Snap to Grid ON or OFF 


1. From the Menu Bar, select the Options drop-down menu. 


2. From the Options drop-down menu, select the Snap to Grid option. 


 


 


A tick mark alongside the Snap to Grid option shows the options active.  No tick mark alongside the 


Snap to Grid option shows the options NOT active. 


 


Set the Grid Spacing 


1. From the Menu Bar, select the Options drop-down menu. 


2. From the Options drop-down menu, select the Grid Interval option. 


3. From the Grid Interval menu, select one of the following options: 


 5 


 10 (default) 


 15 


Add Text and Set Font Properties 


1. From the Side Tool Panel, click the  icon. 


2. Using the Left mouse button, drag the mouse over the grid to place the text. 


3. In the Default Text Font dialog, select a font from the list: 


 Dialog (default) 


 SansSerif 


 Serif 


 MonoSpaced 


 DialogInput 


4. For Bold or Italic text, check the appropriate checkbox. 
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5. From the Size drop-down list select an appropriate size for the font. 


6. Click on the Colour button. 


7. In the Text Colour dialog, select the new colour for the font. 


8. Click the OK button. 


9. In the Write Text Here text area, type in the text you want to appear on the template. 


10. Click the  button. 


 


Set the Card Colour 


1. From the Menu Bar, select the Options drop-down menu. 


2. From the Options drop-down menu, select the Card Colour option. 


3. Select the new colour for the card. 


4. Click the OK button. 


 


 


In this example we left the card with the default setting of White. 


 


Add Database Fields 


1. From the Side Tool Panel, click the  icon. 


2. Using the Left mouse button, drag the mouse over the grid to place the Database Field. 


3. In the Select Database Field dialog, select a Field from the list. 


4. Click the  button. 


5. Using the Pointer icon, select the field for editing. 


6. Right-click the mouse over the Database Field. 


7. Select Properties from the menu. 


8. In the Query Properties dialog, click on each of the following tabs for editing options: 


 Border—allows update of the border position, colour and line width. 


 Font—allows selection of a new font, selection of the bold and italic format, selection of 


the font size and colour. 


 Query—allows selection of a new Database Field. 


 Alignment—allows selection of the horizontal and vertical alignment and rotation of the 


text within the Database Field. 


9. Click the  button. 


 


Insert Image Fields 


1. From the Side Tool Panel, click the  icon. 


2. Using the Left mouse button, drag the mouse over the grid to place the Image Field. 


3. In the Open dialog, select the required image file. 


4. Click the Open button. 


5. Right-click the mouse over the Database Field. 


6. Using the Pointer icon, select the field for editing. 


7. Select Properties from the menu. 


8. In the Image Properties dialog, click on each of the following tabs for editing options: 


 Border—allows update of the border position, colour and line width. 


 Alignment—allows selection of the horizontal and vertical alignment and an image only 


property. 


9. Click the  button. 


 


 


If the Card Printing Module uses third-party tables, then any image fields, must contain the word 


“IMAGE”. 
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Insert a Barcode Field 


1. From the Side Tool Panel, click the  icon. 


2. Using the Left mouse button, drag the mouse over the grid to place the Barcode Field. 


3. In the Select Database Field dialog, select a Field from the list. 


4. Click the  button. 


5. Using the Pointer icon, select the field for editing. 


6. Right-click the mouse over the Barcode Field. 


7. Select Properties from the menu. 


8. In the Barcode Properties dialog, click on each of the following tabs for editing options: 


 Border—allows update of the border position, colour and line width. 


 Query—allows selection of a new Database Field. 


 Barcode—allows selection of general and text settings. 


9. Click the  button. 


 


Drawing Tools 


Borders (Rectangle) 


1. From the Side Tool Panel, click the  icon. 


2. Using the Left mouse button, drag the mouse over the grid in the position that you want the 


Border. 


3. Using the Pointer icon, select the Border for editing. 


4. Right-click the mouse over the Border. 


5. Select Properties from the menu. 


6. In the Rectangle Properties dialog, update of the border position, colour and line width as 


necessary. 


7. Click the  button. 


 


Lines 


1. From the Side Tool Panel, click the  icon. 


2. Using the Left mouse button, drag the mouse over the grid in the position that you want the 


Line. 


3. Using the Pointer icon, select the Line for editing. 


4. Right-click the mouse over the Line. 


5. Select Properties from the menu. 


6. In the Line Properties dialog, update of the border position, colour and line width as 


necessary. 


7. Click the  button. 


 


Print Preview the Card 


1. On the Menu Bar, select File. 


2. From the File drop-down menu, select Print Preview. 
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Figure 84 – Typical Example – Print Preview Mode 


 


Test Print 


 


 


You may have to adjust printer driver settings to ensure that printings performed as needed. These 


settings differ from printer to printer. 


 


 


Single or double-sided card printing is possible. For details of double-sided printing, please refer to the 


on-line Help facility. 


 


1. On the Menu Bar, select File. 


2. From the File drop-down menu, select Print Preview. 


3. In the Print Preview dialog, click the Print Test Card button. 


4. In the Print dialog, select your printer‘s settings. 


5. Click the OK button 


 


Set the Card Properties 


1. On the Menu Bar, select File. 


2. From the File drop-down menu, select Properties. 


3. In the Printer Settings dialog, select from the following options: 


 Print Options—allows selection of Card Layout or Label Layout and offers a preview 


of the Label Layout facility.  In Preview you may adjust the Page Width and Height, the 


X and Y Origin and the X and Y Space. 


 Printing Margin—allows selection of the printing margins width and height, the Default 


button lets you return the settings to the default (0). 


 Units of Measurement—allows selection of imperial or metric units of measurement. 


4. Click the  button. 


 


Close Card Designer 


1. On the Menu Bar, select File. 


2. From the File drop-down menu, select Exit. 
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Batch Printing 


1. From the ImproNet Access Menu Bar, select the Configuration drop-down list. 


2. From the drop-down list, select Batch Printing. 


3. From the Select a Range of Tagholders dialog, select the Tagholders you wish to add to 


the print batch. 


 


 


Use the Shift key and the mouse pointer or the Control key and the mouse pointer when selecting 


multiple Tagholders. 


 


4. Click the  button. 


5. In the Select Template dialog, select the template for printing. 


 


 


If you selected Label Layout in the Card Designer Properties dialog, the Select Print Position dialog 


appears now.  Click on one of the label blocks, this points out where you want the printer to begin 


printing on the page.  This is useful if you have a previously used sheet of labels you wish to continue 


using. 


 


6. Click the  button. 


7. In the Print dialog, select your printer‘s settings. 


8. Click the OK button. 


 


Hints and Tips 


SSeett  tthhee  DDeeffaauulltt  CCaarrdd  TTeemmppllaattee  


Purpose 


This is a facility provided by Card Designer, but used in Tagholders configuration.  The facility 


allows you to select from a library of Card Templates (when configuring a Tagholder in Access), 


the template to be used as the default when printing Credit Card Tags for a specific Tagholder. 


 


Procedure 


 
Figure 85 – Default Card Template selection 
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1. In the Access Navigator Pane, select Tagholders. 


2. In the Tagholders screen, select the required Tagholder. 


3. Click Edit.   


4. Select the Tag concerned. 


5. In the Tag Details dialog hold down the Ctrl key, and select Print. The Select Template 


dialog appears (see Figure 85). 


6. From the Select Template dialog select the required template. 


7. Click the  button. 


 


 


All Credit Card Tags printed for this Tagholder will now use the selected Template. 


 


IImmaaggee  QQuuaalliittyy  


 


 


Specifying large images can adversely affect Database performance and size. 


 


 


As Tagholder images are not automatically resized, the optimum resolution for Tagholder images is 


640 x 480 dpi. 


 


When using a Logo Image 


 Set the X and Y margins to 0. 


 If the image requires a border, use a rectangle. 


 Do not use auto-stretch (right-click the image>properties). 


 Make sure the field dimensions are in proportion, so the image proportions are not changed 


when imported, this would produce a distorted image. 


 


When using a Database Image 


 Set the X and Y margins to 0. 


 If the image requires a border, use a rectangle. 


 


 


USER NOTES 
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Chapter 1:  Tracker Module 


Introduction 


The Tracker Module keeps you advised as to the whereabouts of selected Tagholders 


(maximum 10 Tagholders per site) as they move about the Site.  Alternatively, you may use the 


Tracker Module to monitor events at a selected Reader (maximum 10 Readers per Site).  Both 


these facilities allow for better end user site management, by displaying the latest 20 


transactions for today only, in time order per your group (Tagholders or Readers) selected.    


 


  


In instances where a single Tagholder (Reader) returns more transactions than others it may happen 


that some Tagholders (Readers) do not appear in the list of transactions.  It must be emphasized that it 


is the most recent 20 transactions for the group, not the most recent for each individual Tagholder.  


Achieve best results with this Module by narrowing your range for monitoring to your exact 


requirements.    


 


On opening, the Tracker Module remains discreetly minimized as an icon in the System Tray 


(Notifications Area).  As Tracker receives Tagholder transactions or events from Monitored 


Readers, notification pop-up windows display in the Notification area. 


 


By default the Tracker Module refreshes every 10 seconds, this is the recommended setting.  


The refresh rate is, however, user configurable where you need a faster or slower refresh rate. 


 


 


Each Tracker Client makes a single connection to the Database.  The Engine and other Clients also 


make many connections to the Database, thus DO NOT exceed 30 connections in total. 


 


Starting the Tracker Module 


SSttaarrttiinngg  IImmpprrooNNeett  EEnnggiinnee  oonn  tthhee  HHOOSSTT  PPCC  


1. In Windows®, click Start>All Programs>ImproNet>Engine. 


2. Click on the  button. 


 


SSttaarrttiinngg  tthhee  TTrraacckkeerr  MMoodduullee  oonn  aa  CCLLIIEENNTT  PPCC  ((SSeeppaarraattee  PPCC  WWoorrkkssttaattiioonn))  


 


 


Ensure that you do NOT open more than 1 instance of the Tracker Module per PC workstation. 


 


1. In Windows®, click Start>All Programs>ImproNet>Utils>Tracker. 


2. In the Logon dialog, complete the Server Name textbox.  The default (Localhost) only 


applies where you run Tracker from the Host PC. 


3. In the Database textbox, enter the Database’s path and filename.  (Only use the Browse 


button where the Server is Localhost). 
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4. Enter your Username (SYSDBA) and Password (masterkey). 


5. Click the  button. 


 


UUsseerr  IInntteerrffaaccee  


By default the Tracker Module remains discreetly minimized as an icon in the System Tray 


(Notifications Area).  Configure Tracking settings by right-clicking your mouse over the  Icon 


and selecting Show Tracker.   


 


When open the Tracker Module lists the last 20 transactions generated by the tracked 


Tagholders or Readers.  You may track a maximum of 10 Tagholders or Readers.      


 


 


By double-clicking on any record displayed in the Tracker Module (Tagholders or Readers tab) a dialog 


opens displaying the last 10 transactions for the selected Tagholders or Readers. 


 


 
Figure 1 – Tracker Module User Interface 


 


Tagholder Tracking   


AAdddd  TTrraacckkeedd  TTaagghhoollddeerrss  


1. With the Tracker Module open (see User Interface on page 6), select the Tagholders tab. 


2. Click the Select Tagholders button. 


3. Make your selection from the displayed Tagholder records. 


4. Click the  button. 
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RReemmoovvee  TTrraacckkeedd  TTaagghhoollddeerrss  


1. With the Tracker Module open, select the Tagholders tab. 


2. Click the Select Tagholders button. 


3. Deselect, previously selected Tagholders. 


 


 


Click the selected column header thus sorting by the selected Tagholders. 


 


4. Click the  button. 


 


FFiinndd  TTaagghhoollddeerrss  


1. With the Tracker Module open, select the Tagholders tab. 


2. Click the Select Tagholders button. 


3. From the In Column drop-down list, select a search field, for example: 


 Last Name—searches the Last Name column for a matching record. 


 First Name—searches the First Name column for a matching record. 


 Department—searches the Department column for matching records. 


4. Enter a suitable keyword in the Find textbox. 


 


 


When entering search criteria, keep in mind that the Find textbox is case sensitive.   


 


As you type, the Software automatically moves to the Tagholder record with the closest match. 


 


Reader Event Tracking 


AAdddd  TTrraacckkeedd  RReeaaddeerrss  


1. With the Tracker Module open (see User Interface on page 6), select the Readers tab. 


2. Click the Select Readers button. 


3. Make your selection from the displayed records. 


4. Click the  button. 


 


RReemmoovvee  TTrraacckkeedd  RReeaaddeerrss  


1. With the Tracker Module open, select the Readers tab. 


2. Click the Select Readers button. 


3. Deselect, previously selected Readers. 


 


 


Click the selected column header thus sorting by the selected Readers. 


 


4. Click the  button. 


 


FFiinndd  RReeaaddeerrss  


1. With the Tracker Module open, select the Readers tab. 


2. Click the Select Readers button. 


3. From the In Column drop-down list, select a search field, for example: 
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 Site Name—searches the Site Name column for a matching record. 


 Reader Address—searches the Reader Address column for a matching record. 


 Reader Name—searches the Reader Name column for matching records. 


4. Enter a suitable keyword in the Find textbox. 


 


 


When entering search criteria, keep in mind that the Find textbox is case sensitive.   


 


As you type, the Software automatically moves to the record with the closest match. 


 


Preference Setup 


On opening, the Tracker Module remains discreetly minimized as an icon in the System Tray 


(Notifications Area).  Set your custom preferences as follows: 


 


1. Right-click your mouse over the  Icon (minimized as an icon in the System Tray 


(Notifications Area)).   


2. From the displayed menu, select the Preferences option. 


 


 
Figure 2 – Preferences Dialog 


 


3. From the Preferences dialog, select a Scan Frequency (in seconds). 


4. To have Tracker open without displaying the Logon dialog, select the Remember 


Username and Password checkbox.   


5. Select the Play Sound File on Alert checkbox if required.   


 


 


Browse for an alternate sound file by clicking the  button.  After selection, the file name displays in 


the textbox alongside the  button.   


 


6. During Tracker’s configuration, if you log on as the SYSDBA Administrator you may restrict 


monitored sites for a ―Normal User‖.  ―Normal Users‖ will NOT see this option.  Make your 


selection from the Restrict Site for Tagholder Selection drop-down list. 
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7. Make your selection from the Restrict Site for Transaction Monitoring drop-down list. 


8. Click the  button. 


 


Localisation and Translation 


Localisation and Translation lets Users from different locales (countries and geographical 


locations), use the Tracker Module in their own language. 


 


CChhoooossee  LLooccaallee  


1. Right-click your mouse over the  Icon (minimized as an icon in the System Tray 


(Notifications Area)).   


2. From the displayed menu, select the Choose Locale option. 


 


 
Figure 3 – Locale Chooser Dialog 


 


3. In the Locale Chooser dialog, from the Language drop-down list, make your selection. 


4. From the Country drop-down list, make your selection. 


5. From the Variant drop-down list, select a language variant based on your previous 


selections (optional). 


6. Click the OK button. 


 


TTrraannssllaattiinngg  tthhee  SSooffttwwaarree  IInntteerrffaaccee  


1. Right-click your mouse over the  Icon.   


2. From the displayed menu, select the Translate option. 


 


 
Figure 4 – Translate Dialog 
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3. In the Translate Text : TrackerManager dialog, from the New Text column, select a phrase 


to translate.   


 


 


The Original column displays words in English.  The New Text column displays a copy of the English 


words, but it is editable.  This means you can substitute the default words in the New Text column for 


words in your own language. 


 


4. Press the F2 key, thus opening the phrase for editing.   


5. Enter a substitute phrase suitable for your Locale. 


6. Press the Tab key to move to the next phrase. 


7. Repeat steps 0 to 7 for each phrase you wish to edit. 


8. Click the OK button. 


9. Click the Close button. 
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Chapter 2:  Alarms Client 


Introduction 


The Alarms Client monitors live alarm status in the ImproNet Access System.  The Alarms Client 


pop-up windows contain information about alarms occurring in the System allowing alarm 


monitoring personnel to acknowledge specific alarm conditions.   


 


 


Ensure that Engine’s running for the Alarms Client to work. 


 


 


Ensure the Alarms Server’s installed and running on the Database Server.  However, the Alarms 


Client will run from any PC on the network.   


 


 


More than one Alarms client can run simultaneously. 


 


It’s assumed that after installing the Alarms Client Module that this application will run 


continuously 24 hours a day.  However, if you must shut the application down, restart the 


program in the following manner:  


  


Starting the Alarms Module 


1. In Windows®, click Start>Programs>ImproNet>Alarms. 


2. Enter your Username (SYSDBA) and Password (masterkey).  The Password is case-


sensitive. 


 


 


When the Alarms Module installations complete, change the Password thereby maintaining the 


security of the Database. 


 


 
Figure 5 – Alarm Host Selection Dialog 


 


3. In the Alarm Host Selection dialog, select the required, available, Host. 
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4. Click the OK button. 


 


 


If the Servers not running an error message Server could not be found displays and the program 


closes. 


 


Operation of the Software 


AAllaarrmm  PPoopp--UUpp  


 


 
Figure 6 – Alarm Pop-up Dialog 


 


A brief description of all the fields associated with the Alarm Client Module, the information 


displayed in these fields and button functions follows: 


 


Option Description 


Status Icons for new and acknowledged alarms. 


Date Date the event occurred. 


Time Time the event occurred. 


Event Type of event that occurred. 


Zone The zone name. 


Location The location name. 


Terminal Specific Terminal where alarm occurred. 


Site Site address of the alarm. 


Name Name of Tagholder (for acknowledged alarm). 


Message Message attached to alarm offence. 


Details Button Allows more details to be viewed. 


Acknowledge 


Button 


Accepts the alarm notification. 


Table 1 – Alarm Pop-up Menu Options 
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AAcckknnoowwlleeddggiinngg  AAllaarrmmss  


Continue as follows: 


 


1. In the Alarm Pop-up dialog, select the alarm record. 


 


 


An unacknowledged Alarm displays as a red bell under the status heading. 


 


2. Select one of the following options: 


 Click the Details button—opens the Alarm Notice Details dialog, letting you review 


details of the Alarm or acknowledge the Alarm. 


 Click on the Acknowledge button—acknowledges the Alarm without review of the 


details. 


 


Hints and Tips 


CCuussttoommiizzeedd  EEvveenntt  AAllaarrmmss  


A particular event, such as a door forced, an Anti-Passback violation detected, Tag count 


exceeded, can be made into an Alarm Event.   


 


1. In Windows®, click Start>Programs>ImproNet>Access. 


2. Enter your Username and Password. 


 


 


The default username is SYSDBA.  The default password is masterkey. 


 


3. From the Menu Bar, select Configuration. 


4. From the Configuration drop-down menu, select System Event Editor. 


 


 
Figure 7 – System Event Editor Dialog 
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5. In the System Event Editor dialog, from the Event Name drop-down list, select the event 


you wish to become an Alarm Event. 


6. Check the Event Description textbox matches the Event Name drop-down list item 


selected. 


7. From the Event Type group, click the Alarm Event radio button. 


8. Click the  button. 


 


Carry out the above steps for each Alarm Event, and then close Access. 


 


SSeettttiinngg  uupp  aann  IImmpprrooXX  TTeerrmmiinnaall  


To set-up the ImproX Terminal to raise Forced Door and Door Open too Long events which 


display on the Alarm Client screen similar to that shown earlier in this chapter: 


 


1. In Windows®, click Start>Programs>ImproNet>Access. 


2. Enter your Username and Password.  


3. From the Navigator Pane, select the relevant Terminal. 


 


 


A suitable Terminal could include the ImproX TA, ImproX iTT, ImproX iTRT, ImproX MfT or the ImproX 


I16. 


 


Inputs Setup 


1. In the Main Pane, click on the Inputs tab. 


2. Select Input/Port No 1. 


3. Click the  button.  


4. In the Input Device dialog, from the Input Function drop-down menu, select Door Open 


Sensor.  


 


 


As you want this feature to run continuously DO NOT click the Enable Time Pattern button. 


 


5. Click-on the Input Parameters button.  


6. In the Input Parameters dialog, from the Door Open Contact group, select the Door Open 


Is Open Contact radio button. 


7. Click on the  button. 


8. Select the appropriate Logical Address (of the Terminal where you positioned the Door 


Open Sensor) from the records. 


9. Click the  button. 


10. In the Input Parameters dialog, click the  button. 


11. In the Input Device dialog, click the  button. 


 


Actions Setup 


1. In the Main Pane, click on the Actions tab.  


2. Click the  button.   


3. In the New Action dialog, from the Select Action Type drop-down list, select Door Open 


Timer.  


4. In the Action Name field, type in a name for the Action. 


5. Click the  button. 


6. In the Action Parameters dialog, from the Select Door Open Sensor Input panel, select 


the Input 1 radio button. 
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7. Set the Door Open Time textbox to 30 (default). 


 


 


In most situations, set the Relay Drive Time and Door Open Time to the same time setting. 


 


8. Set the Door Open Delay textbox to 10 (default). 


9. Click the  button. 


 


 


Write down the number of the Action you created above. 


 


 


10. From the Navigator Pane, select the Terminal (that you named in the Door Open Sensor 


setup, where the Door Open Sensor’s detecting if the door’s open). 


11. In the Main Pane, click on the Actions tab. 


12. In the bottom left-hand side of the Main Pane, click the Active System Events button. 


13. In the Active System Events Editor dialog, from the Actions for Allowed Events group, 


select the next available action (click on the number button to the right-hand side of the 


action). 


14. In the Action Selector dialog, from the Actions at Location drop-down list, select the 


location where you defined the action. 


15. From the list of records, select the correct action (the action name should read something 


like ―door open timer‖). 


16. Click the  button. 


17. In the Active System Events Editor dialog, click the  button. 


18. In the Confirm Save dialog, click the Yes button. 


 


 


Ensure the Engine’s running so these settings transfer to the Controller. 


 


Translation - Localisation 


This application is provided with English text.  If you need Localisation of the text, dynamically 


translate the text making use of the Locale and Translate functions.  Property resource files 


store the translated text, for distribution with the application. 
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Chapter 3:  Custom Access Module 


Introduction 


GGeenneerraall  


The Custom Access Module works in conjunction with the Access Module.  Where the Access 


Module allows access to Tagholders based on Access Time Patterns and Tagholder Access 


Groups the Custom Access Module uses its own set of rules for granting or denying access.   


 


As a third-party validation system, the Custom Access Module connects via TCPIP Client 


Socket connection to the started Engine Module.  The Custom Access Module listens for all 


third-party transactions coming from all Sites’ Engines.  Based on the Custom Access Module’s 


own set of user defined rules, the Module allows or denies the transaction. 


 


PPrrooppeerrttiieess  FFiillee  


The Custom Access Module requires that you start the third-party TCPIP Server whenever 


Engine starts.  Change the following Engine property to ensure this happens automatically: 


 


 


The settings referred to in the following paragraph refer to a default installation. 


 


1. From C:\ImproNet open the Engine.properties file. 


2. Change the engine.site.Site.startThirdPartyServer= setting to True. 


3. Save the properties file. 


 


CChhaannggiinngg  tthhee  PPoorrtt  NNuummbbeerr  


By default the Server listens on port number 26669.  If this port number is already in use by 


another application, change the port number as follows: 


 


1. In Windows®, click Start>Programs>ImproNet>Access. 


2. Enter your Username (SYSDBA) and Password (masterkey). 


3. Click the  icon.  The Site’s details display in the Main Pane. 


4. From the Socket Server Port Number Group, change the Host Validation Port value to 


your custom port value. 


5. Click the  button. 


 


Starting the Custom Access Module 


 


 


The Custom Access Module does not function without a started Engine.  Therefore, before using the 


Custom Access Module, ensure that you open Engine and click the Start button. 
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It’s assumed that after installing the Custom Access Module that this application will run 


continuously 24 hours a day.  However, if you must shut the application down, restart the 


application in the following manner:  


 


1. In Windows®, click Start>Programs>ImproNet>Custom Access. 


2. Enter your Username (SYSDBA) and Password (masterkey).  The Password is case-


sensitive. 


 


Operation of the Software 


 
Figure 8 – Custom Access Module 


 


 


When the Custom Access Module denies entry, the transaction record appears in Red.  Double-clicking 


the denied transaction record opens a dialog giving details of the transaction.  Click on the Allowed 


button to allow the Tagholder access to the Zone.   


 


The Allowed button only allows access once per denied transaction. 


 


Configuration of the Software takes place using a Wizard based user interface.  


 


DDaaiillyy  SSiittee  AAnnttii--ppaassssbbaacckk  ((AAPPBB))  RReesseett  


This Wizard lets you specify a daily time, per Site, that Anti-passback (APB) resets across all 


Tagholders.  Continue as follows to activate this feature: 


 


1. From the Menu Bar, select Configuration>Daily Site APB Reset. 


2. From the list of Sites, make your selection. 


3. In the Hrs and Mins fields, make your selection.  These fields make use of the 24-hour 


clock format.   


4. Click the  button. 


5. Click the  button. 
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ZZoonnee  LLiimmiittiinngg  SSeettuupp  


This feature lets you allow a user defined number of Tags into a specified Zone, according to 


their Tagholder Access Group.  This is essentially Zone counting by Tagholder Access Group.  


Activate this feature as follows: 


 


 
Figure 9 – Zone Limiting Wizard Dialog 


 


Assigning Access Groups to a Zone 


1. From the Menu Bar, select Configuration>Zone Limiting. 


2. From the Site drop-down list, make your selection. 


3. From the Zone drop-down list, make your selection. 


4. From the Choice list, select the Tagholder Access Groups you wish to limit access to. 


5. Click the  button alongside the Choice list, thus moving the selected Tagholder Access 


Group to the Selection list. 


 


 


This feature sets selected Zones to Strict Anti-passback (APB) as this feature does not keep record of 


who is in the Zone.  Re-tagging therefore means an increment of people in the Zone, thus returning 


false results. 


 


 


If a Tag belongs to more than one Tagholder Access Group in the Zone, Custom Access only applies 


zone counting on one of these groups.  This takes place as the Custom Access Module does not keep 


a record of what Tagholder Access Group a Tag was allowed in on. 


 


6. Click the  button to move to the next Wizard page. 
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Setting the Number of Users Allowed into the Zone 


 


 


Selecting the Edit Tagholder Access Group Actions checkbox, lets you specify custom allowed and 


or denied actions for each of Tagholder Access Group in the Zone. 


 


1. If required, select the Edit Tagholder Access Groups Actions checkbox. 


 


 


By selecting the Edit Tagholder Access Group Zone Full Actions checkbox you can specify what 


actions occur when the Zone is full or when not yet full.  This is ideal for notifying the next Tag of 


whether the Zone is full for their Tagholder Access Group.  You can specify actions for every 


Tagholder Access Group selected in the Zone. 


 


2. If required, select the Edit Tagholder Access Group Zone Full Actions checkbox. 


3. For each displayed Tagholder Access Group, enter the number of ALLOWED Tagholders 


into the associated textbox. 


4. Click the  button. 


 


Selecting Terminals for Host Validation 


By selecting Terminals here, you change their validation from Controller Validation to Host 


Validation.  This allows the Custom Access Module to get their allowed transactions and decide 


whether to allow access or not. 


 


 


You can customize your actions by selecting the Edit Terminal Actions checkbox.  By not selecting 


the checkbox, the Terminal’s ALLOWED actions are automatically assigned if the Terminal does not 


already have host allowed actions assigned.     


 


1. If required, select the Edit Terminal Actions checkbox. 


2. From the Choice list, select the Terminals to which you wish to apply Host Validation. 


3. Click the  button alongside the Choice list, thus moving the selected Terminal to the 


Selection list. 


4. Click the  button to move to the next Wizard page. 


5. Click the  button. 


 


SSttaattuuss  MMoonniittoorriinngg  


Zone Limiting 


This feature lets you view the number of Tagholders currently in the Zone along with the 


maximum number of Tagholders allowed in the Zone.  An editing option lets you change the 


User Count and Maximum Users Allowed settings from this Dialog. 


 


 


There are instances that when started, Engine transmits rollback transactions.  In some cases these 


transactions filter their way into the Custom Access Module changing the Tag count in a Zone.  In this 


instance, manually change the User Count setting. 


 


1. From the Menu Bar, select Status>Zone Limiting. 


2. From the Tagholder Access Groups drop-down list make your selection. 


3. Edit the Access Group’s User Count and Maximum Users Allowed by clicking on the 


associated field’s  button. 
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Zone Limit Monitor 


This feature shows a complete overview of the Zones setup for Zone Limiting by Tagholder 


Access Group.  The Monitor lists all Zone’s Tagholder Access Groups and their corresponding 


Current and Maximum user counts.  This feature does NOT allow for editing of user counts or 


overriding of denied transactions. 


 


From the Menu Bar, select Status>Zone Limit Monitor. 


 


TTiimmee  LLiimmiitt  RRoouuttee  SSeettuupp  


This feature limits the time a Tagholder can take to proceed through two terminals.  If the 


Tagholder exceeds the specified time limit, the Tagholder will have their access denied until 


someone is notified and the Custom Access Module allows access. 


 


 
Figure 10 – Time Limited Route Wizard Dialog 


 


Exit Terminal Setup 


This is the Terminal that STARTS the timer.   


 


1. From the Menu Bar, select Configuration>Time Limit Route. 


2. From the Site drop-down list, make your selection. 


3. From the Zone drop-down list, make your selection. 


4. From the Choice list, select the Terminal that starts the timer. 







Part 7 – Advanced Software Modules 


22 January 2012 


5. Click the  button alongside the Choice list, thus moving the selected Terminal to the 


Selection list. 


6. Click the  button to move to the next Wizard page. 


 


Entry Terminal Setup 


When a Tagholder tags at this point, the Custom Access Module calculates the time between 


the Exit Terminal and this Entry Terminal.  If the difference exceeds the time specified, the Entry 


Terminal denies access.   


 


1. From the Choice list, select the Entry Terminal. 


2. Click the  button alongside the Choice list, thus moving the selected Terminal to the 


Selection list. 


3. In the Maximum Time group, complete the Hrs, Mins and Secs textboxes. 


 


Depending on the number of Exit Terminals selected previously, this Wizard Page repeats for 


each selected Exit Terminal.   


 


4. Click the  button to move to the next Wizard page. 


5. Click the  button. 


 


Translation - Localisation 


This application is provided with English text.  If you need Localization of the text, dynamically 


translate the text making use of the Locale and Translate functions.  Property resource files 


store the translated text, for distribution with the application. 
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Chapter 4:  ImproVision Module 


Introduction 


The ImproVision Integration Module is a rule-action based Module.  This essentially means a 


matched rule must trigger for execution of up to 5 actions.  Born as a Digital Video Recorder 


based system, for interfacing Digital Video Recorders direct to the ImproNet’s Graphics 


Designer and Graphics Runtime Modules, ImproVision’s interface capabilities now include other 


third-party devices (including Lift Servers and Alarm Panels).    


 


ImproVision’s digital video recording and monitoring integration facilities include: 


 


 Integration with Mirasys V/N Series Digital Video Recording (DVR) equipment. 


 Integration with Dedicated Micro Digital Video Recording (DVR) equipment. 


 


Through the ImproVision framework configuration is carried out using configuration Wizards, 


forming part of ImproVision.  Integration is carried out using graphic displays, part of Graphics 


Designer, and control and monitoring is carried out using the Graphics Runtime Module.   


 


It is assumed that after installing the ImproVision Software that this application will run 


continuously 24 hours a day.  However, if the application is shutdown or the PC needs rebooting 


continue as outlined below, Starting the ImproVision Module. 


 


 


Refer to Part 6 – General Software Modules for information on the Graphics Designer and Graphics 


Runtime Modules. 


 


 


Ensure that Engine’s running for ImproVision to work. 


 


Starting the ImproVision Module 


1. In Windows®, click Start>Programs>ImproNet>Vision Server. 


2. Enter your Username (SYSDBA) and Password (masterkey).  The Password is case-


sensitive. 


 


User Interface 


IImmpprrooVViissiioonn  IInntteeggrraattiioonn  SSeerrvveerr  


The ImproVision Software has been designed with user-friendliness as a major design criterion.  


The Application Window has a menu at the top and three Tabs below.  The System defaults to 


the Log Tab.   
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Figure 11 – Integration Server Dialog 


 


A brief description of each of the drop-down menus associated with the ImproVision Application 


Window follows: 


 


File 


Option Description 


Exit Exits the ImproVision Integration Server. 


Table 2 – File Drop-down Menu 


 


Integration 


Option Description 


Actions Actions you want the ImproVision System to perform.  


Rule Rules to be applied to the Actions.   


Log A log of executed Actions. 


Table 3 – Integration Drop-down Menu 


 


 


Supported Actions could include: 


 Record—creates Actions for camera recordings. 


 Snapshot—creates Actions for capturing pictures locally from a camera. 


 Preset—creates Actions for moving a Pan Tilt Zoom (PTZ) Camera to a preset position. 


 Email—creates Actions for emailing. 


 Log Event—creates Actions for logging to the Integration Server only. 


 IXP400 Action—creates Actions for executing IXP400 created actions and operations. 


 Virtual Output—creates Actions for transmitting data via RS232 or Ethernet Communications. 


 Server Executed App—creates Actions for running applications on the PC hosting the 


Integration Server. 


 Graphics Executed App—creates Actions for running applications on Graphics Runtime 


PCs. 
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Supported Rules could include:   


 IXP400—rules based on IXP400 transactions. 


 Ziton—rules based on Ziton Sensors. 


 Virtual Input—rules based on RS232 or Ethernet Communications. 


 


DVR 


Option Description 


Units A list of the Digital Video Recording (DVR) units stored in the System. 


Table 4 – DVR Drop-down Menu 


 


Configuration 


Option Description 


Event Log Path The default storage location for all recorded Actions. 


Table 5 – Configuration Drop-down Menu 


 


Localize 


Option Description 


Choose Locale Selection of the Country, Language and Variant. 


Translation Allows translation from the base language to the desired language. 


Table 6 – Localize Drop-down Menu 


 


A brief description of Tabs associated with the ImproVision Application Window follows: 


 


Option Description 


Log Displays a log of server-client interaction. 


Database Server A log notifying you of any changes that have taken place in the Database 


(that is creation or modification of Actions or Rules). 


Integration Server A log showing you Actions as they are executed. 


Table 7 – Tabs Displayed in the Application Window 


 


Translation - Localisation 


This ImproVision Software Application is provided with English text.  If you need Localisation of 


the text, dynamically translate the text making use of the Locale and Translate functions.  


Property resource files store the translated text, for distribution with the Application. 


 


Mirasys V (or N) Series Digital Video Recorder (DVR) 


AAccttiivvaattiioonn  ooff  TThhiirrdd--ppaarrttyy  CCoommmmuunniiccaattiioonn  


 


 


Note that the Mirasys V (or N) System Manager application mentioned below is NOT an Impro supplied 


application and is therefore NOT included on the ImproNet Software CD. 


 


 


Please note that the Mirasys V (or N) System Manager V4.4.10 does NOT support the Vista operating 


system platform. 


 


1. Open the Mirasys V (or N) System Manager application. 
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2. Select the  (Local Recorder) tab. 


3. From the Navigation Tree, select General. 


4. Select the Allow SDK and RMC Video Server checkbox. 


5. Select the Allow SDK Alarm Control checkbox. 


6. Click the  button. 


7. From the Navigation Tree select Storage. 


8. Under the Alarm Storage group, select both Not Specified checkboxes (for each camera). 


9. Click the  button. 


 


AAddddiinngg  DDiiggiittaall  VViiddeeoo  RReeccoorrddeerrss  ((DDVVRRss))  


Add Digital Video Recorders (DVRs) in the Integration Server as follows: 


 


1. From the DVR drop-down menu, select Units. 


2. Click the  button. 


3. Read the DVR Wizard start-up screen and then click the  button. 


4. In the DVR Name field, assign your Digital Video Recorder (DVR) a name. 


5. From the DVR Type drop-down menu, select Mirasys V/N Series. 


6. In the IP Address textbox, insert the IP Address of the Digital Video Recorder (DVR). 


7. Click the  button. 


8. Read the Information Screen carefully.  On completion of the download process click the  


button. 


9. Click the  button to exit the Wizard. 


 


 
Figure 12 – Units Dialog 


 


Enabling the Cameras 


1. At the Units dialog, select the Digital Video Recorder’s (DVRs) record you wish to match to 


the camera name. 


2. Click the button. 
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3. In the Cameras dialog, select the Camera record you wish to match to your chosen Digital 


Video Recorder’s (DVRs) record. 


4. Double-click your mouse in the records Title column, replace the text with the Digital Video 


Recorder’s name you assigned earlier. 


5. Click the  button. 


6. Click the  button.   


7. At the Units dialog, click the  button. 


 


AAddddiinngg  DDiiggiittaall  VViiddeeoo  RReeccoorrddeerr  ((DDVVRR))  AAccttiioonnss  


Follow these steps when adding actions you would like the Digital Video Recorder (DVR) 


Camera to perform (that is record, take a snapshot or move): 


 


1. From the Integration drop-down menu, select Actions. 


2. Click the  button. 


3. Read the Action Wizard start-up screen and then click the  button. 


4. In the Action Name textbox, assign your Action a name. 


5. From the Action Type drop-down list, select the appropriate Action Type: 


 Record—opens a new pane at the bottom of the Wizard page letting you add Record 


Duration (secs) and Record Framerate details.  The maximum Record Duration is 120 


seconds and the maximum Framerate is 25. 


 Snapshot—opens a new pane at the bottom of the Wizard page letting you add Pre 


Snapshot Delay details.  The maximum Pre Snapshot Delay is 10. 


 Preset—directs you to the Next button for selection of the Dome Camera. 


 


For the sake of this example we selected the Record Action Type. 


 


6. In the Record Duration (secs) textbox adjust the figure according to your requirements. 


7. In the Record Framerate textbox adjust the figure according to your requirements. 


8. Click the  button. 


9. From the list of available cameras, click the record of the camera you want. 


10. Click the  button. 


11. Read the Information Screen carefully.  On completion click the  button. 
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Figure 13 – Actions Dialog 


 


12. At the Actions dialog, click the  button. 


 


AAddddiinngg  RRuulleess  


A Rule is best described as criteria required for performance of an Action (like the Record Action 


just created).  Set Rules as follows: 


 


1. From the Integration drop-down menu, select Rules. 


2. Click the  button. 


3. Read the Rule Wizard start-up screen and then click the  button. 


4. In the Rule Name textbox, assign your Rule a name. 


5. From the Rule Type drop-down list, select IXP400. 


6. From the Rule Filter panel select the event filter you want action to take place on.   


 


 


When Engine receives a transaction, the Integration Server matches the transaction with the IXP400 


Rule filters selected.  


 


For the sake of this example we selected the Tagholders event filter. 


 


 


Selecting other (or additional) event filters return different lists for refining you Rules.  For example by 


selecting Terminals from the Rule Filter panel, a list of available Terminals returns for your selection. 


 


7. Click the  button. 


8. Select a Tagholder record from the list. 


 


 


A Select All checkbox appears at the bottom of the dialog. 


 


9. Click the  button. 
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10. In the All Actions panel, select the Action you created earlier. 


11. Click the  button to move the Action into the Selected Actions panel. 


12. Click the  button. 


13. Click the  button. 


 


 
Figure 14 – Rules Dialog 


 


14. Click the  button. 


 


VViieeww  AAccttiioonnss  LLooggggeedd  


This option lets you view a log of all executed Actions. 


 


1. From the Integration drop-down menu, select Log. 


2. Click the  button. 
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Figure 15 – Log Dialog 


 


 


The Date, Actions and Rules panels situated at the bottom of the Log dialog provide you with additional 


filtering (search) options. 


 


3. In the Log dialog, select an Action record for review.   


4. Click on the Action record’s  button. 


5. The Execution Results dialog gives you an overview of the executed action.  Review the 


actual Digital Video Recorder (DVR) footage, by clicking on the (View Results)  button. 


6. Close the Digital Video Recorder footage dialog, by clicking the Close button in the top 


right-hand corner of the dialog. 


7. Close the Execution Results dialogue, click the  button. 


8. Close the Log dialog, click the  button. 


 


GGrraapphhiiccss  


Graphics.properties File 


1. From C:\ImproNet, open the Graphics.properties file. 


2. Set the system.cctv setting to your preferred setting from within the range of 6 to 10. 


3. From the File drop-down menu select Save. 


4. From the File drop-down menu select Exit. 
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Graphics Designer 


1. Open the Graphics Designer Module.  (For more information refer to Part 6 – General 


Software Modules). 


 


 


If you do not see the Units icon palette (with the Digital Video Recorder (DVR) and Camera icons), 


your Registration Reader is NOT unlocked for Closed Circuit Television (CCTV). 


 


2. From the Units icon palette, click and drag the Digital Video Recorder (DVR) icon into 


position on the Floor Plan. 


3. From the Select Camera dialog, select the Digital Video Recorder (DVR) you want to add 


to the Floor Plan. 


4. Click the  button. 


5. From the Units icon palette, click and drag the Camera icon into position on the Floor Plan. 


6. From the Select Camera dialog, select the Camera you want to add to the Floor Plan. 


7. Click the  button. 


 


 


After dragging and placing each unit, the units allocated will be removed from the list of units available. 


 


Graphics Runtime 


Open the Graphics Runtime Module.  (For more information refer to Part 6 – General Software 


Modules). 


 


 


If you do not see the Digital Video Recorder (DVR) and Camera icons, your Registration Reader is 


NOT unlocked for Closed Circuit Television (CCTV). 


 


Right-clicking your mouse over the Digital Video Recorder (DVR) and Camera icons gives you 


access to the following options: 


 


Digital Video Recorder (DVR) 


Option Description 


Live Displays a live screening of the Digital Video Recorder (DVR) footage. 


Playback Plays back a recorded screening of the Digital Video Recorder (DVR) 


footage. 


V (or N) Workstation A shortcut to the Mirasys V (or N) Workstation application, for viewing 


Mirasys related events (for example motion detection). 


Table 8 – Digital Video Recorder (DVR) Icon Options 


 


Camera 


Option Description 


Live Displays a live screening of the Digital Video Recorder (DVR) footage. 


Playback Plays back a recorded screening of the Digital Video Recorder (DVR) 


footage. 


Table 9 – Camera Icon Options 


 


 


When a Camera Action occurs, a live video dialog briefly opens, letting you view the camera footage. 
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Using the Graphics Runtime, Tools drop-down menu, gives you access to the following options: 


 


Tools  


Option Description 


Event Log Path Lets you set or change the path to the stored video files. 


Event Log Provides you with a table of all Actions recorded. 


Video Settings Offers settings for the live video dialog. 


Table 10 – Tools Drop-down Menu Options 


 


Dedicated Micros Digital Video Recorder (DVR) 


AAddddiinngg  DDiiggiittaall  VViiddeeoo  RReeccoorrddeerrss  ((DDVVRRss))  


Add Digital Video Recorders (DVRs) in the Integration Server as follows: 


 


1. From the DVR drop-down menu, select Units. 


2. Click the  button. 


3. Read the DVR Wizard start-up screen and then click the  button. 


4. In the DVR Name field, assign your Digital Video Recorder (DVR) a name. 


5. From the DVR Type drop-down menu, select Dedicated Micros. 


6. In the IP Address textbox, insert the IP Address of the Digital Video Recorder (DVR). 


7. Click the  button. 


8. In the Usernames and Passwords screen, if using the default settings, click the  button. 


 


 


The FTP username and password referred to here is the ADMIN FTP account. 


 


9. Read the Information Screen carefully.  On completion of the download process click the 


 button. 


10. At the DVR Reset screen, select the Reset the DVR after Wizard has completed 


(Recommended) checkbox. 


 


 


We recommend that you load the script and reset the DVR at this time.  If you don’t load the script and 


reset the Digital Video Recorder (DVR), the Digital Video Recorder (DVR) will load, however the record 


action will not function. 


 


11. Click the  button. 


12. Click the  button to exit the Wizard. 


 


 


Please note, configuration of the Digital Video Recorder (DVR) takes approximately 2 minutes per 


Digital Video Recorder (DVR). 
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Figure 16 – Units Dialog 


 


Extra Functions Available from the Units Dialog 


Right clicking on a particular Dedicated Micros Digital Video Recorder (DVR) record presents 


the following options: 


  


 Remote Setup—opens a web browser and logs on to the Digital Video Recorder’s (DVR) 


web server.  When requested, enter the web or HTTP protocol Username and Password.   


 


 


The default username is dm.  The default password is web.  The password is case-sensitive. 


 


 


Once logged on you may change any setting on the Digital Video Recorder (DVR), therefore ensure 


that you follow the supplied Dedicated Micros User Manual shipped with the Digital Video Recorder 


(DVR).  


Ensure that you do NOT change any settings that may conflict with the Vision Server.  These settings 


include:   Module, Nuisance Count, Pulse Extension (secs), Select Alarm Zone, Zone Alarm Input and 


Create Database Entry. 


 


 Add/Change Script— lets you run the script update on the Digital Video Recorder (DVR).  


If you failed to run the script during the DVR Wizard, then run the script from this location.  


The script is included with ImproNet V7.6.  In a default installation, run the script from 


C:\ImproNet\thirdparty\dm\scripts. 


 


 


The Digital Video Recorder (DVR) resets after this action. 


 


 Passwords—lets you make sure that the Vision Server has the correct credentials to work 


with.  Each of these usernames and passwords have a specific background purpose.  It is, 


therefore, important that you update these usernames and passwords after changing them 
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on the Digital Video Recorder (DVR) itself (through the Remote Setup).  The FTP username 


and password referred to here is the ADMIN FTP account.   


 


AAddddiinngg  DDiiggiittaall  VViiddeeoo  RReeccoorrddeerr  ((DDVVRR))  AAccttiioonnss  


Follow these steps when adding actions you would like the Digital Video Recorder (DVR) 


Camera to perform (that is record, take a snapshot or move): 


 


1. From the Integration drop-down menu, select Actions. 


2. Click the  button. 


3. Read the Action Wizard start-up screen and then click the  button. 


4. In the Action Name textbox, assign your Action a name. 


5. From the Action Type drop-down list, select the appropriate Action Type: 


 Record—opens a new pane at the bottom of the Wizard page letting you add Record 


Duration (secs) and Record Framerate details.  The maximum Record Duration is 120 


seconds and the maximum Framerate is 25. 


 Snapshot—opens a new pane at the bottom of the Wizard page letting you add Pre 


Snapshot Delay details.  The maximum Pre Snapshot Delay is 10. 


 Preset—directs you to the Next button for selection of the Dome Camera. 


 


For the sake of this example we selected the Record Action Type. 


 


6. Click the  button. 


7. From the list of available cameras, click the record of the camera you want. 


8. Click the  button. 


9. Read the Information Screen carefully.  On completion click the  button. 


 


 
Figure 17 – Actions Dialog 


 


10. At the Actions dialog, click the  button. 
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AAddddiinngg  RRuulleess  


A Rule is best described as criteria required for performance of an Action (like the Record Action 


just created).  Set Rules as follows: 


 


1. From the Integration drop-down menu, select Rules. 


2. Click the  button. 


3. Read the Rule Wizard start-up screen and then click the  button. 


4. In the Rule Name textbox, assign your Rule a name. 


5. From the Rule Type drop-down list, select IXP400. 


6. From the Rule Filter panel select the event filter you want action to take place on.   


 


 


When Engine receives a transaction, the Integration Server matches the transaction with the IXP400 


Rule filters selected.  


 


For the sake of this example we selected the Tagholders event filter. 


 


 


Selecting other (or additional) event filters return different lists for refining you Rules.  For example by 


selecting Terminals from the Rule Filter panel, a list of available Terminals returns for your selection. 


 


7. Click the  button. 


8. Select a Tagholder record from the list. 


 


 


A Select All checkbox appears at the bottom of the dialog. 


 


9. Click the  button. 


10. In the All Actions panel, select the Action you created earlier. 


11. Click the  button to move the Action into the Selected Actions panel. 


12. Click the  button. 


13. Click the  button. 


 


 
Figure 18 – Rules Dialog 
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14. Click the  button. 


 


VViieeww  AAccttiioonnss  LLooggggeedd  


This option lets you view a log of all executed Actions. 


 


1. From the Integration drop-down menu, select Log. 


2. Click the  button. 


 


 
Figure 19 – Log Dialog 


 


 


The Date, Actions and Rules panels situated at the bottom of the Log dialog provides you with 


additional filtering (search) options. 


 


3. In the Log dialog, select an Action record for review.   


4. Click on the Action record’s  button. 


 


 


Double-clicking your mouse over the Action’s record also opens the Execution Results dialog. 


 


5. The Execution Results dialog gives you an overview of the executed action.  Review the 


actual Digital Video Recorder (DVR) footage, by clicking on the (View Results)  button. 


6. Close the Digital Video Recorder footage dialog, by clicking the Close button in the top 


right-hand corner of the dialog. 


7. Close the Execution Results dialogue, click the  button. 
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8. Close the Log dialog, click the  button. 


 


GGrraapphhiiccss  


Graphics.properties File 


1. From C:\ImproNet, open the Graphics.properties file. 


2. Set the system.cctv setting to 8. 


3. From the File drop-down menu select Save. 


4. From the File drop-down menu select Exit. 


 


Graphics Designer 


1. Open the Graphics Designer Module.  (For more information refer to Part 6 – General 


Software Modules). 


 


 


If you do not see the Units icon palette (with the Digital Video Recorder (DVR) and Camera icons), 


your Registration Reader is NOT unlocked for Closed Circuit Television (CCTV). 


 


2. From the Units icon palette, click and drag the Digital Video Recorder (DVR) icon into 


position on the Floor Plan. 


3. From the Select Camera dialog, select the Digital Video Recorder (DVR) you want to add 


to the Floor Plan. 


4. Click the  button. 


5. From the Units icon palette, click and drag the Camera icon into position on the Floor Plan. 


6. From the Select Camera dialog, select the Camera you want to add to the Floor Plan. 


7. Click the  button. 


 


 


After dragging and placing each unit, the units allocated will be removed from the list of units available. 


 


Graphics Runtime 


Open the Graphics Runtime Module.  (For more information refer to Part 6 – General Software 


Modules). 


 


 


If you do not see the Digital Video Recorder (DVR) and Camera icons, your Registration Reader is 


NOT unlocked for Closed Circuit Television (CCTV). 


 


Right-clicking your mouse over the Digital Video Recorder (DVR) and Camera icons gives you 


access to the following options: 


 


Digital Video Recorder (DVR) 


Option Description 


Live Displays a live screening of the Digital Video Recorder (DVR) footage. 


Playback Plays back a recorded screening of the Digital Video Recorder (DVR) 


footage. 


Event Log Provides you with a table of all Actions recorded. 


Table 11 – Digital Video Recorder (DVR) Icon Options 
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Camera 


Option Description 


Live Displays a live screening of the Digital Video Recorder (DVR) footage. 


Playback Plays back a recorded screening of the Digital Video Recorder (DVR) 


footage. 


Event Log Provides you with a table of all Actions recorded. 


Table 12 – Camera Icon Options 


 


 


When a Camera Action occurs, a live video dialog briefly opens, letting you view the camera footage. 


 


Using the Graphics Runtime, Tools drop-down menu, gives you access to the following options: 


 


Tools  


Option Description 


Event Log Path Lets you set or change the path to the stored video files. 


Event Log Provides you with a table of all Actions recorded. 


Video Settings Offers settings for the live video dialog. 


Table 13 – Tools Drop-down Menu Options 


 


Virtual Input Output Control 


Virtual Input Output Control is an add-on to the existing ImproVision Integration Server.  The 


Virtual Input Output feature  is a software controlled Input or Output communications 


mechanism capable of listening to and transmitting data via TCP/IP, UDP or Serial (COM or 


USB).  Virtual Input functions as a rule, which means that, data received must match up to the 


user defined data.  When a match is found, any one or more of the Integration Server Actions 


can be executed.  


 


 


Ensure that you unlock your Registration Interface for Virtual IO before proceeding further. 


 


VViirrttuuaall  IInnppuutt  SSeettuupp  


A Rule is best described as criteria required for performance of an Action.  Set the Virtual Input 


Setup Rules as follows: 


 


1. From the Integration drop-down menu, select Rules. 


2. Click the  button. 


3. Read the Rule Wizard start-up screen and then click the  button. 


4. In the Rule Name textbox, assign your Rule a name. 


5. From the Rule Type drop-down list, select Virtual Input. 


6. Complete the Regular Expression Search String textbox.  


 


 


For help writing Regular Expressions go to http://java.sun.com/docs/books/tutorial/essential/regex/. 


 


 


7. To reply to the third-party device, select the Reply String checkbox.   


  



http://java.sun.com/docs/books/tutorial/essential/regex/





  Part 7 – Advanced Software Modules 


January 2012  39 


8. In the Reply String textbox, enter the string for matching.   


 


 


The Reply String textbox is ASCII based, however if you require a character such as a carriage return 


or line feed, right-click your mouse over the textbox.  From the shortcut menu, select Custom 


Character.  Thereafter make your selection from the available options.   


 


9. In the Reply String textbox, capture the response string. 


10. From the Listen Via drop-down list, make your selection from the following: 


 Serial Communications—select this option for COM and USB Communications.  On 


selection, you are asked to complete the Comm Port, Baud Rate, Data Bits, Stop Bits 


and Parity settings. 


 TCPIP Server Communications—select this option when using your local TCPIP 


Server.  On selection, you are asked to complete the Local IP and Local Port textboxes. 


 TCPIP Client Communications—select this option to connect to the TCPIP Server.  


On selection, you are asked to complete the Host IP and Host Port textboxes.  


Thereafter indicate whether to Enable Polling.  On selecting the Enable Polling 


checkbox, the Polling Interval, Polling String and Poll on Inactivity or Poll Continuously 


fields activate for completion.   


 UDP Communications—this option simulates a local UDP Server.  On selection, you 


are asked to complete the Local IP and Local Port textboxes.  Thereafter indicate 


whether to Enable Polling.  On selecting the Enable Polling checkbox, the Polling 


Interval, Polling String and Poll on Inactivity or Poll Continuously fields activate for 


completion. 


11. Click the  button. 


12. Based on the selection you made in point 10, complete the available fields. 


13. Click the  button. 


14. In the All Actions panel, select an Action you created earlier. 


15. Click the  button to move the Action into the Selected Actions panel. 


16. Click the  button. 


17. Click the  button. 


18. Click the  button. 


 


VViirrttuuaall  OOuuttppuutt  SSeettuupp  


An Action is best described as a task you want the Integration Server to perform. 


 


1. From the Integration drop-down menu, select Actions. 


2. Click the  button. 


3. Read the Action Wizard start-up screen and then click the  button. 


4. In the Action Name textbox, assign your Action a name. 


5. From the Action Type drop-down list, select Virtual Output. 


6. In the Command String textbox, enter the string you wish to send or transmit.   


 


 


The Command String and Acknowledge String textboxes are ASCII based, to add a non-ASCII 


character or information from the triggering IXP400 rule by right-clicking your mouse over the textbox.  


Select one of the following options: 


 


 IXP400 Details—enters information from the triggering IXP400 rule, for example Controller 


Name or Controller SLA. 


 Custom Character—enters a non-ASCII character such as a carriage return or line feed. 
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7. To verify that the server has received the data correctly, select the Acknowledge String 


checkbox.   


8. Complete the Acknowledge String textbox. 


9. From the Send Via drop-down list, make your selection from the following: 


 Serial Communications—select this option for COM and USB Communications.  On 


selection, you are asked to complete the Comm Port, Baud Rate, Data Bits, Stop Bits 


and Parity settings. 


 TCPIP Client Communications—select this option to connect to the TCPIP Server.  


On selection, you are asked to complete the Host IP and Host Port textboxes.  


Thereafter indicate whether to Enable Polling.  On selecting the Enable Polling 


checkbox, the Polling Interval, Polling String and Poll on Inactivity or Poll Continuously 


fields activate for completion.   


 UDP Communications—this option simulates a local UDP Server.  On selection, you 


are asked to complete the Subnet Mask, Destination IP and Destination Port textboxes.  


Thereafter indicate whether to Enable Polling.  On selecting the Enable Polling 


checkbox, the Polling Interval, Polling String and Poll on Inactivity or Poll Continuously 


fields activate for completion. 


10. Click the  button. 


11. Read the Information Screen carefully.  On completion click the  button. 


12. At the Actions dialog, click the  button. 
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Chapter 5:  Ganz Server Module 


Introduction 


The Ganz Server Module is a complete, graphic-based digital video recording and monitoring 


software application.   


 


Ganz Server integrates closely with ImproNet’s Graphics Designer and Graphics Runtime 


Modules.   


 


Through the Ganz Server framework configuration of the Ganz CCTV system is carried out 


using configuration Wizards, forming part of Ganz Server.  Integration is carried out using 


graphic displays, part of Graphics Designer, and control and monitoring is carried out using the 


Graphics Runtime Module.   


 


It is assumed that after installing the Ganz Server Module that this application will run 


continuously 24 hours a day.  However, if the application is shutdown or the PC needs rebooting 


continue as outlined below, Starting the Ganz Server Module. 


 


 


Refer to Part 6 – General Software Modules for information on the Graphics Designer Module and the 


Graphics Runtime Module. 


 


 


Ensure that Engine’s running for the Ganz Server Module to work. 


 


Starting the Ganz Server Module 


1. In Windows®, click Start>Programs>ImproNet>Ganz Server. 


 


User Interface 


GGaannzz  SSeerrvveerr  MMoodduullee  


The Ganz Server Software Module has been designed with user-friendliness as a major design 


criterion.  The Application Window has a menu at the top and five Tabs below.  The System 


defaults to the Log Tab.   
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Figure 20 – Integration Server Dialog 


 


A brief description of each of the drop-down menus associated with the Ganz Server Application 


Window follows: 


 


File 


Option Description 


Open Wavelet 


Viewer 


Lets you select the channel for viewing of snapshots and video on that 


channel. 


Exit Exits the Ganz Integration Server. 


Table 14 – File Drop-down Menu 


 


Integration 


Option Description 


Actions Actions you want the Digital Video Recording (DVR) System to perform. 


Rules Rules to be applied to the Actions. 


Log A list of the Digital Video Recording (DVR) units stored in the System. 


Table 15 – Integration Drop-down Menu 


 


DVR 


Option Description 


Remote Download Enables the downloading of video to a desired storage location. 


Syncronize Runs the Digital Video Recording (DVR) Synch Wizard, assisting in 


Database maintenance. 


Units A list of the Digital Video Recording (DVR) units stored in the System. 


Table 16 – DVR Drop-down Menu 
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Settings 


Option Description 


Server Settings Accesses the Advanced Server Settings dialog. 


General Settings Accesses the General Server Settings dialog. 


Configuration 


Settings 


Lets you change the Event Server Port and Proxy Server Base Port 


numbers. 


Table 17 – Settings Drop-down Menu 


 


Localize 


Option Description 


Choose Locale Selection of the Country, Language and Variant. 


Translation Allows translation from the base language to the desired language. 


Table 18 – Localize Drop-down Menu 


 


Proxy 


Option Description 


View Lets you view the statistics from the Proxy Servers. 


Table 19 – Proxy Drop-down Menu 


 


A brief description of Tabs associated with the ImproVision Application Window follows: 


 


Option Description 


Licensing Displays the number of PCs allowed to use the application. 


Log Displays a log of server-client interaction. 


Synch Server Displays synchronisation details for the Database and Digital Video 


Recorder (DVR) Proxy. 


Database Server A log notifying you of any changes that have taken place in the Database 


(that is creation or edition of Actions or Rules). 


Integration Server A log showing you Actions as they are executed. 


Table 20 – Tabs Displayed in the Application Window 


 


Translation - Localisation 


This Ganz Server Software Application is provided with English text.  If you need Localisation of 


the text, dynamically translate the text making use of the Locale and Translate functions.  


Property resource files store the translated text, for distribution with the Application. 


 


Ganz Digital Video Recorder (DVR) 


AAddddiinngg  DDiiggiittaall  VViiddeeoo  RReeccoorrddeerrss  ((DDVVRRss))  


Add Digital Video Recorders (DVRs) in the Integration Server as follows: 


 


1. From the DVR drop-down menu, select Units. 


2. Click the  button. 


3. Read the DVR Wizard start-up screen and then click the  button. 


4. In the DVR Name field, assign your Digital Video Recorder (DVR) a name. 


5. From the DVR Type drop-down menu, select GANZ. 
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6. In the IP Address textbox, insert the IP Address of the Digital Video Recorder (DVR). 


7. Click the  button. 


8. Read the DVR Information Screen carefully.  On completion of the download process click 


the  button. 


9. Read the next DVR Information Screen carefully and then click the  button. 


10. Read the Camera Information Screen carefully and then click the  button. 


11. Click the  button to exit the Wizard. 


 


 
Figure 21 – Units Dialog 


 


12. At the Units dialog, click the  button. 


13. Click the  button. 


 


AAddddiinngg  AAccttiioonnss  


Follow these steps when adding actions you would like the Digital Video Recorder (DVR) 


Camera to perform (that is record, take a snapshot or move): 


 


1. From the Integration drop-down menu, select Actions. 


2. Click the  button. 


3. Read the Action Wizard start-up screen and then click the  button. 


4. In the Action Name textbox, assign your Action a name. 


5. From the Action Type drop-down list, select the appropriate Action Type: 


 Record—opens a new Action Filter textbox, letting you add Record Duration details.  


The maximum Record Duration is 300 seconds. 


 Snapshot—opens a new Action Filter textbox, letting you add Delay details.  The 


maximum Delay is 300 seconds. 


 Preset—lets you direct the Camera to a specified Preset position.  The maximum 


Preset position is 99. 
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 Email—opens two new Action Filter textboxes, letting you add Host and Port details. 


 Log Event—opens a new Action Filter textbox, letting you select an item to associate 


with. 


 


For the sake of this example we selected the Record Action Type. 


 


6. In the Action Filter textbox adjust the Record for duration figure according to your 


requirements. 


7. Click the  button. 


8. From the list of available cameras, click the record of the camera you want. 


9. Click the  button. 


10. Read the Information Screen carefully.  On completion click the  button. 


 


 
Figure 22 – Actions Dialog 


 


11. At the Actions dialog, click the  button. 


 


AAddddiinngg  RRuulleess  


A Rule is best described as criteria required for performance of an Action (like the Record Action 


just created).  Set Rules as follows: 


 


1. From the Integration drop-down menu, select Rules. 


2. Click the  button. 


3. Read the Rule Wizard start-up screen and then click the  button. 


4. In the Rule Name textbox, assign your Rule a name. 


5. From the Rule Type drop-down list, select IXP400. 


6. From the Rule Filter panel select the event filter you want action to take place on.   


 


 


When Engine receives a transaction, the Integration Server matches the transaction with the IXP400 


Rules filters selected. 
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For the sake of this example we selected the Tagholders event filter. 


 


 


Selecting other (or additional) event filters return different lists for refining you Rules.  For example by 


selecting Terminals from the Rule Filter panel, a list of available Terminals returns for your selection. 


 


7. Click the  button. 


8. Select a Tagholder record from the list. 


 


 


A Select All checkbox appears at the bottom of the dialog. 


 


9. Click the  button. 


10. In the All Actions panel, select the Action you created earlier. 


11. Click the  button to move the Action into the Selected Actions panel. 


12. Click the  button. 


13. Click the  button. 


 


 
Figure 23 – Rules Dialog 


 


14. Click the  button. 


 


VViieeww  AAccttiioonnss  LLooggggeedd  


This option lets you view a log of all executed Actions. 


 


1. From the Integration drop-down menu, select Log. 


2. Click the  button. 
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Figure 24 – Log Dialog 


 


3. In the Log dialog, select an Action record for review.   


4. Click on the Action record’s  button. 


5. The Execution Results dialog gives you an overview of the executed action.  Review the 


actual Digital Video Recorder (DVR) footage, by clicking on the (View Results)  button. 


6. Close the Digital Video Recorder footage dialog, by clicking the Close button in the top 


right-hand corner of the dialog. 


7. Close the Execution Results dialogue, click the  button. 


8. Close the Log dialog, click the  button. 


 


GGrraapphhiiccss  


Graphics.properties File 


1. From C:\ImproNet, open the Graphics.properties file. 


2. Set the system.cctv setting to 5. 


3. From the File drop-down menu select Save. 


4. From the File drop-down menu select Exit. 


 


Graphics Designer 


1. Open the Graphics Designer Module.  (For more information refer to Part 6 – General 


Software Modules). 


 


 


If you do not see the Units icon palette (with the Digital Video Recorder (DVR) and Camera icons), 


your Registration Reader is NOT unlocked for Closed Circuit Television (CCTV). 


 


2. From the Units icon palette, click and drag the Digital Video Recorder (DVR) icon into 


position on the Floor Plan. 


3. From the Select Camera dialog, select the Digital Video Recorder (DVR) you want to add 


to the Floor Plan. 


4. Click the  button. 
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5. From the Units icon palette, click and drag the Camera icon into position on the Floor Plan. 


6. From the Select Camera dialog, select the Camera you want to add to the Floor Plan. 


7. Click the  button. 


 


 


After dragging and placing each unit, the units allocated will be removed from the list of units available. 


 


Graphics Runtime 


Open the Graphics Runtime Module.  (For more information refer to Part 6 – General Software 


Modules). 


 


 


If you do not see the Digital Video Recorder (DVR) and Camera icons, your Registration Reader is 


NOT unlocked for Closed Circuit Television (CCTV). 


 


Right-clicking your mouse over the Digital Video Recorder (DVR) and Camera icons gives you 


access to the following options: 


 


Option Description 


Live Displays a live screening of the Digital Video Recorder (DVR) footage. 


Playback Plays back a recorded screening of the Digital Video Recorder (DVR) 


footage. 


Table 21 – Digital Video Recorder (DVR) and Camera Icon Options 


 


 


When a Camera Action occurs, a live video dialog briefly opens, letting you view the camera footage. 


 


Using the Graphics Runtime, Tools drop-down menu, gives you access to the following options: 


 


Option Description 


Event Log Provides you with a table of all Actions recorded. 


Video Settings Offers settings for the live video dialog. 


Table 22 – Digital Video Recorder (DVR) Icon Options 


 


Advanced Setup Options for the Ganz Digital Video Recorder (DVR) 


SSeerrvveerr  SSeettttiinnggss  


1. In the Ganz Integration Server, from the Settings drop-down menu, select Server Settings.   


2. The Advanced Settings dialog lets you change the following settings: 


 Check the Database for changes delay (ms)—set the delay in milliseconds. 


 Config Keep Alive Delay (ms)—keeps the connection to the Digital Video Recorder 


(DVR) alive for a maximum of 30 seconds. 


 DVR Date Format—sets the Digital Video Recorders (DVR) date format. 


 Sync Manager Sleep Delay—synchronizes the Digital Video Recorder (DVR) and the 


PC using the PCs time. 


3. Click the  button. 
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GGeenneerraall  SSeettttiinnggss  


 


 


Changes to these settings can adversely affect the System’s functionality. 


 


1. In the Ganz Integration Server, from the Settings drop-down menu, select General 


Settings.   


2. The General Settings dialog lets you change the following settings: 


 Timeout Wait (ms)—period of time to delay before communication times out. 


 Tips—lets you enable or disable the display of tips on software start-up. 


 Bandwidth Settings—sets the communications bandwidth to suit the protocol in use. 


 Sleep Rate—sets the time between sending network packets.  Increasing this value 


may improve performance on slower network connections (WAN Connections). 


 Validate Termination with Password—lets you enable or disable the close program 


password request. 


3. Click the  button. 


 


CCoonnffiigguurraattiioonn  SSeettttiinnggss  


 


 


Activate these settings by re-starting the Integration Server. 


 


1. In the Ganz Integration Server, from the Settings drop-down menu, select Configuration 


Settings.   


2. The Configuration Settings dialog lets you change the following settings: 


 Event Server Port—select the Port number, the default setting is 26673. 


 Proxy server Base Port—select the Port number, the default setting is 2000. 


 Logging Mode—set the state of the Log file. 


3. Click the  button. 


 


DDiiggiittaall  VViiddeeoo  RReeccoorrddeerr  ((DDVVRR))  RReemmoottee  SSeettuupp  


This menu provides for the setting up and or viewing of many of the Closed Circuit Television 


(CCTV) system parameters.  Some of these settings are read-only and dependant on the Digital 


Video Recorder (DVR) unit. 


 


1. In the Ganz Integration Server, from the DVR drop-down menu, select Units. 


2. In the Units dialog, select the Digital Video Recorder (DVR). 


3. Right-click over the selected Digital Video Recorder (DVR). 


4. From the Menu, select the Remote Setup option. 
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Figure 25 – Remote Setup Dialog 


 


 


The sections that follow refer to settings directly affecting ImproNet, for details on all other settings, 


please refer to the Ganz Digital Video Recorder (DVR) Instruction Manual. 


 


Alarms 


Option Description 


General Tag Lets you set the pre and post recording times and the Buzzer parameters 


for each listed alarm number.   


Alarm Output 1 Tab  Allows selection of the following Closed Circuit Television (CCTV) 


triggers: 


 Disk Full—if checked, an alarm occurs when the disk is 


full. 


 Admin Password—if checked, an alarm occurs on entry 


of the incorrect Admin Password. 


 Network Failure—if checked, an alarm occurs when 


Closed Circuit Television (CCTV) network failure occurs. 


 Event Partition—if checked, an alarm occurs when the 


Event Partitions at maximum capacity. 


 Select All Motion—if checked, an alarm occurs when 


motions detected by ANY Camera. 


 Motion On—if checked, an alarm occurs when motions 


detected by ONE Camera. 


 Select All Video—if checked, an alarm occurs when 


videos lost on ALL Cameras. 







  Part 7 – Advanced Software Modules 


January 2012  51 


Option Description 


 Video Loss On—if checked, an alarm occurs when videos 


lost on any Camera. 


 Alarm On Channels—check the channel on which the 


Alarm conditions required. 


 Alarm Off—select Manual or Auto method of switching 


Alarm off. 


Table 23 – Alarm Menu Options 


 


Audio 


This menu option lets you select the audio settings (Associated Video Channel, Volume, 


Bypass On and Associated Audio Volume) for each video channel on the Digital Video 


Recorder (DVR). 


 


Cameras 


This menu option lets you select various parameters for each camera connected to the Digital 


Video Recorder (DVR).  These parameters include:  Brightness, Contrast, Saturation and 


Hue.  More complex options include: 


 


Option Description 


Covert Monitor The Camera is covert (not displayable or locked) on the Digital Video 


Recorder (DVR) monitor when you select this option.   


Covert Web  The Camera is covert (not displayable or locked) on Graphics Runtime or 


through the Web when you select this option.   


Table 24 – Camera Menu Options 


 


Date and Time 


This menu option lets you select various date and time related parameters.  These parameters 


include:  Daylight Saving and Date Display.  A more complex option includes: 


 


Option Description 


Time Server Setup Time reference from another server. 


Table 25 – Date and Time Menu Options 


 


Display Setup 


This menu option lets you select the display settings (Sequence, Spot Monitor and 


Transparency Settings) for each Digital Video Recorder (DVR) Monitor only.    


 


Hard Drive 


This menu option provides you with information about the Hard Drives in the Digital Video 


Recorder (DVR) 


 


Mail 


This menu option lets you enable mail notification; this means that notification of various Events 


(Incorrect Administrator Password, Disk Full, Motion Detection, Alarm On, Menu 


Modified, Video Loss On, No Event and Event Conditions) in the Digital Video Recorder 


(DVR) can be e-mailed automatically to designated e-mail addresses. 
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Motion Detection 


This menu option lets you set up Camera motion detection options. 


 


Option Description 


Area Monitors only the selected screen area.  (Define the selection by right-


clicking the required squares on the Screen panel. 


Full Monitors the entire screen area.   


Sensitivity Sets the screen sensitivity. 


Camera Details Review the Camera details for each channel here. 


Table 26 – Motion Detection Menu Options 


 


System 


This menu option provides system information for the Digital Video Recorder (DVR). 


 


Telemetry 


This menu option shows the selected Digital Video Recorders (DVR) Unit Address and Baud 


Rate. 


 


User Defined 


This menu option lets you define how you want the Cameras, attached to the Digital Video 


Recorder (DVR), to display in the Digital Video Recorder (DVR) Monitor.  


 


Option Description 


Channel or Camera 


Selection 


Select the Camera and Channel combination. 


Screen Selection Select the various screen formats. 


Table 27 – User Defined Menu Options 


 


 
USER NOTES 
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CSV Import Utility 


 


The format of a CSV file must match the format of the Database that is receiving the data. 


 


 


If you have no experience with databases or CSV files, we recommend that you consult your 


network administrator. 


 


CSV Overview 


The CSV Import Utility enables you to import a Comma Separated Value (CSV) file into the 


ImproNet Database. 


 


 


Use the CSV Import Utility to import data from other database systems to the ImproNet Database. 


 


WWhhyy  IImmppoorrtt  aa  CCSSVV  FFiillee??  


CSV files are commonly used to transfer data between different databases.  For example, you 


may already have a database containing thousands of records – CSV Import lets you transfer 


this existing data to the ImproNet Database without re-entering it one record at a time.   


 


Specific examples of CSV Import use include the following: 


 


 Transferring a company’s existing employee details to the ImproNet Database. 


 Transferring a list of department names to the ImproNet Database. 


 Transferring details from another access control system to the ImproNet Database. 


 


HHooww  ttoo  CCrreeaattee  aa  CCSSVV  FFiillee  


There are two methods to create a CSV file: 


 


 Export data as a CSV file from another Database—almost all Databases have a CSV 


export facility.  Consult the documentation of the database containing the data to export.  


Export the relevant data to a CSV file using the database’s CSV export facility. 


 Manually create it—you can create a CSV file with a text editor.  Refer to page 9 for 


details. 
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Importing a CSV File 


 


 


Close all ImproNet Software before opening the CSV Import Utility. 


 


GGuuiiddeelliinneess  ffoorr  CCSSVV  IImmppoorrtt  UUttiilliittyy  


 Parent Tables must be added before Child Tables. 


 Add tables with Primary Keys before tables containing Foreign Keys. 


 Not null fields must contain data, even if it is a space character. 


 VarChar fields can have spaces. 


 All fields must be separated by commas. 


 


To open the CSV Import Utility, proceed as follows: 


 


1. In Windows®, click Start>Programs>ImproNet>Utils>Import. 


2. Enter your Username and Password. 


 


OOppeenn  CCSSVV  FFiillee  


 
Figure 1 – CSV Importer 


 


1. Click on the  button. 


2. Browse and select the relevant CSV file. 


 


 
Figure 2 – Open CSV Dialog 
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3. Click Open. 


 


 


Repeat steps 1 to 3 for each CSV file to be imported. 


 


EEnnssuurree  CCoorrrreecctt  SSeeqquueennccee  


If you are importing any of the following files, ensure that they are in the same sequence as 


displayed: 


 


1. Master.csv. 


2. Department.csv. 


3. Employee.csv. 


 


To change the order of the files, select a file and use the arrow buttons. 


 


 
Figure 3 – CSV Importer 


 


IImmppoorrtt  CCSSVV  FFiillee  


Click Start to begin the import process. 


 


 


A confirmation message displays after a successful import. 


 


Creating a CSV File 


 


 


You can create a CSV file manually with a plain text editor such as Notepad.  Microsoft Excel is useful 


for creating spreadsheets to export as CSV files. 


 


 


Do not use rich text editors such as WordPad or Microsoft Word as these programs contain hidden 


characters. 


 


 


CSV files can add data to one table at a time only.  Therefore, you need to have a CSV file for each 


table you are updating. 
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To create a CSV file manually, proceed as follows: 


 


1. Ensure you know the correct field names of the table you are importing into. 


2. Open your text editor. 


3. Enter the field names separated by commas. 


4. Press Enter. 


5. Enter the data value of each record separating the values with commas.  Press Enter after 


each record. 


6. Save the file with a suitable name and a csv file extension. 


 


EExxaammppllee  


Figure 4 shows an example of a CSV file containing two records.  The first row contains the field 


names separated by commas.  The second line is blank.  The third and forth lines contain 


record data; each value separated by a comma.  In this example, the value for EMP_Employer 


is null in both records. 


 


 
Figure 4 – Example of CSV File 


 


 


Correct field types are vital for a successful import.  Be sure to read the next section. 


 


Ensuring Correct CSV File Format 


If you create or modify a CSV file, ensure that its data conforms to the specified field 


requirements. 


 


 


Ensure that your CSV file is called after the table name, for example “MASTER”.csv 


 


NNuullll  aanndd  NNoott  NNuullll  VVaalluueess  


A Null field in a database table means that a value is not required for that field.  Do not confuse 


Null with zero.  Zero is a value (0); Null has no value.  For example, the PIN field in the 


ImproNet Database has a Null option.  This means that you do not have to enter a value in this 


field—you can leave it empty. 


 


A Not Null field in a database table means that a field must contain a value.  The value can be 


any value that conforms to the field Type.  In this case, a zero (0) is accepted as a number 


value, provided the field permits a number Type. 
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FFiieelldd  TTyyppeess  


Each field in a database table has a specified Type.  The Type determines the data that is 


permitted in that field.  For example, a Varchar type is a text field that accepts text and number 


characters.  An Int type is a number field only—it cannot accept text characters.  Table 1 


describes some common Field Types in the ImproNet Database. 


 


Field Type Description 


Varchar(40) A text field permitting up to 40 alphanumeric characters 


Varchar(16) A text field permitting up to 16 alphanumeric characters 


Int A number field permitting up to 65536 characters (16 bit) 


SmallInt A number field permitting up to 256 characters (8 bit) 


Table 1 – Database Field Types 


 


You can use Import to add data to any of the tables in the ImproNet Database, except those 


containing images.  However, ensure that the data conforms to the receiving table’s structure. 


 


IImmppoorrtt  DDaattaa  ttoo  OOtthheerr  TTaabblleess  


To ensure correct CSV file format for other ImproNet Database tables, view the tables’ 


structures.  We recommend using the IBConsole Utility to do this.   


 


Structure of Master, Department, and Employee Tables 


The following tables are the most likely tables to receive data via the Import utility: 


 


 Master 


 Department 


 Employee 


 


MMaasstteerr  TTaabbllee  RReeqquuiirreemmeennttss  


Table 2 displays the field requirements for the Master Table. 


 


Field Name Type Null Value 


MST_SQ(PK) Int Not Null 


MST_Title Varchar(40) Not Null 


MST_FirstName Varchar(40) Not Null 


MST_MiddleName Varchar(40) Not Null 


MST_LastName Varchar(40) Not Null 


MST_Suffix Varchar(40) Not Null 


MST_ID Varchar (16) Not Null 


MST_Gender Char (1) Null 


MST_Pin Int Null 


MST_Type SmallInt Not Null 


MST_Current SmallInt Not Null 


SITE_SLA(FK) Char(8) Not Null 


USRPRF_NUM Int Null 


MST_CDATE Varchar(8) Null 


Table 2 – Master Table Requirements 
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DDeeppaarrttmmeenntt  TTaabbllee  RReeqquuiirreemmeennttss  


Table 3 displays the field requirements for the Department Table. 


 


Field Name Type Null Value 


DEPT_No (PK)(FK) SmallInt Not Null 


Site_SLA(FK) Varchar(8) Not Null 


DEPT_NAME Varchar(40) Not Null 


Table 3 – Department Table Requirements 


 


EEmmppllooyyeeee  TTaabbllee  RReeqquuiirreemmeennttss  


Table 4 displays the field requirements for the Employee Table. 


 


Field Name Type Null Value 


MST_SQ(PK)(FK) Int Not Null 


EMP_EmployeeNo Varchar(16) Not Null 


EMP_Employer Varchar(16) Not Null 


EMP_Position Varchar(40) Not Null 


DEPT_No (FK) SmallInt Not Null 


Site_SLA(FK) Varchar(8) Not Null 


Table 4 – Employee Table Requirements 


 


 


PK means Primary Key—This is an entry unique to every record. 


 


 


FK means Foreign Key—This is an entry that corresponds with the Primary Key.  It is used to link 


records in one table with records in another table.  For example, MST_SQ is the Primary Key in the 


Master Table.  It is also used in the Employee Table as a Foreign Key to identify a particular 


Tagholder. 
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Unlock Utility 


Introduction 


The Unlock Utility unlocks Hardware, namely the ImproX RR, RH, RL, RS, RM and ProxMate, 


so that the dependent Software runs. 


 


Ensure that you install an ImproX RR, RH, RL, RS, RM or ProxMate on the PC where you 


installed Access, Visitors or QuickTag applications.  Engine requires installation of an ImproX 


RH, RL or HI.  Each of these ―Units‖ requires unlocking prior to use. 


 


Unlocking the Hardware 


 


 


Each Unlock Code is unique.  The Unlock Code is therefore only intended for use on the product for 


which it was generated. 


 


1. Contact your Impro Dealer for an Unlock Code. 


2. Connect the hardware direct to one of the PC’s Comm. Ports (Ports 1 to 16). 


3. Proceed with the steps listed in the section below titled Opening and Using the Unlock 


Utility.  


 


Opening and Using the Unlock Utility 


1. In Windows®, click Start>Run. 


2. In the Run dialog, browse to C:\ImproNet\bin\UNLOCK.EXE. 


3. Click the OK button. 


 


 
Figure 5 – Product Unlock Dialog 


 


4. In the Product Unlock Key textbox, enter your Unlock Code. 


5. Click on the Unlock button. 
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The Utility searches Comm. Ports 1 to 16 for one of the following ImproX devices (ImproX RR, 


RH, RS, RM, RL, HI or ProxMate).   


 If the device’s found and the unlock codes correct, the Product Unlock dialog displays 


the text ―Unlock Successfully Completed‖. 


 If the device’s NOT found or the unlock codes incorrect, the Product Unlock dialog 


displays the text detailing the fault. 


 When unlocking a device, ensure that you only plug in ONE ImproX device at a time.  


That is, once the first device’s unlocked, plug in the second device for unlocking. 


 


6. Click on the  button. 


 


Translation - Localization 


This application is provided with English text.  If you need Localization of the text, dynamically 


translate the text making use of the Locale and Translate functions.  Property resource files 


store the translated text, for distribution with the application. 
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Manual Auto-ID Utility 


Introduction 


The Manual Auto-ID Utility performs the following functions: 


 


 Addition of Controllers and Terminals not previously added in Access. 


 Editing of selected Controller and Terminal properties (for example:  Site SLA, Unit Type, 


Fixed Address, Controller LA and Terminal LA). 


 Deletion of Controllers and Terminals. 


 


Opening and Using the Manual Auto-ID Utility 


To open the Manual Auto-ID Utility, proceed as follows: 


 


1. In Windows®, click Start>Programs>ImproNet>Utils>Manual Auto ID. 


2. Enter your Username and Password. 


 


 


The default username is SYSDBA.  The default password is masterkey. 


 


3. Click the  button. 


 


 
Figure 6 – Logon Dialog 
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AAddddiinngg  aa  CCoonnttrroolllleerr  ttoo  tthhee  SSiittee  


1. In the Main Pane, from the Site SLA drop-down list, select the Site. 


2. Select the Controller checkbox. 


3. From the Unit Type drop-down list, select the type of Controller. 


4. In the Fixed Address (hex) textbox, enter the Controller’s Fixed Address. 


5. In the Controller LA (hex) textbox, enter the Controller’s Logical Address. 


6. Click on the  button. 


 


 


These details only update on re-opening of the Access Module. 


 


AAddddiinngg  aa  TTeerrmmiinnaall  ttoo  tthhee  SSiittee  


1. In the Main Pane, from the Site SLA drop-down list, select the Site. 


2. De-select the Controller checkbox. 


3. From the Unit Type drop-down list, select the type of Terminal. 


4. In the Fixed Address (hex) textbox, enter the Terminal’s Fixed Address. 


5. In the Controller LA (hex) textbox, enter the Controller’s Logical Address. 


6. In the Terminal LA (hex) textbox, enter the Terminal’s Logical Address. 


7. Click on the  button. 


 


 


These details only update on re-opening of the Access Module.  Terminals appear on the Unassigned 


Terminals list (situated on the Hierarchical Tree in the Access Module’s Navigator Pane).  Assign the 


Terminals using Access. 


 


DDeelleettiinngg  aa  CCoonnttrroolllleerr  ((oorr  TTeerrmmiinnaall))  ffrroomm  tthhee  SSiittee  


 


 


You can only delete Controllers (or Terminals) not yet added (updated) in the Access Module. 


 


1. In the Navigator Pane, on the Hierarchical Tree, select the Controller (or Terminal) for 


deletion. 


2. Click on the  button. 


 


EEddiittiinngg  aa  CCoonnttrroolllleerr  ((oorr  TTeerrmmiinnaall))  


 


 


You can only edit Controllers (or Terminals) not yet added (updated) in the Access Module. 


 


1. In the Navigator Pane, on the Hierarchical Tree, select the Controller (or Terminal) for 


editing. 


2. In the Main Pain, edit the fields as necessary. 


3. Click on the  button. 
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Translation - Localization 


This application is provided with English text.  If you need Localization of the text, dynamically 


translate the text making use of the Locale and Translate functions.  Property resource files 


store the translated text, for distribution with the application. 
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Database Upgrade Utility   


Introduction 


The Database Upgrade Utility enables automatic updating of the ImproNet Database.  The 


Utility checks the Database for available Scripts in the directory.  Update Scripts are processed 


automatically and a status message is displayed.  A status message is also displayed if no 


scripts are found. 


 


Opening and Using the Database Upgrade Utility 


To open the Database Upgrade Utility, proceed as follows: 


 


1. In Windows®, click Start>Programs>ImproNet>Utils>Database Upgrade. 


2. Enter the Password. 


 


 


The default Password is masterkey. 


 


 
Figure 7 – Database Update Logon 


 


3. Click the OK button. 


 


If no new database scripts are found, the following message displays: 


 


 
Figure 8 – Database Status Screen – No New Database Scripts Found 
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If new database scripts are found, a screen similar to the one shown below displays: 


 


 
Figure 9 – Database Status Screen – Scripts Found 


 


4. Click the Upgrade button. 


5. In the Message dialog, click OK. 
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Firmware Upgrade Utility 


Introduction 


The Firmware Upgrade Utility lets you perform the following actions: 


 


 Identify Firmware versions of connected Hardware. 


 Selection and configuration of the Communications Port. 


 You may Ping the connected Hardware (feedback informs you of whether Hardware is 


connected and working as specified). 


 Perform in-field Firmware Upgrades to connected Hardware. 


 


Opening the Utility 


In Windows®, go to Start>All Programs>ImproNet>Utils>Firmware Upgrade. 


 


Display Firmware File Versions (Available on the Software CD) 


1. Select the Firmware Upgrade tab. 


2. From the Main Menu, select Config>File Versions.  


 


Select and Configure the Communications Port 


1. Select the Protocol tab. 


 


 
Figure 10 – Protocol Tab 
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2. Select one of the following radio buttons: 


 RS232/USB—if you are using an ImproX HI or ImproX RH communications interface 


device, select the RS232/USB option and enter the relevant COM Port number. 


 TCP/IP—used where your Controller connects by Ethernet. 


 UDP—if you want to connect UDP to a single Controller. 


 UDP Multi Controller—if you want to connect many UDP devices as specified in the 


udpmulti.csv file. 


3. Based on your selection made in step 2, complete the following activated fields: 


 Host IP—your Controller’s IP Address. 


 Host Port—enter the default Host Port number of 10002. 


 Local Port—enter the default Local Port number of 10002. 


 Baud Rate—use the default 38 400. 


4. Click the  button. 


 


Firmware Upgrade Procedure 


 


 


On Sites with installed ImproX iTT or iTRT Ethernet Terminals, upgrade the Controller's Firmware and 


perform a Full Upload before upgrading the Terminal's Firmware. 


 


CCoonnttrroolllleerrss  


1. Configure the Protocol settings specific to your Controller and installation requirements.  


Refer to the section Selecting and Configuring the Communications Port on page 21. 


2. Select the Firmware Upgrade tab. 


3. Select the Controller radio button. 


4. Select one of the following Upgrade Type options: 


 Single Unit—upgrades one unit only. 


 All Units (one at a time)—upgrades all units of the specified type, one at a time. 


 Advanced—allows selection of a specific Firmware file.  We recommend that you do 


not use this feature. 


5. Enter the Controller LA—the Logical Address of your Controller.   


 


 


If you select the Controller Unit Type, the Controller LA specifies the Controller that will be upgraded.  


If another Unit Type is selected, the Controller LA specifies the Controller that the selected unit is 


connected to. 


 


6. Click the Upgrade button. 


7. Once the Upgrade is complete, perform a Full Upload.  For more information on performing 


a Full Upload, please refer to the section Full Upload in Part 3 – General Configuration. 


 


 


The Force Upgrade button forces an upgrade on a unit that has a newer firmware version than is 


available with your current Software Suite.  We recommend that you do not use this feature. 


  


TTeerrmmiinnaallss  aanndd  RReeaaddeerrss  


 


 


The ImproX iTT, iTRT, MDR and MDK allow for Zero Downtime Upgrade Support.  During a firmware 


upgrade the affected Hardware continues to operate as expected, however for the ImproX MDR and  
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MDK the LED flickers intermittently while the new file uploads.  Once the upgrade is complete, a reset 


(about 30 seconds) takes place for the new firmware to load.  During this reset, the related Hardware 


will not read Tags. 


 


1. Configure the Protocol settings specific to your Controller and installation requirements.  


Refer to the section Selecting and Configuring the Communications Port on page 21. 


2. Select the Firmware Upgrade tab. 


3. Select the Terminal (or Remote) radio button. 


4. Select one of the following Upgrade Type options: 


 Single Unit—upgrades one unit only. 


 All Units (one at a time)—upgrades all units of the specified type, one at a time. 


 Advanced—allows selection of a specific Firmware file.  We recommend that you do 


not use this feature. 


5. Enter the Controller LA—the Logical Address of your Controller.  The Controller LA 


number specifies the Controller that the selected unit is connected to.   


6. Enter the Terminal LA—the Logical Address of the Terminal. 


7. Click the Upgrade button. 


 


 


The Force Upgrade button forces an upgrade on a unit that has a newer firmware version than is 


available with your current Software Suite.  We recommend that you do not use this feature. 


 


Ping Function 


Ensure that all hardware is connected and working as specified by using the Ping tool. 


 


 


Using ImproNet Engine, perform a Full Upload before you Ping IP Door Controllers.  See Part 3 – 


General Configuration for more information on ImproNet Engine and the Full Upload function. 


 


1. Select the System Tools tab. 


2. Click the Ping button.  


3. At the IP Door Controllers dialog, click the OK button. 


 


 
Figure 11 – Results of a Ping Check 
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Miscellaneous Tools 


Select the Misc Tools tab. 


 


SSeett  tthhee  LLooggiiccaall  AAddddrreessss  


Change your Controller’s Logical Address as follows: 


 


1. From the Set Logical Address group, select the Controller radio button. 


2. In the Fixed Address textbox, enter the Controller’s Fixed Address. 


3. In the active Logical Address textbox, enter the new Logical Address for the Controller. 


4. Click the OK button. 


 


CClleeaarr  tthhee  CCoonnttrroolllleerr’’ss  MMeemmoorryy  


This option clears the Controller’s memory, including details of all transactions.   


 


 


After clearing the Controller’s memory, restore the Controller’s functionality by performing a full upload. 


 


Because of the complexities of this feature, we advise that only approved Distributors or Impro 


Technical Support Staff use it.  Therefore, please contact your Impro Distributor for support. 
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Ethernet Configuration Utility 


 Introduction 


The ImproX EC, unlike other Controllers in an ImproNet system, is not connected to the Host 


PC via the RS485 Host Bus. Instead, it communicates with the Host PC over a LAN using an 


Ethernet protocol. 


 


 


Prior to V7.4 ImproNet Software, you needed an ImproX EL (or RL) between the Host PC, the LAN or 


WAN and the ImproX EC.  With the release of V7.4 Software, you use UDP communications direct to 


the EC.  This means that you no longer need ImproX EL’s (or RL’s).  Please note however, this 


scenario does NOT support inter-controller communications. 


 


CCoonnnneeccttiinngg  ttoo  aann  IImmpprrooXX  EECC  ((PPrree  VV77..44  SSooffttwwaarree))  


 
Figure 12 – ImproNet Setup Prior to V7.4 Software 


 


The physical routing for this connection is: 


 


 Host PC to ImproX RH. 


 ImproX RH to LAN/WAN via an ImproX EL or ImproX RL to LAN/WAN. 


 LAN/WAN to ImproX EC. 


 


CCoonnnneeccttiinngg  ttoo  aann  IImmpprrooXX  EECC  ((UUssiinngg  VV77..44  SSooffttwwaarree))  


 


 


There are NO intercontroller communications when using V7.4 Software.  This means that 


Interleading Zone Routing across Controllers and Actions across Controllers will NOT operate. 


 


 


The ImproX RH and HI no longer function as a communications interface.  Essentially they now 


function as a dongle, allowing ImproNet Engine Software to run. 
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Figure 13 – ImproNet Setup Using V7.4 Software 


 


The physical routing for this connection is: 


 


 Host PC to ImproX RH. 


 LAN/WAN (Ethernet) to ImproX EC. 


 


CCoommmmuunniiccaattiinngg  wwiitthh  tthhee  IImmpprrooXX  EECC  


Communications between the Host PC and the ImproX EC uses Ethernet protocols.  The 


ImproX EC must be configured for the Ethernet protocol in use on the LAN/WAN, using the 


Ethernet Configuration software.   The Ethernet security and operational settings for the ImproX 


EC are configured in the Ethernet Device Configuration Utility as described in this Chapter. 


 


 


Network knowledge is required to set-up ImproX EC.  Additionally, some settings such as router 


gateway addresses require you to liaise with your local network administrator.  Whatever the situation, 


ensure that someone with network experience is available during configuration. 


 


AAllllooccaattiioonn  ooff  TTeerrmmiinnaallss  


ImproX Terminals are connected to the ImproX EC via its Terminal Bus Port. 


 


An ImproX EC will appear in the Access Tree as an ImproX AC Controller. Terminals allocation, 


and other Controller settings, are performed in the same way as for an ImproX AC Controller. 


 


Configuration Procedure 


The Ethernet Configuration Utility enables you to assign an IP Address to an ImproX EC, and 


configure the device for Ethernet operation.   


 


The Utility searches for and displays a list of Ethernet devices on the local subnet.  When an 


ImproX EC is identified by its unique MAC Address, assign a static IP Address to it.  Then 


configure the Device for network use, as described in the following paragraphs: 
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AAssssiiggnn  tthhee  IIPP  AAddddrreessss  


Proceed as follows to open the Ethernet Device Configuration Utility: 


 


1. In Windows®, click Start>Programs>ImproNet>Utils>Ethernet Device Configuration 


Utility. 


 


 
Figure 14 – Ethernet Device Configuration Utility Window 


 


2. In the Action menu, select Search for Devices – Local Subnet Only.  Wait for a list of 


Devices to be displayed. 


3. Identify the ImproX EC by its MAC Address.  Select the Device by clicking it. 


 


 
Figure 15 – Selected Device 


 


4. In the menu, select Action>Assign IP Address – Local Subnet Only.  


 


 
Figure 16 – Assign IP Address 
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5. Enter a valid static IP Address in the IP Address textbox. 


6. Click the  button. 


 


 


If an ImproX EC is not detected in the search and you know its MAC Address, select a blank row on the 


table, then on the menu select Action>Assign IP Address.  Manually enter the Device’s MAC Address 


and IP Address.  Note that the Device must be located on the local subnet. 


 


 


Do not assign an IP address of 0.0.0.0 unless a DHCP server is present.  If a DHCP server is present, 


assigning an IP address of 0.0.0.0 will result in the Device receiving a dynamic IP Address. 


 


CCoonnffiigguurree  tthhee  DDeevviiccee  


 


 


Ensure that you configure the TCP/IP settings correctly for the ImproX EC’s intended network.  If the IP 


Address, Default Gateway, Subnet Mask, or Host Bits settings are not exact, the Device can lock-up.   


If this happens, physically remove the device from the bus and return it to your dealer for re-


programming.  Contact a competent Network Administrator or your regular support channel if you are 


unsure of the correct network settings. 


 


When the ImproX EC has an IP Address, you can configure its Ethernet settings as follows: 


 


1. Select the device to configure from the table. 


2. On the menu, select Device>Device Configuration.   


 


 
Figure 17 – Configuration Settings (Pre V7.4 Software) 


 


 


Devices not destined for the local subnet can be temporarily installed on the local subnet for 


configuration purposes.   
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Figure 18 – Configuration Settings (Using V7.4 and Post Software) 


  


CCoonnffiigguurraattiioonn  SSeettttiinnggss  


 


 


Entering the correct Configuration Settings requires networking knowledge.  If you are not familiar with 


the settings, consult an experienced network administrator.   


 


Socket Connections 


A Socket connection has two components: an IP Address and a Port Number.  Ethernet devices 


must share a common Socket connection to communicate with each other.  For example:     


 


Pre V7.4 Software: Device A = an ImproX EL 


    Device B = an ImproX EC 


 


Using V7.4 Software: Device A = PC (Engine) * 


Device B = an ImproX EC 


 


 


* Refer to page 25 for details of the Ethernet Configuration Utility. 


 


The Local Port on Device A equals the Remote Port on Device B and vice versa.   


 


Proceed as follows to configure the ImproX EC network settings: 


 


1. On the Configuration Settings window, enter the Gateway IP Address – obtain this from 


the network administrator. 
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2. Click one of the following buttons to populate the fields with preset default values: 


 Use UDP Broadcast Defaults. 


 Use UDP Unicast Defaults. 


 Use TCP Master Defaults. 


 Use TCP Slave Defaults (121 Defaults). 


 Use TCP Slave Defaults (110 Defaults). 


 


 


If you are using UDP Broadcast Defaults and you change the Gateway IP Address and Subnet Host 


Bits values, click the Use UDP Broadcast Defaults again, before clicking Update Configuration. 


 


 


For UDP Broadcast Defaults, set the Gateway IP Address to 0.0.0.0. 


 


 


Refer to the Using Defaults section on page 31 for more information. 


 


3. Enter the Subnet Mask or the Subnet Host Bits.  If you are not using TCP Slave Defaults, 


enter the Remote Host IP Address. 


 


 


If the device is destined for a different subnet, refer to the Move Devices to a Different LAN section.   


 


4. Click Update Configuration to save the changes to the device. 


 


 


If you need to change a static IP Address, click the Change Host IP button.  The IP Address field 


toggles to an editable field.  Note that you cannot change a Dynamic IP Address as the DHCP server 


allocates it automatically.   


 


 


Change the Local Port Number and Remote Port Number if required.  We recommend that you only 


change the Serial Baud Rate if the device has explicit instructions to use a different value. 


 


 


Specify a Port Password for additional security.  However, ensure you keep a record of the password 


for future use. 


 


SSaavvee  SSeettttiinnggss  ttoo  aa  FFiillee  


Changes to the ImproX EC configuration settings can be saved to a file for later re-use.  Saving 


settings to a file is essential if you plan to move Devices to a different subnet, as a search will 


not automatically detect it in it’s new location.  After you have clicked Update Configuration, 


proceed as follows to save settings for the currently selected device: 


 


1. On the menu, select File>Save IP Address. 


2. Browse to a suitable location and enter a File Name. 


3. Click Open.  The settings are saved to a file. 
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IImmppoorrtt  SSeettttiinnggss  ffrroomm  aa  FFiillee  


If you move an ImproX EC to a new location, you can import its previously configured settings 


from a file.  To do so, proceed as follows: 


 


1. Select the ImproX EC in the table. 


2. On the menu, select File>Import IP Address. 


3. Browse to the saved file and click it. 


4. Click Open.  The settings from the file are imported to the selected device. 


 


MMoovvee  DDeevviicceess  ttoo  aa  DDiiffffeerreenntt  LLAANN  


Before moving an ImproX EC across a WAN or to a different LAN, change it’s Host IP address, 


Gateway IP Address and Subnet Host Bits to suit its new network.  Save the new settings to a 


file.  To access the device in the future, import the file to obtain the saved IP address details.   


 


 


If you change the Subnet Mask, the device will only function again after it has been moved to the new 


subnet. 


 


UUssiinngg  DDeeffaauullttss  


Clicking one of the default buttons adds default values to the configurable fields.  However, you 


are still required to enter values into other fields.   


 


This section provides brief instructions for using the default values.  For best results, we 


strongly advise consulting an experienced network administrator. 


 


 UDP Broadcast—this facility is simple and quick to use.  However, it only works on a LAN.  


When using this mode, set the Gateway IP Address to 0.0.0.0.  Broadcast is a one-to-many 


transmission. 


 UDP Unicast—this is ideal for using over a WAN or when the local network is congested.  


Unicast is a one-to-one transmission. 


 TCP Master—this is the default setting for a TCP/IP setup.  Recommended when 


connection between units needs to be guaranteed.  Note that TCP/IP requires more 


resources than UDP. 


 


EEtthheerrnneett  SSeeccuurriittyy  


The XPort security features on the ImproX EC secures the Controller from unauthorized 


tampering via TCP/IP over the Internet.  To setup the XPort security features you need to 


configure its Telnet settings. 


 


Telnet Settings 


Securing the ImproX EC’s Telnet settings is required to prevent unauthorized access via Telnet 


or UDP to the dedicated ports.  Only undertake Setup across a secure network.     


 


 


You must Apply this level of security only after configuring the Controller for TCP/IP.  This is because 


enabling Telnet security prevents the Ethernet Device Configuration Utility from accessing the 


Controller. 
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If you need to change the Port Password, temporarily disable the Telnet settings so that you can use 


the Ethernet Device Configuration Utility again. 


 


UDP Security Configuration 


To configure UDP security, proceed as follows: 


 


1. In Windows®, open the Control Panel>Programs and Features. 


2. Under Tasks, select Turn Windows Features On or Off.   


3. Select the Telnet Client checkbox. 


4. Click the OK button. 


5. In Windows®, open Accessories>Run.   


6. Enter cmd in the Open textbox.  


 


 
Figure 19 – Run Window 


 


7. At the prompt, enter telnet followed by a space and the IP Address of the selected 


Controller, followed by another space and 9999.For example, if the IP Address of the 


ImproX EC is 192.1.3.108, enter the following:  telnet 192.1.3.108 9999 


 


 
Figure 20 – Command Prompt 


 


8. Press Enter.   


 


 
Figure 21 – MAC Address Displayed 
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9. Press Enter again to enter Setup Mode. 


10. Enter 0 to select the Server Configuration option. 


11. Press Enter for each prompt until the prompt Change Telnet Password is displayed. 


12. Enter Y. 


13. Enter a 4-character Password when requested. 


 


 


Make a note of this Password.  It is required for future Telnet access. 


 


14. Enter 6 to the select Security option. 


15. Enter Y to disable all options except for the following: 


 Disable Telnet Setup <N>—Enter N. 


 Enable Enhanced Password <Y>—Enter Y to use a 16 character Password instead of 


the default 4 character Password previously selected. 


 Change the Password <Y>—Enter Y. 


 Enter Password—Enter a new Password, a maximum of 16 characters long. 


 


 


Make a note of this Password.  It is required for future Telnet access. 


 


16. Select 9 to save and exit Telnet. 


 


 


To view the settings without saving, select option 8. 


 


The Telnet security feature prevents access to the Controller without a Password.  Similarly, you 


cannot access the Controller via an Internet browser using the IP Address as the URL.   


 


This is because Telnet security settings disable the XPort Web Server.  Therefore, the Controller 


web page is unavailable.  However, you can access the Controller on a network via a TCP/IP 


connection through the built-in serial port with a valid port password. 


 


TTeemmppoorraarriillyy  DDiissaabbllee  TTeellnneett  SSeeccuurriittyy  ttoo  EEnnaabbllee  UUDDPP  AAcccceessss  ffoorr  tthhee  EEtthheerrnneett  


CCoonnffiigguurraattiioonn  UUttiilliittyy  


1. In Windows®, click Start>Run.   


2. Enter cmd in the Open textbox.   


3. Enter telnet and the IP Address of the selected Controller, followed by a space and 9999.  


For example, if the IP Address of the ImproX EC is 192.1.3.108, enter the following 


command:  telnet 192.1.3.108 9999 


4. Press Enter and wait for the password prompt. 


5. Enter the Enhanced Password previously assigned to the unit.  The Setup menu is 


displayed. 


6. Enter 6 to select the Security option. 


7. Configure the following settings as indicated: 


 Disable SNMP <Y>—Enter Y. 


 Disable Telnet Setup <N>—Enter N. 


 Disable TFTP Firmware Update <Y>—Enter Y. 


 Disable Port 77FEh <Y>—Enter N. 


 Disable Web Server <Y>—Enter Y. 
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 Disable ECHO ports <Y>—Enter Y. 


 Enable Enhanced Password <Y>—Enter Y. 


 Change the Password <N>—Enter N. 


 Disable Port 77F0H <Y>—Enter N. 


 


8. Enter 9 to Save and exit Telnet. 


 


TTrroouubblleesshhoooottiinngg  


Some common problems and their solutions are listed here. 


 


Problem: TCP/IP connection to the XPort serial port fails. 


Solution: Ensure that the ECHO ports option is disabled. 


  


Problem: Ethernet Configuration Utility / Search fails to find the unit. 


Solution: Ensure that Port 77FEH and Port 77F0H are enabled. 


  


Problem: Device Timeout – Please try again error message is displayed. 


Solution: Ensure your Subnet Mask is correct. 


 


AAddddeenndduumm  


This section provides some basic definitions and examples of network terminology.  It is 


intended as a guide only.  To fully understand the Etherlink Software, we recommend formal 


training in networking. 


 


Network IP Addresses  


An IP Address is unique number used to identify a device on a network.  The Address is written 


in a so-called dot-decimal notation and consists of four number (octets) separated by dots, for 


example: 125.255.255.1.  Each octet can have decimal values up to 255 (8 bits).   


 


The first octet of each IP Address represents the network number.  The remaining numbers – 


represented by an x - refer to specific computers or hosts.  The value of the first octet 


determines the type of network class as follows: 


 


 Class A:  0.x.x.x to 126.x.x.x 


 Class B:  128.0.x.x to 191.255.x.x  


 Class C:  192.0.0.x to 223.255.255.x 


 


Class A networks reserve only the first octet for network addresses.  The remaining three octets 


are for different host addresses.  This means that a Class A network can support up to 127 


networks and up to 16 777 216 (8 bit x 8 bit x 8 bit) host computers. 


 


Class B networks reserve the first and second octets for network addresses.  Octets three and 


four are used for host addresses.   


 


Class C networks reserve the first, second, and third octets for network addresses.  Only the 


last octet is available for host addresses. 
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IP Addresses that have a 127 value for the first octet are reserved for local host communication.  A 


local host is the currently used computer. 


 


Creating a Subnet 


Creating a subnet on an IP network enables you to create several smaller networks from a 


single large network.  Subnetting is used when several LANs are linked together via a router to 


form a WAN.  You can create a subnet by defining a Subnet Mask.   


 


Subnet Masks 


A Subnet Mask filters out unwanted data from other subnets.  All hosts on the same subnet or 


network segment must have the same Subnet Mask to communicate with each other.  The 


following table shows the default Subnet Masks for each class of network.  Note the location of 


the subnet octet for each network class. 


 


Class From IP To IP Subnet Mask Host Bits 


A 0.x.x.x 126.x.x.x 255.0.0.0 24 


B  128.0.x.x 191.255.x.x 255.255.0.0 16 


C 192.0.0.x 223.255.255.x 255.255.255.0 8 


Class From IP 


A 255.0.0.0 


B  255.255.0.0 


C 255.255.255.0 


Table 5 – Default Subnet Masks for Each Class of Network 


 


 


The subnet mask octet can be any of the following values: 255, 254, 252, 248, 240, 224, 192, 128, or 0. 


 


Subnet Examples: 


 


Host Address Subnet Mask Network Address 


10.1.4.8 255.0.0.0 10.0.0.0 


114.2.4.6 255.255.0.0 114.2.0.0 


192.1.3.156 255.255.255.0 192.1.3.0 


Table 6 – Subnet Examples 


 


 


Use a lookup table to obtain the corresponding Subnet Mask. 


 


 


For further details refer to www.subnetonline.com. 


 


 



http://www.subnetonline.com/
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A Practical Example of the ImproX EC’s Configuration Procedure 


This practical example lays out the procedure for setting up a UDP Site, using ImproX EC’s and 


UDP Multi Drivers. 


 


PPrree--ccoonnffiigguurraattiioonn  


 Configure the ImproX EC’s to communicate with the Engine PC. 


 Assign the IP Address. 


 If communicating across a WAN, assign the Gateway IP Address. 


 


SSeettttiinnggss  UUsseedd  iinn  tthhiiss  EExxaammppllee  


PC IP Address:  192.1.3.141 


Subnet Range:  255.255.254.0 


Controller IP Address: 192.1.2.3 


 


CCoonnffiigguurraattiioonn  PPrroocceedduurree  ffoorr  tthhee  CCoonnttrroolllleerr  ((IIPP  AAddddrreessss  119922..11..22..33))  


1. Plug the ImproX EC into the Network. 


2. Assign the IP Addresses (see the section titled Assign the IP Address 


3.  on page 27). 


4. Configure the Controller (see the section titled Configure the Device on page 28). 


 


 
Figure 22 – Configuration Settings (Pre V7.4 Software) 
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Figure 23 – Configuration Settings (Using V7.4 and Post Software) 


 


Firmware Upgrade Utility 


1. In Windows®, click Start>Programs>ImproNet>Utils>Firmware Upgrade. 


2. From the Menu Bar, select the Config>Protocol. 


3. In the Protocol Settings dialog, select the UDP radio button. 


4. In the Host IP field, enter the Controllers IP Address (in this instance 192.1.2.3). 


5. Enter the Host Port and Local Port numbers (in this instance 5004).  


6. Click the OK button. 


7. Click on the System Tools tab. 


8. Click on the Ping button. 


 


After the Ping, you will see the Fixed Address for the Controller.  Follow these steps for each 


Controller, ensuring that you change the Host IP for each Controller. 


 


MMaannuuaall  AAuuttoo--IIDD  


1. In Windows®, click Start>Programs>ImproNet>Utils>Manual Auto ID. 


2. Enter your Username and Password. 


 


 


The default username is SYSDBA.  The default password is masterkey. 


 


3. Click the  button. 
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4. In the Main Pane, from the Site SLA drop-down list, select the Site. 


5. Select the Controller checkbox. 


6. From the Unit Type drop-down list, select AC from the drop-down list. 


7. In the Fixed Address (hex) textbox, enter the Controller’s Fixed Address (in this instance 


we used 0051E97F). 


8. In the Controller LA (hex) textbox, enter the Controller’s Logical Address. 


9. Click on the  button. 


 


 


These details only update on re-opening of the Access Module. 


 


Access (Site) 


1. In Windows®, click Start>Programs>ImproNet>Access. 


2. In the Navigator Pane, select the Site icon from the hierarchical tree. 


3. At the bottom of the Main Pane, select the UDP Comms checkbox. 


4. Click on the  button. 


5. Select the Site icon, again, from the hierarchical tree. 


6. Press the F5 key on your keyboard, the Site information refreshes. 


 


 


You will notice that an IP Mapping icon now appears in the Navigator Pane on the hierarchical tree 


menu. 


 


 


Access (Host) 


1. In the Navigator Pane, select the  icon from the hierarchical tree. 


2. Select each Controller individually. 


3. In each Controllers Main Pane:  


 in the IP Address field, type in the Controllers IP Address details. 


 in the HW Port field, type in the Controllers Port Number. 


 click on the  button.. 


 


Access (IP Mapping) 


1. In the Navigator Pane, select the  icon from the hierarchical tree. 


2. Click on the  button. 


 


A file is exported that the Engine will use to communicate with the Controllers. 


 


Engine 


1. In Windows®, click Start>Programs>ImproNet>Engine. 


2. From the Menu Bar, select Configuration>Engine Properties. 


3. Select the UDP Comms checkbox. 


4. Click the  button. 


5. Close Engine. 


6. In Windows®, click Start>Programs>ImproNet>Engine. 


7. Click the Auto-ID button. 


 


From there the setup of dragging and dropping is the same. 
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Discovery Utility 


Controller and Terminal Configuration 


The Discovery Utility allows the following actions: 


 


 Detection of Controllers (System Controllers) on the network. 


 Detection of Terminals (Door Controllers) on the network. 


 Configuration of network address settings. 


 Configuration of the Controller’s settings. 


 Configuration of the Terminal's settings. 


 


We recommend you carry out configuration using the following sequence: 


  


1. View the Controllers and Terminals on the Network. 


2. Confirm or change the IP Address and set the Address to static. 


3. Change the default password to a suitable password for your site.  


 


 


Ensure that you keep the same password across all Controllers. 


 


4. Group each Controller with the Terminal it should control. 


5. Query the Logical Address of all the Controllers for your site. 


6. Change the Logical Address of the Controllers as needed, thus ensuring that each 


Controller has a unique Address.  


 


 


Do not change the Logical Addresses after importing them into ImproNet. 


 


7. Configure each Controller and its grouped Terminals.  That is, select the required memory 


size and port number.  Ensure that all the Controllers and Terminals have the same 


configuration.  (This step is optional - default settings should do for most sites).  


8. Select all the Controllers and Terminals for your site and export their settings to a file. 


9. Check the file exists and contains the data for import into ImproNet. 


 


SSttaarrtt  tthhee  DDiissccoovveerryy  UUttiilliittyy  


In Windows®, go to Start>Programs>ImproNet>Utils>Ethernet Discovery Utility. 
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VViieeww  aallll  AAvvaaiillaabbllee  CCoonnttrroolllleerrss  aanndd  TTeerrmmiinnaallss  


 
Figure 24:  Discovery Utility – Action Menu 


 


To view all the Controllers and Terminals on the local subnet: 


 


1. On the menu bar, go to Action>Search Local Subnet. 


2. If the Discovery Utility fails to find any Devices, at the Device Not Found dialog, click the 


OK button. 


3. On the menu bar, go to Action>Advanced Local Search. 


 


 


By selecting Advanced Local Search, you may: 


 


1. select the correct Network Interface (only displayed where more than one exists) and 


2. enter the correct Subnet Mask. 


 


If the search returns Controller or Terminal details, then the Discovery Utility (while running) retains the 


Network Interface and Subnet Mask information captured, for further searches.  You may however, use 


the Advanced Local Search feature again during the session for further searches using different search 


criteria. 


 


4. At the Select Network Interface dialog, select the relevant Network Interface, if more 


than one displays. 


5. Click the  button. 


6. In the Enter Subnet Mask dialog, enter the Subnet Mask for your network. 


7. Click the  button. 


8. Wait for the Controllers and Terminals to display. 


 


On display of the Controllers and Terminals, the following icons appear:  the  icon represents 


unlinked Controllers.  The  icon represents Terminals and the  icon represents 


Controllers with linked Terminals.  On expanding the Controller tree, the  icon displays, with 


the linked Terminals displaying below.   


 


 


Sort the information displayed in either ascending or descending order by selecting the column header.  


The arrow displayed in the column header indicates whether sorting is ascending or descending, and 


the column on which the sort took place.   
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VViieeww  aa  SSppeecciiffiicc  CCoonnttrroolllleerr  oorr  TTeerrmmiinnaall  


To view a specific Controller or Terminal: 


 


1. On the menu bar, go to Action>Search IP. 


2. In the Enter IP Address dialog, enter the IP Address of the Controller or Terminal you’re 


searching for. 


3. Click on the  button. 


4. Wait for the Controller or Terminal to display. 


 


GGrroouuppiinngg  CCoonnttrroolllleerrss  aanndd  TTeerrmmiinnaallss  


The purpose of the group name is for grouping Controllers with their dependent IP Terminals. 


On display of the Controllers and Terminals, the following icons appear:  the  icon represents 


unlinked Controllers.  The  icon represents Terminals and the  icon represents 


Controllers with linked Terminals.  On expanding the Controller tree, the  icon displays, with 


the linked Terminals displaying below.  Group Controllers and Terminals as follows:   


 


Creating a Group for a Controller and its Terminals 


 


 


It is unnecessary to give a group name to a Controller if it has no IP Terminals. 


 


1. Select the Controller and the Terminals it should control. 


2. On the menu bar, go to Configuration>Add to Group. 


 


 


Alternatively, right-click and select Add to Group from the pop-up menu.   


 


3. In the Enter Group Name dialog, enter a suitable group name. 


4. Logon if requested (see page 41).  A password is required for each Controller and Terminal 


being added to the Group. 


5. Click the  button.  


 


Adding Terminals to Existing Controller Groups 


1. Select the Terminal(s) to be added to the Group. 


2. On the menu bar, go to Configuration>Add to Group.  


 


 


Alternatively, right-click and select Add to Group from the pop-up menu.   


 


3. In the Select the Group Name dialog, double-click on your chosen group name row. 


4. Logon if requested (see page 41). 


5. Click the  button.  


 


SSeeccuurree  LLooggoonn  


Accessing certain menu choices, listed on the Action and Configuration menus, needs a secure 


logon.  These choices include: 


 


 Configure IP 
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 Set Configuration 


 Clear Memory 


 Change Password 


 Add To Group 


 Remove From Group 


  


A secure logon activates after about 12 seconds.  


 


You will remain logged on to the selected Controller or Terminal until you select another 


Controller or Terminal and choose a menu alternative needing a logon.   


You will also lose connection to the current Controller or Terminal after changing the IP Address, 


clearing the memory or changing the configuration. 


  


Secure Logon Dialog 


 
Figure 25:  Device Password Dialog 


 


1. In the Device Password dialog, enter your password. 


 


 


The Controller’s default password is impro and the Terminal’s default password is masterkey.  For 


improved security we recommend that you change these passwords, to a string of not more than 16 


characters each. 


 


2. Click on the  button. 


 


CCoonnffiigguurree  IIPP  AAddddrreesssseess  


 


 


If you do not know your Configuration Settings, contact your Network Administrator. 


 


 


If a DHCP server is present, IP Addresses can be dynamically assigned.  If there is no DHCP server, 


obtain a suitable IP Address from your Network Administrator.  A static IP Address is preferred for the 


Controller or Terminal. 


 


Configure a Controller or Terminal’s IP Address settings as follows: 


 


1. In the Discovery Utility window, select the Controller or Terminal for configuration. 


2. On the menu bar, go to Action>Configure IP. 


 







Part 8 – Utilities 


January 2012  43 


 


Alternatively, double-click the Controller or Terminal record in the table.   


 


3. Logon if requested (see page 41). 


 


 
Figure 26:  Configuration Settings Dialog 


 


4. Assign the Controller or Terminal to EITHER a local or non-local Subnet as follows: 


 


Assign the Controller or Terminal to a Local Subnet 


 


 


If you assign an invalid IP Address, the Controller or Terminal may no longer be able to 


communicate.  In this case restore factory defaults (Refer to the Hardware Installation Manual 


for more information). 


 


1. In the Device IP Address textbox, enter a Device IP Address. 


2. Tick the checkbox to set the IP Address to static. 


3. In the Gateway IP Address textbox, enter a Gateway IP Address.   


4. Tick the checkbox to set the Gateway IP Address to static. 


5. Continue with ONE of the procedures (Subnet Mask or Subnet Host Bits) below: 


 


Subnet Mask 


1. Select the Subnet Mask radio button. 


2. In the textbox, alongside, enter the Subnet’s Address.   


3. Tick the checkbox to set the Subnet Mask to static. 


 


Subnet Host Bits 


1. Select the Subnet Host Bits radio button. 


2. Enter the number of bits in the textbox. 


 


6. Enter a Device Name. 
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Use the same site prefix to name devices belonging to the same site.  Example: ―Site 1 – Factory‖, 


―Site 1 – Testing‖. 


 


7. Ensure the Force Update checkbox is UNCHECKED. 


 


 


If the Force Update checkbox remains UNCHECKED, the Controller or Terminal tries to change 


the IP address and test communication on the new address.  If successful, the update becomes 


final; otherwise, the Controller or Terminal reverts to its old settings. 


 


Changes to the IP Configuration result in the Controller or Terminal rebooting on acceptance of 


the change.  The Configuration Settings dialog remains open during this time, allowing the 


Controller or Terminal to reboot. On closure of the Configuration Settings dialog, the Discovery 


Application again searches for the Controller or Terminal and if successful, displays the 


updated Controller or Terminal details. 


 


8. Click the Update button. 


 
Assign the Controller or Terminal to a Non-local Subnet 


 


 


Only perform this action if you want to assign the Controller or Terminal to a non-local subnet.  


After performing the step, the Discovery Utility will NOT detect the Controller or Terminal on the 


local subnet.  Therefore ensure that you assign the Logical Address BEFORE changing the IP 


Address.  Finally physically move the Controller or Terminal to the required location. 


 


To change an IP Address to an IP Address outside the local subnet, continue as follows: 


 


1. In the Device IP Address textbox, enter a Device IP Address. 


2. Tick the checkbox to set the IP Address to static. 


3. In the Gateway IP Address textbox, enter a Gateway IP Address.   


4. Tick the checkbox to set the Gateway IP Address to static. 


5. Select the Subnet Mask radio button. 


6. In the textbox, alongside, enter the Subnet’s Address.   


7. Tick the checkbox to set the Subnet Mask to static. 


8. Tick the Force Update checkbox (the Controller or Terminal adopts the new settings 


regardless). 


9. Click the Update button. 


 


 


After installing the Controller or Terminal  in its new location, you can find it using the Action>Search 


IP menu option. 


 


CChhaannggee  tthhee  DDeeffaauulltt  PPaasssswwoorrdd  


1. On the menu bar, go to Configuration>Change Password. 


2. Logon if requested (see page 41). 


3. In the Enter New Device Password dialog, in the Enter New Password textbox enter a 


new password for the selected Controller or Terminal. 


 


 


Your new password must not exceed 16 characters. 
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4. In the Confirm New Password textbox re-enter your chosen password. 


5. Click on the  button. 


 


QQuueerryy  tthhee  LLooggiiccaall  AAddddrreessss  


 
Figure 27:  Discovery Utility – Configuration Menu 


 


Display the Logical Addresses for the selected Controllers or Terminals in the LA column of the 


Utility. 


 


1. In the Discovery Utility, select the Controllers or Terminals you are querying. 


 


 


To select more than one Controller or Terminal, hold down the CTRL key and left-click additional 


Controllers. 


 


2. On the menu bar, go to Configuration>Query LA. 


 


AAssssiiggnn  aa  LLooggiiccaall  AAddddrreessss  


A new Controller or Terminal has the default Logical Address FF.  To assign a new Logical 


Address: 


 


 


After making changes to the Controller or Terminal’s Logical Address, ensure that you export 


the configuration file, for import into ImproNet Engine. 


 


1. In the Discovery Utility, select the Controllers or Terminals to be configured. 


 


 


To select more than one Controller or Terminal, hold down the CTRL key and left-click additional 


Controllers or Terminals. 


 


2. On the menu bar, go to Configuration>Configure LA. 


3. Type the new hexadecimal Logical Address in the textbox. 


4. Click the  button to confirm.  


5. Repeat steps 3 and 4 for each selected Controller or Terminal. 


 


 


The same Logical Address should not be used more than once per Site.  To prevent this, select all the 


Controllers and Terminals on a Site.  Go to Configuration>Query LA.  The Logical Addresses display 


in the LA column on the right-hand side of the table.  Ensure that the Logical Address is not repeated. 
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CCoonnffiigguurree  tthhee  PPoorrtt  NNuummbbeerr  aanndd  MMeemmoorryy  SSiizzee  


 


 


All Controllers on the same site MUST have the same Memory Size Configuration. 


 


 


After making changes to one or more Controller or Terminal’s Configuration Settings, ensure 


that you export the configuration file for import into ImproNet Engine. 


 


This ADVANCED configuration option lets you view or configure the Port Number and or 


Memory Size of the Controller or Terminal.  Carry out configuration as follows: 


 


1. Select the Controller or Terminal for configuration. 


2. On the menu bar, go to Configuration>Set Configuration. 


3. Logon if requested (see page 41). 


4. In the Engine Listener Port textbox, change the Port Number (Controller listens to 


Engine on this Port).  The default Port Number is 10002.  Only change the default Port 


Number, if it clashes with other devices or services on your network. 


5. In the Terminal Listener Port textbox, change the Port Number (Controller listens to 


Terminals on this Port).  The default Port Number is 10008.  Again, only change the default 


Port Number, if it clashes with other devices or services on your network. 


6. If necessary when setting the Configuration for a Controller, in the Memory Size textbox, 


change the Memory Size Configuration. The default Memory Size Configuration is       


100 000 Tags and  1 000 000 Transactions.   


 


 


Enable Safe IP only AFTER configuring and setting up the whole system.  Once you set Safe IP 


you can only change or query the Logical Address using the Discovery Utility on the Engine PC.    


 


7. Select the Safe IP check-box. 


8. The Group Name textbox displays the group name for the selected Controller.  (For 


information on setting up this group name, see page 41).   


9. Click the  button to confirm. 


10. Wait while the Controller re-boots (about 15 seconds). 


 


EExxppoorrtt  tthhee  CCoonnffiigguurraattiioonn  FFiillee  


Controller and Terminal configuration information is made available to ImproNet Modules as 


follows: 


 


1. Select the Controller(s) to be added to the Site.  Only necessary to select the Controller(s) 


as the grouped Terminal(s) automatically export with their grouped Controller. 


2. On the menu bar, go to File>Export IP Config. 


3. In the Save dialog, enter a file name. 


4. Click on the Save button. 


 


 


Make a note of the Configuration File’s file name and location, as you must import this file when you 


configure ImproNet Engine.  We recommend that you save the file in your ImproNet folder (default file 


name discovery.txt).  We recommend that you give the file a site suffix so that it is associated with 


the correct site (for example: ―Discovery - site 1.txt‖). 
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IImmppoorrttiinngg  tthhee  DDiissccoovveerryy  UUttiilliittyy  CCoonnffiigguurraattiioonn  FFiillee  


Import a previous version Configuration File into the Discovery Utility and add the information to 


the existing table.   


 


1. On the menu bar, go to File>Import IP Config. 


2. In the Open dialog, select the file.   


3. Click on the Open button. 


 


AAddvvaanncceedd  FFeeaattuurreess  


Clear the Controller or Terminal’s Memory 


This feature lets you clear the Controller or Terminal’s memory (used for storing the Database - 


that is the Tags, Transactions, Terminal Tables, Actions, Time Patterns and so on).   


 


 


Only use this feature in consultation with Impro’s Support personnel. 


 


1. Select the Controller or Terminal for configuration. 


2. On the menu bar, go to Action>Clear Memory. 


3. Logon if requested (see page 41). 


4. Click the  button.  


 


Safe IP 


 


 


Enable Safe IP only AFTER configuring and setting up the whole system.  Once you set Safe IP 


you can only change or query the Logical Address using the Discovery Utility on the Engine PC.    


 


 


Safe IP is part of the configuration and is only accessible with a Secure Shell (SSH) Logon and 


the Controller or Terminal password.  Setting Safe IP is accessible from ANY PC on the network 


using Discovery, provided the password is known.  Therefore ensure that you change the 


password from the default password, as soon as you have fully configured the Controller or 


Terminal.   


 


The Safe IP feature enhances the security of your site installation.  It is part of the configuration 


protected by a Secure Shell (SSH) Logon with the Controller or Terminal password.  The Secure 


Shell (SSH) sets up an encrypted communication channel to the Controller or Terminal.   


 


Once you have checked the Safe IP checkbox, The Controller or Terminal only responds to 


communication from devices in the IP Mapping Table uploaded by ImproNet Engine.  This 


means that other PCs on the network cannot access the Controller to change or query the 


Controller’s Logical Address or Port number.  Safe IP on a Terminal defines which Controller can 


send commands to the Terminal. 


Set the Safe IP as follows: 


 


1. Select the Controller or Terminal for configuration. 


2. On the menu bar, go to Configuration>Set Configuration. 


3. Logon if requested (see page 41). 


4. In the Set Configuration dialog, click the Safe IP checkbox. 


5. Click the  button to confirm. 


6. Wait while the Controller or Terminal re-boots (about 15 seconds). 
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Set GSM Modem Configuration 


This feature lets a Controller send and respond to received SMS messages when trigger events 


occur.  Set the GSM Modem Configuration as follows: 


 


1. Select the Controller for configuration. 


2. On the menu bar, go to Action>Set GSM Modem Configuration. 


3. Logon if requested (see page 41). 


 


 
Figure 28:  Set GSM Modem Configuration Dialog 


 


4. In the Set GSM Modem Configuration dialog, configure the following: 


 Device—depends on the Modem used. When using the Falcom Samba 75 Modem, 


select the /dev/ttyACM0 option.  When using the Falcom Samba 3G Modem, select the 


/dev/ttyUSB0 option. 


 SMS Action Password—set this password for use when sending SMS messages.  


This password prevents unauthorized applications from using the GSM service. 


 Optional PIN (for SIM card)—enter your SIM card’s PIN if using one. 


 Delay Interval—the interval in seconds between checking for SMS messages.  Change 


this setting only to ensure the best possible operation. 


 Maximum Number of Pending Outgoing Messages—this setting limits the buffer in 


case an event repeatedly creates false messages.  Change this setting only to ensure 


the best possible operation. 


 Initialisation String—depends on the Modem used.  Select 


AT+CPMS=”SM”,”SM”,”SM” recommended for both the Falcom Samba 75 Modem 


and the Falcom Samba 3G Modem. 


5. Click the  button to confirm. 
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Configure ImproNet Engine  


Configure ImproNet Engine as follows: 


 


IImmppoorrttiinngg  tthhee  DDiissccoovveerryy  UUttiilliittyy  CCoonnffiigguurraattiioonn  FFiillee  


 


 


Using the Discovery Utility, ensure that you assign a Logical Address to each Controller and Terminal.   


Failure to do so results in the Import function failing for those units without Logical Addresses. 


 


Import the Configuration File as follows: 


 


1. In Windows®, go to Start>Programs>ImproNet>Engine. 


2. On the menu bar click Configuration>Import Devices. 


3. Type in the location of the Discovery Configuration File OR click  to browse for the file. 


4. Click the  button. 


5. Click Yes to confirm. 


 


AAccttiivvaattee  UUDDPP  CCoommmmuunniiccaattiioonnss  


Activate the UDP communication option in ImproNet Engine as follows: 


 


1. On the menu bar, click Configuration>Engine Properties. 


2. Tick the UDP comms option. 


3. Click the  button to confirm. 


 


A Practical Example of the ImproX ECII’s Configuration Procedure 


This practical example lays out the procedure for setting up a UDP Site, using ImproX ECII’s 


and UDP Multi Drivers. 


 


SSeettttiinnggss  UUsseedd  iinn  tthhiiss  EExxaammppllee  


Subnet Range:   255.255.252.0 


Controller IP Address:  192.1.2.94 


Controller MAC Address:  00-1A-6E-00-01-0A 


 


CCoonnffiigguurraattiioonn  PPrroocceedduurree  ffoorr  tthhee  CCoonnttrroolllleerr  ((IIPP  AAddddrreessss  119922..11..22..9944))  


1. Plug the Controller into the Network. 


 


If the network’s DHCP enabled, the Controller asks for an IP Address from the DHCP Server. 


 


2. In Windows®, go to Start>Programs>ImproNet>Utils>Ethernet Discovery Utility. 


 


IP Address Configuration 


1. On the menu bar, go to Action>Search Local Subnet. 


2. If the Discovery Application fails to find any Devices, at the Device Not Found dialog, click 


the OK button. 


3. On the menu bar, go to Action>Advanced Local Search. 
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4. At the Select Network Interface dialog, select the relevant Network Interface, if more than 


one displays. 


5. Click the OK button. 


6. In the Input dialog, in the textbox, enter the Subnet Mask for your network. 


7. Click the OK button. 


8. Wait for the Controllers and or Terminals to display. 


9. From the records displayed in the Discovery Utility, double-click on the Controller, you need 


to setup. 


10. Logon if requested (see page 41). 


 


 
Figure 29 – Discovery Utility – Configuration Settings 


 


 


We advise that you set the Controller’s IP Address to Static.  This ensures that if the Controller’s IP 


Address expires on the network, and the DHCP Server assigns a new IP Address, the Engine will NOT 


lose connectivity to the Controller. 


 


Logical Address Configuration 


 


 
Figure 30 – Assign Logical Address to Device Dialog 


 


1. On the menu bar, go to Configuration>Configure LA. 


2. In the Logical Address textbox, type in the Controllers (hexadecimal) Logical Address. 


3. Click on the  button. 


 


 


Please note that the Logical Address is in Hexadecimal Format, that is, numbers 01 to 09 are the 


same as Decimal Format.  Higher numbers, that is 10 upwards, appear as follows:  10 as 0A, 11 as 0B 


and 12 as 0C and so on. 
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When configuring multiple Controllers, hold down the CTRL key on your keyboard and select the 


Controllers you need with the mouse. 


 


Create a Group for the Controller and its Terminals 


 


 


There is no need to give a group name to a Controller if it has no IPTerminals. 


 


1. Select the Controller and the Terminal’s it should control. 


2. On the menu bar, go to Configuration>Add to Group. 


 


 


Alternatively, right-click and select Add to Group from the pop-up menu.   


 


3. In the Enter Group Name dialog, enter a suitable group name. 


4. Logon if requested (see page 41).  A password is required for each Controller and Terminal 


being added to the Group. 


5. Click the  button.  


 


Export the IP Configuration File 


1. On the menu bar, go to File>Export IPConfig. 


2. In the Save dialog, click the Save button. 


 


 


The Export IPConfig menu option saves the Discovery.txt file to the ImproNet root directory by 


default. 


 


Configuration of the Engine 


1. In Windows®, go to Start>Programs>ImproNet>Engine. 


2. On the menu bar click Configuration>Import Devices. 


 


 
Figure 31 – Import Devices Dialog 


 


3. Alongside the File textbox, click the   button. 


4. Select the Discovery.txt file. 


5. Click the Open button. 


6. Click the  button. 


7. Click Yes to confirm. 


8. In Engine, on the main menu, click on Configuration>Engine Properties. 
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Figure 32 – Engine Properties Dialog 


 


9. In the Engine Properties dialog, select the UDP Comms checkbox. 


10. Click on the  button. 


11. Click the Auto-ID button. 


12. Click the Yes button. 


 


The Engine then connects to the Controllers, performing the Auto-ID as normal. 


 


Replacing an ImproX AC or EC with an ImproX ECII 


Action this procedure by first making a selection from either of the choices listed below: 


 


1. Pre ImproNet V7.60, or  


2. ImproNet V7.60 or LATER. 


 


After completing these steps, continue with the steps listed under ImproNet V7.60 or EARLIER. 
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PPrree  IImmpprrooNNeett  VV77..6600    


Pre ImproNet V7.60 use the following procedure when replacing an ImproX AC or EC with an 


ImproX ECII: 


 


Modify the Unit Type 


Start the IBConsole Software 


In Windows®, go to Start>Programs>ImproNet>Utils>IBConsole. 


 


Login to the InterBase Server 


1. From the Hierarchical Tree, select your InterBase Server. 


2. From the Server drop-down menu, select the Login choice. 


3. In the Server Login dialog, enter the Username and Password. 


 


 


The default username is SYSDBA.  The default password is masterkey. 


 


 


Refer to page 77 for details on the IBConsole Utility setup requirements. 


 


4. Click the Login button. 


 


Connect to the Database 


1. From the Hierarchical Tree, select your Database file (for example impronet.fdb) 


2. From the Database drop-down menu, select the Connect choice. 


 


Run the Database Script 


1. From the Hierarchical Tree, click on the impronet.fdb file. 


2. On the toolbar, click on the  button. 


3. Capture the script details highlighted in Figure 33. 


 


 
Figure 33 – Interactive SQL Dialog 


 


4. On the toolbar, click on the  button. 


 


IImmpprrooNNeett  VV77..6600  oorr  LLAATTEERR  


Using ImproNet V7.60 or later, use the following procedure when replacing an ImproX AC or 


EC with an ImproX ECII: 


 


 


Keep ImproNet Engine running when you replace the Controller using the Access Module. 
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1. Remove the old AC or EC Controller from the Controller bus. 


2. Connect the new ECII Controller to the Controller bus. 


3. In Windows®, click Start>Programs>ImproNet>Access. 


 


 
Figure 34 – Replacing the Controller 


 


4. In the Navigator Pane, click the old AC or EC Controller to select it. 


5. Right-click the Controller and select the Replace Unit option.   


6. From the Unit Type drop-down list, select the EC2 unit type. 


7. Enter the new Controllers Fixed Address. 


8. Click the  button. 


 


IImmpprrooNNeett  VV77..6600  oorr  EEAARRLLIIEERR  


Controller Configuration 


1. Plug the Controller into the Network.  If the network’s DHCP enabled, the Controller asks 


for an IP Address from the DHCP Server. 


2. In Windows®, go to Start>Programs>ImproNet>Utils>Ethernet Discovery Utility. 


 


IP Address Configuration 


1. On the menu bar, go to Action>Search Local Subnet. 


2. If the Discovery Application fails to find any Devices, at the Device Not Found dialog, click 


the OK button. 


3. On the menu bar, go to Action>Advanced Local Search. 


4. At the Select Network Interface dialog, select the relevant Network Interface, if more than 


one displays. 


5. Click the OK button. 


6. In the Input dialog, in the textbox, enter the Subnet Mask for your network. 


7. Click the OK button. 


8. Wait for the Controllers to display. 
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9. From the records displayed in the Discovery Utility, double-click on the Controller, you 


need to setup. 


10. Logon if requested (see page 41). 


 


 
Figure 35 – Discovery Utility – Configuration Settings 


 


 


We advise that you set the Controller’s IP Address to Static.  This ensures that if the Controller’s IP 


Address expires on the network, and the DHCP Server assigns a new IP Address, the Engine will NOT 


lose connectivity to the Controller. 


 


Logical Address Configuration 


 


 


Ensure that the Logical Address of the ImproX ECII is the same as the ImproX AC or EC Controller 


being replaced. 


 


 
Figure 36 – Assign Logical Address to Device Dialog 


 


1. On the menu bar, go to Configuration>Configure LA. 


2. In the Logical Address textbox, type in the Controllers (hexadecimal) Logical Address. 
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3. Click on the  button. 


 


 


Please note that the Logical Address is in Hexadecimal Format, that is, numbers 01 to 09 are the 


same as Decimal Format.  Higher numbers, that is 10 upwards, appear as follows:  10 as 0A, 11 as 0B 


and 12 as 0C and so on. 


 


Access Module Configuration 


Open ImproNet Access: 


 


1. In Windows®, click Start>Programs>ImproNet>Access. 


3. Enter your Username and Password. 


 


 


The default username is SYSDBA.  The default password is masterkey. 


 


Site Configuration 


1. In the Navigator Pane, click the  icon. 


2. In the Main Pane, select the UDP Comms checkbox. 


3. Click on the  button. 


 


Controller Configuration 


1. In the Navigator Pane, click the new Controller to select it. 


2. Right-click the Controller and select the Replace Unit option.   


3. From the Unit Type drop-down list, select the EC2 unit type. 


4. Enter the new ECII Controllers Fixed Address. 


5. Click the  button. 


6. In the Navigator Pane, click the new Controller to select it. 


7. In the Main Pane, in the IP Address textbox, enter the Controller’s IP Address details. 


8. In the Controller Comms Port textbox, enter the port number. 


9. In the Inter-controller Comms Port textbox, enter the port number. 


 


 


The default Port number is 10002. 


 


IP Mapping 


Export the udpmulti.csv file, used by Engine for communication with the Controllers, as 


follows: 


 


1. In the Navigator Pane, select the  icon from the hierarchical tree. 


2. Click on the  button. 


 


Engine Configuration 


1. In Windows®, click Start>Programs>ImproNet>Engine. 


2. From the Menu Bar, select Configuration>Engine Properties. 


3. Select the UDP Comms checkbox. 


4. Click the  button. 


5. Close Engine. 


6. In Windows®, click Start>Programs>ImproNet>Engine. 


7. Click the Full Upload button. 
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Universal Data Exporter Utility  


Introduction 


The Universal Data Exporter Utility lets you extract transaction (including time and attendance) 


records from the ImproNet Database for use by third-party applications.  The Exporter Utility 


makes use of user defined templates (created in Design Mode) that specify the data for 


extraction and the export format.   


 


Using the Run Mode, you have the choice of exporting the records interactively or as scheduled 


(using Windows® Scheduler).  Command line arguments specify the Mode and other 


parameters. 


 


On installation of the ImproNet Software V7.60 Service Pack 3 (and upwards), two additional 


Utility shortcuts appear on the Programs Menu.  These are Universal Data Exporter 


(Designer) (used for Design Mode) and Universal Data Exporter (used for Run Mode).    


 


 


This Utility requires advanced knowledge of SQL.   


 


Opening the Utility 


In Windows®, go to Start>All Programs>ImproNet>Utils>Universal Data Exporter 


(Designer). 


 


Template Creation (Design Mode) 


1. From the toolbar, click the  button.  


2. If no template exists, at the Message dialog, click the OK button. 


3. Enter your Username (SYSDBA) and Password (masterkey).  


 


 







Part 8 – Utilities 


58  January 2012 


 
Figure 37 – Template File Tab 


 


TTeemmppllaattee  FFiillee  TTaabb  


1. In the Template Name textbox, enter a name for the template (template files must have the 


file extension tpl).  Find this file in the subfolder Templates in the installation folder.   


 


 


Alternatively, load an existing template by clicking the Browse button (alongside the Template Name 


textbox) and selecting the template file.   


 


2. In the Export Filename textbox, specify a name for the exported file.  


3. In the Export Directory Path textbox, specify the export directory details. 


4. From the Export Filename group, select one of the following radio buttons: 


 Leave Unchanged—lets you export the filename unchanged. 


 Append ISO Date—lets you attach an ISO formatted date to the filename. 


 Append ISO Date/Time to Filename—lets you attach an ISO formatted date or time to 


the filename. 
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5. Select either the Append to File or Overwrite File radio button. 


6. Select the End of Line Character required: 


 CR & LF—the Carriage Return (CR) & Line Feed (LF) option is selected by default for 


Windows®.   


 CR Only—Carriage Return (CR) Only. 


 LF Only—Line Feed (LF) Only. 


 


EExxppoorrtt  FFoorrmmaatt  TTaabb  


Build Export Format 


1. Select the Export Format Tab. 


 


 
Figure 38 – Export Format Tab 


 


A suggested SQL Query (specific to the product database) displays.  You may edit this Query 


including other fields or restricting the record set selection. 
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Edit this SQL Query at your own risk.  Knowledge of the System Database Tables and of SQL is 


essential during editing.  If you mistakenly edit the SQL Query click the Reset Query button to return to 


the default SQL Query. 


 


 


The query includes placeholders for a Start and End Date for the selected transaction records.  You 


may specify these at runtime using command line arguments (for example: START_DATE=20090101).  


Note that the End Date is NOT inclusive, so the Utility exports from the Start Date up to and including 


the day before the End Date.  If you do not want the Start and End Date for the selection, or you intend 


using Windows® Scheduler, then delete the date parameters.     


 


Similarly you may include a site placeholder as AND field_name=%SITE% where for example 


field_name is S_ID.  An example of the query with the placeholders specified could look as follows:  


and TR_DATE>=2009 0101 and TR_DATE<20090131 and t.s_ID=1. 


 


 


Expand your transaction results beyond time and attendance by changing the TA value in the query to 


TA=0. 


 


2. Click the Execute SQL Query button. 


3. In the Input dialog, enter a Start Date, using the yyyymmdd format. 


4. Click the OK button. 


5. Enter the End Date, again using the supplied format. 


6. Click the OK button. 


7. If prompted, enter the Site Number (that is the SITE_SLA of the particular Site).  Ensure 


that the SITE_SLA uses the format xx000000 (where xx specifies the Site number, in 


hexadecimal, followed by 6 zeroes). 


8. Click the OK button.  Once successfully executed, the Select Field drop-down list 


populates. 


9. Start building the export format, column by column using one or both of the following 


methods: 


 


Select Field Method 


For using fields stored in your Database, continue as follows: 


 


1. From the now-populated Select Field drop-down list, select a field. 


2. Alongside the Select Field drop-down list, click the Format button.  The Format Field 


dialog opens giving you various choices specific to the field selected, edit these fields 


as needed: 


 Selected Field—displays the actual data found in this field. 


 Format Pattern—based on the field selected, you may choose from the following 


choices:   


 None—adds the field value exactly as stored in the database. 


 Fixed Length—field value truncated (only if selected) or padded to the required 


length with the fill character in the direction named. 


 dd/MM/yyyy—this applies only to a date field stored as an integer yyyymmdd. 


The d represents day, dd represents the double-digit day preceded by a 0 as 


necessary and MM represents double-digit month.  Alternatively use MMM 


representing the 3-letter abbreviation of the month name.  The yyyy represents 


a 4-digit century and yy represents the last 2 digits of the century.  The / 


represents the date separator, you may, however, use any preferred separator. 
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 HH:mm—this applies to a time field stored as an integer hhmmss.  The HH 


represents the double-digit hour of day, mm represents the double-digit minute 


of the hour and ss represents the double-digit second of the minute.  The : 


represents the time separator, you may, however, use any preferred separator. 


 I/O—this applies only to the integer Direction field stored as 1 (In) (formatted as 


I) and 0 (Out) (formatted as O).  You may specify alternative characters 


separated by a ―/‖, for example In/Out. 


 Clock# d—this applies only to the Name field of a Door (Location).  If a number 


follows the last space in the name, it’s interpreted as a number.  This would be 


a way for the user to give a specific number to the time attendance point, for 


example TA Reader 1.   


 


 


If the name does not follow this convention then the formula fails for this field and the record will not 


export. 


 


 Use Field Delimeter—select this checkbox, if a field delimiter must follow the field. 


 Delimiter Character—allows selection of the character used to separate fields in 


the output record.   


 Fill Char—the character used when padding a field value to the chosen length in 


the direction named. 


 Length—extends the field output to the number of characters named. 


 Truncate—select whether output must be shortened. 


 Fill Left—select this alternative if you want the fill characters to fill from Left. 


 Fill Right— select this alternative if you want the fill characters to fill from Right. 


3. Click the Test button and make sure that the Output meets your expectations. 


4. Click the OK button. 


 


Enter Fixed Data Method 


For entering constant information not physically stored in your Database, this could include 


for example a Company Registration Number. 


 


1. Select the Fixed Data radio button. 


2. Enter the required data. 


3. Click the Add button. 


 


The fixed data appears in the Build Export Format text area, enclosed in square brackets.  


You may also add a delimiter in this way if needed. 


 


10. After editing the choices mentioned in point 9, click the Test button.  The Output and Format 


textboxes complete as follows: 


 Output—shows a sample of the output record. 


 Format—formula used to construct the output from the data. 


11. Click the OK button. 


 


 


As you edit Fields from the Select Fields drop-down list, they appear in the Build Export Format text 


area, midway on the Universal Data Exporter Utility dialog.  Clicking the Test button displays a sample 


record (in the Export Output Record text area) based on the choices you made in the Format Field 


dialog.  The Clear button lets you delete first the delimiter and then the field from the Build Export 


Format text area.   
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Should you incorrectly add field information in the Build Export Format text area, position your cursor at 


a suitable point and delete the necessary field information.  After you have added new field information 


your cursor automatically reverts to the end of the field list.  Alternatively, reposition the cursor at the 


end of the field list yourself and continue adding fields in the usual manner. 


 


12. Select the Mark Records Successfully Exported checkbox (if required). 


 


 


The Transack table in the Database has an integer field called TR_PROCESSED.  Its value is set to 


zero when the transaction is added to the Database.   You may, however, set this value to 1 after 


export of the record, to distinguish it from other records.  To use this successfully, add the clause AND 


TR_PROCESSED=0 to the Selection SQL Query thus excluding records already exported. 


 


13. Click the Save button. 


 


Export Data (Run Mode) 


1. From the toolbar, click the  button. 


 


 
Figure 39 – Export Transactions From Database Dialog 


 


If you did not supply a template file name as a command line argument, the file name default.tpl 


is assumed.  The template loads with any other arguments, for example:  Site, Start Date or End 


Date. 


 







Part 8 – Utilities 


January 2012  63 


 


Click the Browse button alongside the Template textbox to select a different template. 


 


2. Click the Export button.   


 


The formatted export records display in the Data text area.  Depending on the number of 


records in the set, the export process may take some time.  Only every 100
th
 record exported 


displays thus preventing the user interface from becoming overloaded.  Wait until the message 


***** Export ended ***** displays in the Status textbox. 


 


Advanced Features 


CCoommmmaanndd  LLiinnee  AArrgguummeennttss  


The Universal Data Exporter Utility also lets you assign arguments using the command line.  


This advanced alternative automates tasks, simplifying the process.   


 


A typical command line argument appears as follows:  "C:\ImproNet\bin\Universal Data 


Exporter.exe" mode=run template=default.tpl site=1 startdate=20090101 


enddate=20090131 run= auto.  The text above (in bold) represents a few typical (optional) 


arguments. 


 


 


Ensure that you precede listed arguments with a space as shown earlier.  Note however that spaces 


are NOT allowed within the individual arguments, that is startdate= 20080901 is not allowed, 


startdate=20080901 is correct.  


 


Access the command line as follows: 


   


1. In Windows®, navigate to Start>All Programs>ImproNet>Utils. 


2. Right-click the Universal Data Exporter program name. 


3. From the Menu, select the Properties choice. 


4. Select the Shortcut tab if not already selected. 


5. In the Target textbox, at the end of the "C:\ImproNet\bin\Universal Data Exporter.exe" 


phrase, add any of the following arguments: 


 mode=design—drives the Utility to open in Design Mode.  This Mode provides the 


tools necessary for template creation. 


 mode=run—drives the Utility to open in Run Mode (default).  This Mode provides the 


tools necessary for export of transactions.  When used without any further supporting 


arguments, the Utility runs interactively, this requires that you manually supply the Start 


Date and End Date before export takes place.   


 template=filename.tpl—specifies the template file for use by the Utility.  If no template 


file exits, the Utility exits in Run Mode.  The default value is default.tpl. 


 run=auto—ignored when you specify Design Mode.  When named alongside the Run 


Mode argument, the Utility runs without user intervention and exits when complete.  


Export of transactions, not marked as exported, takes place according to the Start Date, 


End Date and Schedule details.   


 site=ddddd—specifies the site for which transactions are to be exported.  If not named, 


the Utility exports transactions for all sites. 


 schedule=sd—when used with the Auto argument the Utility automatically extracts 


transactions for yesterday’s date only. 
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 schedule=sw—when used with the Auto argument the Utility automatically extracts 


transactions for the last seven days ending yesterday. 


 schedule=sm— when used with the Auto argument the Utility automatically extracts 


transactions for the month ending yesterday.   


 


 


The Schedule argument runs best when used with the run=auto argument and with Windows® 


Scheduler.  


 


 startdate=yyyymmdd—the Start Date in ISO format, specifies the earliest date that 


transactions are required.  The Utility ignores this argument when you specify a 


Schedule. 


 enddate=yyyymmdd—the End Date in ISO format, specifies the last date that 


transactions are required.  The Utility ignores this argument when you specify a 


Schedule. 


 


 


Transactions for the startdate and enddate will be included depending on how the query is stated, for 


example TR_DATE  <= %END_DATE%.  


 


6. Click the Apply button. 


7. Click the OK button. 


 


LLooccaalliissaattiioonn  aanndd  TTrraannssllaattiioonn  


Localisation and Translation lets Users from different locales (countries and geographical 


locations), use the Utility in their own language. 


 


Choose Locale 


1. From the Menu Bar, select File>Choose Locale. 


 


 
Figure 40 – Locale Chooser Dialog 


 


2. In the Locale Chooser dialog, from the Language drop-down list, make your selection. 


3. From the Country drop-down list, make your selection. 


4. From the Variant drop-down list, select a language variant based on your previous 


selections (optional). 


5. Click the OK button. 
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Translating the Software Interface 


1. From the Menu Bar, select File>Translate. 


 


 
Figure 41 – Translate Text :  Dialog 


 


2. In the Translate Text : dialog, from the New Text column, select a phrase to translate.   


 


 


The Original column displays words in English.  The New Text column displays a copy of the English 


words, but it is editable.  This means you can substitute the default words in the New Text column for 


words in your own language. 


 


3. Press the F2 key, thus opening the phrase for editing.   


4. Enter a substitute phrase suitable for your Locale. 


5. Press the Tab key to move to the next phrase. 


6. Repeat steps 3 to 5 for each phrase you wish to edit. 


 


 


Do NOT edit a translation twice in the same session.  Close the application and re-start thus preventing 


loss of the translated data. 


 


7. Click the OK button. 


8. At the Information dialog, click the OK button. 
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Find Duplicates Utility 


Introduction 


Before upgrading a Database to a new version, the Utility searches the Database looking for 


repeats of ID Numbers and Employee Numbers. 


 


 


The Utility does NOT search for duplicate Tagholder NAMES.  The Tagholders Name appears for 


reference only. 


 


Opening and Using the Find Duplicates Utility 


1. In Windows®, go to Start>Programs>ImproNet>Utils>Find Duplicates. 


2. Enter your Username and Password. 


 


 


The default username is SYSDBA.  The default password is masterkey. 


 


On opening, the Find Duplicates dialog lists the duplicated records. 


 


EEddiittiinngg  DDuupplliiccaattee  RReeccoorrddss  


1. In the Find Duplicates dialog, select one of the duplicated records. 


2. Click on the  button. 


3. In the Edit Tagholder dialog, edit the ID Number textbox. 


4. Click on the  button.  


5. Click on the  button (this refreshes the Find Duplicates list of records). 


6. Close the Find Duplicates dialog, by clicking on the  button. 


 


DDeelleettiinngg  DDuupplliiccaattee  RReeccoorrddss  


1. In the Find Duplicates dialog, select one of the duplicated records. 


2. Click on the  button. 


3. In the Confirm Delete dialog, click the Yes button. 


4. Close the Find Duplicates dialog, by clicking on the  button. 


 


DDiissppllaayy  TTaagghhoollddeerr  DDeettaaiillss  


1. In the Find Duplicates dialog, select one of the duplicated records. 


2. Click on the  button. 


3. Close the dialog, by clicking on the  button. 


4. Close the Find Duplicates dialog, by clicking on the  button. 


 


 


If the Utility returns details of a large number of duplicate entries, contact Impro's Customer Support for 


a script to resolve the problem. 
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IXP200 Conversion Utility 


Introduction 


The IXP200 Conversion Utility lets you convert IXP200 user information files to ImproNet files.   


 


 


The Utility does NOT import site information; therefore, ensure that you configure the site and 


Hardware before converting the user information. 


 


Opening and Using the IXP200 Conversion Utility 


1. In Windows®, go to Start>Programs>ImproNet>Utils>IXP200Conversion. 


2. Enter your Username and Password. 


 


 
Figure 42 – Logon to Database Dialog 


 


 


The default username is SYSDBA.  The default password is masterkey. 


 


3. Click on the Browse button. 


4. In the Open dialog, select the Database file. 


5. Click the Open button.  The route address displays in the Converting From textbox. 


6. In the Logon to Database dialog, click the OK button. 


 


The Proxette → ImproNet Database Conversion dialog displays the progress of the 


conversion.   


 


7. When the conversions complete, click the OK button. 
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Pump Utility 


Introduction 


The Pump Utility lets you flush out and correct a ―muddled‖ or overloaded Database.  When 


executed, the Pump takes all the Tagholders, Visitors and Transaction data and pumps this into 


a fresh Database.   


 


 


Before implementing the Pump Utility, ensure that you close all other applications. 


 


 


For large Databases carry out this action over a quiet period, as completion could take many hours. 


 


Opening and Using the Pump Utility 


1. In Windows®, go to Start>Programs>ImproNet>Utils>Pump. 


2. Enter your Username and Password. 


 


 
Figure 43 – Logon to Database Dialog 


 


 


The default username is SYSDBA.  The default password is masterkey. 


 


3. Click on the OK button. 


4. In the Pump Database dialog, click the Start button. 


5. In the Message dialog, click the OK button. 
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Translate Utility 


Introduction 


This Utility lets you translate the Database contents and Reports into a different language. 


 


Opening and Using the Translate Utility 


In Windows®, go to Start>Programs>ImproNet>Utils>Translate. 


 


CChhoooossee  tthhee  LLooccaallee  


 
Figure 44 – Locale Dialog 


 


1. In the External Translation Utility dialog, click on the  button. 


2. From the Language drop-down list, select the language for use in the translation. 


3. From the Country drop-down list, select the corresponding country. 


4. Click the OK button. 


 


TTrraannssllaattee  aa  FFiillee  


1. In the External Translation Utility dialog, from File drop-down list, select Open. 


2. In the Open dialog, select the LOCALIZATION.XML file. 


3. Click on the Open button. 


 


 


Editing the Database contents files requires entry of a username and password.  The default username 


is SYSDBA.  The default password is masterkey.  Editing the Web Reports files, does NOT require 


entry of a username or password. 
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Figure 45 – External Translation Utility Dialog 


 


4. Expand either the Database or Web Reports folders. 


5. In the Directory Tree, double-click the file for editing. 


6. From the list of records displayed, select a line for translation. 


7. In the Translation column, double-click on the pre-existing text, activating the text for 


replacement. 


8. Type in the replacement text. 


9. Once you’ve edited the required records, click on the  button. 


10. From the File drop-down list, select Exit. 
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Archiving Utility 


Introduction 


This Utility lets you archive transactions (Normal, Status and Alarms), placing the transactions in 


a separate archived Database.  We recommend that you run the Archive Utility on a regular 


basis.  Running Utility regularly keeps your Database below the maximum recommended 


database size of 2 GB.  This action has two major benefits: 


 


 Manages the size of the Database, freeing up space on the PC. 


 Keeps a cleaner, uncluttered Database. 


 


Opening and Using the Archive Utility 


1. In Windows®, go to Start>Programs>ImproNet>Utils>Archive. 


2. Enter your Username and Password. 


 


 
Figure 46 – Logon Dialog 


 


 


The default username is SYSDBA.  The default password is masterkey. 


 


 
Figure 47 – Database Archive Utility Dialog 
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SSeelleecctt  tthhee  AArrcchhiivvee  DDaattee  


 


 


This is the end date for the archive.  Your newly archived database will therefore contain all 


transactions for this date and earlier. 


 


1. In the Database Archive Utility dialog, in the Archive Date group, click on the Change 


button. 


2. In the calendar dialog, click on the Month drop-down list and select the desired month from 


the list. 


3. Click on the Year drop-down list and select the year from the list. 


4. From the grid, select the day number. 


 


CCoonnffiirrmm  tthhee  AArrcchhiivviinngg  OOppttiioonnss  


 
Figure 48 – Archiving Options Dialog 


 


1. In the Database Archive Utility dialog, click on the Options button. 


2. In the Archiving Options dialog, click either the Archive or Delete radio button for each of 


the named transaction types. 


 


 


If you select the delete option, confirm the deletion in the Delete Transactions dialog, by clicking on 


the OK button.  After confirmation, the Archiving Options dialog closes automatically. 


 


3. Click on the OK button. 


 


AArrcchhiivvee  tthhee  TTrraannssaaccttiioonnss  


1. In the Database Archive Utility dialog, click on the Archive button. 


2. In the Archiving Options dialog, confirm the archiving details by clicking on the OK button. 


 


 
Figure 49 – Archive Complete Dialog 


 


3. In the Archive Complete dialog, click on the OK button. 
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IB Console Utility 


Introduction 


This Utility lets you perform the following functions to your ImproNet Database: 


 


 Manual upgrades from older versions of ImproNet. 


 Database maintenance in the form of checking for errors and performing backup and 


restores of the Database. 


 From IB Console you can review the Database structure, allowing addition of extra tables 


for third-party integration. 


 Addition and deletion of users. 


 Password changes. 


 


Manual Upgrade Function 


In Windows®, go to Start>Programs>ImproNet>Utils>IBConsole. 


 


RReeggiisstteerr  tthhee  SSeerrvveerr  


 
Figure 50 – Register Server and Connect Dialog 


 


1. From the Server drop-down menu, select the Register option. 


2. In the Register Server and Connect dialog, click the Remote Server radio button. 


3. In the Server Name textbox, assign the Server a name.  In this instance, we used 


LOCALHOST. 
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Rather than assigning the Server a name in the Server Name textbox, you may use the PC’s IP 


Address. 


 


4. In the Network Protocol textbox, select TCP/IP from the drop-down list. 


5. In the Alias Name textbox, assign a meaningful name. 


6. Leave the remaining fields unchanged. 


7. Click the OK button. 


 


LLooggiinn  ttoo  tthhee  IInntteerrBBaassee  SSeerrvveerr  


1. From the Hierarchical Tree, select your InterBase Server (based on the example in Figure 


50 select Local Server). 


2. From the Server drop-down menu, select the Login option. 


3. In the Server Login dialog, enter the Username and Password. 


 


 


The default username is SYSDBA.  The default password is masterkey. 


 


4. Click the Login button. 


 


RReeggiisstteerr  tthhee  DDaattaabbaassee  


 
Figure 51 – Register Database and Connect Dialog 


 


1. From the Database drop-down menu, select the Register option. 
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2. In the Register Database and Connect dialog, In the Database textbox, enter in the full 


file path to your Database (see Figure 51). 


3. Click your mouse pointer in the File textbox, the Database’s file name automatically 


appears. 


4. Leave the remaining fields unchanged. 


5. Click the OK button. 


6. In the Hierarchical Tree, double-click on the Impronet.fdb file, starting the Database. 


 


UUppddaattiinngg  tthhee  DDaattaabbaassee  wwiitthh  DDaattaabbaassee  SSccrriippttss  


Since the release of ImproNet V3.0, we included extra Database Scripts to upgrade Databases 


earlier than V3.0.  We have already applied these scripts to the newly released Databases. 


Thus, when upgrading your ImproNet Software, you will have to upgrade your existing 


Database with the Scripts new for that release. 


 


 


If you install a fresh copy of ImproNet V5.0 or later you need not run any scripts.  If you upgrade a 


version of ImproNet older than V5.0 ensure that you run the necessary scripts. 


 


1. From the Hierarchical Tree, click on the Impronet.fdb file. 


2. On the toolbar, click on the  button. 


3. From the Query drop-down menu, select the Load Script option. 


 


 


Review the Scripts_Readme.wri file located in C:\ImproNet\scripts for details of which Scripts you 


must run. 


 


4. In the Open dialog, browse to C:\ImproNet\scripts\V?. 


5. Select the Script to run. 


6. Click on the Open button. 


 


 
Figure 52 – Script Transferred into the Main Script Screen 
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7. On the toolbar, click on the  button. 


8. Repeat the selection and execution process outlined in steps 3 to 7, for each Script. 


 


Database Maintenance 


PPeerrffoorrmmiinngg  aa  BBaacckkuupp  ooff  tthhee  DDaattaabbaassee  


1. In Windows®, go to Start>Programs>ImproNet>Utils>IBConsole. 


2. From the Database drop-down menu, select Maintenance>Backup / Restore>Backup. 


 


 
Figure 53 – Database Backup Dialog 


 


3. In the Database group, from the Alias drop-down list, select the Database for backup. 


4. In the Backup File(s) group, in the Alias textbox, provide a name for the backed up 


Database. 


 


 


Ensure that your backed up file has an FBK file extension. 


 


5. In the Backup File(s) group, in the Filename(s) textbox, provide the directory path and file 


name for the backup database.  We suggest C:\ImproNet\Database\ImproNet.fbk. 


6. Leave the remaining values as they are. 


7. Click on the OK button. 


8. In the Information dialog, click on the OK button. 


9. Close the Database Backup dialog. 
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RReessttoorriinngg  tthhee  DDaattaabbaassee  


 


 


Disconnect from the Database before restoring. 


 


1. In Windows®, go to Start>Programs>ImproNet>Utils>IBConsole. 


2. From the Database drop-down menu, select Maintenance>Backup / Restore>Restore. 


 


 
Figure 54 – Database Restore Dialog 


 


3. In the Backup File(s) group, in the Alias textbox, select the name of the backed up 


Database.   


If IBConsole does not auto complete the remaining fields continue as follows, otherwise 


continue with point 5: 


 


 In the Backup File(s) group, in the Filename(s) textbox, provide the directory path and 


file name for the backup database.  We suggest C:\ImproNet\Database\ImproNet.fbk. 


 In the Database group, from the Server drop-down list, select the server in which the 


Database will reside. 


 In the Database group, from the Alias drop-down list, select the Database to restore 


to. 


 In the Database group, in the Filename(s) textbox, provide the directory path and file 


name for the restored Database.  We suggest C:\ImproNet\Database\ImproNet.fdb. 


 


4. From the Options group, select the Overwrite record. 


5. From the Overwrite drop-down list, select True. 


6. Click on the OK button. 


7. Close the Database Restore dialog when you see the comment “Service Ended”. 
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Add and Delete Users 


 
Figure 55 – IB Console Dialog 


 


AAddddiinngg  aa  UUsseerr  


1. From the Hierarchical Tree, click on the  (Users) icon.  


2. Right-click over the User’s icon and select the Add User option. 


3. In the User Information dialog, in the User Name textbox, enter the user’s name. 


4. In the Password and Confirm Password textboxes, enter a password. 


5. Click the Apply button. 


6. Click the Close button. 


 


DDeelleettiinngg  aa  UUsseerr  


1. From the Hierarchical Tree, click on the  (Users) icon.  


2. In the right-hand pane, select the User Name for deletion. 


3. Right-click over the Users icon and select the Delete User option. 


4. In the Confirm dialog, click the Yes button. 


 


Change Password 


1. From the Hierarchical Tree, click on the  (Users) icon. 


2. Right-click over the Users icon and select the Modify User option. 


3. In the User Information dialog, from the User Name drop-down menu, select the user’s 


name. 


4. In the Password and Confirm Password textboxes, enter a new password. 


5. Click the Apply button. 


6. Click the Close button. 
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Linux Integration 


ImproNet V7.6 (onwards) supports installation of ImproNet Engine on OpenSUSE V10.30 Linux. 


 


Conversion of the USB Registration Interface for Linux 


IInnssttaallll  tthhee  UUSSBB  RReeggiissttrraattiioonn  IInntteerrffaaccee  aanndd  DDeevviiccee  DDrriivveerrss  


 


 


If there are old USB Drivers on the PC, delete them before installing the provided driver. 


 


1. Plug the USB Registration Interface into a USB port on the PC.  The Found New 


Hardware Wizard displays. 


2. Follow the onscreen instructions.  In some cases, two drivers install; one for the USB 


Registration Reader and one for the COM port to USB Bridge.  Therefore, the Wizard 


pops up twice. 


 


 


Ensure that you only assign the Registration Interface to an unused Communications Port lower than 


10. 


 


 


On some PC’s, the New Hardware Found wizard is displayed every time a USB Registration Reader 


Interface with a new USB Serial Number (Fixed Address) is plugged in.  If this happens, choose the 


option to automatically install the unit; The New Hardware Found wizard will not be displayed again. 


 


CChhaannggiinngg  tthhee  PPrroodduucctt  IIDD  


 


 


Ensure that you use the Windows XP operating system when changing the Product ID. 


 


1. Open the CP210x Set IDs Application, by running the CP2101SetIDs.exe file. 


 


 
Figure 1 – CP210x Set IDs Dialog 
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If the textboxes displayed in the Figure 1 contain no values, then the USB Device Drivers installed 


incorrectly.  Disconnect and then reconnect the USB Device. 


 


2. In the Pid group, select the checkbox. 


3. In the Pid group, in the textbox, enter the text EA60 (replacing the existing text FF01 or 


FF02). 


4. Click on the Progam Device button. 


5. Disconnect the USB Registration Interface from the Windows PC. 


6. Connect the USB Registration Interface to the Linux PC. 


7. Install the necessary Drivers. 


8. Click the Computer button. 


9. Click the More Applications button. 


10. Select the System menu option. 


11. Select the Terminal icon. 


12. View the number of USB Ports in use, by entering the following instruction: 


ls /dev/ttyUSB* 


 


 


Usually a single USB Port is in use (ttyUSB0).  In that case, link the USB Port to COM Port 2 for 


example.  If the PC has more than 2 COM Ports alter the instruction accordingly.  Suitable scenarios 


could include ttyS0 to COM Port 1, ttyS1 to COM Port 2, ttyS2 to COM Port 3, ttyS3 to COM Port 4, 


ttyS4 to COM Port 5 and ttyS5 to COM Port 6. 


 


13. Press Enter. 


14. For the sake of this example, we entered the following instruction: 


ls /dev/ttyUSB0 /dev/ttyS2 


15. Press Enter. 


 


Installing ImproNet on Linux OpenSUSE V10.30 


 


 


Ensure that you log-in to the Linux PC as the root user, before proceeding further. 


 


Copy the contents of your supplied ImproNet CD to your Linux Desktop, naming the folder 


IMPRONET. 


 


FFiirreebbiirrdd  IInnssttaallllaattiioonn  


1. Click the Computer button. 


2. Click the More Applications button. 


3. Select the System menu option. 


4. Select the Terminal icon. 


5. In the Terminal dialog, type in the following instruction: 


cd /root/Desktop/IMPRONET/database/firebird/linux 


6. Press Enter. 


7. Type in the following instruction: 


rpm -uhv firebird.rpm 


8. Press Enter. 
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IImmpprrooNNeett  IInnssttaallllaattiioonn  


Terminal Application 


1. Type in the following instruction: 


cd /root/Desktop/IMPRONET 


2. Press Enter. 


3. Type in the following instruction: 


mv setup.bin setup.bak 


4. Press Enter. 


5. Type in the following: 


 cat setup.bak | sed “s/export LD_ASSUME_KERNEL/#xport LD_ASSUME  


_KERNEL/” > setup.bin 


6. Press Enter. 


 


Browser 


1. From the Desktop, select the IMPRONET installation directory. 


2. Right-click the setup.bin file. 


3. Choose the Properties menu option. 


 


 
Figure 2 – Setup.bin Properties Dialog 


 


4. Select the Permissions tab. 


5. From each of the Access drop-down menus, select the Read and Write option. 


6. Select the Execute checkbox. 


7. Click the Close button. 
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Terminal Application 


1. Type in the following instruction: 


export LIBXCB_ALLOW_SLOPPY_LOCK=1 


2. Press Enter. 


3. Type in the following instruction: 


./setup.bin 


4. Press Enter. 


 


ImproNet Installer Application 


1. Select English as the language option. 


2. Click the OK button. 


3. At the Introduction screen, click Next.  


4. At the Licence Agreement screen, select the I Accept the Terms of the Licence 


Agreement radio button. 


5. Click the Next button. 


6. At the Choose Install Folder screen, click Next. 


 


 
Figure 3 – Install Set Menu 


 


7. At the Choose Install Set screen, from the Install Set drop-down list, select Custom. 


8. Select the Engine checkbox. 


9. Click the Next button.  


10. Click the Install button. 


11. At the Install Complete dialog, click the Done button. 
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CCrreeaattee  LLiinnkkss  ffoorr  PPrrooppeerrttiieess  FFiilleess  


Terminal Application 


1. Type in the following instruction: 


cd /opt/ImproNet 


2. Press Enter. 


3. Type in the following instruction: 


In Engine.properties engine.properties 


4. Press Enter. 


 


CCoommmmuunniiccaattiioonn  PPoorrtt  SSeettuupp    


Terminal Application 


1. Type in the following instruction: 


rm /dev/ttyS2 


2. Press Enter. 


3. Type in the following instruction: 


In /dev/ttyUSB0 dev/ttyS2 


4. Press Enter. 


 


UUsseerr  SSeettuupp  


Terminal Application 


1. Type in the following instruction: 


cd /opt/firebird/ 


2. Press Enter. 


3. Type in the following instruction: 


cat SYSDBA.password 


4. Press Enter. 


 


 


Linux displays two comments as follows: 


ISC_USER=sysdba 


ISC_PASSWD=”a randomly generated password displays here” 


 


5. Type in the following instruction: 


Usermod –g 0 firebird 


6. Press Enter. 


7. Type in the following instruction: 


./bin/changeDBAPassword.sh 


8. Press Enter. 


9. At the Please Enter Current Password prompt, type in the randomly generated password 


displayed earlier. 


10. Press Enter. 


11. At the Please Enter New Password for SYSDBA User prompt, enter in a new password of 


up to 8 characters. 


12. Press Enter. 
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IImmpprrooNNeett  PPrrooppeerrttiieess  SSeettuupp  


1. From the Desktop, select the IMPRONET installation directory. 


2. Right-click the IMPRONET.FDB file. 


3. Choose the Properties menu option. 


 


 
Figure 4 – ImproNet.fdb Properties Dialog 


 


4. Select the Permissions tab. 


5. From each of the Access drop-down menus, select the Read and Write option. 


6. Click the Close button. 


 


EEnnggiinnee  PPrrooppeerrttiieess  SSeettuupp  


1. From the Desktop, select the IMPRONET installation directory. 


2. Select the Engine.properties file. 


3. From the displayed dialog, click the Display button. 


4. Locate this entry: 


engine.database.Interbase.URL=jdbc:firebirdsql:localhost:/opt/ImproNet/Database/ 


IMPRONET.FDB 


5. Where you see reference to the term localhost, replace this term with the IP Address of the 


PC where you installed the Database. 


6. Add the following entries at the end of the Engine.properties file: 


 engine.comms.DetectedPort=2 


 engine.database.password = bWFzdGVya2V5 


 engine.database.user = sysdba 
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 engine.site.Site.startCommandServer=true 


 device.comms.alternate=true 


 device.comms.alternate.driver=net.impro.serialcomm.DeviceUDPMulti 


 engine.comms.q.delete=true 


 


Running ImproNet Engine 


Using the Terminal Application: 


1. Type in the following instruction: 


cd /opt/ImproNet/bin 


2. Press Enter. 


3. Type in the following instruction: 


export LIBXCB_ALLOW_SLOPPY_LOCK=1 


4. Press Enter. 


5. Type in the following instruction: 


./Engine 


6. Press Enter. 


 


 


Every time the PC restarts, ensure that you setup the Communications Port and Modules as 


indicated under Communications Port Setup and Running Modules below.   


 


CCoommmmuunniiccaattiioonnss  PPoorrtt  SSeettuupp  


Using the Terminal Application, continue as follows:  


 


1. Type in the following instruction:   


rm /dev/ttyS2 


2. Press Enter. 


3. Type in the following instruction: 


In /dev/ttyUSB0 /dev/ttyS2 


4. Press Enter. 


 


RRuunnnniinngg  MMoodduulleess  


Each time before running a Module, using the Terminal Application, ensure that you run the 


following first: 


 


1. Type in the following instruction:   


export LIBXCB_ALLOW_SLOPPY_LOCK=1 


2. Press Enter. 


3. Type in the following instruction: 


./Engine 


4. Press Enter. 
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Introduction 


This section describes integration of the following third-party systems with ImproNet: 


 


 Various Morpho Fingerprint and Registration Readers, integrated with ImproNet via the 


Biometric Server Software. 


 The HandKey® CR Reader, integrated with ImproNet via the Biometric Server Software. 


 B-SHO Fingerprint Terminals, integrated direct to the Access Module. 


 


The introduction of biometric access control greatly increases the access control capabilities of 


ImproNet Systems where you need extra security measures.  Some Biometric Readers are not 


supported by the Biometric Server Software.  Table 1 below gives Reader support information. 
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MorphoAccess MA100 YES 500 2.13.4 iTRT, MfT and TA No 


MorphoAccess MA120 YES 500  2.13.4 iTRT, MfT and TA No 


MorphoAccess  J-Bio YES 500  2.13.4 iTRT, MfT and TA No 


MorphoAccess  J-Dual YES 500  2.13.4 iTRT, MfT and TA No 


MA200 Fingerprint Reader YES 800 5.53 iTRT, MfT and TA No 


MA220 Fingerprint Reader YES 800 5.53 iTRT, MfT and TA No 


MA300 Fingerprint Reader YES 48 000  5.53 iTRT, MfT and TA No 


MA500 Fingerprint Reader YES 3 000 standard, 


upgradeable to 50 000  


2.13.4 iTRT, MfT and TA No 


MA500+ Fingerprint Reader YES 3 000 standard, 


upgradeable to 50 000  


2.13.4 iTRT, MfT and TA No 


MA520 Fingerprint Reader YES 3 000 standard, 


upgradeable to 50 000  


2.13.4 iTRT, MfT and TA No 


MA520+ Fingerprint Reader YES 3 000 standard, 


upgradeable to 50 000  


2.13.4 iTRT, MfT and TA No 


OMA520 Fingerprint Reader YES 3 000 standard, 


upgradeable to 50 000 


2.13.4 iTRT, MfT and TA No 


MorphoSmart™ MSO300 


Registration Reader 


YES NA TBA iTRT, MfT and TA Yes 


ImproX B-SHO Fingerprint 


Terminal 


No TBA 1.22 TBA No 


ImproX B-SHO USB Fingerprint 


Enrollment Reader 


No TBA 1.04 TBA Yes 


ImproX B-SHO BioMini USB 


Fingerprint Enrollment Reader 


No TBA TBA TBA Yes 


NITGEN Fingkey Hamster II™ YES TBA TBA TBA Yes 
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Biometric Reader 
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NITGEN Fingkey Access 


Terminal 


YES TBA TBA TBA No 


NITGEN NAC-2500 Plus 


Terminal 


YES TBA TBA TBA No 


NITGEN NAC-5000 Terminal YES TBA TBA TBA No 


HandKey® CR YES 31 000 TBA iTRT, MfT and TA TBA 


Schlage HandKey 2  No TBA TBA TBA TBA 


Table 1 – Biometric Reader Support Information 


 


 


Number of users supported by the MA120, MA220 and MA520 limited by the number of Tags 


supported by the Controller. 


 


 


MA200 and MA300 limited to 3 000 users per Database, with a maximum of 16 Databases supported.  


MA5XX series, limited to 5 Databases of 10 000 users each. 


 


 


The ImproX TA, ImproX iTRT and ImproX MfT each offer a Third-party Port approved for use with the 


Biometric Reader. 


 


 


The MorphoAccess  J-Bio and MorphoAccess  J-Dual support 500 users (with 2 templates each) or 3 000 


users (with 2 templates each) with a license. 


 


The Biometric Server Module lets the System Administrator configure various third-party 


Biometric Readers for use with ImproNet.  The Module also allows for the direct enrollment 


(registration) of Tagholders and related biometric data at those Biometric Readers from within 


the ImproNet Software. 
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Morpho (Sagem) Reader Use in an 
ImproNet System 


General 


This section guides you step by step through the process of setting up Morpho Biometric 


Readers to work with the ImproNet System.  The requirements for the integration are as follows: 


 


 IXP400 Access Control System. 


 ImproNet V7.60 and Service Pack 3 (or higher) installed. 


 


There are five steps in configuring the Biometric Readers to work with ImproNet.  These are: 


 


1. Hardware installation of the Biometric Readers. 


2. Setting up the Enrollment Reader. 


3. Detection of the Biometric Readers on the TCP/IP bus. 


4. Software setup of the Biometric Readers using the Biometric Server Software. 


5. Enrolling users on the System. 


 


DDooccuummeennttaattiioonn  


Documentation for these units can be found on the supplied ImproNet Installation CD.  This 


information references the Morpho documentation where necessary. 


 


Principle of Operation 


 
Figure 1 – Using Morpho Fingerprint Readers within an ImproNet System 
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Hardware Installation  


Each Morpho Reader must connect to the LAN to send and receive templates from the 


ImproNet Database.  The Morpho Reader must also connect to an associated ImproX Terminal 


(such as the ImproX TA, iTRT or the MfT) thus facilitating communication with the Controller.  


Please install the Morpho Readers as outlined in the associated Morpho Hardware Installation 


Manual. 


 


CCoonnnneeccttiioonn  ttoo  tthhee  MMAA110000,,  MMAA112200,,  MMAA220000,,  MMAA330000,,  MMAA550000  oorr  MMAA552200  ttoo  tthhee  iiTTRRTT  


 
Figure 2 – Morpho Reader (MA100, MA120, MA200, MA300, MA500 or MA520) Connected to the         


ImproX iTRT and LAN 
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CCoonnnneeccttiioonn  ttoo  tthhee  MMAA110000,,  MMAA112200,,  MMAA220000,,  MMAA330000,,  MMAA550000  oorr  MMAA552200  ttoo  tthhee  MMffTT  


 
Figure 3 – Morpho Reader (MA100, MA120, MA200, MA300, MA500 or MA520) Connection to the        


ImproX MfT and LAN 
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CCoonnnneeccttiioonn  ttoo  tthhee  MMAA110000,,  MMAA112200,,  MMAA220000,,  MMAA330000,,  MMAA550000  oorr  MMAA552200  ttoo  tthhee  TTAA  


 
Figure 4 – Morpho Reader (MA100, MA120, MA200, MA300, MA500 or MA520) Connected to the          


ImproX TA and LAN 
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CCoonnnneeccttiioonn  ttoo  tthhee  MMoorrpphhooAAcccceessss™™  JJ--BBiioo  oorr  JJ--DDuuaall  ttoo  tthhee  iiTTRRTT  


 
Figure 5 – MorphoAccess™ J-Bio or J-Dual Connected to the ImproX iTRT and LAN 
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CCoonnnneeccttiioonn  ttoo  tthhee  MMoorrpphhooAAcccceessss™™  JJ--BBiioo  oorr  JJ--DDuuaall  ttoo  tthhee  MMffTT  


 
Figure 6 – MorphoAccess™ J-Bio or J-Dual Connected to the ImproX MfT and LAN 
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CCoonnnneeccttiioonn  ttoo  tthhee  MMoorrpphhooAAcccceessss™™  JJ--BBiioo  oorr  JJ--DDuuaall  ttoo  tthhee  TTAA  


 
Figure 7 – MorphoAccess™ J-Bio or J-Dual Connected to the ImproX TA and LAN 
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Installation and Setup of the MSO300 Enrollment Reader and 
Verification Dongle  


 


 


Ensure that you unlock your Registration Interface (by purchasing a Biometric Unlock Code) before 


proceeding further. 


 


..NNEETT  FFrraammeewwoorrkk  IInnssttaallllaattiioonn  


If the .Net Framework is NOT already installed, download the update as follows:  From 


http://www.microsoft.com/downloads, download the .NET Framework Version 2.0 update. 


 


 


Alternatively download the update from http://www.impro.net/site/downloads/listing/10/Other.  From 


the list of displayed files, select Files for Sagem Enrolment.  This package includes the .NET 


Framework installation files. 


 


MMSSOO330000  EEnnrroollllmmeenntt  DDeevviiccee  DDrriivveerr  IInnssttaallllaattiioonn  


 


 


Install the drivers, before you plug in the MSO300. 


If connected, disconnect the MSO300 Enrollment Reader from the PC.  


 


1. If running a 32-bit operating system, continue as follows: 


 Browse to C:\ImproNet\driver\Sagem MorphoSmart USB 32 bits Driver. 


 Double-click on the Sagem MorphoSmart USB Drivers.msi file. 


2. Alternatively, if running a 64-bit operating system, continue as follows: 


 Browse to C:\ImproNet\driver\Sagem MorphoSmart USB 64 bits Driver. 


 Double-click on the Sagem MorphoSmart USB 64 bits Drivers.msi file. 


3. At the Welcome screen, click the Next button. 


4. Click the Next button to install in the default directory. 


5. Click the Install button. 


6. Click the Finish button. 


 


VVeerriiffiiccaattiioonn  DDoonnggllee  DDeevviiccee  DDrriivveerr  IInnssttaallllaattiioonn  


 


 


Install the drivers, before you plug in the Verification Dongle. 


If connected, disconnect the Verification Dongle from the PC.  


 


SafeNet Dongle 


1. Browse to C:\ImproNet\driver\SafeNetDongle. 


2. Double-click the SentinelProtectionInstaller.7.4.0(DriversOnly).exe file. 


3. At the Welcome screen, click the Next button. 


4. Select the I Accept the Terms in the License Agreement radio button. 


5. Click the Next button. 


6. Under Setup Type, select either the Complete or Custom radio button. 


7. Click the Next button. 


8. Click the Install button. 


9. At the Windows Firewall Detected screen, click the Yes button. 


10. Click the Finish button. 
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Morpho Dongle (MSO-EVerif) 


1. If running a 32-bit operating system, browse to C:\ImproNet\driver\Morpho Dongle\x86. 


2. Alternatively, if running a 64-bit operating system, browse to C:\ImproNet\driver\Morpho 


Dongle\x64. 


3. Double-click on the ACR38U_PCSC_Driver-1.1.6.1.msi file. 


4. At the Welcome screen, click the Next button. 


5. Click the Next button to install in the default directory. 


6. Click the Install button. 


7. Click the Finish button. 


 


MMSSOO330000  IInnssttaallllaattiioonn  


1. Plug in the MSO300 Enrollment Reader into an unused USB Port on the PC. 


 


 


Some PC’s proceed with automatic installation of the MSO300, if installation occurs automatically 


move direct to step 4 below.  


 


2. Follow the on-screen prompts, instead of letting the Installer run automatically, select Install 


from a Specific Location. 


3. Browse to C:\Program Files\Sagem Securite\MorphoSmart Drivers, this folder contains 


the drivers for the MSO300.  


4. After installation of the Drivers, the LED on the MSO300 blinks Green once a second.  


 


MMSSOO330000  FFiirrmmwwaarree  UUppggrraaddee  PPrroocceedduurree  


1. Browse to C:\ImproNet\driver\Sagem MorphoSmart Firmware Update. 


2. Double-click on the Firmware_MSO.exe file. 


3. At the Welcome screen, click the Next button. 


4. Select the method by which you want to upgrade your MSO300 Enrollment Reader. 


 A Serial Connection 


 A USB Connection 


5. Click the Next button. 


6. Once the result shows Upgrade Successful, click the Finish button. 


 


VVeerriiffiiccaattiioonn  DDoonnggllee  IInnssttaallllaattiioonn  


1. Now plug in the Verification Dongle into an unused USB Port on the PC.  


2. The installer runs discreetly and when fully installed, the Verification Dongles Green LED 


remains permanently on.  


 


MMoorrpphhookkiitt  LLiicceennssiinngg  SSeerrvviiccee  IInnssttaallllaattiioonn  


 


 


The Morphokit Licensing Service runs continuously after installation.  If you do not see evidence of the 


SagemSecurite_Licence_Protection.exe file running in the Windows Task Manager, install the software 


as follows. 


 


1. Browse to C:\ImproNet\driver. 


2. Double-click on the SagemSecurite_Licence_Protection_Installer.exe file. 
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3. At the Welcome screen, click the Next button. 


4. Click the Next button to install in the default directory. 


5. Click the Next button. 


6. Click the Close button. 


 


CCrreeaattiinngg  aa  DDaattaa  EExxeeccuuttiioonn  PPrreevveennttiioonn  EExxcceeppttiioonn  ffoorr  SSaaggeemm  SSeeccuurriittee  LLiicceennccee  


MMaannaaggeerr  


1. From the Control Panel, select the System option. 


2. Select the Remote Settings option. 


3. In the System Properties dialog, select the Advanced tab. 


4. In the Performance group, click the Settings... button. 


5. Select the Turn On DEP for all Programs and Services Except Those I Select radio 


button. 


6. Click the Add... button. 


7. Navigate to the installation directory at C:\Program Files\Sagem Securite\Licence 


Protection. 


8. Double-click on the following executable files: 


 SagemSecurite_Licence_Protection.exe 


 SagemSecurite_Licence_Manager.exe 


9. Click the OK button. 


10. At the System Properties dialog, click the OK button. 


11. Click the  button. 


 


MMSSOO330000  BBiioommeettrriicc  AAddddrreessss  CCoonnffiigguurraattiioonn  


The default address is 0.0.0.0.  Change the IP Address as follows: 


 


1. In Windows®, click Start>Programs>ImproNet>Access. 


2. From the Menu Bar, select Configuration>Biometric Addresses. 


 


 
Figure 8 – Biometric Addresses Configuration Dialog 


 


3. From the Biometric Device drop-down list. Select Sagem.  In future versions of this 


Software, this list will detail other biometric devices that can be integrated with ImproNet, 


and will allow you to set up the enrollment units for each biometric device.  


4. From the Device drop-down list, select the MSO300(Licensed) option. 
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The Unit Address field appears greyed out for Sagem, as it refers to addresses of units on the RS485 


bus, Morpho (Sagem) does not currently support RS485.  The Unit IP Address field is reserved for 


future use. 


 


5. Click on the  button. 


6. Click on the  button. 


 


Repeat steps 1 to 6 above to setup separate Enrollment Readers for each System PC running 


Access.  


 


Morpho MA100, MA120, MA500 or J-Series Internal Parameter Setup  


 


 


The Morpho MA1XX, MA5XX and J-Series biometric devices have the following default IP Address:  


134.1.32.214. 


 


UUSSBB  FFllaasshh  DDiisskk  SSeettuupp  


Using a USB Flash Disk (refer to the unit’s Installation Manual for acceptable Flash Disk sizes) 


continue as follows: 


 


1. Format the Flash Disk as indicated in the unit’s Installation Manual. 


2. Assign the Flash Disk a name of no more than 12 characters. 


3. Browse to C:\Impronet\Driver\Tools\Sagem\USB Network Tools. 


4. Double-click on the USBNetworkTool.exe file. 


 


 
Figure 9 – USB Network Tool Dialog 
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5. In the USB Network Tool dialog, under TCP Parameters complete the following details: 


 In the IP field, assign an available IP Address for your network 


 In the Mask field, give details for the Subnet mask  


 In the Gateway field, give details for the Default Gateway 


 


 


If you are in any doubt as to where to source this information, please contact your network 


administrator for assistance. 


 


 


You cannot at this time edit the Terminal Serial Number field.   


 


6. Click the Write File button. 


7. In the Save As dialog, from the Save In drop-down list, select your pre-formatted USB 


Flash Disk. 


8. In the File Name field, give the file a name (the file saves as a *.reg file). 


9. With the MA100 powered up, plug the USB Flash Disk into the front of your MA100. 


 


 


During the file download process the MA100’s Buzzer beeps and the LED changes colour.   


 


 


Do NOT remove the USB Flash Disk until the downloads complete.  On completing the download, 


the MA100’s Buzzer emits a deep tone and the LED slowly flashes Blue.   


 


SSeettttiinngg  uupp  tthhee  WWiieeggaanndd  CCoonnffiigguurraattiioonn  oonn  aann  MMAA110000  oorr  MMAA550000  


1. Browse to C:\Impronet\Driver\Tools\Sagem\Configuration Tool. 


2. Double-click on the ConfigurationTool.exe file. 
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Figure 10 – Configuration Tool Dialog 


 


3. In the Morpho Access Connection dialog, ensure that the IP Address field reflects the same 


IP Address details as used in point 0 on page 18. 


4. Click the Connect >> button. 


 


 
Figure 11 – Configuration Tool Dialog 
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5. In the Configuration Tool dialog, click the Get File button. 


 


 


The Log File setting referred to in point 6 (only available on sites using MA100 and MA500 Morpho 


Readers) is required for the functionality of the Sagem Identify Report.  In Installations without 


installed MA100 and MA500 Morpho Readers, skip direct to point 8. 


 


6. From the Directory Tree, double-click the Log File setting. 


7. Double-click on the Enabled setting and adjust the value to 1. 


8. From the Directory Tree, double-click the send ID wiegand setting. 


9. Double-click on the following settings to adjust their values: 


 built frame 


 valid format—1 


 custom format—0.0 


 ID format—0.40 


 site format—0.0 


 stop format—4.0 


 start format—4.0 


 frame length—40 


 HID conversion—0 


 site code—0 


 enabled—1 


10. Apply the settings by rebooting the Terminal. 


 


Problems and Solutions 


1. Problem—Software fails to report denied transactions on sites with installed Morpho          


J-Series Readers. 


Solution—Adjust the following settings under Failure ID: 


 not recognized ID—0 


 enabled—1 


2. Problem—Wiegand Code not sent through. 


Solution 1—Swap your Data 1 and Data 0. 


Solution 2—Check each setting in the App file according to the following list: 
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Figure 12 – Configuration Tool Dialog 


 


 bio ctrl 


 AC_ID—FINGER;CARDDATA;KBD;WGDTCLK; 


 bypass authentication—0 


 authent timeout—10 


 authent card mode—1 


 authent PK contactless—1 


 authent ID contactless—0 


 authent remote ID source—0  


 authent ID keyboard—0 


 identification timeout—5 


 nb attempts—2 


 identificaton—1 


 contactless 


 desfire params—2 


 enabled profiles—0 


 data type—0.1 


 data offset—0 


 data length—0 


 C—1 


 B—4 


 event on—2 


 data format—0 


 relay 


 external control by LED1—0 


 relay default state—0 


 aperture time in 10 ms—300 


 enabled—1 


 led IN 
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 controller ack timeout—300 


 enabled—0 


 send ID UDP 


 host name—134.1.2.189 


 host port—11020 


 enabled—0 


 log file 


 enabled—1 


 tamper alarm 


 interval—1500 


 level—0 


 info 


 release—15 


 minor—9 


 major—2 


 type—500 


 G.U.I 


 display hour—0 


 led out signal—0 


 database conversion—500 


 display user info—2 


 time and attendance icons—1 


 default language—0 


 volume—5 


 send ID ethernet 


 connect timeout—2000 


 profile id—0 


 SSL enabled—0 


 controller on no responce—1 


 timeout back to controller 1—3600 


 controller 2 port—11020 


 controller 2 IP—134.1.2.189 


 controller 1 port—11020 


 controller 1 IP—134.1.2.189 


 mode—0 


 send ID wiegand 


 built frame 


 valid format—1 


 custom format—0.0 


 ID format—0.40 


 site format—0.0 


 stop format—4.0 


 start format—4.0 


 frame length—40 


 HID conversion—0 


 site code—0 


 enabled—1 


 send ID dataclock 


 card present signal—0 
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 data inverted—0 


 clock inverted—0 


 enabled—0 


 send ID serial 


 display duration—3 


 reply timeout—5 


 wait reply—0 


 terminal identifier—178 


 parity—0 


 stopbits—1 


 databits—8 


 speed—11520 


 mode—485 


 enabled—0 


 failure ID (used for diagnostic purposes) 


 


 


In this mode, set the ImproX iTRT to Wiegand Open Mode (that is on the DIP-switch, 123 OFF and 4 


ON) 


 


 send ID mask—255 


 not on time ID—65535 


 generic error ID—65535 


 timeout ID—65535 


 not in DB ID—65535 


 not recognized ID—65535 


 alarm ID—65535 


 enabled—1 


 wiegand in 


 custom format—0.0 


 ID format—9.16 


 site format—1.8 


 stop format—2.12 


 start format—2.12 


 frame length—26 


 check site code—1 


 site code—7 


 data clock in 


 data inverted—0 


 clock inverted—0 


 modes 


 idle timeout—0 


 idle peripherals—3 


 T&A operation timeout—20 


 time mask—0 


 time and attendance—0 
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Morpho MA200 or MA300 Internal Parameter Setup 


GGeenneerraall  


Set up the internal parameters for MA200 and MA300 Biometric Readers using the built-in 


Display and Keypad.  In order to carry out this procedure, please refer to:  Morpho MA200/300 


MorphoAccess Installation Guide, SK-0000011145-03 – January 2004. 


 


NNootteess  oonn  SSeett--uupp  ffoorr  MMoorrpphhoo  MMAA220000  oorr  MMAA330000  


The information that follows takes you through the Morpho Manual, indicating which information 


applies to the use of the Biometric Reader with ImproNet, and which does not. 


 


IInntteerrnnaall  MMoorrpphhoo  CCoonnffiigguurraattiioonn  SStteeppss  


The internal configuration steps of the MA200 or MA300 into the ImproNet System include: 


 


1. Configure the Switches on the motherboard. 


2. Configure the Software Administration Interface. 


3. Perform Sagem System Set-up Actions (biometric management operations). 


4. Configure the Biometric Reader using the Sagem CONFIG Menu. 


 


 


Table 2 lists all headings in the Morpho manual, and indicates whether, and how, this information 


relates to the Morpho-ImproNet integration process.  The Morpho MA200 or MA300 Manual headings 


are listed sequentially in Table 2 as a guide to the use of the Morpho manual in this application. 


However, in some cases the most convenient order for the integration process is different. In these 


cases the PROCEDURE or COMMENTS column refers you to the STEP where this information’s used. 


 


STEP DESCRIPTION MORPHO MANUAL HEADING PROCEDURE OR COMMENTS 


1. PHYSICAL INSTALLATION INSTALLATION PROCEDURE Follow the Morpho Manual procedures. 


2. ELECTRICAL CONNECTION ELECTRICAL INTERFACE The Morpho Interfaces used in this 


application are J1, J3 and J4 (Refer to the 


Morpho Manual).   


 


See Figure 2, Figure 3 and Figure 4 in this 


manual. 


Terminal Block Board Background Information 


Power Supply Cable See Figure 2, Figure 3 and Figure 4 in this 


manual. 


Ethernet Wiring See Figure 2, Figure 3 and Figure 4 in this 


manual. 


Wiegand Output Wiring See Figure 2, Figure 3 and Figure 4 in this 


manual. 


Output Relays and Tamper Switch Optional, depends on user requirements.  


Follow the instructions in the Morpho Manual 


if required. 


CONFIGURING THE MORPHOACCESS  


Motherboard Configuration Refer to the Morpho Manual. 


Configure the Switches as follows: 


Set SW1 and SW2 for Wiegand Mode. 


Set SW3 and SW4 as indicated in the 


Morpho Manual. 


Set SW7 and SW8 for Wiegand Mode. 


MORPHOACCESS SOFTWARE Refer to step 5 of this Table. 
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STEP DESCRIPTION MORPHO MANUAL HEADING PROCEDURE OR COMMENTS 


3. INTERNAL SETUP OF THE 


READER BEFORE 


INTEGRATION AND USE WITH 


IMPRONET 


BIOMETRIC MANAGEMENT OPERATIONS Refer to the Morpho Manual, “Access the Set 


up Functions of the System”, but ignore the 


following headings: 


 Biometric Management in Stand Alone 


 Insert Template/ID in Database 


 Remove Template/ID from Database 


THE CONFIG MENU Refer to the Morpho Manual. 


SETTING UP NETWORK PARAMETERS Refer to the Morpho Manual. 


SETTING UP THE SYSTEM 


ADMINISTRATOR PIN 


Refer to the Morpho Manual. 


This PIN provides access to the SYSTEM 


Menus in the Morpho Software for 


administration of the Reader. 


SETTING UP THE MORPHOACCESS 


ADMINISTRATOR PIN 


Refer to the Morpho Manual. 


This PIN provides access to the MACCESS 


Menus in the Morpho Software for 


administration of the external management. 


Setting Up Host Communication Refer to the Morpho Manual. 


Set the Host Com value to 3. 


Setting Up User Interface Refer to the Morpho Manual. 


Setting Up Wiegand or Dataclock Output  Refer to the Morpho Manual. 


Setting Up Wiegand Interface Refer to the Morpho Manual. 


The default format is 26-Bit. 


Frame Definition Refer to the Morpho Manual. 


Configuration Keys Refer to the Morpho Manual.. 


Set Section is OUT. 


Set Length is 26. 


Setting Up Etherlink Parameters Refer to the Morpho Manual. 


Set Etherlink Send is 1. 


Set IP Address as required. 


Setting Up Time Attendance Refer to the Morpho Manual. 


4. OPTIONAL SETUP AND 


BACKGROUND INFORMATION 


THE VERSION MENU Refer to the Morpho Manual. 


THE SERIAL NUMBER MENU Refer to the Morpho Manual. 


THE SETTING MENU Refer to the Morpho Manual. 


COMMUNICATION PROTOCOL Background Information. 


MORPHOACCESS TECHNICAL 


CHARACTERISTICS 


Background Information. 


Recommendations Background Information. 


Ethernet Colour Standard Background Information. 


Appendix 2 Background Information. 


Appendix 4 Background Information. 


APPENDIX 5 – FINGERPRINT PLACEMENT 


RULES 


Refer to step 6 of this Table. 


5. USER INTERFACE SETUP MORPHOACCESS SOFTWARE USER 


INTERFACE 


Refer to the Morpho Manual. 


Access Control by Identification (MA200) Refer to the Morpho Manual.  The Mode is 0. 


Access Control by Identification (MA300) Refer to the Morpho Manual.  The Mode is 0. 


Access Control by Identification (MA200 and 


MA300) 


Optional – use if authentication is used by 


presentation of Tag to an external Reader. 


6. OPERATIONAL INFORMATION APPENDIX 5 – FINGERPRINT PLACEMENT 


RULES 


Important operational information.  Follow the 


instructions in the Morpho Manual.  Ensure 


that all users are aware of these rules. 


Table 2 – Internal Configuration of the Morpho Fingerprint Readers 


 


 


For easy reference we listed the Morpho Manual Headings in Table 2 in the order in which they appear 


in the Morpho Manual.  Sections not listed in Table 2 are NOT required for ImproNet Integration. 
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Configuration of Morpho Readers into the ImproNet System 


Once you’ve connected the Morpho Readers and configured them internally as described in the 


previous paragraphs, configure the Readers into the ImproNet System.  This section applies to 


the supported Morpho Fingerprint Readers, the MA100, MA120, MA200, MA300, MA500 and 


MA520. 


 


 


Each Morpho Reader used in the Biometric Server requires its own Unlock Token.  For details of the 


unlocking procedure refer to the section titled Morpho Dongle Protection using the Unlock Token on 


page 29. 


 


The configuration of these Readers within ImproNet is done using the ImproNet Biometric 


Server Software, as follows: 


 


1. From Windows® select Start>Programs>ImproNet>Biometric Server. 


2. Enter your Username (SYSDBA) and Password (masterkey). 


 


When you upgrade an existing ImproNet System to V7.40, you need to tell the new Software 


what Readers are installed.  In this case, a Unit Not Detected dialog displays.  For the units 


NOT detected, specify the unit Type. 


 


DDeetteeccttiinngg  MMoorrpphhoo  RReeaaddeerrss  oonn  tthhee  TTCCPP//IIPP  BBuuss  


This procedure is the same for the MA100, MA120, MA200, MA300, MA500 and MA520. 


 


1. On the Configuration menu, select Sagem>Sagem Devices.  


 


 
Figure 13 – Sagem Devices Dialog 
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At the top of the Sagem Devices dialog you will see the Connection Type drop-down list with 


TcpipSocket selected.  This is the only option at this stage (ImproNet V7.40). 


 


2. In the IP Range field enter the start and end IP Addresses for the range of Addresses that 


the Biometric Server must search for. 


3. Click the Search button.  


 


 


The Search may take some time, depending on how busy the network is.  After the Search finds the 


Morpho units, they appear as records in the table with their Serial Numbers, IP Addresses and their 


current Status.  The displayed units appear as follows: 


 


 All newly discovered units highlight in Green. 


 All units with changed IP Addresses highlight in Orange. 


 All units that are in the Database but have been found to be off-line or missing highlight in 


Red. 


 


 


The Enabled checkbox enables or disables each individual Morpho unit on the network.  This means 


that you can carry out repairs on a unit without affecting the rest. 


The Enable / Disable All checkbox enables or disables all the Morpho units on the network.   


The Server will not attempt communication with a disabled Morpho unit. 


 


 


You will also notice a  button in the dialog.  This button allows manual deletion of Morpho Readers 


from the database.  Note however, reintroduction of the Morpho Reader requires use of the Unlock 


Token. 


 


 


On enabled Morpho Readers with their status shown as OK, clicking the Info button displays the 


Device Information dialog.  This dialog shows the number of templates uploaded to the Morpho 


Reader and the unused capacity.   


 


4. When you are finished using the Sagem Devices dialog, click the  button. 


5. Click the  button. 


6. After setting up the units, do a Full Upload to create fresh databases on the units. 


7. Now click on the Start button to get the Biometric Server running and ready to upload 


templates as you enroll users. 


 


BBiioommeettrriicc  SSeerrvveerr  QQuueeuuee  


All messages to Morpho devices queue so that each device can be processed independently.  


The Unit Details tab shows the queue status and allows you to upload to each unit individually.  


 


This tab is also useful in identifying units having communication problems. 
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Figure 14 – Unit Details Tab 


 


The queue processes automatically during normal operation (that is after you press the Start 


button).  You may perform a full upload on a specific Morpho Reader as follows: 


 


1. Select the unit record for update. 


2. From the menu, select the Full Upload option. 


 


DDuupplliiccaattee  SSeeaarrcchh  ((11::NN  MMaattcchhiinngg))  


From ImproNet V7.60 onwards, the Biometric Server communicates with the Sagem Matcher.  


This communication structure enables duplicate search functionality.  To use this feature, ensure 


that you have a MorphoSmart MSO300 Registration Reader and one of the following licences:   


an IDENT LITE (5 000 templates), an IDENT (10 000 templates) or an IDENT PLUS (20 000 


templates). 


 


Usually installed on a USB Flash Disk, the IDENT licence connects direct to the Biometric 


Server.  You may, however, purchase an IDENT licence that resides direct on the MSO300, for 


use in a stand-alone PC environment. 


 


Enabling Matcher in the Biometric Server Software 


1. Start the Biometric Server Software (for more information, see page 26). 


2. From the menu bar, select Configuration>Sagem>Matcher. 
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Figure 15 – Matcher Configuration Dialog 


 


3. In the Matcher Configuration dialog, select the Enabled checkbox. 


4. From the Maximum Records drop-down list, select the maximum number of records 


supported by your IDENT LITE, IDENT or IDENT PLUS licence. 


5. Click the  button. 


6. Restart the Biometric Server Software for the changes to take effect. 


 


 


The Biometric Server opens a TCP/IP server on Port 26670 for all Matcher related communications. 


 


 


For an existing site, with templates already loaded, the Matcher uncompresses all your existing 


templates into a format easily searched and stored in the Matcher database.  This process can take 


some time to complete but only runs upon starting the Biometric Server. 


 


Enabling Duplicate Search at an Enrollment Station 


 


 


For detailed steps on arriving at the Biometric Enrollment dialog, refer to page 30. 


 


1. In the Biometric Enrollment dialog, click the Advanced button. 


2. Select the Enable Duplicate Check checkbox. 


3. Click the  button  


4. Restart the Access Module for this change to take effect. 


 


 


Ensure the Biometric Server Software is running for checking to take place. 


 


If the Matcher Service does NOT find a matching record, the records added to the Matcher 


Database.  If the Matcher Service finds a matching record, an Error message gives you the 


matching records Tag code. 


 


MMoorrpphhoo  DDoonnggllee  PPrrootteeccttiioonn  uussiinngg  tthhee  UUnnlloocckk  TTookkeenn  


 


 


Only ImproNet Software V7.40 (with service packs ImproNet_ESU_20070620.exe and                


update-ImproNet-7.40-20070620.exe) upwards supports the use of the Unlock Token. 


 


 


Only the ProxMate (any Firmware version) or USB Registration Readers with Firmware V1.14 upwards 


support the use of the Unlock Token. 
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On initial use, ANY Unlock Token of the correct type unlocks ANY Morpho Reader of the same type. 


That is, any MA100 Unlock Token unlocks any MA100 Morpho Reader, any MA200/300 Token unlocks 


any MA200, MA300 or MA500 Morpho Reader and any J-Series Token unlocks any J-Bio or J-Dual 


Reader.  However, once an Unlock Token is used with a specific Morpho Reader, the Unlock Token is 


permanently associated to that Reader.  Ensure that you keep your supplied Unlock Tokens labelled 


and in a safe place. 


 


The Unlock Token supplied with third-party integrated products, shows the products have our 


full factory level approval.  This means the products work seamlessly with ImproNet, with central 


enrollment taking place in the ImproNet Tagholder Enrollment screen. 


The Token allows you access to extra integration features related to the Morpho Readers.  


These features include: 


 


 Intelligent distribution of templates (uploading of templates only to Readers where the 


Tagholder has access). 


 Sagem Capture Quality Report (implemented in ImproNet V7.60). 


 


To unlock Morpho Readers enabled in the Biometric Server, continue as follows: 


 


1. From Windows® select Start>Programs>ImproNet>Biometric Server. 


2. Enter your Username (SYSDBA) and Password (masterkey) (this is only required on first-


time use of the Biometric Server Software). 


3. In the Licence Info dialog, click the Unlock button. 


4. Place your Unlock Token in position in the Tag Registration Reader. 


5. In the Sagem Device Unlock dialog, click on the Read button. 


6. Click on the OK button. 


 


On unlock, the Biometric Server Software opens allowing full use of the Software. 


 


EEnnrroolllliinngg  UUsseerrss  oonn  tthhee  SSyysstteemm  


Setting Truncation for Enrollment 


1. From Windows® select Start>Programs>ImproNet>Access. 


2. From the Main Menu, select File>Preferences. 


3. Select the Enrollment tab. 


4. Alongside the Ascii, Biomentric, Magstripe option, click the Truncation button. 


5. From the Tag Format drop-down list, select the 26-bit Normal option. 


6. Click the  button  


7. Close the Preference Configuration dialog by clicking the  button 


 


Tagholder Setup 


1. In the Navigator Pane, select the Tagholder icon. 


2. Open the Edit Tagholder or Add Tagholder dialog. 


3. Select New Tag to enter the Tag dialog.  


4. Have the Tagholder place their Tag on the Enrollment Reader. 


5. Click Read Tag (or just enter a number of 7 digits or less in the Tag Code field).  


6. From the Tag Type drop-down list, select ASCII, Biometric, Magstripe. 
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7. Set the Access Groups in the usual way. 


8. Click on the  button. 


9. Click on the Biometric Enrollment button. 


 


 
Figure 16 – Biometric Enrollment Dialog 


 


10. In the Biometric Enrollment dialog, from the Device drop-down list, select the type of 


device you wish to enroll the user on, in this case Sagem.  


 


 


The Template No field will be greyed out as it does not apply to Morpho units. Other Biometric Devices 


allow you to enroll multiple templates per user.  Morpho units enroll two fingers and store them as one 


template, not allowing multiple templates per ID. 


 


 


The ID field is the ID derived from the Tag Code and is the number under which the user’s data is 


saved when his or her fingerprints are enrolled in the units. 


 


 


The Template field remains empty until the enrollments completed.  


 


11. Click on the Advanced button. 


 


Advanced Settings 


Clicking the Advanced button makes the following settings available for change: 


 


 Timeout—this is the time the enrollment unit will wait before declaring the enrollment a 


failure.  The default 30 seconds should serve for most enrollments. 


 Default DB—the default MA300 or MA500 database to which the Reader assigns 


fingerprint templates.  Changing the default Database to a number greater than 0 may result 


in fingerprint templates not uploading to the MA100, MA120, MA200 and J-Series Readers. 


 DB for this User—the default MA300 or MA500 database to which this users templates are 


stored.  Changing the default Database to a number greater than 0 may result in fingerprint 


templates not uploading to the MA100, MA120, MA200 and J-Series Readers. 


 Quality Threshold—determines the minimum quality score for each template.  A higher 


threshold, leads to a better quality template.  Make your selection from the range 0 to 255.  


For best results, we recommend a score of above 200.   
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 Use Consolidation—allows you to capture the fingerprint 3 times.  The Software then 


saves the best capture.  If disabled, the Software only captures the fingerprint once. 


 Enable Matching 


 Matching Threshold—determines the minimum accepted matching threshold during the 


verification stage of each template capture.  For full functionality, ensure that you have a 


Morpho Dongle or Verification Dongle installed and plugged in.  Make your selection from 


the range 0 to 255.  For best results we recommend a score of above 200.   


 Enable Duplicate Check—when enabled, after template capture, the ImproNet Software 


searches for matches in the Matcher Database (located in the Biometric Server Software).  


Restart the Access Module for this setting to take effect.  For full functionality, ensure that 


you start the Biometric Server Software and that you have a MorphoSmart™ MSO300 


Registration Reader and either an IDENT LITE (5 000 templates), an IDENT (10 000 


templates) or an IDENT PLUS (20 000 templates) licence.  Refer to the section Duplicate 


Search (1:N Matching) on page 28 for more information. 


12. Click on the Enroll button, thereby initiating the enrollment.  
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Fingerprint Placement Rules 


Figure 17 shows the area of the fingerprint that contains the most information.  Therefore, when 


enrolling Tagholders, ensure they place their fingers as shown in Figure 18.  


 


 
Figure 17 – Area of the Fingerprint Containing the most Information 


 


 
Figure 18 – Fingerprint Placement Rules (Generic Enrollment Reader, Fingerprint Sensor Shown) 


 


Enrollment procedure at the Morpho MSO300 


1. Place Finger 1 (fingerprint down) on the MSO300 Enrollment Reader’s fingerprint Sensor. 


2. Remove Finger 1 from the Sensor 


3. Place Finger 1 on the Sensor a second time.  


4. Again, remove Finger 1 from the Sensor. 


5. Place Finger 2 (fingerprint down) on the MSO300 Enrollment Reader’s fingerprint Sensor. 
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6. Remove Finger 2 from the Sensor. 


7. Place the Finger 2 on the Sensor a second time. 


8. Again, remove Finger 2 from the Sensor. 


 


Once the enrollments complete, the Template field displays the Template Number and an 


Enrollment Successful message appears in the Status Bar. 


 


9. Click the  button. 


10. Click the  button.  


 


The enrollment process is now complete.  Repeat this process for each Tagholder, as required. 


 


 


With the Biometric Server running, the Server automatically uploads templates to the Morpho Readers. 


 


Configuration of MIFARE® Encoders into the ImproNet System 


 


In instances where you cannot store fingerprint templates in the ImproNet Database, you may 


write templates direct to the MIFARE® Tag.  Reasons for this could include:  cost, Reader limits, 


laws of the country or just general safety concerns.   


 


Using MIFARE® Encoder support, templates do not upload to the Biometric Readers.  Instead 


templates are written directly to the MIFARE® Tag.  Thus when you present the MIFARE® Tag 


to the Biometric Reader, it reads the template information from the Tag.  When presenting your 


finger to the Reader, the Reader performs a 1:1 authentication of the template information 


stored on the MIFARE® Tag.   


 


 


The MIFARE® Encoder is only supported when using the Morpho MA120, MA520 and the J-Dual. 


 


 


You may have as many MIFARE® Tags with templates written to them as supported by your System.  


That is, up to 8 000 in an IXP300 System, up to 160 000 in an IXP400 System and up to 300 000 in an 


IXP400i System.  You are therefore, not limited by the number of templates supported by the Biometric 


Reader. 


 


 


ImproNet offers MIFARE® Encoder support on the following 32-bit and 64-bit Operating Systems:  


Windows XP, Windows Vista and Windows 7.   


 


 


ImproNet supports 1 K and 4 K MIFARE® Tags used with the SDI010 Contact or Contactless 


Reader (MIFARE® Encoder). 


 


MMIIFFAARREE®®  EEnnccooddeerr  DDrriivveerr  IInnssttaallllaattiioonn  


 


 


On a 32-bit Operating System, ensure you use Driver version V4.36.   


 


On a 64-bit Operating System, use Driver version V5.18.  V5.18 is however a legacy Windows XP 


Driver and therefore installation must take place from a PC running Windows XP.   
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1. Plug the SDI010 Contact or Contactless Reader into an unused USB Port on the PC. 


2. From the Found New Hardware dialog, click the Cancel button. 


3. From the Control Panel, select the Device Manger option. 


 


SDI010 Contact (Smart) Card Reader Driver 


1. From the displayed tree, select the Other Devices node. 


2. From the displayed list, select the SDI010 Smart Card Reader option. 


3. Select the Update Driver Software... option. 


4. Select the Browse My Computer for Driver Software option. 


5. Browse to C:\ImproNet\driver\Mifare Encoder. 


6. Click the OK button. 


7. Select the Include Subfolders checkbox. 


8. Click the Next button. 


9. At the Found New Hardware dialog, click the Cancel button. 


10. At the Update Driver Software – SDI010 Smart Card Reader dialog, click the Close button. 


 


SDI010 Contactless Reader Driver 


1. From the displayed tree, select the Other Devices node. 


2. From the displayed list, select the SDI010 Contactless Reader option. 


3. Select the Update Driver Software... option. 


4. Select the Browse My Computer for Driver Software option. 


5. Browse to C:\ImproNet\driver\Mifare Encoder. 


6. Click the OK button. 


7. Select the Include Subfolders checkbox. 


8. Click the Next button. 


9. At the Update Driver Software – SDI010 Contactless Reader dialog, click the Close button.  


10. At the Device Manager dialog, click the  button. 


 


MMIIFFAARREE®®  EEnnccooddeerr  FFiirrmmwwaarree  IInnssttaallllaattiioonn  


 


 


V6.32 is the supported Firmware version and is included in the ImproNet installation. 


 


1. Browse to C:\ImproNet\driver\Mifare Encoder\SDI010_fw6.32. 


2. Run the file FwUpdate.exe. 


3. Follow the prompts as they appear thus completing the Firmware installation. 
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MMIIFFAARREE®®  EEnnccooddeerr  CCoonnffiigguurraattiioonn  aanndd  TTeessttiinngg    


 


 


Ensure the SDI010 Contact or Contactless Reader is plugged in and that a MIFARE® Tag is in position 


on the MIFARE® Encoder.   


 


1. Browse to C:\ImproNet\test.exe. 


2. In the Card Writer Test dialog, from the Select Writer drop-down list, select the Mifare SCM 


option. 


3. At the Contactless Card error message, click the OK button. 


4. On the Left-hand-side of the Card Writer Test dialog, click the Configure button. 


5. From the Device Name drop-down list, select the SCM Microsystems Inc. SDI010 


Contactless Reader 0 option. 


6. In the Mifare Contactless Card Writer Configuration dialog, click the Autodetect button. 


7. At the Information dialog, click the OK button. 


8. In the Mifare Contactless Card Writer Configuration dialog, click the OK button. 


9. In the Card Writer Test dialog, from the Basic Operations group, click the Autodetect 


button. 


10. From the Basic Operations group, click the Read File Keys button. 


11. At the Test dialog, click the OK button. 


12. From the Basic Operations group, click the Load Keys button. 


13. At the Test dialog, click the OK button. 


14. From the Basic Operations group, click the Write button. 


15. At the Test dialog, click the Yes button. 


16. Click the Quit button. 


 


Key File Configuration 


 


The steps that follow are optional for Contact (Smart) Card users.  By following this procedure a 


unique to site security code writes to the Contact (Smart) Card.  This unique security code 


prevents users gaining entry to site using unencrypted MIFARE® Tags.   


 


1. Browse to C:\ImproNet\test.exe. 


2. In the Card Writer Test dialog, from the Select Writer drop-down list, select the Mifare SCM 


option. 


3. On the Left-hand-side of the Card Writer Test dialog, click the Configure button. 


4. From the Key Files group, alongside the Old Key File textbox, click the  button. 


5. Browse to ImproNet\keys\4K.   


6. Select the oldkeys_Philips.ini file. 


7. Click the Open button. 


8. Alongside the New Key File textbox, click the  button. 


9. Browse to ImproNet\keys\4K.   


10. Select the newkeys_Philips.ini file. 


11. Click the Open button. 


12. Alongside the Default Key File textbox, click the  button. 


13. Browse to ImproNet\keys\4K.   


14. Select the defaultkeys_Philips.ini file. 


15. Click the Open button. 


16. Click the Check Key Files button. 
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17. At the Information dialog, click the OK button. 


18. Click the Quit button. 


 


WWrriittiinngg  TTeemmppllaatteess  ttoo  tthhee  MMIIFFAARREE®®  TTaagg  


Editing the Biometric.properties File 


1. Browse to ImproNet\Biometric.properties.   


2. Set the server.drivers.Sagem.enroll.writeToTag=false property to True. 


3. From the drop-down menu, select File>Save. 


4. Click the  button. 


 


Setting Truncation for Enrollment 


 


 


Setup Truncation on ASCII Tag Types, thus ensuring matching of Tags and generation of the 


Allowed Event.  Enrolling a MIFARE® Tag at a MIFARE® Registration Reader or tagging at a 


MIFARE® Reader requires truncation on the MIFARE® Tag type. 


 


1. From Windows® select Start>Programs>ImproNet>Access. 


2. From the Main Menu, select File>Preferences. 


3. Select the Enrollment tab. 


4. Alongside the Ascii, Biomentric, Magstripe option, click the Truncation button. 


5. From the Tag Format drop-down list, select the 26-bit Normal option. 


6. Click the  button. 


7. Close the Preference Configuration dialog by clicking the  button. 


 


Tagholder Setup 


1. In the Navigator Pane, select the Tagholder icon. 


2. Open the Edit Tagholder or Add Tagholder dialog. 


3. Select New Tag to enter the Tag dialog.  


4. Have the Tagholder place their Tag on the Enrollment Reader. 


5. Click Read Tag (or just enter a number of 7 digits or less in the Tag Code field).  


6. From the Tag Type drop-down list, select ASCII, Biometric, Magstripe. 


7. Set the Access Groups in the usual way. 


8. Click on the  button. 


9. Click on the Biometric Enrollment button. 


 


 
Figure 19 – Biometric Enrollment Dialog 
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10. In the Biometric Enrollment dialog, from the Device drop-down list, select the type of 


device you wish to enroll the user on, in this case Sagem.  


11. Place your MIFARE® Tag on the SDI010 Contact or Contactless Reader. 


12. In the instance that this is a first-time enrollment, click on the Enroll button.  


13. If you enrolled your template previously, and therefore wish to write an existing template to 


the MIFARE® Tag, click on the Write button.  Otherwise, continue with the enrollment 


procedure as outlined under Enrollment procedure at the Morpho MSO300 (below).   


 


Enrollment procedure at the Morpho MSO300 


 


 


The number of times you present your finger depends on whether you have duplicate checking 


enabled.   


 


1. Place Finger 1 (fingerprint down) on the MSO300 Enrollment Reader’s fingerprint Sensor. 


2. Remove Finger 1 from the Sensor 


3. Place Finger 1 on the Sensor a second time.  


4. Again, remove Finger 1 from the Sensor. 


5. Place Finger 2 (fingerprint down) on the MSO300 Enrollment Reader ’s fingerprint Sensor. 


6. Remove Finger 2 from the Sensor. 


7. Place the Finger 2 on the Sensor a second time. 


8. Again, remove Finger 2 from the Sensor. 


 


Once the enrollments complete, the Template field displays the Template Number and an 


Enrollment Successful message appears in the Status Bar. 


 


9. Click the Write button. 


10. Click the  button.  


 


The enrollment process is now complete.  Repeat this process for each Tagholder, as required. 
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HandKey
®
 CR Use in an ImproNet System 


General 


This section guides you step by step through the process of setting up the HandKey® CR 


Biometric Reader to work with the ImproNet System.  The requirements for the integration are 


as follows: 


 


 IXP400 Access Control System. 


 ImproNet V7.60 (and Service Pack 3) or later Installed. 


 


There are five steps in configuring the Biometric Readers to work with ImproNet.  These are: 


 


1. Hardware installation of the Biometric Readers. 


2. Software setup of the Biometric Readers using the Biometric Server Software. 


3. Detection of the Biometric Readers on the TCP/IP bus. 


4. Setting up the Enrollment Reader. 


5. Enrolling users on the System. 


 


Principle of Operation 


 
Figure 20 – Data Flow when using a HandKey® Reader with the ImproNet Software 
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Hardware Installation of HandKey® CR Readers  


Each HandKey® CR Reader must connect to the LAN to send and receive templates from the 


ImproNet Database.  The HandKey® Reader must also connect to an associated ImproX 


Terminal (such as the ImproX TA, iTRT or the MfT) thus facilitating communication with the 


Controller.  Please install the HandKey® CR Readers as outlined in the associated HandKey® 


Readers Hardware Installation Manual. 


 


CCoonnnneeccttiioonn  ttoo  tthhee  IImmpprrooXX  iiTTRRTT  


 
Figure 21 – HandKey® CR Reader Connected to the ImproX iTRT and LAN 
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CCoonnnneeccttiioonn  ttoo  tthhee  IImmpprrooXX  MMffTT  


 
Figure 22 – HandKey® CR Reader Connected to the ImproX MfT and LAN 
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CCoonnnneeccttiioonn  ttoo  tthhee  IImmpprrooXX  TTAA  


 
Figure 23 – HandKey® CR Reader Connected to the ImproX TA and LAN 
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Configuring the Biometric Device 


 


Ensure that you unlock BOTH your Registration Interface and your Registration Reader, for 


Biometrics, before continuing further. 


 


 


Where you intend using a HandKey® CR Reader purely for enrollment, you do NOT require a Wiegand 


Reader. 


 


Before configuration into an ImproNet System, internally configure each HandKey® Reader (as 


a stand-alone unit), as follows: 


 


1. Connect the HandKey® Reader as shown in Figure 21, Figure 22 or Figure 23. 


2. Internally allocate the HandKey® Reader an address in the range 0 to 255.  Refer to the 


HandKey® CR Installation and Operation Manual supplied with your HandKey® Reader. 


 


AAddddiinngg  aa  BBiioommeettrriicc  DDrriivveerr  


1. From Windows® select Start>Programs>ImproNet>Biometric Server. 


2. From the Menu Bar, select the Drivers drop-down list. 


3. Select the HandKey radio button. 


4. From the Menu Bar, select the Configuration drop-down list. 


5. Select HandKey>Devices. 


6. In the Search for HandKey Devices dialog, select the Connection Type.  Your choices 


include RS232 or TCPIP Socket. 


 


RS232 Configuration (Setting the Address) 


1. Apply power to the HandKey® Reader. 


2. On the HandKey® Reader’s Keypad, simultaneously press the Clear and Enter buttons. 


3. Select menu option 2 and press the Enter key. 


4. Select the No option until you reach the Set Address menu option. 


 


 


―0‖ Addresses do NOT appear when you set the RS232 Address option. 


 


TCPIP Configuration (Setting the Address) 


The settings outlined below set the IP Address, the Gateway and the Host Bit settings. 


1. Plug in the Ethernet connection. 


2. Apply power to the HandKey® Reader. 


3. On the HandKey® Reader’s Keypad, simultaneously press the Clear and Enter buttons. 


4. Select menu option 2 and press the Enter key. 


5. Select the No option until you reach the Set Serial menu option. 


 


 


Ensure that all IP Addresses fall under the same subnet. 


 


TCPIP Configuration 


 


 


If you change the Connection Type, in the Search for HandKey Devices dialog, click the button for 


the change to take effect. 
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If you carry out an RS232 search, the search range automatically runs from 1 to 255.  You cannot set 


the range. 


 


1. In the IP Range textboxes, type in the IP Address for your TCPIP configuration. 


2. Click on the Search button. 


 


 


The search records display highlighted according to the following key.  Search Records highlighted in: 


GREEN represent new HandKey® Readers; RED represent missing HandKey® Readers; ORANGE 


represents HandKey® Readers that have newly applied setting changes.  Records returned without 


highlighting indicate existing HandKey® Readers without any setting changes. 


 


3. Click the  button. 


4. In the Biometric Server Software, click the Start button. 


  


EEnnrroolllliinngg  UUsseerrss  oonn  tthhee  SSyysstteemm  


Setting Truncation for Enrollment 


1. From Windows® select Start>Programs>ImproNet>Access. 


2. From the Main Menu, select File>Preferences. 


3. Select the Enrollment tab. 


4. Alongside the Ascii, Biomentric, Magstripe option, click the Truncation button. 


5. From the Tag Format drop-down list, select the 26-bit Normal option. 


6. Click the  button  


7. Close the Preference Configuration dialog by clicking the  button 


 


Biometric Address Configuration 


  


 


Ensure that you note each HandKey® Reader’s installation location with its serial number on the Site 


Plan.  During this installation phase, you would have appointed one of the HandKey® Readers as the 


Enrollment Reader for the System.  Identify this Enrollment Reader by its serial number.   


 


1. From the Menu Bar, select the Configuration drop-down list. 


2. Select Biometric Addresses. 


 


 
Figure 24 – Biometric Addresses Configuration Dialog 


 


3. From the Biometric Device drop-down list, select the HandKey option. 


4. From the Device drop-down list, select the HandKeyCR option. 
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5. Check that the Unit IP Address reflects the IP Address of your HandKey® Reader. 


6. From the Connection Type drop-down list, select the connection type in use. 


7. Click the  button. 


8. Click the  button. 


 


Tagholder Setup 


1. In the Navigator Pane, select the Tagholder icon. 


2. Open the Edit Tagholder or Add Tagholder dialog. 


3. Capture your Tagholders details.  Refer to Part III for more information on adding a 


Tagholder. 


4. Click the  button. 


5. On activation, click the New Tag button. 


6. From the Tag Type drop-down list, select Slim Tag (5 Bytes). 


7. Place your Tag in the Registration Reader. 


8. Click the Read Tag button. 


9. Click the  button. 


10. From the Tag Type drop-down list, select ASCII, Biometric, Magstripe. 


11. Click the  button. 


12. Click the  button. 


13. On activation, click the Biometric Enrollment button. 


 


 
Figure 25 – Biometric Enrollment Dialog 


 


14. From the Device drop-down menu, select the HandKey option. 


 


 


The ID textbox shows the modified Tag Code used by the HandKey® Reader.  Note, however, that 


ImproNet still uses the full unmodified Tag Code in all communications. 


 


 


Clicking on the Advanced button lets you set the Threshold (optimal at the default setting of 30), 


Authority (default setting is 0) and Special Enroll settings.   


 


Settings explained:     


 Threshold Setting—the lower the Threshold, the greater the security as you get less false 


readings.  Lowering the Threshold does, however, result in more false rejects. 


 Authority Setting—this setting provides the Tagholder access to the internal HandKey® 


menus.  There are 5 menus, and the digit selected here indicated how many of these menus 


the Tagholder can access.   


 Special Enroll—selecting this checkbox, allows identification of disabled people (without 


hands).  Enrollment takes place with the Tagholder placing the remainder of the limb on the 


HandKey® Reader’s Registration Plate.  Identification of the Tagholder is then only by Tag 


ID. 
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Hand Enrollment 


 


 


When enrolling the hand template, ensure that you place the Tagholder’s hand on the HandKey® 


Readers Registration Plate, 3 times in quick succession.  If enrollment takes too long, the process 


times out, resulting in a failure to record a template, or the incorrect template being recorded. 


 


 


At each stage of the Tagholder’s hand enrollment the HandKey® Reader displays status messages on 


the its liquid crystal display (LCD).  Take note of these messages and act on them in good time. 


 


1. In the Biometric Enrollment dialog, click the Enroll button.   


2. Place the Tagholders RIGHT hand on the HandKey® Readers Registration Plate.   


3. Remove the Tagholders hand from the HandKey® Readers Registration Plate.   


4. Place the Tagholders RIGHT hand on the HandKey® Readers Registration Plate again. 


5. Remove the Tagholders hand from the HandKey® Readers Registration Plate. 


6. Place the Tagholders RIGHT hand on the HandKey® Readers Registration Plate again.   


 


At the successful enrollment of the Tagholder, the message ―Record added successfully‖ 


displays in the Message Panel at the bottom of the Biometric Enrollment dialog.  The Template 


No. drop-down list is now active. 
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ImproX B-SHO Fingerprint Terminals Use 
in an ImproNet System 


General 


This section guides you step by step through the process of setting up ImproX B-SHO 


Fingerprint Terminals to work with the ImproNet System.  The requirements for the integration 


are as follows: 


 


 IXP400i Access Control System. 


 ImproNet V7.60 (and Service Pack 3) or later Installed. 


 


There are four steps in configuring the Fingerprint Terminals to work with ImproNet.  These are: 


 


1. Hardware installation of the Fingerprint Terminals. 


2. Detection of the Fingerprint Terminals on the RS485 bus. 


3. Setting up the Enrollment Reader. 


4. Enrolling users on the System. 


 


Principle of Operation 


 
Figure 26 – Data Flow when using an ImproX B-SHO Fingerprint Terminal with ImproNet 
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Hardware Installation of ImproX B-SHO Fingerprint Terminals  


The ImproNet System recognizes these Fingerprint Terminals in the same fashion as other 


ImproX Terminals.  Therefore, connect these Terminals to the ImproX ECII Controller’s Terminal 


Bus using the RS485 bus protocol.  As when using with associated ImproX Terminals, you may 


multi-drop up to 64 Terminal Fixed Addresses, including up to 16 B-SHO Terminals per ECII 


Controller.  


 


In situations that require heightened security, we recommend that you connect the ImproX       


B-SHO Fingerprint Terminal via an associated ImproX OSCAR Door Control Unit.  In all other 


instances multi-drop the Fingerprint Terminals direct from the Terminal Bus. 


 


 


Figure 27, Figure 28 and Figure 29 show connections to the ImproX B-SHO Fingerprint Terminal, 


these connections remain the same for the ImproX B-SHO Keypad Fingerprint Terminal. 


 


 


Use B-SHO Fingerprint Terminals with ImproX ECII Controllers, where the Controllers connect by 


Ethernet. 


 


 
Figure 27 – Fingerprint Terminals Relationship with the Rest of the ImproX Product Range 
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Figure 28 – ImproX B-SHO Fingerprint Terminal Connected to the ImproX ECII using the Terminal Bus 
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Figure 29 – ImproX B-SHO Fingerprint Terminal Connected Via the ImproX OSCAR Door Control Unit 


 


CCoonnnneeccttiinngg  tthhee  IImmpprrooXX  BB--SSHHOO  UUSSBB  FFiinnggeerrpprriinntt  EEnnrroollllmmeenntt  RReeaaddeerr  


1. Plug the ImproX B-SHO USB Fingerprint Enrollment Reader or ImproX B-SHO BioMini 


USB Fingerprint Enrollment Reader into an unused USB Port on the PC. 


2. Follow the on-screen prompts for installation of the Enrollment Reader. 
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Configuring the Biometric Device 


Continue as follows for configuration into an ImproNet System: 


 


RRuunn  AAuuttoo--IIDD  ttoo  DDeetteecctt  yyoouurr  FFiinnggeerrpprriinntt  TTeerrmmiinnaallss  


Before you can use your Fingerprint Terminals, you must run the Auto-ID function in ImproNet 


Engine to detect the hardware.   


 


 


If ImproNet Engine and ImproNet Access are on different Host PCs, you must change the 


Engine.properties file (refer to Part 2 – Software for more information).   


 


To open ImproNet Engine and run Auto-ID, proceed as follows: 


 


1. In Windows®, click Start>Programs>ImproNet>Engine. 


2. Click the  button.   


 


When hardware units are detected, they are added to the ImproNet Database and become 


available on the Access Hierarchical Tree.   


 


 


Use your Unit Location Chart to re-name the Fingerprint Terminals. 


 


AAssssiiggnn  tthhee  FFiinnggeerrpprriinntt  TTeerrmmiinnaallss  


To assign the Fingerprint Terminals to a Controller, proceed as follows: 


 


1. In the Navigator Pane, select a Controller, an Unassigned Terminals node displays. 


 


 
Figure 30 – Unassigned Terminals 


 


2. Double-click the  icon to expand the Unassigned Terminals node. 


3. Drag-and-drop unassigned Fingerprint Terminals onto a Controller. A new Zone containing 


a Location is created.  Terminals display in the Location.   


 


EEddiitt  TTeerrmmiinnaall  PPaarraammeetteerrss  


The Terminals screen lets you configure your Fingerprint Terminal and set-up its Actions, Inputs, 


and Outputs.  The Terminal Settings are the same as those mentioned in Part 3 – General 


Configuration.  Refer to the section titled Terminals for more information. 


 


Terminal Modes 


Select the Fingerprint Terminal from the Navigator Pane (Hierarchical Tree).  
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The Default Terminal Mode drop-down list situated on the Main Pane, gives you access to the 


following options: 


 


Mode Mode Description 


Tag or Finger The Terminal requires a valid Tag OR fingerprint. 


Finger The Terminal requires a valid fingerprint. 


Tag + Finger The Terminal requires a valid Tag code and fingerprint. 


―Tag + Finger‖ + PIN The Terminal requires a valid Tag code, fingerprint and 


PIN-code. 


―Tag + Finger‖ + Reason Code The Terminal requires a valid Tag code, fingerprint and 


Reason Code. 


―Tag + Finger‖ + PIN + Reason 


Code 


The Terminal requires a valid Tag code, fingerprint and 


PIN-code and Reason Code. 


―Tag or Finger‖ + PIN The Terminal requires one of the following combinations:  


Either a valid Tag code and PIN-code OR a valid 


fingerprint and PIN-code. 


―Tag or Finger‖ + Reason Code The Terminal requires one of the following combinations:  


Either a valid Tag code and Reason Code OR a valid 


fingerprint and Reason Code. 


―Tag or Finger‖ + PIN + Reason 


Code 


The Terminal requires one of the following combinations:  


Either a valid Tag code, PIN-code and Reason Code OR 


a valid fingerprint, PIN-code and Reason Code. 


Finger + PIN The Terminal requires a valid fingerprint and PIN-code. 


Finger + Reason Code The Terminal requires a valid fingerprint and Reason 


Code. 


Finger + PIN + Reason Code The Terminal requires a valid fingerprint, PIN-code and 


Reason Code. 


Personal Access Code + Finger The Terminal requires a valid Personal Access Code and 


fingerprint. 


Personal Access Code or Finger The Terminal requires a valid Personal Access Code OR 


fingerprint. 


―Tag‖ or ―Finger‖ or ―Personal 


Access Code + Finger‖ 


The Terminal requires one of the following combinations:  


Either a valid Tag code or fingerprint OR a combination of 


valid Personal Access Code and fingerprint. 


Table 3 – Table of ImproX B-SHO Terminal Modes 


 


EEnnrroolllliinngg  UUsseerrss  oonn  tthhee  SSyysstteemm  


Tagholder Setup 


 


 


For more complex B-SHO installations using ImproNet V7.60 we added the Copy Existing Tag Code 


button and the Save Template to all Biometric Tags checkbox.   


 


Clicking the Copy Existing Tag Code button opens a dialog allowing selection of the Tag Code you 


want to copy.  You may copy the Tag Code of any Tags for that Tagholder (other than ASCII) for 


creation of a new ASCII Tag.  Then connect a fingerprint template to this Tag by going to the Biometric 


Enrollment dialog of an ASCII Tag already enrolled for that Tagholder and selecting the Save 


Template for all Biometric Tags checkbox.  
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1. From Windows® select Start>Programs>ImproNet>Access. 


2. In the Navigator Pane, select the Tagholder icon. 


3. Open the Edit Tagholder or Add Tagholder dialog. 


4. Select New Tag to enter the Tag dialog.  


5. Have the Tagholder place their Tag on the ImproNet Enrollment Reader. 


6. Click Read Tag (or just enter a number of 7 digits or less in the Tag Code field).  


7. From the Tag Type drop-down list, select ASCII, Biometric, Magstripe. 


8. Set the Access Groups in the usual way. 


9. Click on the  button. 


10. Click on the Biometric Enrollment button. 


 


 
Figure 31 – Biometric Enrollment Dialog 


 


11. In the Biometric Enrollment dialog, from the Device drop-down list, select the type of 


device you wish to enroll the user on, in this case BSho.  


 


 


The Template No field appears greyed out as it does not apply to BSHO units.  The ID field is the ID 


derived from the Tag Code and is the number under which the user’s data is saved when his or her 


fingerprints are enrolled in the units.  The Template field remains empty until the enrollments 


completed.     


 


Advanced Button Options 


1. Click on the Advanced Button. 


 


 


We recommend that you leave the Quality Threshold set at 80.  You may however adjust this setting 


based on your preferences. 


 


2. From the No. Of Enrollments drop-down list, select 2.  This figure indicates that you intend 


enrolling 2 fingers.   


3. Click the  button. 
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Fingerprint Placement Rules 


Figure 32 shows the area of the fingerprint that contains the most information.   


 


 
Figure 32 – Area of the Fingerprint Containing the most Information 


 


When enrolling Tagholders, ensure enrollees place their fingers as shown in the green 


(checked) blocks below: 


 


 
Figure 33 – Fingerprint Placement Rules 


 


 


After enrollment, ensure that Tagholders use the Fingerprint Placement Rules shown in Figure 33 each 


time they present their finger to the ImproX B-SHO Fingerprint Terminal.  
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Enrollment procedure at the ImproX B-SHO USB Fingerprint Enrollment Reader 


1. Click on the Enroll button, thereby initiating the enrollment.  


2. At the Acquisition Window dialog, place Finger 1 (fingerprint down) on the Enrollment 


Reader’s fingerprint Sensor. 


3. Remove Finger 1 from the Sensor. 


4. Place Finger 1 on the Sensor a second time.  


5. Again, remove Finger 1 from the Sensor. 


6. For verification, place Finger 1 on the Sensor a third time.  


7. Again, remove Finger 1 from the Sensor. 


8. At the Message dialog, click the OK button. 


9. Place Finger 2 (fingerprint down) on the Enrollment Reader’s fingerprint Sensor. 


10. Remove Finger 2 from the Sensor. 


11. Place Finger 2 on the Sensor a second time. 


12. Again, remove Finger 2 from the Sensor.  


13. For verification, place Finger 2 on the Sensor a third time. 


14. Again, remove Finger 2 from the Sensor.  


15. At the Message dialog, click the OK button. 


 


Once the enrollments complete, the Template field displays the Template Number and an 


Enrollment Successful message appears in the Status Bar.   


 


16. Click the  button. 


17. Click the  button.  


18. At the Tag dialog, click the  button.  


19. Click the  button.  


 


The enrollment process is now complete.  Repeat this process for each Tagholder, as required. 
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NITGEN Fingerprint Terminals Use in an 
ImproNet System 


General 


This section guides you step by step through the process of setting up NITGEN Fingerprint 


Terminals to work with the ImproNet System.  The requirements for the integration are as 


follows: 


 


 


Ensure that you unlock your Registration Interface (by purchasing a Biometric Unlock Code). 


 


 IXP400i Access Control System. 


 ImproNet V7.67 or later installed. 


 


There are five steps in configuring the Fingerprint Terminals to work with ImproNet.  These are: 


 


1. Hardware installation of the Biometric Terminals. 


2. Setting up the Enrollment Reader. 


3. Detection of the Biometric Terminals on the TCP/IP bus. 


4. Software setup of the Biometric Terminals using the Biometric Server Software. 


5. Enrolling users on the System. 


 


Principle of Operation 


 
Figure 34 – Data Flow when using a NITGEN Fingerprint Terminal with ImproNet 
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Hardware Installation of NITGEN Fingerprint Terminals  


Each NITGEN Terminal must connect to the LAN to send and receive templates from the 


ImproNet Database.  The NITGEN Terminal must also connect to an associated ImproX 


Terminal (such as the ImproX TA, iTRT or the MfT) thus facilitating communication with the 


Controller.  Please install the NITGEN Terminals as follows: 


 


 
Figure 35 – NITGEN Biometric Terminal Range Connected to the ImproX iTRT Terminal 
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Figure 36 – NITGEN Biometric Terminal Range Connected to the ImproX MfT Terminal 
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Figure 37 – NITGEN Biometric Terminal Range Connected to the ImproX TA Terminal 
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CCoonnnneeccttiinngg  tthhee  NNIITTGGEENN  FFiinnggeerrpprriinntt  EEnnrroollllmmeenntt  RReeaaddeerr  


1. Browse to C:\ImproNet\driver\NITGEN\Hamster II_III. 


2. Run the Setup.exe file. 


3. At the Welcome screen click the Next button. 


4. At the Windows Security dialog, select the Install This Driver Software Anyway option. 


5. At the Device Status screen, plug the NITGEN Fingerprint Enrollment Reader into an 


unused USB Port on the PC. 


6. At the InstallShield Wizard Complete screen, select the Device Diagnostic Tool checkbox. 


7. Click the Finish button. 


 


NITGEN Fingerprint Terminal Internal Parameter Setup  


 


 


Navigate within the Fingerprint Terminals internal parameters using either the Up and Down arrow 


keys or the numeric keypad.  Step back or exit from menu options using the ESC or Cancel buttons.      


 


1. On the Fingerprint Reader, press the Menu button. 


2. Enter the Network selection menu by selecting menu option 5. 


3. Press the ENT (Enter) button.  


4. Set the Terminal ID by selecting menu option 1.   


5. Press the ENT (Enter) button. 


6. Enter any UNIQUE (across all NITGEN Terminals installed) number between 1 and 2 000. 


7. Set the IP Address by selecting menu option 2.   


8. Press the ENT (Enter) button. 


9. Within the TCP/IP menu, select option 1 to Use DHCP. 


10. Select the ON option. 


11. Press the ENT (Enter) button. 


12. Select option 5 to set the Server IP. 


13. Press the ENT (Enter) button. 


14. Enter the IP Address of the Host PC (running the Biometric Server Software). 


15. Press the ENT (Enter) button. 


16. Leave the Port Number (menu option 4) set at the default of 7332. 


 


 


When changing the Port Number from the default, ensure that you change the Port Number setting in 


the Biometric Server Software.  On the Configuration menu, select Nitgen>Properties to change the 


Port Number. 


 


Using NITGEN Terminals within the ImproNet System 


Once you’ve connected the NITGEN Terminals and configured them internally as described in 


the previous paragraphs, use the Terminals within the ImproNet System.  This section applies to 


the following supported NITGEN Fingerprint Terminals:  the NITGEN Fingkey Access Terminal, 


the NITGEN NAC-2500 Plus Terminal and the NITGEN NAC-5000 Terminal. 
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Each NITGEN Terminal used in the Biometric Server requires its own Unlock.  For details of the 


unlocking procedure refer to the section titled NITGEN Unlock Protection on page 64. 


 


The configuration of these Terminals within ImproNet is done using the ImproNet Biometric 


Server Software, as follows: 


 


1. From Windows® select Start>Programs>ImproNet>Biometric Server. 


2. Enter your Username (SYSDBA) and Password (masterkey). 


 


DDeetteeccttiinngg  NNIITTGGEENN  TTeerrmmiinnaallss  oonn  tthhee  TTCCPP//IIPP  BBuuss  


1. From the Devices menu, select Nitgen. 


2. At the Message dialog, click the OK button. 


3. On the Configuration menu, select Nitgen>Properties. 


4. Confirm that the Server Port and Server IP Address appear as specified under the section 


NITGEN Fingerprint Terminal Internal Parameter Setup. 


 


 


By default the Master ID is set at 00000. 


 


5. Enter a Password (from between 1 and 8 digits in length.  By default this password is set at 


00000). 


6. Click the Apply button. 


7. Close the Biometric Server, by clicking the  button. 


8. From Windows® select Start>Programs>ImproNet>Biometric Server. 


9. Enter your Username (SYSDBA) and Password (masterkey). 


10. On the Configuration menu, select Nitgen>Devices. 


11. Click the Search button. 


 


 


The Search may take some time, depending on how busy the network is.  After the Search finds the 


NITGEN units, they appear as records in the table.  The displayed units appear as follows: 


 


 All newly discovered units highlight in Green. 


 All units with changed IP Addresses highlight in Orange. 


 All units that are in the Database but have been found to be off-line or missing highlight in Red. 
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Figure 38 – NITGEN Devices Dialog 


 


 


The Enabled checkbox enables or disables each individual NITGEN unit on the network.  This means 


that you can carry out repairs on a unit without affecting the rest. 


The Enable / Disable All checkbox enables or disables all the NITGEN units on the network.   


The Server will not attempt communication with a disabled NITGEN unit. 


 


 


You will also notice a  button in the dialog.  This button allows manual deletion of NITGEN 


Terminals from the database.  Note however, reintroduction of the NITGEN Terminal requires use of 


the unlock. 


 


 


Enabled NITGEN Terminals display with their status shown as OK.  Clicking the User ID Check button 


displays the Template Comparison dialog.  This dialog shows the first 50 missing User IDs per 


Database.  You may export the full list of missing User IDs. 


 


12. Enable the NITGEN Fingerprint Teminals as required by selecting the associated 


Fingerprint Terminal’s Enabled checkbox. 


13. Click the  button. 


14. Now click on the Start button to get the Biometric Server running and ready to upload 


templates as you enroll users. 


 


BBiioommeettrriicc  SSeerrvveerr  QQuueeuuee  


All messages to NITGEN devices queue so that each device can be processed independently.  


The Unit Details tab shows the queue status and allows you to upload to each unit individually.  


 


This tab is also useful in identifying units having communication problems. 
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Figure 39 – Unit Details Tab 


 


The queue processes automatically during normal operation (that is after you press the Start 


button).  You may perform a full upload on a specific NITGEN Reader as follows: 


 


1. Select the unit record for update. 


2. From the menu, select the Full Upload option. 


 


NNIITTGGEENN  UUnnlloocckk  PPrrootteeccttiioonn    


The Unlock supplied with third-party integrated products, shows the products have our full 


factory level approval.  This means the products work seamlessly with ImproNet, with central 


enrollment taking place in the ImproNet Tagholder Enrollment screen.  The Unlock allows 


intelligent distribution of templates (uploading of templates only to Terminals where the 


Tagholder has access). 


 


In instances where NITGEN Terminals are purchased from Impro, the Factory unlocks the 


Terminal prior to shipment.  In instances where the Terminal does not come from the Impro 


Factory, please unlock NITGEN Terminals as follows: 


 


1. At the License Information dialog, click the Unlock button. 


2. At the Device Unlock dialog, click the Import button. 


3. Select the Unlock.xml file for import (contact Impro’s Support team for further information 


on sourcing this file). 


4. Click the Open button. 


5. At the Message dialog, click the OK button. 


6. At the Device Unlock dialog, click the OK button. 
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On unlock, the Biometric Server Software opens allowing full use of the Software. 


EEnnrroolllliinngg  UUsseerrss  oonn  tthhee  SSyysstteemm  


Setting Truncation for Enrollment 


1. From Windows® select Start>Programs>ImproNet>Access. 


2. From the Main Menu, select File>Preferences. 


3. Select the Enrollment tab. 


4. Alongside the Ascii, Biomentric, Magstripe option, click the Truncation button. 


5. From the Tag Format drop-down list, select the 16-bit Normal option. 


6. Click the  button.  


7. Close the Preference Configuration dialog by clicking the  button. 


 


Tagholder Setup 


1. In the Navigator Pane, select the Tagholder icon. 


2. Open the Edit Tagholder or Add Tagholder dialog. 


3. Select New Tag to enter the Tag dialog.  


4. Have the Tagholder place their Tag on the Enrollment Reader. 


5. Click Read Tag (or enter any number between 1 and 65535 in the Tag Code field).  


6. Set the Access Groups in the usual way. 


7. Click on the  button. 


8. Click on the Biometric Enrollment button. 


 


 
Figure 40 – Biometric Enrollment Dialog 


 


9. In the Biometric Enrollment dialog, from the Device drop-down list, select the type of 


device you wish to enroll the user on, in this case Nitgen.  


 


 


The Template No field will be greyed out as it does not apply to NITGEN units. Other Biometric 


Devices allow you to enroll multiple templates per user.  NITGEN units enroll two fingers and store 


them as one template, not allowing multiple templates per ID. 


 


 


The ID field is the ID derived from the Tag Code and is the number under which the user’s data is 


saved when his or her fingerprints are enrolled in the units. 


 


 


The Template field remains empty until the enrollments completed.  
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10. Click on the Advanced button. 


 


Advanced Settings 


Clicking the Advanced button makes the following settings available for change: 


 


 Enroll Image Quality—this is the quality setting that will be applied during the enrollment of 


the fingerprint.  By default the Enrollment Image Quality is set to 50.  Reducing this figure 


will result in a poorer quality fingerprint image.  Increasing this figure ensures a higher 


quality fingerprint image. 


 Verify Image Quality—quality level of the fingerprint image for verification.  The value 


range is from 0 to 100. The default value is 30. 


 Security Level—select from one of the following options:  Lowest, Lower, Low, Below 


Normal, Normal, Above Normal, High, Higher, Highest.  By default the Security Level is set 


at Normal.  If the level is set to a low setting, the False Acceptance Rate (FAR) increases 


and False Rejection Rate (FRR) decreases.  If set to a high setting, False Acceptance Rate 


(FAR) decreases and False Rejection Rate (FRR) increases. 


11. Click on the Enroll button, thereby initiating the enrollment.  
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Fingerprint Placement Rules 


Figure 17 shows the area of the fingerprint that contains the most information.  Therefore, when 


enrolling Tagholders, ensure they place their fingers as shown in Figure 18.  


 


 
Figure 41 – Area of the Fingerprint Containing the most Information 


 


 
Figure 42 – Fingerprint Placement Rules (Generic Enrollment Reader, Fingerprint Sensor Shown) 
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Enrollment procedure at the NITGEN Fingkey Hamster II™ 


 


 


Enrollment can take place using either a single finger or multiple fingers per user.  Regardless of the 


number of fingers enrolled, configure the Biometric Server to upload either one or two templates per 


user.  By default two templates upload. 


 


1. At the NITGEN Biometric Solutions dialog, click the Next button. 


2. Select Finger 1 for use during enrollment, by clicking on the corresponding dot above the 


fingertip. 


3. Place the corresponding Finger (fingerprint down) on the NITGEN Fingkey Hamster II™ 


fingerprint Sensor. 


4. Remove the Finger from the Sensor. 


5. Place the Finger on the Sensor a second time.  


6. Again, remove the Finger from the Sensor. 


7. Select Finger 2 for use during enrollment, by clicking on the corresponding dot above the 


fingertip. 


8. Place the corresponding Finger (fingerprint down) on the NITGEN Fingkey Hamster II™ 


fingerprint Sensor. 


9. Remove the Finger from the Sensor. 


10. Place the Finger on the Sensor a second time.  


11. Again, remove the Finger from the Sensor. 


12. Click the Next button to end the enrollment process. 


13. Click the Finish button. 


 


Once the enrollments complete, the Template field displays the Template Number and an 


Enrollment Successful message appears in the Status Bar. 


 


14. Click the  button. 


15. Click the  button.  


 


The enrollment process is now complete.  Repeat this process for each Tagholder, as required. 


 


 


With the Biometric Server running, the Server automatically uploads templates to the NITGEN 


Terminals. 


 


USER NOTES 
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At a Glance 


 Part 1 – Hardware—provides information to configure the ImproX Hardware before 


configuring the ImproNet System.  It includes information on cabling, power and grounding 


or earthing requirements. 


 Part 2 – Software—provides an overview of the ImproNet System, and the basic steps for 


installation and pre-configuration.   


 Part 3 – General Configuration—General Configuration provides the nuts-and-bolts 


procedures for ImproNet Software configuration.  The steps for the initial configuration as 


well as all everyday tasks are described in this section. 


 Part 4 – Reports—provides an overview of the Reports available in the ImproNet System, 


the application of these to single or multiple Sites, and the basic steps for running the 


Reports. 


 Part 5 – Advanced Configuration—details not covered in Parts 1, 2, 3 and 4, are 


described here.  Most information in this Part is not required for everyday configuration. 


 Part 6 – General Software Modules—these General Software Modules form the core of 


the ImproNet Suite and provide control of everyday and other important functions.   


 Part 7 – Advanced Software Modules—Advanced Software Modules provide additional 


control of everyday and other important functions.   


 Part 8 – Utilities—the ImproNet Utilities enable you to perform administrative and 


maintenance tasks concerning the core ImproNet components. 


 Part 9 – Integration Modules—support for integration of other systems with ImproNet is 


covered in this Part.   


 Part 10 – Linux Integration—Linux integration is covered in this Part.   
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Introduction 


Document Conventions 


The following conventions are used in this document: 


 


 


Note—indicates additional information about a topic 


 


 


Tip—indicates suggestions and alternative methods to perform tasks 


 


 


Important—indicates important information 


 


 


Warning—indicates potential danger to you or the product 


 


Terminology 


IImmpprroo--SSppeecciiffiicc  TTeerrmmiinnoollooggyy  


The following terminology appears in this document: 


 


 ImproNet—the commonly used name of the IXP300, IXP400 or IXP400i Series Software 


Suite.  However, the term ImproNet also describes an access solution as a whole; it 


encompasses all Hardware, Software and third-party applications. 


 IXP300—the ImproNet System based around the ImproX IC Controller. 


 IXP400—the ImproNet System based around the ImproX EC Controller. 


 IXP400i—the ImproNet System based around the ImproX ECII Controller. 


 ImproX Hardware—the hardware units comprising an ImproNet System.  The major 


ImproX components are Controllers, Terminals and Tag Readers. 


 Tag—the passive, proximity component used as a unique identifier in an ImproNet Access 


Control System. 
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CCoouunnttrryy--ssppeecciiffiicc  TTeerrmmiinnoollooggyy  


Different countries use different words to name or describe the same thing.  Table 1 lists the 


International terms and their American equivalents used (sometimes inter-changeably) in this 


document. 


 


International American British 


Lift Elevator Lift 


Grounding Grounding Earthing 


Ground Ground Earth 


Tag Card Tag 


Registration Enrollment Registration 


Registration Reader Enrollment Reader Registration Reader 


Screen Shield Screen 


Screening Shielding Screening 


Table 1 – Area-specific Terminology 


 


 


In some cases, terms are used inter-changeably. 


 


Supported Software and Firmware Versions 


This release of the ImproNet Software Installation Guide applies to the following Impro 


Software and Firmware versions, as well as any later versions that do not affect the contents of 


this Guide. Update of this Guide takes place only when significant changes occur. 


 


ImproNet Software Suite V7.66 


ImproX IC Controller V7.20 


ImproX EC Ethernet Advanced Controller V7.20 


ImproX ECII Ethernet Controller V8.02 


ImproX RH Registration Interface V1.18 


ImproX DBv 125 kHz Vertical Mount Drop Box V7.18 


ImproX DBv 13.56 MHz Vertical Mount Drop Box V7.24 


ImproX ER Extended Range Terminal V7.16 


ImproX LR Long Range Terminal V7.16 


ImproX MfT Multi-function Terminal V7.24 


ImproX I16 Input Terminal V7.24 


ImproX O16 Output Terminal V7.24 


ImproX TA Time Attendance Terminal V7.26 


ImproX iTT Twin Antenna Terminal V4.02 


ImproX iTRT Intelligent Twin Reader Terminal V4.02 


ImproX MDTA Multi-discipline Time Attendance Terminal  V1.14 


ImproX XFM Multi-mode 13.56 MHz Remote Reader V3.08 


ImproX TAR Time Attendance Remote Reader V3.06 


ImproX Multi-discipline Readers V2.14 


ImproX B-SHO Enrollment Terminal V1.04 


ImproX B-SHO Fingerprint Terminal V1.26 


Wiegand 125 kHz Passive Proximity Readers V1.08 
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General Hardware Installation Guidelines 


Essential Installation Requirements 


 


 


All units must be installed and wired in accordance with the good installation practices, local 


codes, and the requirements of authorities having jurisdiction. 


 


Part Number 


Each type of ImproX product or document has a Part Number.  This Code is used when 


ordering products.  The format of the code is as follows:  (XXXNNN-N-N-XX-XX, where X 


indicates a letter and N a decimal digit).   


 


 
Figure 1 – Unit Identification Code Format 


 


 


Typical examples of this code for  hardware products are: 


 XTT900-1-0-GB-01 – ImproX Twin Antenna Terminal, frequency 125 kHz, hardware design 


revision 01. 


 MDR900-5-0-GB-06 – ImproX (MDR) Multi-discipline Reader, frequency 125 kHz, 13.56 MHz 


and Wiegand, hardware design revision 06. 


 


Serial Numbers 


All ImproX hardware has a unique serial number of the following format: 


 


 
Figure 2 – Serial Number Format 


 


 


The Year Identifier uses letters to denote the year.  Each year, the letter advances by one. 
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Power Supply 


RReeqquuiirreemmeennttss  


 


 


Using a Power Supply where the input voltage exceeds the value named in this Manual, will 


damage the unit.   


 


 Power units using a power-limited access control or burglar alarm power supply that 


provides the required voltage and current and a minimum 4-hour standby time. 


 Reduce the current load, by installing ONE Power Supply for each set of Readers and 


Terminals at a Location.   


 Power each high-current Magnetic Lock using a separate Power Supply. 


 ImproX Controllers and most Terminals operate from DC input voltages in the range 10 to 


30 V DC. 


 ImproX Remote Readers operate from an input voltage of 5 V DC. 


 The maximum distance between the Power Supply and the units it supplies with power, 


depends on the output voltage of the Power Supply and the cross-sectional area of 


cable.  Refer to Table 3 for more information. 


 


RReeccoommmmeennddaattiioonnss  


 Protect all mains inputs to the Power Supply from high voltage surges. 


 Power Supplies with battery backup are preferable as they ensure that occurrences of 


mains brownouts have no effect on the Reader or Controller performance.  Battery backups 


should supply a minimum of 4 hours standby time. 


 Batteries typically have a life expectancy of 3 to 4 years.  Therefore, replace batteries at 


regular intervals. 


 


ImproX Power Supplies are specifically designed to fulfil all of these requirements. 


 


AArrcc  SSuupppprreessssiioonn  


 


 


Fit arc suppression components on all doors and access points using Strike or Magnetic Locks. 


 


 
Figure 3 – Arc Suppression Circuitry 
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Suitable devices should be used for EMF flyback and arc suppression when driving an inductive 


load via the relay contacts.  Figure 3 shows the technical details.  


 


SSuurrggee  PPrrootteeccttiioonn  


In areas where lightning is common, we recommended using surge protection on low voltage 


power lines and RS485 Communications lines.  The Impro Line Surge Protector is 


recommended for RS485 Communications Protection.  The Impro Low Voltage Line Protector 


is recommended for low voltage lines. 


 


Communication 


The majority of the ImproX product range uses RS232 and RS485 protocols for most 


communication purposes.  The ImproX EC and ImproX ECII, however, support Ethernet (LAN) 


communication. 


 RS232—is generally used for short distances up to 25 m (82.02 ft).  RS232 connects to a 


single hardware device via a serial communications port to a PC running the ImproNet 


Software. 


 RS485—supports longer communications runs.  It connects multiple hardware devices to a 


common bus (Multi-Dropping).  The IXP300 and IXP400 Systems use RS485 for their 


Terminal and Controller busses. 


 Connect to the LAN—using an Ethernet Switch or Hub (or other network device).  Cable 


runs for LAN connections must conform to Ethernet cabling specifications. 


 USB—is used between the ImproX RH and the PC running ImproNet Engine. 


 


RReeccoommmmeennddeedd  CCaabbllee  


Choice of cable is a critical part of the installation process.  Defective or unspecified cable can 


result in communication problems.  This can result in hardware timeouts and an overall speed 


reduction of System procedures.  Correct cable is particularly important for RS485 buses.   


 


Ensure the following when selecting cable: 


 For the RS485 Comms Bus, use twisted-pair Mylar shielded cable only. 


 For RS485 Ports, the individual cross-sectional area of the each conductor in the cable 


must not be less than 0.2 mm² (0.0003 in²).   


 For RS485 Ports, the maximum permissible cable length is 1 000 m (3 281 ft). 


 For RS232 Ports, the individual core cross-sectional area of the each conductor in the cable 


must not be less than 0.2 mm² (0.0003 in²).  


 For RS232 Ports, the maximum permissible cable length is 25 m (82.02 ft). 


 Cables must be: 


 Neatly laid out 


 Labelled correctly on both ends with cable markers 


 Earthed correctly—connect the shield of the cable to the Earth terminal on the unit.  In 


turn, connect the unit to a good Earth point.  The earth must be a low resistance 


connection to Earth and not an arbitrary Earth connection. 
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Connect the shield at one end of the cable only. 


 


 Keep cable joins to a minimum.  However if necessary, connect cable joins using proper 


connecting strips. 


 On shielded cables, connect the shield to ground (earth) as follows: 


 Strip to the required length exposing the internal wires 


 Untwist the excess length of metallic foil and plastic covering and remove the plastic  


 Twist the metallic foil to form a wire tail 


 Connect the shield lead to the Earth terminal.  Earthing is at ONE end of the cable only. 


 Cable layout of an installation must be documented, and the documents placed under 


configuration control. 


 Daisy-chain formations are preferable to Star formations. 


 Sites where transmission lines are long, or multiple star formations are used, may 


experience timeouts on certain ImproX Controllers or Terminals.  These are caused by 


reflections on the RS485 lines.  To solve the problem, it may be necessary to terminate the 


lines.  Termination resistors are added at the end of a cable run only and not at every 


Terminal.  Refer to the section Terminating the Communication Bus on page 20 for 


details. 


 


 


Termination resistors are built into most ImproX Terminals. 


 


Network Topology 


Run in a daisy chain configuration to provide effective RS485 communication for ImproX 


hardware.  Figure 4 illustrates a daisy chain configuration.   


 


 
Figure 4 – Daisy-Chain Bus Connection (Good Wiring Practice) 


 


Star configurations are not recommended, as they are susceptible to signal reflections and 


can result in signal degradation.  End-of-line termination is also a problem with Star 


configurations, due to the number of end points.  If a termination resistor is required at each 


endpoint, it will overload the RS485 driver. 
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More than four resistors on four of the star bus connections will overload the driver due to low parallel 


resistance. 


 


 
Figure 5 – Star Bus Connection (BAD Wiring Practice) 


 


 


Placement of ImproX Units 


MMiinniimmuumm  DDiissttaannccee  bbeettwweeeenn  IImmpprrooXX  UUnniittss  


To avoid mutual interference, keep a minimum distance of 500 mm (19.69 in) between 


adjacent ImproX Terminals or Remote Readers. 


 


 
Figure 6 – Minimum Distance between Terminals or Remote Readers 


 


SShhiieellddiinngg  ooff  UUnniittss  


In some situations, it is not possible to space the Readers the minimum distance apart.   


For example, if you mount two Readers back-to-back on either side of a drywall.  In this case, 


place an aluminium plate (at least 400 mm X 400 mm (15.75 in x 15.75 in), with a thickness of 


at least 1 mm (0.04 in)) between the two Readers. 
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LLiinnee  TTeerrmmiinnaattiioonn——PPrriinncciipplleess  ooff  aa  TTeerrmmiinnaattiinngg  RReessiissttoorr  


Long RS485 cable runs can cause problems with impedance matching and result in degraded 


signals. The impedance between two units can mismatch when an increase in number of units 


changes the resistance and capacitance of the connection. Such an impedance-mismatched 


network creates reflections on signals and data sent on the cable. Reflected signals introduce 


noise and errors on the connecting line.   


 


Each connected unit adds a small amount of capacitance to the network.  The longer the cable 


run, the more inductance and resistance is added.  If this occurs, units on the cable-run can 


timeout due to the reflections from the end of the cable conflicting with the messages sent from 


the Terminals. 


 


To overcome this problem, match the impedance by placing a terminating resistor between the 


A and B line, at the last unit on the run.  The terminating resistor inhibits the reflection and 


enhances the signal or data integrity. 


 


Ensure you adhere to the following criteria when placing terminating resistors: 


 


 Place one terminating resistor on a single cable run only.  If more are placed, they could 


lower the resistance too much.  As a result, the bus may hang-up. 


 Place a terminating resistor on the cable run only if the cable has been checked for faults 


but timeouts are still occurring. 


 


 


You should use terminating resistors only if the system is experiencing communication problems, or if 


the combined RS485 communications run is greater than 100 m (328 ft). 


 


Grounding the Shield in an IXP400 System 


A shield’s purpose is to drain off electrical noise.  A correctly grounded shield leads electrical 


noise along a path to the ground.  Using a mains ground is possible, but it must be established 


before hardware installation to determine if it is a suitable option. 


 


To prevent ground loops, a shield must never be grounded at both ends of an RS485 cable run. 


We recommend that you join - but not ground - the shield for the Controller bus and Terminal 


bus at each termination point, and ground the shield at one end of the bus only.  A suitable 


grounding position is at the beginning or the end of the bus.   


 


Grounding Controllers and Terminals in an IXP400 System 


CCoommmmoonn  GGrroouunndd  


Connecting to a mains ground is acceptable provided it is a common (local) ground. Often, in a 


single building or structure, each mains ground point is connected to a common ground.  


However, you must confirm the grounding scenario before proceeding with a common ground. 


 


The common ground method is preferred because it conforms to EMC standards.  It also 


provides good electrostatic discharge protection and emission reduction. 
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Figure 7 – The Recommended Grounding Procedure When a Common Ground Point is Available 


 


SSeeppaarraattee  GGrroouunndd  PPooiinnttss  


Often the case when the communications bus spans across buildings or structures that don’t 


share a common (local) ground.  Communication problems can occur if the hardware is 


grounded to separate (isolated) ground points and a potential difference exists between these 


points.  Therefore, we recommend you do not ground Controllers and Terminals via separate 


ground points.  In this configuration, Controllers and Terminals are floating; therefore, they are 


susceptible to electrostatic discharge. This method requires true floating power supplies.   


 


 


Figure 8 – The Recommended Grounding Procedure When a Common Ground Reference is Not Available.   
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Terminating the Communication Bus 


The communications bus requires termination to prevent reflections on the line.  ImproX 


Controllers and Terminals have onboard resistors that are used for line termination.  Ensure the 


following when terminating the Communication Bus: 


 


RRSS448855  HHoosstt  BBuuss  ((PPoorrtt  22))  


 Terminate the Controller communications bus (port 2) at the last Controller on the bus if the 


combined RS485 communications run is more than 100 m (328 ft). 


 The ImproX IC (IXP300) Controller has an onboard termination resistor that is disabled by 


default.  To terminate the communications bus at a particular Controller, short the TR1 


jumper. 


 


TTeerrmmiinnaall  BBuuss  ((PPoorrtt  11))  


 Terminate the Terminal communications bus (port 1) at the last Terminal on the bus if the 


combined RS485 communications run is more than 100 m (328 ft). 


 To terminate the communications bus at a particular ImproX iTT Terminal, short the 


onboard jumper. 


 To terminate the beginning of the Terminal communications bus at the Controller, short the 


TR2 jumper on the Controller. 


 The ImproX iTT, ImproX I16, ImproX O16, and ImproX ER Terminals have a single, 


onboard, termination resistor (all onboard termination resistors on Controllers and Terminals 


are 150 ohms).  To enable line termination on a particular Terminal, connect the onboard 


line termination link. 


 


Door Hardware Units 


DDoooorr  SSttrriikkee  


The Door Strike is a mechanical type lock but with an electromechanical action enabling 


activation by the presence or absence of a current flowing through an internal solenoid.  Figure 


9 and Figure 10 show a typical Door Strike Lock.  A Door Strike uses a small electro-mechanical 


solenoid to release the lip (the metal latch keeping the door closed) thus opening the door. 


 


 


 


Figure 9 – Door Strike Figure 10 – Door Strike Showing Lip Released 


 


 


Door Strikes have the advantage of being able to be opened with a key if necessary. 
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Figure 11 – Typical Wiring to a Door Strike 


 


MMaaggnneettiicc  LLoocckkss  


A Magnetic Lock uses an electro-magnet to stay closed.  When the metal plate attached to the 


back of the door makes contact with the Magnetic Lock, a current in the lock activates.  The 


current induces a magnetic field in the electro-magnet, holding the door closed.  If power to the 


Lock fails, or is switched off, the door opens easily.  This is an advantage in an emergency. 


 


 
Figure 12 – Magnetic Lock 


 


 
Figure 13 – Typical Wiring to a Magnetic Lock 
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Summary of Cable Requirements 


General Requirements 


Table 2 on page below provides a summary of cable requirements and related information for 


ImproX units.  The following notes refer to the content of Table 2. 


 


 


Do not attempt to extend the USB cable supplied with the ImproX RH.  Rather, obtain a new                 


5 m (16.4 ft) cable. 


 


 


We recommend that you run a 2-pair or 3-pair cable with at least a one-pair spare.  Although only a 


single-pair cable is required for Host Bus (Port 2) communication, it is advisable to run 2 or 3 pair cable 


and have at least one pair spare. 


 


 


We recommend cable specifications similar to the following: 


 Conductor Resistance: < 2 ohms 


 Capacitance, Core to Earth: > 160 pF/m 


 Capacitance Core to Core: < 100 pF/m 


 


 


A Standard USB cable is 1.8 m (5.9 ft) long and has one Type A and one Type B Connector. 


 


 


The metric conversions used in Table 2 are as follows: 


 1 m = 3.28 ft 


 2 m = 6.56 ft 


 3 m = 9.80 ft 


 5 m = 16.40 ft 


 10 m = 33 ft 


 16 m = 52.5 ft 


 20 m = 65.60 ft 


 25 m = 82 ft 


 1 000 m = 1 093.60 yd 


 0.2 mm
2
 = 0.0003 in


2
 


 


Unit 
Communication 


Protocol 


Cable 
Shield 


Grounding Specification Supplied 
Maximum 


Length 


HI RS232 from HI to PC 4 to 6 core shielded 
cable, individual 
conductor. Cross-
sectional area must 
not be less than     
0.2 mm


2
 


6 core shielded 
cable with DB9 
serial connector 


25 m from HI to PC Not Required 


ProxMate RS232 from ProxMate 
to PC or HI 


8 core cable, with 
RJ45 and DB9 
connectors 


1 m flat 8 core cable 
with 2 RJ45 
connectors 
1 m flat 8 core cable 
with 1 RJ45 
connector and 1 
DB9 serial 
connector 


20 m from ProxMate 
to PC.  This 
measure includes 
the Interface box 


Not Required 


RH USB from RH to PC Standard USB Standard USB 5 m from RH to PC 
See Note 1 


N/A 
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Unit 
Communication 


Protocol 


Cable 
Shield 


Grounding Specification Supplied 
Maximum 


Length 


RS USB from RS to PC Standard USB Standard USB 5 m from RS to PC 
See Note 1 


N/A 


RRA N/A 6 core stranded 
cable 


2 m 6 core cable 2 m from RRA to RH 
or RS unit 


N/A 


RRM N/A 6 core stranded 
cable 


2 m 6 core cable 2 m from RRM to 
RH or RS unit 


N/A 


MDE N/A 6 core stranded 
cable 


2 m 6 core cable 2 m  N/A 


IC Port 1 - RS485 
Port 2 - RS485 


Twisted pair (multi-
stranded) shielded, 
with mylar sheath. 
Cross-sectional area 
must not be less 
than 0.2 mm


2
. 


(Single pair required 
for Port 2)            
See Note 2 


None Port 2 from HI or RH 
to last Controller on 
the bus must not 
exceed 1 000 m 


Ensure that the 
shield is grounded at 
only one end of each 
run between 
Controllers 


EC Port 1 - RS485 
Port 2 - RS485 


Twisted pair (multi-
stranded) shielded, 
with mylar sheath. 
Cross-sectional area 
must not be less 
than 0.2 mm


2
. 


(Single pair required 
for Port 2)            
See Note 2 
 
If the host 
communication 
is network based, 
then use 
standard Cat 5 (or 
higher) network 
cable with standard 
RJ45 connectors 


None Port 1 from 
Controller to last 
Terminal on the bus  
must not exceed      
1 000 m 


Ensure that the 
shield is grounded 
at only one end of 
each run between 
Terminals 


ECII Port 1 - RS485 
Port 2 - RS485 


Twisted pair (multi-
stranded) shielded, 
with mylar sheath. 
Cross-sectional area 
must not be less 
than 0.2 mm


2
. 


(Single pair required 
for Port 2)            
See Note 2 
 
If the host 
communication is 
network based, then 
use 
standard Cat 5 (or 
higher) network 
cable with standard 
RJ45 connectors 


None Port 1 from RH to 
last Controller on the 
bus must not exceed 
1 000 m 


Ensure that the 
shield is grounded at 
only one end of each 
run between 
Controllers 


MDTA RS485 Twisted pair (multi-
stranded) shielded, 
with mylar sheath. 
Cross-sectional area 
must not be less 
than 0.2 mm


2
. 


(Single pair required 
for Port 1) 


None From Controller to 
last Terminal on the 
bus must not exceed 
1 000 m 


Ensure that the 
shield is grounded at 
only one end of each 
run between 
Terminals 


iTT Port 1 – RS485 Twisted pair (multi-
stranded) shielded, 
with mylar sheath. 
Cross-sectional area 
must not be less 
than 0.2 mm


2
. 


(Single pair required 
for Port 1) 
 
For network based 
communications, use 
standard Cat 5 (or 
higher) network 
cable with standard 
RJ45 connectors 


None Port 1 From 
Controller to last 
Terminal (iTT) on 
the bus must not 
exceed 1 000 m 


Ensure that the 
shield is grounded at 
only one end of each 
run between 
Terminals 
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Unit 
Communication 


Protocol 


Cable 
Shield 


Grounding Specification Supplied 
Maximum 


Length 


iTRT Port 1 – RS485 Twisted pair (multi-
stranded) shielded, 
with mylar sheath. 
Cross-sectional area 
must not be less 
than 0.2 mm


2
. 


(Single pair required 
for Port 1) 
 
For network based 
communications, use 
standard Cat 5 (or 
higher) network 
cable with standard 
RJ45 connectors 


None Port 1 From 
Controller to last 
Terminal (iTRT) on 
the bus must not 
exceed 1 000 m 


Ensure that the 
shield is grounded at 
only one end of each 
run between 
Terminals 


MfT Port 1 (Cont) – RS485 Twisted pair (multi-
stranded) shielded, 
with mylar sheath. 
Cross-sectional area 
must not be less 
than 0.2 mm


2
. 


(Single pair required 
for Port 1) 


None Port 1 From 
Controller to last 
Terminal (MfT) on 
the bus must not 
exceed 1 000 m 


Ensure that the 
shield is grounded at 
only one end of each 
run between 
Terminals 


ER Port 1 – RS485 Twisted pair (multi-
stranded) shielded, 
with mylar sheath. 
Cross-sectional area 
must not be less 
than 0.2 mm


2
. 


(Single pair required 
for Port 1) 


None Port 1 From 
Controller to last 
Terminal (ER) on the 
bus must not exceed 
1 000 m 


Ensure that the 
shield is grounded at 
only one end of each 
run between 
Terminals 


LR Port 1 – RS485 Twisted pair (multi-
stranded) shielded, 
with mylar sheath. 
Cross-sectional area 
must not be less 
than 0.2 mm


2
. 


(Single pair required 
for Port 1) 


None Port 1 From 
Controller to last 
Terminal (LR) on the 
bus must not exceed 
1 000 m 


Ensure that the 
shield is grounded at 
only one end of each 
run between 
Terminals 


O16 Port 1 – RS485 Twisted pair (multi-
stranded) shielded, 
with mylar sheath. 
Cross-sectional area 
must not be less 
than 0.2 mm


2
. 


(Single pair required 
for Port 1) 


None From Controller to 
last Terminal (O16) 
on the bus must not 
exceed 1 000 m 


Ensure that the 
shield is grounded at 
only one end of each 
run between 
Terminals 


I16 Port 1 – RS485 Twisted pair (multi-
stranded) shielded, 
with mylar sheath. 
Cross-sectional area 
must not be less 
than 0.2 mm


2
. 


(Single pair required 
for Port 1) 


None From Controller to 
last Terminal (I16) 
on the bus must not 
exceed 1 000 m 


Ensure that the 
shield is grounded at 
only one end of each 
run between 
Terminals 


ER or  LR 
Antenna 


Antennas use non-
standard protocols 


RG58 Multi-strand 
50 ohm coaxial cable 


5 m of black coaxial 
multi-strand cable 
with 2 pin connector 


5 m from ImproX 
Terminal to Antenna 


Not Required 


Antenna 
Readers 
(connect to 
iTT) MA, 
KA MHA,  
MMA, KHA, 
KMA, RA, 
CA, DPA 


Antenna Readers use 
non-standard protocols 


Shielded, multi-
strand, 3-pair twisted 
cable. Cross-
sectional cable area 
must be at least    
0.2 mm


2
 See Note 3 


None 16 m from Terminal Not Required 


Remote 
Readers 
(connect to 
iTRT, MfT, 
TA, iTA) 
MDR, 
MDK,  


Multi-mode Remote 
Readers use non-
standard protocols 


Shielded, multi-
strand, 2-pair twisted 
cable. Cross-
sectional cable area 
must be at least    
0.2 mm


2
 See Note 3 


None 10 m from Terminal Not Required 


Wiegand 
Readers 
(connect to 
iTRT, MfT, 
TA, iTA, 
RS, RH) 


Wiegand Readers use 
non-standard protocols 


Shielded, multi-
strand, 2-pair twisted 
cable. Cross-
sectional cable area 
must be at least    
0.2 mm


2
 See Note 3 


None 150 m from Terminal 
when connected to a 
12 V Power Supply 
Unit 


Not Required 


Table 2 – Cable Requirements Matrix 
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Low Voltage Power Supply to Controllers and Terminals 


Typical cable lengths are provided in Table 3. 


 


PSU Output 
Voltage 


Maximum Distance 
from PSU to Device Cable Specification 


10 V DC 10 m (32.81 ft) Conductors with a minimum cross-sectional area of 


0.5 mm
2
 (0.0008 in


2
) 


30 V DC 20 m (65.62 ft) Conductors with a minimum cross-sectional area of 


0.5 mm
2 
(0.0008 in


2
) 


Table 3 – Low Voltage Power Supply cable Requirements 


 


Digital Input Specifications 


Terminal Recommended Cable Detection Resistance Range 


ImproX iTT Single Pair < 5 kOhm 


ImproX iTRT Single Pair < 5 kOhm 


ImproX MfT Single Pair < 5 kOhm 


ImproX I16 Single Pair < 5.6 kOhm 


Table 4 – Digital Input Specifications 
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Input Voltage Requirements 


 


Power all units using a power limited, access control or burglar alarm power supply.  The power supply 


must provide the required voltage and current as stated, and provide a minimum 4-hour standby time. 


 


Comms Interfaces 


These units can be used to interface between the Host PC and its Controllers. 


 


Comms Interfaces Input Voltage 


ImproX RH and HI (For use with PC 


RS232 Comms Ports) 


10 V DC - 30 V DC 


Table 5 – Comms Interfaces - Input Voltage 


 


Enrollment Readers 


Enrollment Readers Input Voltage 


ProxMate, Utility ProxMate, ImproX RS 


and ImproX MDE 


5 V DC 


Table 6 – Enrollment Readers - Input Voltage 


 


 


The ProxMate and Utility ProxMate operate at 5 V DC.  However, they require a 6 V DC power supply,   


as the power supply connects to the 5 V DC, PC-interface junction-box connected to the ProxMate or 


ProxPal.   


 


 


The ImproX RS and ImproX MDE operate at 5 V DC, supplied by the PCs USB Port. 


 


Controllers 


Controllers Input Voltage 


ImproX IC, EC and ECII 10 V DC - 30 V DC 


Table 7 – Controllers - Input Voltage 


 


Terminals 


Terminals Input Voltage 


ImproX iTRT, iTT, TA, MfT, O16 and I16 10 V DC - 30 V DC 


ImproX MDTA 8 V DC – 14 V DC 


ImproX ER 10 V DC - 16 V DC 


ImproX LR 12 V DC 


Table 8 – Terminals - Input Voltage 
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ImproNet Hardware Components 


Interface Devices 


ImproNet supports the following types of interface devices connected to a Comms Server (Host 


PC): 


 


 ImproX HI 


 ImproX RH 


 ImproX RS 


 


 


The ImproX HI acts as an RS485 to RS232 converter.  The ImproX RH acts as an RS485 to USB 


converter.  Either device can connect to a Comms Server (Host PC). 


 


 


The ImproX RS has protocol conversion functionality.  However, this functionality is not used in an 


ImproNet System.  Therefore, in an ImproNet System, the ImproX RS is used only to interface third-


party Tag enrollment hardware. 


 


 


When used in a network implementation, the ImproX ECII Controller does not need the Interface 


Devices (mentioned above) for communication purposes.  The Interface Devices are only required for 


authentication of the ImproNet Software. 


 


Remote Readers 


Remote readers attach to ImproX iTRT, ImproX TA and ImproX MfT Terminals, providing them 


with proximity Tag-reading functionality. 


 


Controllers 


ImproNet supports the following Controller types: 


 


 ImproX IC (IXP300) 


 ImproX EC (IXP400 Ethernet Controller) 


 ImproX ECII (IXP400i Ethernet Controller) 


 


The main functional difference between the Controllers is memory size.  The EC and ECII 


Controllers have more memory than the IC Controller.  Therefore, the EC and ECII Controllers 


support more Tagholders and buffer more transactions.  They also support more Tagholder 


Access Groups than the IC Controller.  For details on differences between the Controllers, refer 


to Table 12 on page 35. 
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If a combination of ImproX IC, ImproX EC and ImproX ECII Controllers are used in the same System 


the limitations of the ImproX IC Controller apply.  The only exception is the number of transactions that 


each Controller can buffer. 


 


CCoonnttrroolllleerr  OOppeerraattiioonn  aanndd  FFuunnccttiioonnaalliittyy  


Controllers perform many functions in an ImproNet System.  However, the main functions are as 


follows: 


 Terminal Polling—Controllers poll Terminals for Transactions.  A Transaction is generated 


when a Tag or Card is read by a Terminal. 


 Making System Related Decisions—when a Controller receives a Transaction, the 


Controller decides whether to allow or deny access based on pre-defined information 


stored in its memory. 


When a transaction is processed, the Controller instructs the Terminal to execute Actions 


associated with the allowed or denied access Event.  The decision to grant a Tagholder 


access is made by the Controller only; the Terminal only passes Transaction data to the 


Controller.  If Controller communication with Terminals is disrupted, Terminals are disabled 


until communication is re-established. 


 Off-line Transaction Buffering—if the Controller is off-line (disconnected from the Host PC 


or Engine Software), the Controller buffers Transactions received from its Terminals.  When 


the Controller is back on-line, it is polled by the Engine and the stored transactions are 


downloaded to the Engine PC. 


 


Terminals 


There are four groups of ImproX Terminals in the ImproNet System; each has a different 


purpose.  The Terminal groups are as follows: 


 Tag Reading Terminals—provide a Tag reading function. 


 Non Tag-Reading Interface Terminals—provide Tag reading functions via attached 


Remote Readers, Antenna Readers, or other devices such as Biometric Readers and so 


on. 


 Non Tag-Reading Terminals—perform functions other than reading Tags.  For example, 


Building Management and or Lift (Elevator) Control. 


 Biometric Terminals—provide a fingerprint reading function. 


 


TTaagg  RReeaaddiinngg  TTeerrmmiinnaallss  


These are access readers for Locations (Doors and/or Lifts (Elevators)) and include Reader 


Terminals (such as the ImproX TA), and Remote Readers (such as the ImproX MDR). 


 


NNoonn  TTaagg--RReeaaddiinngg  IInntteerrffaaccee  TTeerrmmiinnaallss  


These include Terminals such as the ImproX iTT, ImproX MfT and ImproX iTRT. 
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NNoonn  TTaagg--RReeaaddiinngg  TTeerrmmiinnaallss  


Used for Building Management and Lift (Elevator) Control, and include the ImproX I16 and 


ImproX O16.   


 


BBiioommeettrriicc  TTeerrmmiinnaallss  


These are access readers for Locations (Doors) and include Terminals such as the ImproX     


B-SHO Fingerprint Terminal. 


 


 


During the Software Configuration Process, you must assign Terminals to a Door, a Lift (Elevator), or a 


Building Management function in accordance with installation wiring. 


 


Bus Types (ImproX IC) 


In an IXP400 System, there are two data bus types, that is the Host Bus and Terminal Bus. 


 


HHoosstt  BBuuss  ((CCoonnttrroolllleerr  PPoorrtt  22))  


The connection from the ImproX HI or ImproX RH to the ImproX IC Controller is known as the 


Host Bus.   


 


 


Connect the PC communications port via an RS232 to RS485 converter (ImproX HI) in to the ImproX 


EC Terminal Port 2 RS485 terminal block.  Alternatively, use the ImproX RH instead of the ImproX HI—


the ImproX RH functions as a USB to RS485 converter. 


 


 


The ImproX EC and ImproX ECII in effect use the LAN cabling as a communications bus. 


 


TTeerrmmiinnaall  BBuuss  ((CCoonnttrroolllleerr  PPoorrtt  11))  


The connection from the ImproX IC Controller to the other ImproX Terminals is known as the 


Terminal Bus and uses the RS485 bus protocol. 


 


System Hardware Combinations 


IIXXPP330000  


The IXP300 System includes the following hardware: 


 Up to16 ImproX IC Controllers. 


 Each IC Controller supports up to 16 Locations, with a maximum of three Fixed Addresses 


per location.  The most commonly used Terminals for door access are the ImproX TA, 


ImproX iTT, ImproX iTRT and ImproX MfT. 


 ImproX TA – 2 Fixed Addresses (if a Remote is connected) 


 ImproX iTT – 2 Fixed Addresses 


 ImproX iTRT – 2 Fixed Addresses 


 ImproX MfT – 3 Fixed Addresses 


 Optional Terminals that may be used for Building Management functions, are the ImproX 


O16 and ImproX I16. 
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 A maximum of five O16 Terminals may be coupled per Lift (Elevator) for Lift (Elevator) 


Control (if Lift (Elevator) Control is implemented), with one ImproX Reader per Lift 


(Elevator). 


 


IIXXPP440000  


The IXP400 System includes the following hardware: 


 Up to 64 ImproX EC Controllers. 


 Each EC Controller supports up to 64 Terminal Fixed Addresses.  The most commonly 


used Terminals for door access are the ImproX TA, ImproX iTT, ImproX iTRT and  


ImproX MfT. 


 ImproX TA – 2 Fixed Addresses (if a Remote is connected) 


 ImproX iTT – 2 Fixed Addresses 


 ImproX iTRT – 2 Fixed Addresses 


 ImproX MfT – 3 Fixed Addresses 


 Optional Terminals that may be used for Building Management functions are the       


ImproX O16 and ImproX I16. 


 A maximum of five O16 Terminals may be coupled per Lift (Elevator) for Lift (Elevator) 


Control (if Lift (Elevator) Control is implemented), with one ImproX Reader per Lift 


(Elevator). 


 


 


If a single Terminal (with a single Fixed Address) only, is allocated to a Location, it is possible for the 


Controller to support 64 Locations. 


 


IIXXPP440000ii  


The IXP400i System includes the following hardware: 


 Up to 64 ImproX ECII Controllers. 


 Each ECII Controller supports up to 64 Terminal Fixed Addresses.  The most commonly 


used Terminals for door access are the ImproX TA, ImproX iTT, ImproX iTRT and  


ImproX MfT. 


 ImproX TA – 2 Fixed Addresses (if a Remote is connected) 


 ImproX iTT – 2 Fixed Addresses 


 ImproX iTRT – 2 Fixed Addresses 


 ImproX MfT – 3 Fixed Addresses 


 Optional Terminals that may be used for Building Management functions are the       


ImproX O16 and ImproX I16. 


 A maximum of five O16 Terminals may be coupled per Lift (Elevator) for Lift (Elevator) 


Control (if Lift (Elevator) Control is implemented), with one ImproX Reader per Lift 


(Elevator). 


 


 


If a single Terminal (with a single Fixed Address) only, is allocated to a Location, it is possible for the 


Controller to support 64 Locations. 
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ImproX Units for use in an IXP300, IXP400 or IXP400i System 


IInntteerrffaaccee  DDeevviicceess  


Unit Description Part Number 


ImproX HI  Host Interface XHI900-0-0-GB-XX 


ImproX RH Registration Interface XRH900-1-0-GB-XX 


ProxMate Tag Reader with RS232 connection XPM901-1-0-GB-XX 


ImproX RS Registration Interface XRS902-1-0-GB-XX 


ImproX RRA Antenna Reader for the ImproX RH and RS XPR901-1-0-GB-XX 


ImproX RRM Enrollment Reader for the ImproX RH and RS XRM901-4-0-GB-XX 


ImproX MDE Multi-discipline Enrollment Reader MDE900-5-0-GB-XX 


ImproX B-SHO ImproX B-SHO Enrollment Reader IBT900-4-0-GB-XX 


IBT902-0-0-GB-XX 


 


 


Only use the B-SHO Fingerprint Enrollment Reader in conjunction with the ImproX ECII Controller. 


 


 


The ImproX RS has protocol-conversion functionality.  However, this functionality is not used in an 


ImproNet System.  Therefore, the ImproX RS is used only to interface third-party Tag Enrollment 


hardware. 


 


CCoonnttrroolllleerrss  


Unit Description Part Number 


ImproX IC Controller in the ImproNet System (IXP300). This 


standard Controller supports connection of up to 


48 Terminal Fixed Addresses 


XIC900-1-0-GB-XX 


ImproX EC Ethernet Advanced Controller in the ImproNet 


System (IXP400).  The Ethernet Advanced 


Controller supports connection of  up to 64 


Terminal Fixed Addresses 


XAC906-1-0-GB-XX 


ImproX ECII Ethernet Controller in the ImproNet System 


(IXP400i).  The Ethernet Controller supports 


connection of up to 64 Terminal Fixed Addresses 


XEC900-0-0-GB-XX 


 


TTeerrmmiinnaallss  


Unit Description Part Number 


ImproX ER Extended Range Terminal  XER901-3-0-GB-XX 


ImproX LR Long Range Terminal XLR900-1-0-GB-XX 


ImproX MfT Multi-function Terminal XEA931-1-0-GB-XX 


IPS930-1-0-GB-XX 


ImproX I16 Input Terminal providing 16 digital inputs XIT900-0-0-GB-XX 


ImproX O16 Output Terminal providing 16 relay outputs XOT900-0-0-GB-XX 


ImproX TA Time Attendance Terminal XTA902-1-0-GB-XX 


ImproX iTRT Intelligent Twin Reader Terminal XRT910-0-0-GB-XX  


XRT920-0-0-GB-XX 


IPS920-0-0-GB-XX 


IPS921-0-0-GB-XX 
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Unit Description Part Number 


ImproX iTT Intelligent Twin Antenna Terminal XTT910-1-0-GB-XX  


XTT920-1-0-GB-XX 


IPS910-1-0-GB-XX 


IPS911-1-0-GB-XX 


ImproX MDTA Multi-discipline Time Attendance Terminal XTA920-5-0-GB-XX 


XTA921-5-0-GB-XX 


ImproX DBv 125 kHz Vertical Mount Drop Box XDB902-1-0-GB-XX 


XDB903-1-0-GB-XX 


ImproX DBv 13.56 MHz Vertical Mount Drop Box XDB904-4-0-GB-XX 


XDB905-4-0-GB-XX 


ImproX B-SHO ImproX B-SHO Fingerprint Terminal IBT910-4-0-GB-XX 


ImproX B-SHO ImproX B-SHO Keypad Fingerprint Terminal IBT920-4-0-GB-XX 


 


 


Only use B-SHO Fingerprint Terminals in conjunction with the ImproX ECII Controller. 


 


AAnntteennnnaa  RReeaaddeerrss    


These Readers are also used with other compatible units – see the section entitled Remote 


Reader and Antenna Reader Compatibility. 


 


Unit Description Part Number 


ImproX MMA Mullion Antenna Reader XTT901-1-0-GB-XX 


ImproX MA Micro Antenna Reader XTT902-1-0-GB-XX 


ImproX MHA Metal Antenna Reader XTT903-1-0-GB-XX 


ImproX KHA Metal Keypad Antenna Reader XTT904-1-0-GB-XX 


ImproX KMA Mullion Keypad Antenna Reader XTT905-1-0-GB-XX 


ImproX RA Rod Antenna Reader XTT906-1-0-GB-XX 


ImproX KA Keypad Antenna Reader XTT907-1-0-GB-XX 


ImproX DPA Door Entry Panel Antenna Reader XTT908-1-0-GB-XX 


ImproX CA Conduit Antenna Reader XTT909-1-0-GB-XX 


ImproX AMR Antenna Metal Reader XTT951-1-0-GB-XX 


ImproX AMK Antenna Metal Keypad Reader XTT952-1-0-GB-XX 


 


RReemmoottee  RReeaaddeerrss    


These Readers are used with the ImproX iTRT, MfT and TA as well as other compatible units – 


see the section entitled Remote Reader and Antenna Reader Compatibility. 


 


Unit Description Part Number 


ImproX MDR Multi-discipline Reader MDR900-5-0-GB-XX 


ImproX MDK Multi-discipline Keypad Reader MDK900-5-0-GB-XX 


ImproX XFMp Multi-mode 13.56 MHz Remote Reader – plastic, 


no keypad  


XRT901-4-0-GB-XX 


ImproX XFMpk Multi-mode 13.56 MHz Remote Reader – plastic, 


keypad 


XRT902-4-0-GB-XX 


ImproX XFMm Multi-mode 13.56 MHz Remote Reader – metal, 


no keypad 


XRT903-4-0-GB-XX 
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Unit Description Part Number 


ImproX XFMmk Multi-mode 13.56 MHz Remote Reader – metal, 


keypad 


XRT904-4-0-GB-XX 


 


WWiieeggaanndd  RReeaaddeerrss    


These Readers are used with the ImproX iTRT, MfT, TA, iTA, RS and RH. 


 


Unit Description Part Number 


Wiegand Plastic Non-keypad 125 kHz Passive Proximity Reader WPR900-1-0-GB-XX 


Wiegand Plastic Keypad 125 kHz Passive Proximity Reader WPK900-1-0-GB-XX 


Wiegand Metal Non-keypad 125 kHz Passive Proximity Reader WMR900-1-0-GB-XX 


Wiegand Metal Keypad 125 kHz Passive Proximity Reader WMK900-1-0-GB-XX 


 


RReecceeiivveerrss  


 


 


Receivers are treated as Remote Readers by the System. 


 


 


Unit Description Part Number 


ImproX IR Infrared Receiver ITR900-0-0-GB-XX 


ITR901-0-0-GB-XX 


ImproX RF 4-Channel UHF Receiver UHR903-0-1-GB-XX 


 


OOtthheerr  


Unit Description Part Number 


ImproX OSCAR ImproX OSCAR Door Control Unit IBT930-0-0-GB-XX 


Table 9 – ImproX Units Compatible with the IXP300,  IXP400 or IXP400i Systems 


 


 


Other IXP300 AND IXP400-compatible units are under development. 


 


RReemmoottee  RReeaaddeerr  aanndd  AAnntteennnnaa  RReeaaddeerr  CCoommppaattiibbiilliittyy  


Some ImproX units are designed to interface with several types of Remote and/or Antenna 


Readers. These are listed here. 


 


Unit Interfaces With 


ImproX MfT One Third-party device and two ImproX Antenna Readers  


or two ImproX Remote Readers 


or one Wiegand Reader and two ImproX Antenna Readers 


ImproX iTRT Two ImproX Remote Readers 


or two ImproX Receivers 


or two Third-party hardware devices 


or two Wiegand Readers 


ImproX iTT Two ImproX Antenna Readers 


ImproX TA One Remote Reader  
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Unit Interfaces With 


or one Receiver  


or one third-party hardware device 


or one Wiegand Reader 


ImproX DBv 125 kHz One ImproX Antenna Reader 


ImproX DBv 13.56 MHz One ImproX Remote Reader 


or one ImproX Receiver 


or one Third-party hardware device 


or one Wiegand Reader 


Table 10 – Remote Reader and Antenna Reader Compatibility 


 


System Size Limits 


This list provides details of a maximum system using ImproX IC, ImproX AC, ImproX EC or 


ImproX ECII Controllers. 


 


 


If a Site uses a combination of Controllers, it is limited by the lowest Controller’s parameters.  Only the 


number of transaction types that each Controller can buffer is independent.   


 


For Systems with preinstalled ImproX EC’s or IC’s, on addition of the ECII ensure the Systems configured 


for NO cross-controller communications (including Interleading Zone Routing). 


 


 


Table 11 – System Configuration Parameters  
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Table 12 – System Configuration Parameters (continued) 


 


 


Note 1—Up to 9 000 buffered transactions in the Controller Transaction Buffer at one time. 


 


 


Note 2—This amount is relative to the number of Tags in the ImproNet Database, and the number of 


memory modules in the Controller. 


 


 


Note 3—A Terminal with two Fixed Addresses, such as the ImproX iTT, is treated as two separate 


Terminals. In the same way, a Terminal with 3 Fixed Addresses (that is the ImproX MfT), is treated as 


three Terminals by the Software. 


 


 


Note 4—In Anti-passback (APB) Mode, two Terminals per Location are required.  Therefore, if all 


locations are in Anti-passback (APB) Mode, the limit is 64 Locations per ImproX EC—assuming all 


Terminals have a single Fixed Address.   


 


 


Note 5—The ImproX ECII Controller generally has the same features as the ImproX EC Controller.  


However, the ImproX ECII does support more advanced functionality not supported in the EC. 


 


 


Note 6—All figures provided are the maximum. In some cases interdependence between parameters; 


that is the maximum number of Zones per Controller depends on how many Terminals are used per 


Location. 


 


 


Note 7—When using IXP300 or IXP400, we recommend a maximum of 6 Lifts (Elevators).  This 


enables one Access Group per Tag for normal access control requirements.  A maximum of 80 floors 


per Lift (Elevator) is supported. 


 


 


Note 8—When using IXP400i, we recommend a maximum of 15 Lifts (Elevators).  A maximum of 80 


floors per Lift (Elevator) is supported. 
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Installation Information 


Doors and Zones 


Each Location supports up to three Fixed Addresses. 


 


 


The ImproX IC Controller supports a maximum of 48 Terminal Fixed Addresses.  However, if each 


Location uses 3 Terminals, the ImproX IC Controller can only support 16 Locations. 


 


The ImproX EC and ECII support a maximum of 64 Terminal Fixed Addresses.  However, if each 


Location uses 3 Terminals, the Controller can only support 21 Locations. 


 


 


Anti-passback (APB) Mode requires two Readers at each Location at which Anti-passback (APB) is 


required.  Each Location can have its own Zone, or a number of Locations can be grouped together to 


form an Anti-passback (APB) Zone.  Anti-passback (APB) Zones are set-up during configuration of an 


IXP300, IXP400 or IXP400i System. 


 


Addressing Scheme 


Each ImproX Controller and Terminal has two types of addresses:   A Logical Address and a 


Fixed Address.  The following process is performed when the Auto-ID function in the ImproNet 


Engine Software is run: 


 


1. The Engine polls all Controllers. 


2. The Controllers poll their Terminals to request their unique Fixed Addresses. 


3. The ImproNet Software assigns a unique Logical Address to each detected Controller and 


Terminal. 


 


LLooggiiccaall  AAddddrreesssseess  


A Logical Address is a unique, hexadecimal address assigned by ImproNet Engine to each 


Controller and Terminal in a System.  Logical Addresses are used to identify hardware units and 


are stored in each unit’s non-volatile memory.  The process of assigning Logical Addresses to 


all units (called Auto-ID) is required on initial System start-up, or when adding additional units, 


or when replacing units. 


 


 


Hardware cannot be configured until it is physically connected to the PC via the serial port (when 


ImproX HI is used) or to the USB port (if an ImproX RH is used).  Data cannot be entered until the 


hardware units have been identified and assigned Addresses using the Auto-ID process in the Engine. 


 


FFiixxeedd  AAddddrreesssseess  


 


 


Each ImproX iTT, ImproX TA and ImproX iTRT has two Fixed Addresses.  Therefore, ImproNet 


operates each unit as two separate Terminals. 







Part 1 – Hardware 


January 2012                                                                                                                                                     37 


A Fixed Address is a unique address allocated to each ImproX unit during manufacture.  All 


ImproX Terminals are programmed with an eight-digit unique Address.  


 


ImproX iTT and ImproX MfT 


The ImproX iTT and ImproX MfT (Firmware V7.18 or above) operate under the following rules: 


 If you have no Antenna Readers connected to the Terminal, the Terminal reveals both 


Fixed Addresses.  This is because the Terminal is most likely being used for non-tag-


reading applications. 


 If only Antenna Reader 1 is connected to the Terminal, it only reveals Antenna Reader 1’s 


Fixed Address. 


 If you connected both Antenna Readers, the Terminal reveals both Fixed Addresses. 


 If you connected only Antenna Reader 2, the Terminal reveals both Fixed Addresses. 


 


So, if you’re only using one Antenna Reader, then use Antenna Reader 1.  The Terminal reveals 


only one Fixed Address.  In all other arrangements the Terminal reveals two Fixed Addresses. 


 


You may override this Firmware feature on a site by using ImproNet Engine. This is however 


complex, and not recommended.  Please contact the Support Department if you wish to do this. 


 


RReeccoorrddiinngg  IInnssttaallllaattiioonn  IInnffoorrmmaattiioonn  


 


 


It is very important that installation information is always kept up to date, that details of changes 


are recorded, and that Unit Location Charts are identified and dated clearly to avoid confusion of old 


and new information. Old sheets can be stored separately so that a record of changes is maintained for 


reference. The same care must be taken with System cabling diagrams. 


 


This following procedure is required by ImproNet Software Operators when they configure the System. 


 


 


The Unit Location Chart is included with all ImproX Controllers.  An adhesive label displaying the 


unit’s Fixed Address is included with every unit—stick this label onto the Unit Location Chart. 


 


When you install ImproX Controllers, Terminals or Remote Readers, you must record the 


following information on the Unit Location Chart: 


 


 The unit’s name 


 


 


Consistent naming of units and their locations is important.  Use this description during configuration 


when naming units in the Graphic User Interface (GUI). 


 


 The unit’s Fixed Address(es) (record the Fixed Address before attaching a unit to its 


mounting surface). 


 The unit’s direction—Entry or Exit 


 The unit type 


 An accurate description of the unit’s location 
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Positioning Units 


Information on the Unit Location Chart(s) must correspond with the cable layout diagram(s) or 


Site Plan(s) drawn up for the Site.  This enables you to trace units and find faults.  


 


Attach each unit to the wall or other mounting surface as stated in its individual Installation 


Manual.  All covers must be attached and in place at all times once installation is complete. 


 


 


Fit Arc Suppression Circuitry to all unit relay outputs at Locations where the units drive Strike Locks or 


Magnetic Locks.  25 Vrms, 500 A, 77 V max clamping Metal Oxide Varistors can be used. 


Guidelines are provided in the individual Hardware Installation Manuals. 


 


 


The configuration shown in Figure 14 does not support inter-controller communications. 


 


 
Figure 14 – IXP400 Interconnection Diagram 1 
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Figure 15 – IXP400 Interconnection Diagram 2 
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Hardware Maintenance 


Maintenance Overview 


Periodic hardware maintenance ensures that units run efficiently and that problems requiring 


attention are noted. 


 


 


Impro Technologies does not support on-site repairs.  Should an ImproX unit fail, return it to your local 


Impro Distributor.  They will repair or replace the unit. 


 


Maintenance Tools 


HHaarrddwwaarree  TToooollss  


 


 


Do not use water, detergents, or other chemicals when cleaning inside an ImproX unit. 


 


 Cleaning Unit Housings—wipe unit housings with a damp, lint-free cloth.  Do not use 


detergents or solvents.  


 Cleaning Inside the Unit—use a high-pressure air hose to clean inside ImproX units.   


 


SSooffttwwaarree  TToooollss  


Ethernet Configuration Utility 


Use the Ethernet Configuration Utility to find ImproX EC Controllers on the network and 


assign Controller IP Addresses.  To open the Ethernet Configuration Utility, proceed as follows: 


 


In Windows®, click Start>Programs>ImproNet>Utils>Ethernet Configuration Utility. 


 


 
Figure 16 – Ethernet Configuration Utility 


 


Ethernet Discovery Utility 


Use the Ethernet Discovery Utility to find ImproX ECII Controllers on the network and assign 


Controller IP Addresses.  To open the Ethernet Discovery Utility, proceed as follows: 


 


In Windows®, click Start>Programs>ImproNet>Utils>Ethernet Discovery Utility. 
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Figure 17 – Ethernet Discovery Utility 


 


Firmware Upgrade Utility 


The Firmware Upgrade Utility offers the following maintenance and fault-detection options: 


 Ping Test—indicates the installed ImproX hardware communicating on the communications 


busses.  The Ping Test detects the communications interface, Controllers and Terminals.  


Refer to the Firmware Upgrade information in Part 8 of this manual for more information. 


 Comms Test—determines the quality of communications on the Controller (Host) 


communications bus (Port 2), and Terminal communications bus (Port 1).  To prevent 


potential communications errors, tested units should return a pass of 100 %.  A pass rate 


less than 100 % indicates potential problems with the hardware or communications media. 


 


Performing a Comms Test 


 


 


Perform a Ping Test BEFORE you run a Comms Test. (See the section Hardware Testing on page 42). 


 


1. Start the Firmware Upgrade Utility from Start>Programs>ImproNet>Utils>Firmware 


Upgrade. 


2. Select the System Tools tab (as shown in Figure 18). 


 


 
Figure 18 – Firmware Upgrade (System Tools) 
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 The No. of Cycles field specifies the number of times that the Comms Test cycles through 


sending and receiving data packets from units. 


 The Test (std) button displays the Comms Test window in a simple format. 


 The Test (Adv) button displays the Comms Test window in a detailed grid format. 


 


Hardware Testing 


CCoommmmuunniiccaattiioonnss  


 Ping Test—used to test whether a connection between units or the Host PC is present.  


Details are provided for each unit in the Specific Maintenance section below. 


 Onboard diagnostic LEDs—units display communication status via onboard LEDs.  This is 


useful if you are working on the unit or do not have access to the Host PC. 


 


TTaagg  RReeaaddiinngg  


Test the read range of a Reader by presenting a Tag from a distance and moving it closer to the 


Reader.  When the Tag is read, the Reader beeps or flashes its LED depending on its features 


and settings (these parameters can be set up during Access software configuration – refer to 


Part 3 of this manual for more information). 


  


BBuuzzzzeerr  


Units with Buzzers make a beep sound on presentation of a Tag.  However, the Buzzer must 


have previously been enabled via the ImproNet Access Software Application. 


 


LLEEDDss  


Some ImproX hardware devices have onboard LEDs that indicate the communication, input, 


and relays status.  LEDs are useful in-field diagnostic tools when the Host PC is unavailable or 


distant from the unit.  Various diagnostic options are discussed later in Part 1. 


 


Specific Maintenance 


IImmpprrooXX  RRHH  


 Ping Test—use the Firmware Upgrade Utility to run a Ping Test.  Ensure that the unit 


responds. 


 Comms Test—use the Firmware Upgrade Utility to run a Comms Test.  This ensures that 


communication between the unit and Host PC is present. 


 Diagnostic LEDs: 


 USB LED illuminates when ImproNet Engine is polling 


 RS485 LED illuminates when communication is established between the Controller and 


the ImproX RH. 


 POST Test—on power-up, the Controller automatically runs a Power-on Self-test (POST).  


During this test, the diagnostic LEDs indicate the unit’s status. 
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Figure 19 – ImproX RH Diagnostic LEDs 


 


IImmpprrooXX  RRRRAA  oorr  IImmpprrooXX  RRRRMM  


 Tag Reading Test  


 place a Tag on the unit 


 In ImproNet Access, create a new Tagholder 


 Select Read Tag (The Tag’s number displays in the Tag Code textbox) 


 POST Test—on power-up, the Reader automatically runs a Power-on Self-test (POST).  


During this test, the LED changes from Red to Green and the Buzzer beeps when a Tag is 


read. 


 


IImmpprrooXX  IICC  


 Ping Test—use the Firmware Upgrade Utility to run a Ping Test.  Ensure that the 


Controller responds. 


 Comms Test—use the Firmware Upgrade Utility to run a Comms Test.  This ensures that 


communication between the Controller and Host PC is present. 


 Onboard LEDs—provide real-time indication of communication status for Port 1 (Terminal) 


and Port 2 (Controller) communications busses.  When you have configured the attached 


Terminals in ImproNet Access, LEDs 2, 3, 4, and 5 are permanently on. 


 LEDs 2 and 3 indicate that the Controller is sending and receiving information from its 


Terminals.  Intermittently flashing LEDs indicate potential communication problems; 


probable causes are bad wiring, induced noise on the communications bus, or faulty 


Terminals on the communications bus. 







Part 1 – Hardware 


44  January 2012 


 LEDs 4 and 5 indicate the Controller communications bus state.  If both LEDs are on, 


there is good communication between the ImproX HI and the ImproX RH.  The LEDs 


are off if the ImproX HI or RH is off-line. 


 Power LED—remove power from the unit.  Reconnect power to the unit – the power LED 


illuminates when sufficient voltage is available. 


 


 
Figure 20 – ImproX IC Diagnostic LEDs 


 


IImmpprrooXX  EECC  


 Assign IP Addresses—use the Ethernet Configuration Utility to find ImproX EC 


Controllers on the network and assign the Controllers IP Addresses. 


 Ping Test—use the Firmware Upgrade Utility to run a Ping Test.  Ensure that the 


Controller responds. 


 Comms Test—use the Firmware Upgrade Utility to run a Comms Test.  This ensures that 


communication between the Controller and Host PC is present. 


 Onboard LEDs—provide real-time indication of communication status for Port 1 (Terminal) 


and Port 2 (Host) communications busses.  When you have configured the attached 


Terminals in ImproNet Access, LEDs 1, 2, 3, and 4 will be permanently on. 


 LEDs 1 and 2 indicate that the Controller is sending and receiving information from its 


Terminals via the Terminal Bus.  Intermittently flashing LEDs indicate potential 


communication problems; probable causes are faulty wiring, induced noise on the 


Terminal Bus, or faulty Terminals on the Terminal Bus. 


 LEDs 3 and 4 indicate the Controller communications bus state.  If both LEDs are on, 


there is good communication between the Controller and the ImproNet System.  The 


LEDs will be off if the ImproX EC
  
is off-line. 
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Figure 21 – ImproX EC Diagnostic LEDs 


 


IImmpprrooXX  EECC
IIII
  


 Assign IP Addresses—use the Ethernet Discovery Utility to find ImproX ECII Controllers 


on the network and assign the Controllers IP Addresses. 


 Ping Test—use the Firmware Upgrade Utility to run a Ping Test.  Ensure that the 


Controller responds. 


 Comms Test—use the Firmware Upgrade Utility to run a Comms Test.  This ensures that 


communication between the Controller and Host PC is present. 


 Onboard TCP/IP LEDs 1, 2 and 3—provide a real-time indication of Link Speed, Duplex 


Mode and Link Active status of the Controller. 


 Onboard Power LED 4—indicates whether power has been applied to the Controller. 


 Onboard CPU Diagnostic LEDs—provide a real-time indication of the status of the CPU 


 CPU Usage LED 5 indicates when ON that the CPU is idle, and when OFF that the 


CPU is busy. 


 CPU Running LED 6 indicates when ON that the CPU is running, and when OFF that 


the CPU is not running. 


 CPU Fault LED 7 indicates when ON that a fault condition exists with the CPU, and 


when OFF that the CPU is OK. 


 Onboard RS485 LEDs—provide real-time indication of communication status for RS485 1 


(Controller) and RS485 2 (Terminal) communications busses.  When you have configured 


the attached Terminals in ImproNet Access, LEDs 14, 15, 16 and 17 remain permanently 


on. 


 RS485 (1) LEDs 8 and 9 indicate the Controller Comms Bus state.  If both LEDs are on, 


there is good communication between the Controller and the ImproNet System.  The 


LEDs are off if the ImproX ECII is off-line. 
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 RS485 (2) LEDs 10 and 11 indicate that the Controller is sending and receiving 


information from its Terminals via the Terminal Bus.  Intermittent flashing of LEDs 16 


and 17 indicate potential communication problems; probable causes are faulty wiring, 


induced noise on the Terminal Bus, or faulty Terminals on the Terminal Bus. 


 


 
Figure 22 – ImproX ECII Diagnostic LEDs 


 


IImmpprrooXX  MMffTT  


 Ping Test—use the Firmware Upgrade Utility to run a Ping Test.  Ensure that the 


Terminal responds. 


 Comms Test—use the Firmware Upgrade Utility to run a Comms Test.  This ensures that 


communication between the Terminal and Controller is present. 
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 POST Test—on power-up, the Terminal automatically runs a Power-on Self-test (POST).  


Power-on Self-test (POST) tests the RAM and Flash Checksums, and the Read/Write 


Circuitry.  The results of the Power-on Self-test (POST) are available as diagnostic 


information from the Controller or PC. 


 If a parameter fails, the Antenna Reader emits a continuous beep for 2 seconds. 


 When the Power-on Self-test (POST) is complete, the Terminal emits two short beeps. 


 Onboard Diagnostic LEDs—these indicate the status of: 


 RS485 Rx and Tx 


 Test Mode—tests Readers attached to ImproX MfT.  This mode indicates when a Tag is in 


range and being read by the Antenna Reader. 


  


To access Test Mode: 


3. Remove the RS485 communications cable from the ImproX MfT. 


4. Wait for approximately 10 seconds until the Red LED on the Antenna Reader attached to 


the ImproX MfT flashes intermittently. 


5. Present a Tag to the Antenna Reader. 


6. When the Tag is read the LED changes to solid RED and the Buzzer emits a continuous, 


long beep while the Tag is in range. 


 


Use this procedure to verify that an Antenna Reader is reading a Tag, or to determine the Tag 


reading range. 


 


 
Figure 23 – ImproX MfT Diagnostic LEDs 


 


IImmpprrooXX  iiTTTT  


 Ping Test—use the Firmware Upgrade Utility to run a Ping Test.  Ensure that the 


Terminal responds. 
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 Comms Test—use the Firmware Upgrade Utility to run a Comms Test.  This ensures that 


communication between the Terminal and Controller is present. 


 POST Test—on power-up, the Terminal automatically runs a Power-on Self-test (POST).  


Power-on Self-test (POST) tests the RAM and Flash Checksums, and the Read/Write 


Circuitry.  The results of the Power-on Self-test (POST) are available as diagnostic 


information from the Controller or PC. 


 If a parameter fails, the Antenna Reader emits a continuous beep for 2 seconds. 


 When the Power-on Self-test (POST) is complete, the Terminal emits two short beeps. 


 Onboard Diagnostic LEDs—these indicate the status of: 


 Ethernet Communications 


 RS485 Rx and Tx 


 Reader 1 and 2, Input 1 and 2 


 Relay 1 and 2 


 Test Mode—Tests Readers attached to ImproX iTT.  This mode indicates when a Tag is in 


range and being read by the Antenna Reader. 


 


To access Test Mode: 


1. Remove the RS485 communications cable from the ImproX iTT. 


2. Wait for approximately 10 seconds until the Red LED on the Antenna Reader attached to 


the ImproX iTT flashes intermittently. 


3. Present a Tag to the Antenna Reader. 


4. When the Tag is read the LED changes to solid RED and the Buzzer emits a continuous, 


long beep while the Tag is in range. 


 


Use this procedure to verify an Antenna Reader is reading a Tag, or to determine the Tag 


reading range. 


 


 
Figure 24 – ImproX iTT Diagnostic LEDs 
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IImmpprrooXX  iiTTRRTT  


 Ping Test—use the Firmware Upgrade Utility to run a Ping Test.  Ensure that the 


Terminal responds. 


 Comms Test—use the Firmware Upgrade Utility to run a Comms Test.  This ensures that 


communication between the Terminal and Controller is present. 


 POST Test—on power-up, the Terminal automatically runs a Power-on Self-test (POST).  


Power-on Self-test (POST) tests the RAM and Flash Checksums, and the Read/Write 


Circuitry.  The results of the Power-on Self-test (POST) are available as diagnostic 


information from the Controller or PC. 


 If a parameter fails, the Reader emits a continuous beep for 2 seconds. 


 When the Power-on Self-test (POST) is complete, the Terminal emits two short beeps. 


 Onboard Diagnostic LEDs—these indicate the status of: 


 Ethernet Communications 


 RS485 Rx and Tx 


 Reader 1 and 2, Input 1 and 2 


 Relay 1 and 2 


 Test Mode—Tests Readers attached to ImproX iTRT.  This mode indicates when a Tag is 


in range and being read by the Reader. 


  


To access Test Mode: 


1. Remove the communications cable from the ImproX iTRT. 


2. Wait for approximately 10 seconds until the Red LED on the Reader attached to the ImproX 


iTRT flashes intermittently. 


3. Present a Tag to the Reader. 


4. When the Tag is read the LED changes to solid RED and the Buzzer emits a continuous, 


long beep while the Tag is in range. 


 


Use this procedure to verify a Reader is reading a Tag, or to determine the Tag reading range. 


 


 
Figure 25 – ImproX iTRT Diagnostic LEDs 
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IImmpprrooXX  MMDDTTAA  MMuullttii--ddiisscciipplliinnee  TTiimmee  AAtttteennddaannccee  TTeerrmmiinnaall  


 Ping Test—use the Firmware Upgrade Utility to run a Ping Test.  Ensure that the 


Terminal responds. 


 Comms Test—use the Firmware Upgrade Utility to run a Comms Test.  This ensures that 


communication between the Terminal and Controller is present. 


 POST Test—on power-up, the Terminal automatically runs a Power-on Self-test (POST).  


Power-on Self-test (POST) tests the RAM and Flash Checksums, and the Read/Write 


Circuitry.  The results of the Power-on Self-test (POST) are available as diagnostic 


information from the Controller or PC. 


 If a parameter fails, the Terminal emits a continuous beep for 2 seconds. 


 When the Power-on Self-test (POST) is complete, the Terminal emits two short beeps. 


 


 
Figure 26 – ImproX MDTA LEDs 


 


IImmpprrooXX  DDBBvv  112255  kkHHzz  VVaarriiaanntt  


 Ping Test—use the Firmware Upgrade Utility to run a Ping Test.  Ensure that the 


Terminal responds. 


 Comms Test—use the Firmware Upgrade Utility to run a Comms Test.  This ensures that 


communication between the Terminal and Controller is present. 


 POST Test—on power-up, the Terminal automatically runs a Power-on Self-test (POST).  


Power-on Self-test (POST) tests the RAM and Flash Checksums, and the Read/Write 


Circuitry.  The results of the Power-on Self-test (POST) are available as diagnostic 


information from the Controller or PC. 


 If a parameter fails, the Antenna Reader emits a continuous beep for 2 seconds. 


 When the Power-on Self-test (POST) is complete, the Terminal emits two short beeps. 
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 Onboard Diagnostic LEDs—these indicate the status of: 


 RS485 Rx and Tx 


 Reader 1 and 2, Input 1 and 2 


 Relay 1 and 2 


 Test Mode—tests Readers attached to ImproX DBv.  This mode indicates when a Tag is in 


range and being read by the Antenna Reader. 


 


To access Test Mode: 


1. Remove the RS485 communications cable from the ImproX DBv. 


2. Wait for approximately 10 seconds until the Red LED on the Antenna Reader attached to 


the ImproX DBv flashes intermittently. 


3. Present a Tag to the Antenna Reader. 


4. When the Tag is read the LED changes to solid RED and the Buzzer emits a continuous, 


long beep while the Tag is in range. 


 


Use this procedure to verify that an Antenna Reader is reading a Tag, or to determine the Tag 


reading range. 


 


IImmpprrooXX  DDBBvv  1133..5566  MMHHzz  VVaarriiaanntt  


 Ping Test—use the Firmware Upgrade Utility to run a Ping Test.  Ensure that the 


Terminal responds. 


 Comms Test—use the Firmware Upgrade Utility to run a Comms Test.  This ensures that 


communication between the Terminal and Controller is present. 


 POST Test—on power-up, the Terminal automatically runs a Power-on Self-test (POST).  


Power-on Self-test (POST) tests the RAM and Flash Checksums, and the Read/Write 


Circuitry.  The results of the Power-on Self-test (POST) are available as diagnostic 


information from the Controller or PC. 


 If a parameter fails, the Reader emits a continuous beep for 2 seconds. 


 When the Power-on Self-test (POST) is complete, the Terminal emits two short beeps. 


 Onboard Diagnostic LEDs—these indicate the status of: 


 RS485 Rx and Tx 


 Reader 1 and 2, Input 1 and 2 


 Relay 1 and 2 


 Test Mode—tests Readers attached to ImproX DBv.  This mode indicates when a Tag is in 


range and being read by the Reader. 


  


To access Test Mode: 


1. Remove the RS485 communications cable from the ImproX DBv. 


2. Wait for approximately 10 seconds until the Red LED on the Reader attached to the ImproX 


DBv flashes intermittently. 


3. Present a Tag to the Reader. 


4. When the Tag is read the LED changes to solid RED and the Buzzer emits a continuous, 


long beep while the Tag is in range. 


 


Use this procedure to verify that a Reader is reading a Tag, or to determine the Tag reading 


range. 
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IImmpprrooXX  OO1166  


 Ping Test—use the Firmware Upgrade Utility to run a Ping Test.  Ensure that the 


Terminal responds. 


 Comms Test—use the Firmware Upgrade Utility to run a Comms Test.  This ensures that 


communication between the Terminal and Controller is present. 


 Status LEDs—Terminal bus comms is correct if the Green LED and the Red LED on the 


Terminal are flashing.  The Rx and Tx LEDs are continuously on when the Terminal is 


communicating correctly.  If they flash intermittently, there are communication problems.  


The Relay LEDs indicate when the processor has sent a command for a particular relay to 


activate. 


 


 
Figure 27 – Position of the Status Indicators on the Front End Plate 


 


IImmpprrooXX  II1166  


 Ping Test—use the Firmware Upgrade Utility to run a Ping Test.  Ensure that the 


Terminal responds. 


 Comms Test—use the Firmware Upgrade Utility to run a Comms Test.  This ensures that 


communication between the Terminal and Controller is present. 


 Status LEDs—Terminal bus comms is correct if the Green LED and the Red LED on the 


Terminal are flashing. The Rx and Tx LEDs are continuously on when the Terminal is 


communicating correctly.  If they flash intermittently, there are communication problems.  


The Relay LEDs indicate when the processor has sent a command for a particular relay to 


activate. 


 


 
Figure 28 – Position of the Status Indicators on the Front End Plate 
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IImmpprrooXX  EERR  


 Ping Test—use the Firmware Upgrade Utility to run a Ping Test.  Ensure that the 


Terminal responds. 


 Comms Test—use the Firmware Upgrade Utility to run a Comms Test.  This ensures that 


communication between the Terminal and Controller is present. 


 Test Mode—testing Readers attached to ImproX ER. This mode indicates when a Tag is in 


range and being read by the Reader. 


 


To access Test Mode: 


1. Remove the RS485 communications cable from the ImproX ER. 


2. Wait for approximately 10 seconds until the ImproX ER’s RED status LED flashes 


intermittently. 


3. Present a Tag to the Antenna. 


4. When a Tag is read the Status LED changes to solid Green and the Buzzer emits a long, 


continuous beep while the Tag is in range. 


 


Use this procedure to verify that an Antenna is reading a Tag, or to determine the Tag reading 


range. 


 


IImmpprrooXX  LLRR  


 Ping Test—Use the Firmware Upgrade Utility to run a Ping Test.  Ensure that the 


Terminal responds. 


 Comms Test—Use the Firmware Upgrade Utility to run a Comms Test.  This ensures that 


communication between the Terminal and Controller is present. 


 Test Mode—Testing Readers attached to ImproX LR. This mode indicates when a Tag is in 


range and being read by the Reader. 


 


To access Test Mode: 


1. Remove the RS485 communications cable from the ImproX LR. 


2. Wait for approximately 10 seconds until the ImproX LR’s RED status LED flashes 


intermittently. 


3. Present a Tag to the Antenna. 


4. When a Tag is read the Status LED changes to solid Green and the Buzzer emits a long, 


continuous beep while the Tag is in range. 


 


Use this procedure to verify that an Antenna is reading a Tag, or to determine the Tag reading 


range. 


 


IImmpprrooXX  BB--SSHHOO  FFiinnggeerrpprriinntt  TTeerrmmiinnaall  


 Ping Test—use the Firmware Upgrade Utility to run a Ping Test.  Ensure that the 


Terminal responds. 


 Comms Test—use the Firmware Upgrade Utility to run a Comms Test.  This ensures that 


communication between the Terminal and Controller is present. 
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 POST Test—on power-up, the Terminal automatically runs a Power-on Self-test (POST). 


Power-on Self-test (POST) tests the RAM, Flash Checksums, and the Fingerprint Scanner 


Circuitry. 


 If a parameter fails, the Terminal emits a continuous beep for 2 seconds. 


 When the Power-on Self-test (POST) is complete, the Terminal emits two short beeps. 


 


IImmpprrooXX  MMMMAA  AAnntteennnnaa  RReeaaddeerr  


 Tag Reading Test—Present a Tag to the Antenna Reader by moving in from a distance.  


The status LED illuminates when the Tag is read.  Ensure that the read distance is 


adequate. 


 LED Test—Using ImproNet Access, set the Antenna Reader’s LED state to Red strobe 


Green, and then to Green strobe Red.  Ensure that the LED flashes Red and Green for 


both settings. 


 


IImmpprrooXX  RReemmoottee  RReeaaddeerrss  


ImproX Remote Readers are dependent on their host Terminal.  Therefore, refer to the 


appropriate ImproX Terminal maintenance information for details. 


 


WWiieeggaanndd  RReeaaddeerrss  


Wiegand Readers are dependent on their host Terminal.  Therefore, refer to the appropriate 


ImproX Terminal maintenance information for details. 


 


 


USER NOTES 


 


 


 


 


 


 


  


 


 


 


 


 


 


 


 


 


 


 


 


 


 


IXP362-0-0-GB-10 Issue 11 January 2012 
ImproNet\English Manual\LATEST ISSUE\ 


P1 400i-swm-en-11.docx 
 





		ImproNet Software Manual

		Copyright and Trademark

		Copyright

		Trademarks



		At a Glance

		Contents

		Introduction

		Document Conventions

		Terminology

		Impro-Specific Terminology

		Country-specific Terminology



		Supported Software and Firmware Versions



		PART 1 – HARDWARE

		General Hardware Installation Guidelines

		Essential Installation Requirements

		Part Number

		Serial Numbers

		Power Supply

		Requirements

		Recommendations

		Arc Suppression

		Surge Protection



		Communication

		Recommended Cable



		Network Topology

		Placement of ImproX Units

		Minimum Distance between ImproX Units

		Shielding of Units

		Line Termination—Principles of a Terminating Resistor



		Grounding the Shield in an IXP400 System

		Grounding Controllers and Terminals in an IXP400 System

		Common Ground

		Separate Ground Points



		Terminating the Communication Bus

		RS485 Host Bus (Port 2)

		Terminal Bus (Port 1)



		Door Hardware Units

		Door Strike

		Magnetic Locks





		Summary of Cable Requirements

		General Requirements

		Low Voltage Power Supply to Controllers and Terminals

		Digital Input Specifications



		Input Voltage Requirements

		Comms Interfaces

		Enrollment Readers

		Controllers

		Terminals



		ImproNet Hardware Components

		Interface Devices

		Remote Readers

		Controllers

		Controller Operation and Functionality



		Terminals

		Tag Reading Terminals

		Non Tag-Reading Interface Terminals

		Non Tag-Reading Terminals

		Biometric Terminals



		Bus Types (ImproX IC)

		Host Bus (Controller Port 2)

		Terminal Bus (Controller Port 1)



		System Hardware Combinations

		IXP300

		IXP400

		IXP400i



		ImproX Units for use in an IXP300, IXP400 or IXP400i System

		Interface Devices

		Controllers

		Terminals

		Antenna Readers

		Remote Readers

		Wiegand Readers

		Receivers

		Other

		Remote Reader and Antenna Reader Compatibility



		System Size Limits



		Installation Information

		Doors and Zones

		Addressing Scheme

		Logical Addresses

		Fixed Addresses

		ImproX iTT and ImproX MfT



		Recording Installation Information



		Positioning Units



		Hardware Maintenance

		Maintenance Overview

		Maintenance Tools

		Hardware Tools

		Software Tools

		Ethernet Configuration Utility

		Ethernet Discovery Utility

		Firmware Upgrade Utility

		Performing a Comms Test





		Hardware Testing

		Communications

		Tag Reading

		Buzzer

		LEDs



		Specific Maintenance

		ImproX RH

		ImproX RRA or ImproX RRM

		ImproX IC

		ImproX EC

		ImproX ECII

		ImproX MfT

		ImproX iTT

		ImproX iTRT

		ImproX MDTA Multi-discipline Time Attendance Terminal

		ImproX DBv 125 kHz Variant

		ImproX DBv 13.56 MHz Variant

		ImproX O16

		ImproX I16

		ImproX ER

		ImproX LR

		ImproX B-SHO Fingerprint Terminal

		ImproX MMA Antenna Reader

		ImproX Remote Readers

		Wiegand Readers









